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Introduction
This guide will help you gain familiarity with Altair Analytics Workbench, the graphical user interface of
Altair SLC. Altair Analytics Workbench has two environments: The SAS Language Environment (SLE),
for developing traditional text based SAS language programs, and the Workflow Environment (WFE), a
drag-and-drop graphical development tool. Each environment comes with its own perspective, that tailors
Altair Analytics Workbench's features and views to each environment.

The SAS Language Environment enables you to create, edit and run SAS language programs, along with
their resulting datasets, logs and other output.

The Workflow Environment is a graphical development environment with features for data mining,
predictive modelling tasks, and a range of Machine Learning capabilities.

For an overview of some commonly-used features, see Altair SLC tips and tricks  (page 526). For
information to help you resolve some previously-reported problems see Altair SLC troubleshooting
(page 528).

About Altair SLC
A description of the main two components of Altair SLC: an Integrated Development Environment (IDE)
and a compiler/interpreter.

Altair SLC consists of the following components:

• An Integrated Development Environment (IDE) – Altair Analytics Workbench. This environment
utilises the Eclipse IDE and provides facilities to create and manage SAS language programs, and
then to run these programs using the Altair SLC Server.

• A compiler/interpreter – the Processing Engine, known as Altair SLC Server when in the SAS
Language Environment and the Engine when in the Workflow Environment. When using Altair
Analytics Workbench, the compiler is run as a server process and is used to process and execute
programs.

Altair SLC Server or Engine process
To run SAS language programs, Altair Analytics Workbench requires a connection to a licensed
Processing Engine (for more information, see Processing Engines  (page 31)). This process may be
running either on the local workstation (a local server or local engine), or on an installation of Altair SLC
on a remote machine (a remote server or remote engine).

7



Altair Analytics Workbench user guide
Version 2023

Altair SLC and SAS® software
An overview of the relationship between Altair SLC and SAS® software.

If you are accustomed to using other products related to the SAS language, you will find that the
language support in Altair SLC is familiar. You can expect to find much of the same syntax in terms of
procedures, formats, macros, DATA steps, and so on.

Altair SLC provides other recognisable features and objects such as logs, datasets, or the Work library.
Other features may be new to you, such as the Altair Analytics Workbench environment itself and the
way in which it handles or displays objects. You will find that the Altair Analytics Workbench has help and
reference material to assist you in migrating to Altair SLC .

Compatibility with SAS® software
Besides being able to run, modify, share and save programs written in the SAS language, Altair SLC is
also able to read and write data files used by SAS software, for example SAS7bdat files. Altair SLC also
includes a wide selection of library engines to allow you to access many leading third party databases,
data warehouses and Hadoop big data environments.

Altair SLC uses a proprietary dataset file format known as WPD. Temporary datasets written to the Work
library use this WPD format.

Supported language elements
Altair SLC does not yet support every element in the SAS language. Altair Analytics Workbench provides
a code analysis tool (see Code Analyser  (page 13)) to help determine if any of your existing
SAS programs contain unknown language elements. Details of the SAS language elements currently-
supported in Altair SLC can be found in the Altair SLC Reference for Language Elements.

Existing SAS programs
Altair SLC uses the terms SAS language program, or program to describe scripts, programs and
applications written in the SAS language.

Altair Analytics Workbench components
Brief descriptions of the types of objects managed by the Altair Analytics Workbench.

Projects
The fundamental unit of organisation for SAS language programs and related objects. For
example, you might have a project for applications under development, or another for monthly
reporting jobs. For more information, see Projects  (page 51).
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SAS language programs
Create or modify SAS language programs using the SAS language editor. Files containing SAS
language programs use either .wps or .sas extensions. For more information see SAS language
editor  (page 163).

Workflow
The Workflow Environment is a drag-and-drop graphical development environment with features
for data mining, predictive modelling tasks, and a range of Machine Learning capabilities.

Log output
When you run a SAS language program, the information generated is stored in a log file. This file
can be viewed, printed and saved from within the Altair Analytics Workbench. The log generated
is cumulative and contains the results of each program run since opening Altair Analytics
Workbench, restarting the Processing Engine, or clearing the log. For more information, see Log
(page 82).

Listing output
This contains the printed output from any programs that you have run. For example, this could
be a table of data generated by a PROC PRINT statement. Listing output can be viewed, printed
and saved in the Altair Analytics Workbench. The listing output generated is cumulative and
contains the output of each program run since opening Altair Analytics Workbench, restarting the
Processing Engine, or clearing the listing output. For more information, see Listing output  (page
157).

ODS output
As described, the ODS (Output Delivery System) can be used to produce text listing and HTML
output. Each program can specify when and where its output is stored but it is also possible to
allow the Altair Analytics Workbench to manage the process automatically. The default option is
for the Altair Analytics Workbench to generate HTML output. For more information see Managing
ODS output  (page 156).

Datasets
The data generated from running a program is stored in datasets. You can browse or edit a
dataset using the dataset viewer. For more information, see Datasets  (page 134).

Host Connection
A computer, local or remote that Altair Analytics Workbench can access. The local host connection
enables you to run SAS language programs and Workflows on the Processing Engine installed on
your local machine. Connections can also be made to remote Altair SLC Servers, see Connecting
to a remote Processing Engine  (page 33) for more information.

Processing Engine
Executes SAS language programs and Workflows and generates the resulting output, such as
the log, listing output, results files, and datasets. For more information, see Processing Engines
(page 31).
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Workspace Launcher
A description of the Altair Analytics Workbench Launcher that is displayed when Altair Analytics
Workbench is opened, allowing you to choose which workspace to use.

When you open Altair Analytics Workbench, the Altair Analytics Workbench Launcher dialog box is
displayed.

A workspace is the parent folder used to hold one or more projects (see  projects  (page 51)).
It is possible to use any folder on any drive that your computer can access as a workspace, and the
workspace you use is the default location for newly-created projects.

You do not have to use projects to manage your Altair Analytics Workbench resources; any files you
can access (on your local system or a remote computer) can be accessed in Altair Analytics Workbench
through the File Explorer (see File explorer  (page 76)).

On Windows, the default location of the workspaces is your My Documents folder, and, on UNIX and
Linux platforms, it is your home directory. In all cases, by default the sub-directory is called Workbench
Workspaces and the workspaces are by default named incrementally, starting at Workspace1.

To use a different workspace either select the name in the Workspace list, select a workspace from
the Recent Workspaces list, or click Browse and navigate to the workspace folder in the Select
Workspace Directory dialog box.

The Altair Analytics Workbench Launcher dialog box is displayed whenever you start Altair Analytics
Workbench. To hide the dialog box at start up and use the selected workspace every time you start Altair
Analytics Workbench, select the Use this as the default and do not ask again check box.
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Migrating existing programs
or projects
Details of how to use existing projects or SAS language programs with the latest version of Altair SLC .

Importing an existing project
Importing an existing project into Altair Analytics Workbench.

To import an existing project into the Altair Analytics Workbench:

1. Click the File menu, click Import to open the Import wizard.
2. On the Select page, expand the tree under the  General node, select Existing Projects into

Workspace and click Next
3. Select the import method:

• To import an existing project, click Select root directory and either select the project from the list
or click Browse to navigate to the folder where the project is located.

• To import an archived project, for example a project stored as a Zip .zip file, click Select archive
file. Select the archive file from the list or click Browse to navigate to the folder where the archive
file is located.

If the archive file or folder contains a valid project, the project name is added to the Projects list.
4. Click Finish to import the selected project.

Use this method to import the samples project supplied with Altair Analytics Workbench. Sample projects
are available in each supported language, and the project archive file samples.zip is located in the
doc/<language> folder in your Altair Analytics Workbench installation.
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Migrating from previous versions of
Altair SLC
Workspaces from previous versions of Altair SLC can be opened using the latest version, possibly
requiring an automated migration step to be confirmed when doing so.

Workspaces opened with previous versions of Altair SLC can be opened with the current version, so
there are no migration steps to be performed to use a workspace from a previous version of Altair SLC
with the latest version. However, the first time that you open a workspace that was created using an
earlier version of Altair SLC , an Eclipse dialog is displayed asking for your confirmation that it is OK for
the workspace to be upgraded automatically. Such automatic upgrades should not cause any problems.

Existing  programs do not need to be modified to work with the latest version of Altair SLC . In
addition, projects that were created with earlier versions of Altair SLC can be opened and used by later
versions of Altair SLC without any additional action.

Migrating programs from SAS® software
into the Altair SLC SAS Language
Environment
Using existing programs written in the SAS language with the Altair Analytics Workbench

If you already have programs written in the SAS language, there is no conversion process to undertake in
order to use these programs with Altair SLC. Any file with the .wps or .sas extension is assumed to be a
program that the Altair Analytics Workbench can open, edit and run.

Accessing your existing programs
You can access your existing programs from the File Explorer view.

Alternatively, you can use Altair Analytics Workbench projects, to manage your files enabling you to use
other features such as local history.

Checking program compatibility
Opening programs in the Altair Analytics Workbench causes unknown or unsupported language
elements to be displayed in red. However, before trying to execute your existing programs with Altair
SLC, it is also recommended that you use the Altair Analytics Workbench Code Analyser  (page 13)
for further verification.
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Analysing programs, even hundreds of programs at a time, can take less than a few minutes to complete
and can therefore be quicker than trying to execute long-running programs. Program analysis is available
from both the File Explorer view or the Project Explorer view.

Code Analyser
Use the Altair Analytics Workbench SAS Language Environment's Code Analyser tool to scan the code
of existing programs written in the SAS language.

The Code Analyser is a feature of the Altair Analytics Workbench and can therefore only be used on
platforms on which Altair Analytics Workbench is supported. The Code Analyser generates reports that
indicate which of your existing programs will run unchanged in Altair SLC, which programs may require
modification to run, and which programs contain language elements not yet supported by Altair SLC .

The Code Analyser enables you to:

• Analyse Program Compatibility – determines whether your existing programs or projects contain
any unsupported language elements.

• Analyse Language Usage – lists language elements used in the selected programs or projects. The
analysis indicates which elements are supported and which are not.

Analysing mainframe programs
The Code Analyser is a feature of the Altair Analytics Workbench and can therefore only be used on
platforms on which Altair Analytics Workbench is supported. To analyse programs designed to run on a
mainframe, copy the required programs from the mainframe to a workstation running the Altair Analytics
Workbench. When these programs are analysed, the Code Analyser will identify SAS language elements
specific to the z/OS platform.

Before analysing programs copied from a mainframe to a workstation:

• We recommended you remove sequence numbers from your jobs.
• Ensure each program file has a file extension of .sas
• Package up the jobs on the mainframe using XMIT.
• Once transferred to the workstation, use XMIT Manager to un-XMIT the jobs for analysis.

Note:
XMIT Manager can only handle PDSs (Partitioned Datasets) and not PDSEs (Extended Partitioned
Datasets).

When downloading the XMIT files from mainframe to your workstation, you must specify FB (Fixed
Block) with an LRECL (Logical Record Length) of 80 and with no ASCII/EBCIDIC conversion, truncation
or CRLF translation.
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Running analyses
The Code Analyser can quickly analyse single programs, all programs in one or more projects, or all
programs in one or more folders.

Programs that might normally be executed on multiple different platforms can be analysed together.
Gather the programs from these other environments, copy them to your workstation and then run the
analysis tools from Altair Analytics Workbench.

Analysing program compatibility
You can analyse one or more programs to identify language elements that are not yet supported by Altair
SLC .

To analyse SAS language programs:

1. Select the files to be analysed:

• Select the required file or files to analyse in the Project Explorer or File Explorer. You can
highlight programs in different projects or folders within the particular view.

• Select one or more projects in the Project Explorer to analyse all contained programs.
• Select one or more folders in the File Explorer to analyse all contained programs.

2. In the view corresponding to your selection, right-click on the selected items and from the short cut
menu click Analyse, and then click Program Compatibility.

When the analysis has finished, a Program Compatibility Report automatically opens in the Altair
Analytics Workbench.
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This report contains details about unsupported language elements used in programs. It does not report
on any supported language elements that were used in the programs.

Analysing language usage
You can analyse one or more programs to identify supported language elements used in one or more
programs.

To analyse SAS language usage in programs:

1. Select the files to be analysed:

• Select the required file or files to analyse in the Project Explorer or File Explorer. You can
highlight programs in different projects or folders within the particular view.

• Select one or more projects in the Project Explorer to analyse all contained programs.
• Select one or more folders in the File Explorer to analyse all contained programs.

2. In the view corresponding to your selection, right-click on the selected items and from the short cut
menu click Analyse, and then click  Language Usage.

When the analysis has finished, a Language Usage Report automatically opens in the Altair Analytics
Workbench.
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This report details the SAS language elements used in the selected programs, and you can explore the
detail of this report in the Altair Analytics Workbench, or export the content to Microsoft Excel

Viewing or exporting an analysis report
You can view the detail of a Code Analyser report in Workbench, or export the report detail to Microsoft
Excel.

When viewing a report in Altair Analytics Workbench, you can navigate to more detail, and ultimately to
the source program where an issue is located.

• The program compatibility report summary links to a list of programs analysed. From this list you
can access a list of problem elements, see where those elements are used within a program, and
navigate to the element location within the file.

• The language usage report summary displays the SAS language elements used in the analysed
programs. From this list you can find the frequency of SAS language element usage, which programs
contain the elements, and navigate to the element location within the file.

Exporting analysis results to Microsoft Excel
The results of a program compatibility report or language usage report can be exported to a Microsoft
Excel workbook for either further analysis or to preserve the report information. To export a report:

1. In the report summary page, click Export results to Excel.
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2. In the Save as window, enter the required name for the workbook, and browse to the required
location before saving it.

Analysis restrictions
Limitations of the Code Analyser.

Because of the nature of the SAS language, the result of the analysis cannot be guaranteed, and reports
should be treated as a guide for further analysis.

The Code Analyser has some limitations:

• The Code Analyser will not report incorrect syntax.
• SAS language elements that are not yet supported in Altair SLC are now shown in the Compatibility

Report as unknown.
• The analysis reports do not currently contain information about the use of macro language elements

and library engine (data access) elements. Their use is however supported in Altair SLC .
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Licensing Altair Analytics
Workbench
Before using Altair Analytics Workbench, you must apply a licence. This can be through a local wpskey
file (.wpskey), a local Altair on-premise licence or through an Altair managed licence.

When you first open Altair Analytics Workbench, you are prompted to licence the product. The licence
can be applied in three ways:

• Wpskey licence - using a local wpskey file (.wpskey) to licence your Altair Analytics Workbench
installation.

• Altair on-premises licence - using Altair units from a localised Altair Licence Manager (ALM) to
licence your Altair Analytics Workbench installation.

• Altair managed licence - using Altair units with a remotely hosted Altair Hosted Hyperworks server
(HHWU) to licence your Altair Analytics Workbench installation.

If you try to use Altair Analytics Workbench without applying a licence, an Error dialog box is displayed
and no processing will occur until your Altair Analytics Workbench installation is licenced.

Note:
It is still possible to run the Code Analyser without a licence. For more information, see the Code
Analyser  (page 13) section.

Applying an Altair SLC licence in Altair
Analytics Workbench using wpskey
Licencing your Altair SLC Server using the wpskey method.

To licence your Altair Analytics Workbench installation using a wpskey file:

1. Open Altair Analytics Workbench.

If this is the first time you are using Altair Analytics Workbench, the Licence Type dialog is displayed.
If you have already applied a licence and want to change it, you have to open the Licence Type
dialog manually. If the Altair SLC Server Explorer pane is not already displayed, click the Altair SLC
Server Explorer tab. Then right-click the required Altair SLC Server and select Apply Licence.

2. Select Wpskey licence, then click Next.

The Import Wpskey Licence dialog is displayed.
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3. Click Import From File, browse to the wpskey file and click Open. Alternatively you can paste the file
contents into the text box.

4. Click Finish.

Your Altair Analytics Workbench is now licensed for the selected Altair SLC Server. For more
information about licensing your Altair Analytics Workbench installation, or if you encounter issues,
contact the Altair support team. For more information on contacting the Altair support team, see Making
technical support requests  (page 529).

Applying an Altair SLC licence in Altair
Analytics Workbench using Altair units
from an Altair on-premises licence file
Using Altair units from a localised Altair Licence Manager (ALM) to licence your Altair Analytics
Workbench installation.

Licencing your Altair SLC Server using the Altair on-premises licence file method:

1. Open Altair Analytics Workbench.

If this is the first time you are using Altair Analytics Workbench, the Licence Type dialog is displayed.
If you have already applied a licence and want to change it, you have to open the Licence Type
dialog manually. If the Altair SLC Server Explorer pane is not already displayed, click the Altair SLC
Server Explorer tab. Then right-click the required Altair SLC Server and select Apply Licence.

2. Select Altair On-Premises Licence, then click Next.

The Altair On-Premises Licence dialog is displayed.
3. Click Add to open an Add an Altair Licence Location dialog box.
4. Select Licence file then click Browse, browse to the licence file and click Open. Alternatively you

can enter the path to the file in the Path text box.
5. Click OK to close the Add an Altair Licence Location dialog box.
6. Click Finish.

Your Altair Analytics Workbench is now licensed for the selected Altair SLC Server. For more
information about licensing your Altair Analytics Workbench installation, or if you encounter issues,
contact the Altair support team. For more information on contacting the Altair support team, see Making
technical support requests  (page 529).
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Applying an Altair SLC licence in Altair
Analytics Workbench using Altair units
from an Altair on-premises licence
server
Using Altair units from a localised Altair Licence Manager (ALM) to licence your Altair Analytics
Workbench installation.

Licencing your Altair SLC Server using the Altair on-premises server licence method:

1. Open Altair Analytics Workbench.

If this is the first time you are using Altair Analytics Workbench, the Licence Type dialog is displayed.
If you have already applied a licence and want to change it, you have to open the Licence Type
dialog manually. If the Altair SLC Server Explorer pane is not already displayed, click the Altair SLC
Server Explorer tab. Then right-click the required Altair SLC Server and select Apply Licence.

2. Select Altair On-Premises Licence, then click Next.

The Altair On-Premises Licence dialog is displayed.
3. Click Add to open an Add an Altair Licence Location dialog box.
4. Enter a hostname and port number in Server host and Server port respectively.

If required you can click Verify Host to verify your connection.
5. Click OK to close the Add an Altair Licence Location dialog box.
6. Click Finish.

Your Altair Analytics Workbench is now licensed for the selected Altair SLC Server. For more
information about licensing your Altair Analytics Workbench installation, or if you encounter issues,
contact the Altair support team. For more information on contacting the Altair support team, see Making
technical support requests  (page 529).
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Applying an Altair SLC licence in Altair
Analytics Workbench using Altair units
from an Altair managed licence server
Using Altair units from a remote Altair Hosted Hyperworks server (HHWU) to licence your Altair SLC
Server.

Licencing your Altair SLC Server using the Altair managed licence server method:

1. Open Altair Analytics Workbench.

If this is the first time you are using Altair Analytics Workbench, the Licence Type dialog is displayed.
If you have already applied a licence and want to change it, you have to open the Licence Type
dialog manually. If the Altair SLC Server Explorer pane is not already displayed, click the Altair SLC
Server Explorer tab. Then right-click the required Altair SLC Server and select Apply Licence.

2. Select Altair Managed Licence, then click Next.

The Altair Managed Licence dialog is displayed.
3. You can authorise your access to the server in two ways. To use a login:

a. Enter your e-mail address and password credentials for Altair One in E-mail address and
Password respectively.

b. Click Authorise to verify your connection.

To use an authorisation code:

a. Generate an authorisation code from the Altair One website.
b. Select Authorisation code and enter the code in the Authorisation code text box.
c. Click Authorise to verify your connection.

4. Click Finish.

Your Altair Analytics Workbench is now licensed for the selected Altair SLC Server. For more
information about licensing your Altair Analytics Workbench installation, or if you encounter issues,
contact the Altair support team. For more information on contacting the Altair support team, see Making
technical support requests  (page 529).
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Online help
The context-sensitive Help view automatically displays relevant help items as you select different Altair
Analytics Workbench views.

This view is not open by default. To add this view to the current perspective click the Help menu and
then click Show Contextual Help or press F1.

Help view
The Help view can also display the content of the Altair SLC documentation; to do this click the Help
menu and then click Help Contents. The Help view provides features to help you navigate through the
documentation:

• Show in Contents – ( , at top right of help window) synchronises the table of contents with the help
topic you are reading.

• Bookmark Document – ( , at top right of help window) adds a shortcut to a specific page in the
documentation.

• Search – (top left of help window) search the help for specific keywords and phrases.
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Cheat sheets
The Altair Analytics Workbench contains tutorials known as cheat sheets designed to help you start
using Altair SLC by introducing specific tasks and features.

Cheat sheets can be one of two different types:  simple or  composite.

A simple cheat sheet, designed to guide you through a single task, has an introduction to set the scene,
followed by a list of tasks designed to be performed one after another:

A composite cheat sheet is designed to guide you through a more complex problem. The problem is
broken down into smaller manageable groups, each group consisting of an introduction and conclusion:

Composite cheat sheets have two panes in the user interface. One shows the groups of tasks, the other
shows the tasks in each group.
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Open a cheat sheet
Cheat sheets are opened from the help menu in the Altair Analytics Workbench.

1. Click the Help menu and then select Cheat Sheets.
2. If necessary, expand the Altair Analytics Workbench grouping.
3. Select the cheat sheet from the list, and click OK to open.
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Close a cheat sheet
You can close the active cheat sheet by selecting the  Close on the cheat sheet's tab. The active cheat
sheet saves its completion status when it is closed so that you can continue where you left off when you
next reopen it.

Working through a cheat sheet
When you open a new cheat sheet, the introduction is expanded so that you can read a brief description
about the selected cheat sheet.

In a simple cheat sheet, click Click to Begin at the bottom of the introductory step. The next step is then
expanded and highlighted. You should also see action buttons at the bottom of the next step, for example
Click to Complete.

In a composite cheat sheet, read the introduction and then click the Go to... link at the bottom of the
first sheet. The introduction for the first group is displayed, click the Start working... link to begin. You
progress through a group in the same manner as a simple cheat sheet.

In simple cheat sheets or a composite group, when you have finished a particular step, click Click when
complete to move to the next step. A check mark  appears in the left margin of each completed step.

Composite cheat sheets have a conclusion, and also the option to review the task, or to progress onto
the next group of tasks. Starting the next task will take you to the introduction for the next group.

You can open any step out in a cheat sheet by clicking the title of the section. If you are working through
each step in the sheet, click   Collapse All Items but Current to collapse all opened steps except the
current active step waiting to be completed.

In composite cheat sheets, you can review any previously-completed group by clicking the group in
the task group pane. The displayed point in the group is where you left that group, for example if you
completed the group tasks, the conclusion is displayed.

A simple cheat sheet is completed when you finish the last step. A composite cheat sheets is complete
when all task groups have been finished.

To restart from the first step, open the first step and click Click to Restart. A Composite cheat sheet
allows you to reset task groups. Right-click on the task group in the groups pane and click Reset.
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Environments
Altair Analytics Workbench has two environments: The SAS Language Environment (SLE), for
developing traditional text based SAS language programs, and the Workflow Environment (WFE), a
higher level graphical development tool.

The SAS Language Environment
The SAS Language Environment enables you to create, edit and run SAS language programs, and view
the resulting datasets, logs and other output.

Opening the SAS Language Environment Perspective
To open the SAS Language Environment perspective, click on the SAS Language Environment button
at the top right of the screen: . This button can be made clearer by right-clicking on it and selecting
Show Text; this displays the name of the button on the button itself: .

The Workflow Environment
The Workflow Environment is a drag-and-drop graphical development environment with features for data
mining, predictive modelling tasks, and a range of Machine Learning capabilities.

Opening the Workflow Environment Perspective
To open the Workflow Environment perspective, click on the Workflow Environment button at the top
right of the screen: . This button can be made clearer by right-clicking on it and selecting Show Text;
this displays the name of the button on the button itself: .

Overview
The Workflow Environment operates in a completely different way to how Altair Analytics Workbench
operates when you develop SAS language programs using the SLE.

The Workflow Editor view provides a palette of drag-and-drop interactive blocks that you combine to
create Workflows that connect to a data source, filter and manipulate the data into a smaller subset using
Data Preparation blocks. You can save the data to an external dataset for later use. You can use the
Machine Learning capabilities available in the Model Training blocks to discover predictive relationships
in your filtered and manipulated data.

26



Altair Analytics Workbench user guide
Version 2023

Once created, a Workflow is re-usable, so can be used with different input datasets to generate output
datasets filtered or manipulated in the same way.

A Workflow can auto-generate error-free code from the models, ready for deployment and execution in
production.

The Data Profiler view is a graphical tool that enables you to explore Altair SLC datasets used in a
Workflow, or external to a Workflow. You can use the Data Profiler view to interact with and explore your
data through graphical views and predictive insights.

Many of the Data Science features available in the Workflow Editor view are enabled by World
Programming's built-in SAS language capabilities. Although coding is not a prerequisite for creating a
Workflow, those in the team who have the requisite programming skills can carry out more advanced
tasks in a Workflow, using not only the SAS language code block, but also R, Python and SQL.

Who should use the Workflow Environment
If you are familiar with the Cross-Industry Standard Process for Data Mining (CRISP-DM), you can
use Workflows to follow this process in the preparation and modelling of data sources of all sizes. The
Workflow Environment tools enable a team of people with different skill sets to work on the same data in
a collaborative environment. For example, a single Workflow could be created that enables:

• Data analysts to blend the prepared data through joining, transformation, partitioning, and so on, to
create raw datasets of varying sizes.

• Data scientists to use machine learning algorithms to build, explore and validate reproducible
predictive models, including scorecards, from proven datasets.
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Perspectives
The positions of available views, windows, view stacks, menu items, and toolbars, together with any
other items that make up the general layout of Altair Analytics Workbench, together constitute a 
perspective.

There are two default perspectives provided with Altair Analytics Workbench, one for each environment:

• Workflow Environment perspective: A collection of views suited to producing Workflows. Some views
are applicable to just the Workflow Environment, some to the SAS Language Environment and some
to both.

• SAS Language Environment perspective: A collection of views suited to producing SAS language
code. Some views are applicable to just the Workflow Environment, some to the SAS Language
Environment and some to both.

The Altair Analytics Workbench can be specified to automatically change to a default perspective
depending on opening a specific file type. SAS languange programs can be automatically displayed in
the SAS Language Environment perspective; Workflows can be automatically displayed in the Workflow
Environment perspective.

The two default perspectives can each be customised by moving, resizing, adding or removing different
views. You can save customised perspectives and switch between different Altair Analytics Workbench
perspectives.

When you open Altair Analytics Workbench, the windows views, toolbars and the so on, are displayed in
the same arrangement as when closed. This ensures that your preferred perspective is visible when you
open Altair Analytics Workbench.

Opening a perspective
Opening a perspective in Altair Analytics Workbench.

To open a different perspective, click the Window menu click Open Perspective and then click Other:

• To open one of the default perspectives, click either Workflow Environment perspective or SAS
Language Environment perspective. These default perspectives can also be opened using the
quick access icons at the top right of the Altair Analytics Workbench window.

• To open another perspective, click Other, then select the required perspective from the list and click
OK.

The selected perspective is displayed in Altair Analytics Workbench. If you have other perspectives
available, they are listed in top right of the Altair Analytics Workbench, so that you can click switch
between them quickly.
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Closing a perspective
Closing a perspective in Altair Analytics Workbench.

To close a perspective:

1. If you have more than one perspective open, ensure that the Altair Analytics Workbench is displaying
the one that you want to close.

Note:
To switch perspective, look in the area to the right of the Open Perspective  icon, and then click
on the perspective required.

2. Select Window ➤ Perspective ➤ Close Perspective.

Note:
To close all the perspectives, so that only the Default Perspective remains available, select
Window ➤ Perspective ➤ Close All Perspectives Your interface will go blank.

Note:
To restore the default perspective, select Window ➤ Perspective ➤ Open Perspective ➤ SAS
Language Environment.

Resetting a perspective
Resetting a perspective in Altair Analytics Workbench back to its default layout.

To reset the current perspective back to its default layout:

1. Select the Window menu, click Perspective, then Reset Perspective.
2. You are prompted for confirmation to reset the perspective. Click Yes to confirm that you wish to do

so.

Saving a perspective
Saving a perspective in Altair Analytics Workbench.

If you have changed the layout of a perspective, you can save it under a user defined name for future
use, as follows:

1. Select the Window menu, then click Save Perspective As….
2. Enter a name for the perspective at the top of the Save Perspective As... dialog.
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3. Click OK to continue.

The new perspective appears in the top right of the Altair Analytics Workbench, to the right of the Open
Perspective  icon.

Deleting a perspective
Deleting a perspective in Altair Analytics Workbench.

To delete a perspective:

1. Select the Window menu, then Preferences.
2. From the left hand tree view of the Preferences window, select General, then Perspectives.
3. From the list of Available perspectives, click on the perspective that you want to delete.
4. Click Delete to remove the perspective permanently.

Note:
You can only delete perspectives that you have created. You cannot delete a perspective that was
supplied with Altair SLC , including the SAS Language Environment perspective.

5. Click OK to close the Preferences window.
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Processing Engines
Altair Analytics Workbench uses one or more Processing Engines to run SAS language programs
and Workflows. In the SAS Language Environment, Processing Engines are referred to as Altair
SLC Servers; whereas in the Workflow Environment Processing Engines are referred to as Engines.
Processing Engines can exist locally, on the same host as the Altair Analytics Workbench installation, or
remotely, on another host.

Viewing servers and connections
The list of defined connections and Processing Engines is stored in a workspace, and is visible through
the Link Explorer (when in the SAS Language Environment perspective) or the Workflow Link
Explorer (when in the Workflow Environment perspective).

Location of Processing Engines
A Processing Engine can either be on the local workstation or on a remote machine with an installation
of Altair SLC .

• A Processing Engine on a local machine (a local server or local engine) can be accessed through a
local host connection.

• A Processing Engine on a remote host (a remote server or remote engine) can be accessed through
a remote host connection.

Setting up remote servers can give you access to the processing power of remote server machines from
the Altair Analytics Workbench on your workstation. Multiple servers can run under a single remote host
connection. For more information, see Connecting to a remote Processing Engine  (page 33).

When Altair Analytics Workbench is first installed, a single local host connection called Local is created.
This local connection hosts the Processing Engines: a Local Server for the SAS Language Environment
and a Local Engine for the Workflow Environment. This connection is started by default when the Altair
Analytics Workbench is started, and terminates when the Altair Analytics Workbench is closed.

Altair SLC Server data
As well as running SAS language programs, Altair SLC Servers in the SAS Language Environment
contain data associated with programs they have run, such as the log, output results, file references,
library references and datasets. This does not apply to Engines, which exist purely to run Workflows.

Creation of new Processing Engines
In the SAS Language Environment, further local servers can be created if required, or the local server
can be deleted or uninstalled. Creating multiple local servers requires no further licensed Altair SLC
products and the only restriction on the number of local servers is the local machine resources.
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In the Workflow Environment, only one engine per host can be manually defined. Altair Analytics
Workbench will automatically create and manage multiple engines as and when required to run
concurrent Workflow branches. The number of engines currently running is shown by a number in
brackets after the engine name in Workflow Link Explorer. All engines on a host will use the original
engine's properties as a template.

Changing workspaces
If you change workspace, you may have different connections and Processing Engines. To share
server definitions in a work group, or between workspaces, export (see Exporting an Altair SLC Server
definition  (page 37)), and import (see Importing an Altair SLC Server definition  (page 37))
Processing Engine definitions to or from a file.

Configuring a local Altair SLC
installation
If you only run SAS language programs and Workflows on a remote Processing Engine, you can modify
your Altair Analytics Workbench installation to remove the local Processing Engine. This option is only
available for Altair Analytics Workbench installations on Microsoft Windows.

To remove the local Processing Engine:

1. From the Windows start menu, open Settings, and then click Apps, to open the Apps & Features
window.

2. Locate and click on Altair SLC, then click Modify.
3. Click Next at the Welcome to the Altair SLC Setup Wizard screen.
4. Click Change at the top of the Programs and Features window.
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5. In the Custom Setup window, clear Altair SlC Local Server and complete the amended installation.

On a non-Windows platform, the Altair SLC Server cannot be removed from the Altair Analytics
Workbench installation. To remove the local server access from Altair Analytics Workbench, in the Link
Explorer view, select the Local Server and click Delete.

Connecting to a remote Processing
Engine
How to create a link from Altair Analytics Workbench to an Altair SLC Server on a remote machine.

The Altair SLC Server must exist before a connection can be made from Altair Analytics Workbench.
The remote server requires a licensed copy of the Altair SLC Server. If the remote server is Windows, it
requires an SSH server; this is not necessary for Linux due to native SSH support.

Client/server installation summary
Before connecting to a remote server, you require the hostname for the remote server, the user name
and password log on credentials, and the full Altair SLC Server installation path on the remote server.

To create a connection to a remote server:

1. Create a connection to the remote host. See Creating a new remote host connection  (page 34).
2. Add an Altair SLC Server to this remote host. See Defining a new Processing Engine  (page

36).
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Creating a new remote host connection
A remote host connection enables you to access a remote host's file system using the File Explorer view
and link to a remote Processing Engine to run Workflows or SAS language programs.

New remote hosts will display in both Link Explorer view and Workflow Link Explorer, but links to
Altair SLC Servers can only be viewed in the SAS Language Environment perspective, and Workflow
Engines in the Workflow Environment.

Before creating a new connection, you will need:

• SSH access to the server machine that has a licensed Altair SLC Server installation.
• The installation directory path for the Altair SLC Server installation.

You may need to contact the administrator to obtain this information, and to ensure that you have access.
For more details about SSH authentication, see the Altair SLC Link user guide and reference.

To create a new remote host connection:

1. Click the Altair menu, click Link and then click New Remote Host Connection. The New Server
Connection dialog is displayed.

2. Select New SSH Connection (3.2 and later – UNIX, MacOS, Windows) and click Next.
3. Complete the New Remote Host Connection (3.2 and later) dialog box as follows:

a. In Hostname, enter the domain name or IP address of the remote server machine.
b. Unless modified by your system administrator, the default Port value (22) should be left

unchanged.
c. In Connection name enter a unique name to be displayed in Altair Analytics Workbench for this

connection. By default this entry will be copied from your entry in the Hostname box.
d. In User name, enter your user ID on the remote host.

Click the required check box:

Option Description
Enable compression Controls whether or not data sent between the

Altair Analytics Workbench and the remote
connection is compressed.

Verify Hostname Confirms whether the host you have specified in
the Hostname entry exists.

Open the connection now Whether the connection is automatically opened
immediately

Open the connection automatically on
Workbench startup

Controls whether the connection is automatically
opened when the Altair Analytics Workbench is
started.
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4. Click Next to define the connection directory shortcuts (if required):

a. Click Add to display the Directory Shortcut dialog box.
b. In Directory Name enter the displayed shortcut name, and in Directory Path the full path of the

target directory. Click OK to save the changes.
c. Enter the displayed shortcut name in Directory Name, and the full path in Directory Path and

click OK.
5. Click Finish to save the changes.

If you have not previously validated the authenticity of the remote host, an SSH2 Message dialog box
is displayed requesting confirmation of the new connection.

6. In the Password Required dialog enter your password for the remote machine and click OK.

The Link Explorer view contains an entry for the new connection. To run a Workflow or SAS language
program, you will now need to define a new processing engine (see Defining a new Processing
Engine  (page 36)).

Advanced connection options
Controlling the environment variables available to a remote Processing Engine.

By default, the Processing Engine process inherits the interactive shell environment for the user under
whose ID the server is being started. The default environment may not include everything required by the
Processing Engine, for example database client shared libraries may not be defined for the server.

On Unix/Linux systems, this might require that any special environment variables for the Processing
Engine are added to the LD_LIBRARY_PATH; or the /etc/profile or ~/.profile modified so that
database client shared libraries can be loaded by the Processing Engine.

An alternative on Unix/Linux is to place a wpsenv.sh file in the Altair SLC installation directory, or in
your home directory. This file is automatically run before the server is launched

On Windows, any special environment variables for the Altair SLC Server should be configured through
the Control Panel, as either system or user environment variables.

Note:
All processes running as the user will see the created variables, and there is no way to specify that they
should only be visible to the Altair SLC process.

Exporting a host connection definition
A host connection definition can be exported from Altair Analytics Workbench to enable sharing in a
workgroup or to copy connection definitions between workspaces.

To export host connection definitions:
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1. In the Link Explorer, select the connection for which definitions will be exported.
2. Right-click the connection and click Export Host Connection in the shortcut menu.
3. In the Export to File dialog box, navigate to the save location, enter a File name and click Save. The

exported file .cdx contains the connection definition in XML format.

The host connection definition is saved to the selected file, which can be shared in the workgroup.

You can select multiple connections in the Link Explorer view and export them all to the same definition
file to share more than one connection definition.

See Importing a host connection definition  (page 36) for how to import the connection definitions
into a workspace.

Importing a host connection definition
A host connection definition can be imported into Altair Analytics Workbench to use consistent host
definitions in a workgroup or between workspaces.

This task assumes that you have previously exported some connection definitions to a file, or have been
provided with an export file created by someone else in your work group.

1. Click the Altair menu, click Link, and then click  Import Remote Host Connection.
2. In the Import Host Connection dialog box, select the required connection definition file (.cdx) and

click Open.

The host connection definition is imported from the selected file.

If there are any name clashes, the imported connection definition is automatically renamed so that it has
a unique name within your list of connections.

Defining a new Processing Engine
In the SAS Language Environment, Altair Analytics Workbench allows you to manually create multiple
Altair SLC Servers on a local or remote host connection. In the Workflow Environment, only one Engine
can be created for each host.

New Processing Engines can only be defined for an active host connection.

To define a new Processing Engine:

1. In Workflow Link Explorer or Link Explorer view, right-click on the host you wish to create an engine
on, and select New Altair SLC Server (SAS Language Environment), or New Engine (Workflow
Environment).
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2. In New Altair SLC Server or New Remote Engine dialog box, enter a unique display name in
Server name or Engine Name (or accept the default suggestion).

If you are defining a new remote Altair SLC Server, then in the Base Altair SLC install directory box
enter the path to the Altair SLC base installation directory on the remote server.

3. Click Finish save the changes.

The Link Explorer view contains an entry for the new Altair SLC Server.

Exporting an Altair SLC Server definition
In the SAS Language Environment, an Altair SLC Server definition can be exported from Altair Analytics
Workbench to enable sharing in a workgroup or to copy connection definitions between workspaces.

To export an Altair SLC Server definition:

1. In the Link Explorer view, select the server for which the definition will be exported.
2. Right-click the server and click Export Host Connection in the shortcut menu.
3. In the Export to File dialog box, navigate to the save location, enter a File name and click Save. The

exported file .sdx contains the connection definition in XML format.

The Altair SLC Server definitions will be saved to the selected file, which can be shared in the
workgroup.

You can select multiple servers in the Link Explorer view and export them all to the same definition file
to share more than one connection definition.

See Importing an Altair SLC Server definition  (page 37) for how to import the server definitions into
a workspace .

Importing an Altair SLC Server definition
In the SAS Language Environment, an Altair SLC Server definition can be imported into Altair Analytics
Workbench to use consistent definitions in a workgroup or between workspaces.

An Altair SLC Server definition can only be imported into a host connection. If you need to create a host
definition, see Creating a new remote host connection  (page 34).

To import an Altair SLC Server definition

1. Click the Altair menu, click Link, and then click Import Remote Host Connection.
2. In the Import from File dialog box, select the required server definition file (.sdx) and click Open.

The Altair SLC Server definitions are imported from the selected file.
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If there are any name clashes, the imported server definition is automatically renamed so that it has a
unique name within your list of Altair SLC Servers.

Connecting to an LSF cluster
How to create a link from Altair Analytics Workbench to an Altair SLC Server on an IBM Spectrum LSF
cluster.

The LSF cluster must exist before a connection can be made from the Altair Analytics Workbench
on your local machine. The LSF cluster requires a licensed copy of the Altair SLC Server and an
installation of Altair SLC on each execution host.

Client/server installation summary
Before connecting to an LSF cluster, you require the hostname for a submission host, the user name and
password log on credentials, and the full Altair SLC Server installation path on the submission host.

To create a connection to an LSF cluster:

1. Create a connection to the remote host. See Creating a new connection to an LSF cluster  (page
38).

2. Add an Altair SLC Server to this remote host. See Defining a new Processing Engine on an LSF
connection  (page 40).

Creating a new connection to an LSF cluster
A connection to an LSF cluster enables you to access the file system of the machine you have connected
to using the File Explorer view and link to a remote Processing Engine to run Workflows or SAS
language programs.

New LSF connections are displayed in both the Link Explorer view and the Workflow Link Explorer.
For more information about the connection node see Creating a new remote host connection  (page
34).

Before creating a new connection, you will need:

• Access to the cluster with a licensed Altair SLC Server installation.
• The installation directory path for the Altair SLC Server installation.

You may need to contact the administrator to obtain this information, and to ensure that you have access.
For more details about SSH authentication, see the Altair SLC Link user guide and reference.

To create a new remote host connection:
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1. Click the Altair menu, click Link and then click New Remote Host Connection.

A New Server Connection window is displayed.
2. Select New IBM Spectrum LSF Connection (4.3 and later) and click Next.
3. Complete the New IBM Spectrum LSF Connection dialog box as follows:

a. In LSF Submission host, enter the domain name or IP address of a submission host in the LSF
cluster.

b. Unless modified by your system administrator, the default Port value (22) should be left
unchanged.

c. In Connection name, enter a unique name to be displayed in Altair Analytics Workbench for this
connection. By default this entry will be copied from your entry in the Hostname box.

d. In User name, enter your user ID for the remote host.

Click the required check box:

Option Description
Open the connection now Specifies whether the connection is automatically

opened immediately.
Open the connection automatically on
Workbench startup

Controls whether the connection is automatically
opened when the Altair Analytics Workbench is
started.

Verify Hostname Confirms whether the host you have specified in
the Hostname entry exists.

4. If required, click Next to define connection directory shortcuts:

a. Click Add to display the Directory Shortcut dialog box.
b. In Directory Name, enter the displayed shortcut name. In Directory Path enter the full path of the

target directory. Click OK to save the changes.
5. Click Finish to save the changes.
6. In the Password Required dialog, enter your password for the remote cluster and click OK.
7. To runWorkflows on the LSF cluster, you need to specify a temporary file path for the connection:

a. Right-click the new connection and select Connection, then select Properties and Workflow
Properties.

b. Under Temporary File Path enter a path to store temporary files, this must be a path that every
machine in the LSF cluster has access to.

c. Click Finish to save the changes.

The Link Explorer view contains an entry for the new connection. To run a SAS language program or
Workflow, you will need to define a new processing engine (see Defining a new Processing Engine on an
LSF connection  (page 40)).
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Defining a new Processing Engine on an LSF connection
In the SAS Language Environment, you can create multiple Altair SLC Servers on your LSF connection.
In the Workflow Environment, only one Engine can be created for each LSF connection.

New Processing Engines can only be defined for an active host connection.

To define a new Processing Engine:

1. In Link Explorer view or Workflow Link Explorer, right-click on the host you wish to create an
engine on, and select New Altair SLC Server (SAS Language Environment), or New Engine
(Workflow Environment).

2. In New Altair SLC Server or New Remote Engine dialog box, enter a unique display name in
Server name or Engine Name (or accept the default suggestion).

If you are defining a new remote Altair SLC Server, then in the Base Altair SLC install directory box
enter the path to the Altair SLC base installation directory on the remote server.

Note:
The base Altair SLC install directory must exist on each execution host in the LSF cluster

3. Click Finish save the changes.

The Link Explorer view contains an entry for the new Altair SLC Server.

Specifying startup options for a
Processing Engine
You can specify the settings applied to a Processing Engine and use these startup options to change the
behaviour of the engine.

The startup options for Processing Engines are Altair SLC system options. You can control items such
as system resource usage or language settings. Not all system options can be set as startup options. A
list of system options that can be set when a Processing Engine starts, their effect, and their supported
values, can be found in the Altair SLC Reference for Language Elements.

All startup options are set in Altair Analytics Workbench in the same way. For example, to set the value
of the ENCODING startup option for a Processing Engine:

1. In the Workflow Link Explorer or Link Explorer view, right-click the required Processing Engine and
click Properties.

A Properties dialog box is displayed.
2. Expand Startup, and then click System Options.
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3. In the System Options panel, click Add.

The Startup Option dialog box is displayed.
4. For this example, enter ENCODING in the Name field.

If you do not know or are unsure of the name of a system option, you can click Select, which displays
the Select Startup Option dialog box from which you can select a system option. Click OK in this
dialog box to select the option.

5. Enter UTF-8 in the Value field.
6. Click OK to save the changes and when prompted, click Yes to restart the Workflow Engine for the

changes to take effect.

Default Processing Engine
Setting or changing the Processing Engine used by default when running SAS language programs or
Workflows in Altair Analytics Workbench.

One of the available Processing Engine connections defined in Altair Analytics Workbench must be
identified as the default Altair SLC Server to be used when a SAS language program is executed or a
Workflow is run.

When Altair Analytics Workbench is first installed, the Local Server or Local Engine is the default Altair
SLC Server (depending on environment). You can select any available server to be the default Altair
Analytics Workbench server.

To set the default server:

1. Open the Link Explorer or Workflow Link Explorer (depending on perspective) and expand the
connection containing the required Altair SLC Server.

2. Right-click on the required server and click Set as Default Server on the shortcut menu.

Local host connection properties
The local host is created during workbench installation, and the only properties available for a local host
connection are directory shortcuts.

To access local host connection properties, in the Link Explorer, right-click on the Local host connection
and click Properties in the shortcut menu.

A directory shortcut is a shortcut to a directory on the local file system. The local shortcuts that are
created by default differ in accordance with the operating system on which you are running the Altair
Analytics Workbench:
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• On Microsoft Windows operating systems, there will be Home and Workspace shortcuts, and also
a shortcut for each available local drive. For example, if you have drives C:\ and D:\ on your
computer, there will be four shortcuts by default.

• On all other operating systems, only the Home (~/) and Root (/) shortcuts are created by default.

Create a new shortcut
To create a new directory shortcut:

1. In the Link Explorer view, right-click on the Local host connection and click Properties in the
shortcut menu.

2. Click Add to display the Directory Shortcut dialog box.
3. In Directory Name, enter the displayed shortcut name, and in Directory Path the full path of the

target directory. Click OK to save the changes.

Processing Engine Properties
Viewing information about a Processing Engine.

To display Processing Engine properties, right-click on the Processing Engine and then click Properties.
Processing Engine properties are displayed as follows:

• Code Submission: An option to change the working directory to the program directory when code is
submitted to the Processing Engine.

• Engine Instances: Controls how many engines are created to run Workflows.
• Environment: Details of the Processing Engine's environment (working directory, process ID and

environment variables).
• Macro Variables: The full list of automatic and global macro variables used by the server.
• Startup: Flag to indicate whether or not the server is to be started automatically on connection

startup, the initial current directory for the server process (for remote servers), startup environment
variables (for local servers), and startup system options.

• System Options: The currently applied system options. For more information about this topic, please
refer to the Configuration Files section of the Altair Analytics Workbench user guide.

• Altair SLC License Information: Full details about your licence key.
• Altair SLC Software Information: Details about the Altair SLC software, including the version number.
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Processing Engine LOCALE and
ENCODING settings
Specifying locale and encoding options for anAltair SLC Server.

Any LOCALE option defined in a configuration file is ignored when running SAS language programs
or Workflows from Altair Analytics Workbench. To be effective, the LOCALE must be set as an Altair
Analytics Workbench start-up option.

In order to display and save programs and other files that contain characters for your selected
LOCALE, you may need to set a General text file encoding  (page 44) value for the Altair Analytics
Workbench.

Set LOCALE for an Altair SLC Server
The locale used by Altair SLC is set individually by the particular server. To set the language system
option for the locale for a server:

1. In the Link Explorer or Workflow Link Explorer, ensure the required Processing Engine is running.
2. Right-click the server and click Properties on the shortcut menu to display the Properties dialog box.
3. In the properties list, click Startup and then click System Options.
4. On the System Options panel, click Add to display the Startup Option dialog box.
5. In the Name field, type LOCALE, and in the Value field enter the required locale value.

A list of valid LOCALE values can be found in the Altair SLC Reference for Language Elements.
6. Click OK to save the changes restart the server to apply your changes.

Set ENCODING for an Altair SLC Server
You may also need to set an appropriate ENCODING value on the server (for example to execute an
Altair SLC installation containing non-ASCII characters). As an example, proceed as follows to set UTF-8
on the server:

1. In the Link Explorer or Workflow Link Explorer, ensure the required Processing Engine is running.
2. Right-click the server and click Properties on the shortcut menu to display the Properties dialog box.
3. In the properties list, click Startup and then click System Options.
4. On the System Options panel, click Add to display the Startup Option dialog box.
5. In the Name field, type ENCODING, in the Value field type UTF-8 and click OK.

A list of valid ENCODING values can be found in the Altair SLC Reference for Language Elements.
6. Restart the server when prompted.
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General text file encoding
To display and save programs and files that contain international characters, you may need to set an
appropriate text file encoding.

Text file encoding can be done at two levels:

• Global, for all Altair Analytics Workbench projects and associated files.
• Project, for programs contained in the specific project. This can be used where a different encoding is

required to the inherited global encoding option.

Set the encoding at a global level
To set a global encoding value:

1. Click the Window menu and then click Preferences to display the Preferences dialog box.
2. In the preferences list, expand General and then click Workspace.
3. In the Workspace panel, under Text File Encoding, click Other and select the required value from

the list.

If the required encoding option is not in the drop-down list, enter the encoding name, for example
Shift_Jis in the Other field.

4. Click OK to apply your change.

Check the locale is set for your country so that data is handled correctly by the Altair SLC Server.
The locale is displayed in the bottom right hand corner of Altair Analytics Workbench (for example, to
FR_FR if you are in French territories). If not set, specify the LOCALE and ENCODING settings. For more
information, see Altair SLC Server LOCALE and ENCODING settings  (page 43).

Setting encoding at a project level
To set a project encoding value:

1. In the Project Explorer view, select the required project, right-click and on the shortcut menu click
Properties.

2. In the Properties for… dialog box, in the properties list, click Resource.
3. On the left of the Properties window, ensure the Resource option is selected.
4. In the Resource panel, under Text File Encoding, click Other and select the required value from the

list.

If the required encoding option is not in the drop-down list, enter the encoding name, for example
UTF-8 in the Other field.

5. Click OK to apply your change.
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Setting the encoding at a global level
Changing text file encoding for the whole of Altair Analytics Workbench.

To set a global encoding value:

1. Click the Window menu and then click Preferences to display the Preferences dialog box.
2. In the preferences list, expand General and then click Workspace.
3. In the Workspace panel, under Text File Encoding, click Other and select the required value from

the list. If the required encoding option is not in the drop-down list, enter the encoding name, for
example Shift_Jis in the Other field.

4. Click OK to apply your change.

Check the locale is set for your country so that data is handled correctly by the Processing Engine.
The locale is displayed in the bottom right hand corner of Altair Analytics Workbench (for example, to
FR_FR if you are in French territories). If not set, specify the LOCALE and ENCODING settings. For more
information, see Altair SLC Server LOCALE and ENCODING settings  (page 43).

Setting encoding at a project level
Changing text file encoding for a project.

To set a project encoding value:

1. In the Project Explorer view, select the required project, right-click and on the shortcut menu click
Properties.

2. In the Properties for… dialog box, in the properties list, click Resource.
3. On the left of the Properties window, ensure the Resource option is selected.
4. In the Resource panel, under Text File Encoding, click Other and select the required value from the

list. If the required encoding option is not in the drop-down list, enter the encoding name, for example
UTF-8 in the Other field.

5. Click OK to apply your change.

Restarting Processing Engines
Processing Engines may be manually restarted at any time.

The consequences of restarting a Processing Engine depend on the environment:

• SAS Language Environment: Altair SLC Servers may be restarted as a troubleshooting step, as well
as a quick and easy way to clear data associated with an Altair SLC Server (the log, all the output
results, file references, library references, datasets, and so on).
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• Workflow Environment: Engines may be restarted as a troubleshooting step. This will not clear logs
and datasets, as these are held by the Workflow upon execution, rather than by the Processing
Engine (as in the SAS Language Environment). Because multiple Workflow engines are managed
automatically by Altair Analytics Workbench, you cannot close individual engines from a set. Instead,
a restart action closes all open engines and starts up a new single engine, from which point Altair
Analytics Workbench decides afresh whether to open multiple engines to run the Workflow.

Restarting an Altair SLC Server
Restarting an Altair SLC Server, both simply and with advanced server actions.

Each time that the Altair Analytics Workbench is closed, the temporary results associated with
the session (the log, all the output results, file references, library references, datasets, and so on)
are cleared. If you want to clear the same temporary results prior to the end of the Altair Analytics
Workbench session, you can restart the Altair SLC Server. Restarting the server means that programs
will no longer be able to interact with temporary objects created in the previous server session.

Alternatively, you can clear the log or results and keep all the other temporary output.

To restart the server:

1. Click the Altair menu, click Restart Server (SAS Language Environment) or Restart Engine
(Workflow Environment) and then click the server or engine you want to restart. If you are restarting
the local server or engine, you can use Ctrl + Alt + S.

2. A confirmation dialog box may be displayed. If so, click OK to restart the server. You will not see the
confirmation dialog if you have previously selected the Do not show this confirmation again option
in this dialog box.

Restarting with Advanced Server Actions
If you have selected Show advanced server actions in the Altair page of the Preferences window, the
shortcut menu for the Altair SLC Server or engine in the Altair SLC Server Explorer, Workflow Link
Explorer, Output Explorer and Results Explorer views displays alternative restart options:

• Restart, new WORK – restart and clear the contents of the WORK library.
• Restart, keep WORK – restart and keep the contents of the WORK library.

Restarting Workflow Engines
Restarting a Workflow Engine.

To restart a Workflow engine, click the Altair menu, click Restart Engine and then click the engine you
want to restart.
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Altair Analytics Workbench
Views
The layout of the items in Altair Analytics Workbench is known as a perspective and comprises individual
windows that contain one or more views. These views display specific types of information and provide
specific functions. Some views also have context-specific toolbars located in the top right of each view.

• Some views are the same in both SAS Language Environment and Workflow Environment (see
Generic views  (page 50)).

• Some views are specific to the SAS Language Environment (see SAS Language Environment
views  (page 85)).

• Some views are specific to the Workflow Environment (see Workflow Environment views  (page
97)).

Working with views
This section describes how to manipulate the Altair Analytics Workbench views both individually and as
part of overall view stacks.

For more information on view stacks, see view stacks  (page 47).

View stacks
A view stack is a window formed by a collection of views that are all allocated the same area in a
perspective.

You can move, minimize and maximize views using a view stack. When a view is reopened, that view
opens in the view stack to which it was last attached.

For example, the view stack below contains two views:
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Resizing a view
Resizing a view by resizing its view stack.

In order to resize a view, you have to resize its associated view stack, which will then resize all the views
within it.

1. Move your mouse over the border between the particular view stack or window, and its adjacent view
stack or window (whether this is to the side, above or below), until the cursor changes to the  or 
resize icon.

2. Press your left mouse button and keep it pressed while you drag the border side to side, or up and
down.

3. Release the mouse button to complete the resize operation.

Minimising a view
Minimising a view by minimising its view stack.

To minimise a view, you have to minimise its associated view stack. To minimise a view stack or window,
click the Minimise button on the view stack or window.

Once minimised, the views are represented by icons on either the left or right of the Altair Analytics
Workbench, so that you can restore them:
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Maximising a view
Maximising a view by maximising its view stack.

To maximise a view, you have to maximise its associated view stack, which fills the Altair Analytics
Workbench interface.

Maximising a view causes it to occupy all available space in the Altair Analytics Workbench window. All
other view stacks are minimised to the edges of the Altair Analytics Workbench window, where they are
represented as icons.

To maximise a view stack or window, click the Maximise button on the view stack or window.

Restoring a view
Restoring a view by restoring its view stack.

To restore a view to its 'normal' state after it has been minimised or maximised, you have to restore its
associated view stack.

To restore a view stack or window that has been maximised, click on the  Restore button on the view
stack or window.

To restore a view stack or window that has been minimised, click the  Restore button above the
minimised view stack to restore all the views in that stack.

Opening a view
Opening a view.

To open a view:
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1. Click the Window menu, click Show View and then click Other.
2. In the Show View dialog box, either enter the view name or select the required view from the list of

views. Click OK to display the view

The view is opened in the view stack to which it was last attached. If the required view is already open, it
will become active in Altair Analytics Workbench.

Detaching and reattaching a view
Detaching a view so it can be moved to a different view stack.

You can move a view between view stacks in Altair Analytics Workbench or into a new detached window.

To detach a view:

Click on the view tab or title bar and drag the view to a different view stack. Alternatively, drag the view
away from the Altair Analytics Workbench window to create a new view stack. If you close a detached
view stack, it will still be detached when you next open it.

To attach a view to a view stack:

Click on the view tab or title bar and drag the view over the required view stack. Use the guides to
position the view in the view stack.

Generic views
Views that apply to both the SAS Language Environment and the Workflow Environment.

Project Explorer
The Project Explorer view is used to edit and manage SAS language programs and Workflows, along
with related files, programs or datasets; all organised into projects.

Projects can store any kind of local file, and support file system operations such as running programs.
Objects within projects can be managed with Local History features (see Local history  (page 61)),
and they can also be exported to archives or to other folders in the local file system. The Project view
cannot be used to manage files stored on a remote file system or files on a local file system that are not
part of the project.

The Project Explorer view only displays projects that are in your current workspace. You can create
several Projects in a workspace (see Projects  (page 51)), and use each project for a specific task.

Selecting an item in the Project Explorer displays information about that item in the Properties view.
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When in Workflow Environment perspective, if you change the default Workflow Engine to a remote
host, the location of the projects and Workflow files does not change and remains on the local host. Any
references to datasets in the workspace or project cannot be used with a remote Workflow Engine, and
must be moved to the remote host using the File Explorer view, and any references in the Workflow
changed to the appropriate filepath for the remote host.

Displaying the view
To display the Project Explorer view:

From the Window menu, click Show View and then click Project Explorer.

Operating system tools
As well as the Altair Analytics Workbench's tools, you can use those supplied by your operating system
to delete, cut, copy and paste objects into a project. If you do use the operating system tools rather than
the Altair Analytics Workbench tools, modifications are not preserved in the local history.

You may need to refresh the Project Explorer view to ensure that objects manipulated in this way are
displayed correctly. To do this right-click the project and, click Refresh on the shortcut menu (or select
the file and press F5).

Projects
A project is an Altair Analytics Workbench representation of a folder, containing objects such as
programs, datasets, files and folders.

Altair SLC uses a project to hold the files and folders that relate to each other. For example, you might
have one project containing programs that are still under development and another project for monthly
reporting applications. There is no limit to the number of projects you can have open within Altair
Analytics Workbench.

Each project is defined by a project definition file named .project stored in the root directory of a project.
This file can only be viewed in the system file browser and must not be deleted, edited, moved from the
project folder or copied into another project.

Only one workspace can be open at a time in Altair Analytics Workbench, but you can switch between
workspaces as required. The Project Explorer view is used to display and manage the current
workspace and projects in the active workspace.

Creating a new project

Creating a new project in Altair Analytics Workbench.

To create a new project:
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1. Click the File menu, click New and then click Project to launch the New Project wizard.
2. Expand the General folder, click Project and click Next.
3. Enter the new Project name.
4. To create the new project in a location other than the current workspace folder, clear Use default

location and specify a new directory in the Location field.
5. Click Finish to create the new project.

The new project is displayed in the Project Explorer view. If the new project location is not in the
workspace folder, the path to the project folder is displayed in the Properties view.

You can also use the Altair Analytics Workbench's copy and paste facility to create a new project based
on an existing project.

Creating a new folder in a project

Creating a new folder in a project.

To create a new folder:

1. On the File menu, click New and then click Folder to launch the New Folder wizard.
2. The parent for the folder defaults to either the current project or folder selected in the Project

Explorer view.
3. Enter a Folder name for the new folder.
4. To change the location of the folder on the file system click Advanced and select one of:

• Use default location. The folder is created as a file system folder, in the same location as the
parent folder or workspace.

• Folder is not located in the file system (Virtual Folder). The folder only exists as a workspace
artifact, no folder is created on the file system. You can drag-and-drop your other project resources
into the virtual folder to create links to other files and folders in this new folder, and also add other
virtual folders. It is not possible to create physical files and folders within virtual folders.

• Link to alternate location (Linked Folder). Creates the folder on the file system in a different
location to the parent folder or workspace. Click Browse to select the location on your file system
to which to link.

5. Click Finish to create the new folder.

Moving or copying a project file

Moving any folder, file, program, or any other object, between projects, or between folders within the
same project.

1. In the Project Explorer view, select the object you need to move.
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2. Click the File menu, and then click Move. In the Move Resources dialog box, select the new
destination project or folder and click OK to move the resource.

If you want to duplicate rather than move the object, click the Edit menu and then click Copy; select
the target folder or project, click the Edit menu and then click Paste. If you duplicate the object in the
same project or folder as the original, you must provide a different name for the copied object.

Note:
Files can also be dragged and dropped between folders.

To return the object to its original location, click the Edit menu and then click either Undo Move
Resource if the object was moved, or Undo Copy Resource if the object was duplicated.

Linking the active file to the Project Explorer

If you have several files from different projects open in the Editor view, you can configure the Project
Explorer view to highlight the program in the project or folder each time that you switch the focus to that
program in the Editor view.

To link the Project Explorer view and the Editor view, in the Project Explorer view click Link with
Editor ( ).

Deleting an object from a project

Deleting (and undoing deletion for) an object in a project.

To delete an object from a project:

1. In the Project Explorer view, select the required object to delete.
2. Click the Edit menu, and then click  Delete. In the Delete Resources dialog box, click OK.

To return the object to its original location, click the Edit menu and click either Undo Delete Resource.

Renaming a project or project file

Renaming a project or project file.

To rename a project, or an object in a project:

1. In the Project Explorer view, select the required object or project.
2. Click the File menu and then click Rename.
3. Enter the New name in the Rename Resource dialog box and click OK.
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Copying a project

You can use the Altair Analytics Workbench's   Copy and   Paste facility to create a new project
based on an existing project.

1. In the Project Explorer view, select the required project.
2. Click the Edit menu, and then click Copy.
3. Click the Edit menu, click Paste and in the Copy Project dialog box, enter a new Project name .

If you want to copy the project to a location other than the current workspace, clear Use default
location and enter an alternate Location for the new project.

4. Click OK to create the project.

Importing files or archives

You can import files from either an archive file (such as a ZIP file) or from the file system into an existing
project.

To import files:

1. Click the File menu and then click Import to open the Import wizard.
2. Expand the tree under the General node and select one of the following options:

• File System – to import files and folders not archived in a single file.
• Archive File – to import files and folders that are archived in one file (for example, a zip, or tar.gz).

3. Click Next and click Browse to select either the archive file or directory.
4. You will see a list of the files and folders that are available to import. Ensure that all the objects that

you want to import are selected.

Note:
Do not select the parent folder of the files to import; if you do, your imported files are added to a
subfolder in your project.

Note:
Do not import a project definition file (.project ); if you do the imported file will overwrite the project
definition file in the existing project

5. Click Browse and specify the Into folder – the target folder for the imported files.
6. Click Finish to import the selected files.
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Closing and reopening a project

You can close or open a project to control the number of available projects in a workspace.

Closing a project collapses the tree under project in the Project Explorer view and closes any programs
or other files that were open in the Altair Analytics Workbench Editor view.

To close a project, in the Project Explorer, right-click an open project ( ) and click Close Project on
the shortcut menu.

If you want to open or reopen a closed project, in the Project Explorer, right-click a closed project ( )
and click Open Project on the shortcut menu.

Exporting a project

Making a copy or backup of a project and all the files and folders contained within it.

1. In the Project Explorer view, select the project to export.
2. Click the File menu and then click Export to display the Export wizard.
3. On the Select page, expand the General node and select

• Archive File to create zip file in the export location.
• File System to makes a copy of your project folder and its contents.

4. Click Next and select the folders and files to export from the selected project
5. If you are exporting to an archive, enter the path for file, including filename in To archive file. If you

are exporting to the file system, enter the folder path in To directory.
6. Click Finish to export the selected folders and files.

Deleting a project

Deleting a project.

1. In the Project Explorer view, select the required project to delete.
2. Click the Edit menu and click Delete.
3. In the Delete Resources dialog box, choose whether to delete the reference to the project in the

current workspace, or delete the reference and the folder contents on disk:

a. to remove the workspace reference to the project without deleting the project folder and contents,
clear Delete project contents on disk (cannot be undone).

b. To remove the workspace reference and folder contents from the disk, select Delete project
contents on disk (cannot be undone).

4. Click OK.
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Comparing and merging multiple files

You can carry out either two or three-way comparisons between different versions of a file. The
comparison tool is purely text based, so will not produce a meaningful result for Workflow files.

Three-way comparisons show the differences between three different versions of a file, for example the
differences between the resource in the Altair Analytics Workbench, the version of the resource that
is committed in a branch, and the common ancestor on which the two conflicting versions are based.
If a common ancestor cannot be determined, for example because a resource with the same name
and path was created and committed by two different developers, the comparison  becomes a two-way
comparison.

1. In the Project Explorer, highlight the files that you want to compare. You can select up to three
different files.

2. Right-click, and on the shortcut menu, click Compare With and then click Each Other.

• In a two-way comparison, the Text Compare window displays the differences (marked in grey)
between the two files.

• In a three-way comparison, select the common ancestor – the file against which comparisons
will be made. The Text Compare window displays the two file versions. To display the common
ancestor at the same time, click Show Ancestor Pane.

3. Make the required changes to the files

You can navigate through the files using the text compare toolbar:

• Click Next Difference to show the first difference between the files after the cursor location or
highlighted text.

• Click Previous Difference to show the first difference between the files before the cursor location
or highlighted text.

• Click Next Change to show the first change between file versions after the cursor location or
highlighted text.

• Click Previous Change to show the first difference between file versions before the cursor
location or highlighted text.

You can merge changes from one file to the other using the text compare toolbar:

• Click Copy Current Change from Right to Left to overwrite the highlighted text in the left file with
the highlighted text in the right file.

• Click Copy All from Right to Left to replace the content of the left file with the content of the right
file.

• Click Copy Current Change from Left to Right to overwrite the highlighted text in the right file
with the highlighted text in the left file.

• Click Copy All from Left to Right to replace the content of the right file with the content of the left
file.

4. Once you have made your changes, click the File menu and then click Save.
5. Click the File menu and then click Close to close the Text Compare window.
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Altair Analytics Workbench Projects

An Altair Analytics Workbench Project is a project that contains all the functionality of a normal
Workbench project, but includes features for compatibility with the Altair SLC Hub. Altair Analytics
Workbench Projects can be built into Artefacts for uploading to a specified Altair SLC Hub from the
Workbench. Artefacts allow packaging of files for uploading to the Altair SLC Hub. The Artefact can be
made of SAS language files, Workflow files, Python language files, R language files or supporting files of
any type.

Right-clicking an Altair Analytics Workbench Project displays all the options of a regular project, with the
addition of:

• Upload to Hub: Uploads the artefact to the Altair SLC Hub. If not already logged in to the Altair SLC
Hub, a Hub login window appears where credentials can be entered.

• Included files: Opens the Include Files tab in the Properties window, which specifies the files in the
Altair Analytics Workbench Project that are included as part of the Altair SLC Hub Artefact.

Altair Analytics Workbench Projects still use the .project project definition file in their root directories.

For more information on Artefacts, or the Hub in general, see the Altair SLC Hub documentation.

Hub Login
Enables you to enter credentials for logging in to the Altair SLC Hub

Protocol
Specifies the network protocol to use when connecting to the Altair SLC Hub. The following
options are available:

• HTTP
• HTTPS

Host
Specifies the fully qualified domain name (FQDN) or IP address to use when connecting to the
Altair SLC Hub.

Port
Specifies the port number for the host.

Username
Specifies the username on the Altair SLC Hub.

Password
Specifies the password for the specified username.

Note:
Ensure that firewalls on the Altair SLC Hub host and connecting client are both configured to allow
communication with the specified network protocol and port.
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Hub API

A Hub API is a program built from anAltair Analytics Workbench Project ready to be deployed to the
Altair SLC Hub. When a Hub API is created, a new object is created in the Altair Analytics Workbench
Project. Opening a Hub API will open a pane with three tabs: The program itself, Hub configuration for
configuring the input and output parameters and a form layout page for specifying the dialog box format
when specifying input and output parameters.

Note:
A Hub API is different from a more traditionally defined REST API used elsewhere in the Altair SLC Hub.

Opening a program from the Hub API has the following sections:

• SAS language code:
• Hub Configuration:
• Hub form layout:
• Description:

SAS language code tab
Specifies the SAS language code of the Altair SLC Hub program.

Hub Configuration Tab
Enables you to configure the Altair SLC Hub program and Altair SLC Hub parameters.

General information
Enables you to specify information about the Altair SLC Hub program.

Label
Sets the label for the Altair SLC Hub parameter.

Program path
Sets the program path of the Altair SLC Hub parameter.

Parameters
Specifies parameters for the Altair SLC Hub program. Parameters can be added and removed
using the Add and Remove buttons. You can click on a parameter to display the Parameter
Details pane.

Parameter Details
Specifies the attributes of a specified Hub parameter. Different options are available for different
parameter types.

Name
Sets the name of the Altair SLC Hub parameter.

Label
Sets a label for the Altair SLC Hub parameter.
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Prompt
Sets the prompt message for the Altair SLC Hub parameter.

Hidden
Specifies that the parameter is hidden in the Altair SLC Hub interface.

Required
Specifies whether the Altair SLC Hub parameter is required or not.

Repeatable
Specifies whether the Altair SLC Hub parameter is repeatable or not.

Type
Specifies the type of Altair SLC Hub parameter. The following options are available:

• String
• Password
• Choice
• Integer
• Float
• Boolean
• Stream
• Date
• Time
• Date and Time

For more information on parameter types, see the Altair SLC Hub documentation.

Autocomplete service URL
Specifies a URL to fetch data for dynamic population of parameters.

From List
Specifies the choice parameter to take values from a list. When this option is enabled, the
list appears below the option and elements of the list can be added and removed using the
Add and Remove buttons.

From Service
Specifies the choice parameter to take values from a URL service.

Default value
Specifies the default value of the specified parameter.

Minimum value
Specifies the minimum value of the specified parameter.

Maximum value
Specifies the maximum value of the specified parameter.
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Default date
Specifies the default value of the specified date parameter.

Minimum date
Specifies the minimum value of the specified date parameter.

Maximum date
Specifies the maximum value of the specified date parameter.

Default date and time
Specifies the default value of the specified date and time parameter.

Minimum date and time
Specifies the minimum value of the specified date and time parameter.

Maximum date and time
Specifies the maximum value of the specified date and time parameter.

Provide maximum length
Specifies the maximum length of the parameter value.

Results
Displays a list of each program output. Results can be added and removed using the Add and
Remove buttons. You can click on a result to display the Result details pane.

Result details
Specifies the attributes of a specified result.

Name
Specifies the name of the result.

Result type
Specifies the type of the result.

Content type
Sets the format of the result The following options are available:

• CSV
• Custom
• Excel
• HTML
• JSON
• PDF
• Text
• XML
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Hub Form Layout Tab
Enables you to configure the dialog box when running a Hub program with parameters. The dialog
box is accessed by right clicking a Hub API and selecting Run with parameters

Layout
Specifies the layout of the dialog box, elements can be added and removed using the Add and
Remove buttons.

Element details
Specifies the type of a specified element. The following options are available:

Parameter
Specifies the attributes of a specified Hub parameter.

Group
Specifies a group of elements for the dialog box and a group layout.

Horizontal Layout
Specifies any elements of this node are layed out vertically.

Vertical Layout
Specifies any elements of this node are layed out vertically.

Categorization
Specifies that the parameter is hidden in the Altair SLC Hub interface.

Description Tab
Description

Specifies a description for the Altair SLC Hub program.

Local history
The Altair Analytics Workbench maintains a local history of modifications to programs or other project
files changed in the Project Explorer view.

Each time you save a project file in the Altair Analytics Workbench, a snapshot of the current contents of
the file is added to the Altair Analytics Workbench's local history. This history provides the ability to take
any of your current programs and compare or replace them with local history.

History of Deletions
Each time you delete a program or file, the edit history of the item being deleted is added to the local
history of the containing project or folder. This enables you to restore state from local history, or to select
which particular state from the item's history to restore. See Restoring from local history  (page 63)
and Replacing from local history  (page 63) for more information.
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Local History Preferences
Local history preferences allow you to control how long to keep the local history, how many entries to
keep in the history, and the maximum file size that can be recorded. See Local history preferences
(page 64) for more information.

Comparing with local history

Project Explorer's comparison tool allows a current file to be compared with a version from local history.
The comparison tool is purely text based, so will not produce a meaningful result for Workflow files.

To compare a current saved project file with a previous version:

1. In the Project Explorer view, select the required file, right-click, click Compare With and then click
Local History on the shortcut menu.

A History window opens listing program revisions with revision times.
2. Double-click the revision with which you want to compare the current version of the file.

The Text Compare window opens showing the differences (marked in grey) between the two
versions. The current version is shown on the left, with the local history version on the right.

3. Make the required changes to the files.

You can navigate through the files using the text compare toolbar:

• Click Next Difference to show the first difference between the files after the cursor location or
highlighted text.

• Click Previous Difference to show the first difference between the files before the cursor location
or highlighted text.

• Click Next Change to show the first change between file versions after the cursor location or
highlighted text.

• Click Previous Change to show the first difference between file versions before the cursor
location or highlighted text.

You can merge changes from one file to the other using the text compare toolbar:

• Click Copy Current Change from Right to Left to overwrite the highlighted text in the left file with
the highlighted text in the right file.

• Click Copy All from Right to Left to replace the content of the left file with the content of the right
file.

4. Once you have made your changes, click the File menu and then click Save.
5. Click the File menu and then click Close to close the Text Compare window.
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Replacing the current version with the previous version from
local history

How to revert a program in a project back to the previously saved version.

To replace the current version with the previous version, in the Project Explorer right-click the required
file and, on the shortcut menu, click Replace With and then click Previous from Local History.

Replacing the current version with a version from local history

How to revert a program in a project back to a previous saved version.

To replace the current version with a version from the local history:

1. In the Project Explorer right-click the required file and, on the shortcut menu, click Replace With and
then click Local History.

2. In the Compare dialog, double-click a revision to review and select the required version. Click
Replace to use the selected version.

Replacing from local history

How to revert a program in a project back to a previous saved version.

You can either replace the current version with the previous version or select a version from the local
history.

1. To replace the current version with the previous version, in the Project Explorer right-click the
required file and, on the shortcut menu, click Replace With and then click Previous from Local
History

2. To replace the current version with a version from the local history:

a. In the Project Explorer right-click the required file and, on the shortcut menu, click Replace With
and then click Local History.

b. In the Compare dialog, double-click a revision to review and select the required version. Click
Replace to use the selected version.

Restoring from local history

Recovering a project file that has been deleted in the Project Explorer view.

To restore a project file:
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1. In the Project Explorer view, right-click either the project or folder that the file contained, and then on
the shortcut menu click Restore from Local History.

2. In the Restore from Local History, select the files to restore:

a. Click the check box next to the project file name To restore the last version of that file.
b. If a selected file has a saved local history, select the file name and choose the required version of

the file in the Select an edition of a file panel.
3. Click Restore to recover the selected files and close the Restore from Local History dialog box.

Local history preferences

Changing the time period for retention of local history for each project file.

By default, the Altair Analytics Workbench keeps seven days of local history for each individual project
file, with a maximum of fifty versions for each file. There is also a default of 1 MB of storage allocated for
each program's local history.

The above settings can be changed as follows:

1. Select Window ➤ Preferences… ➤ General ➤ Workspace ➤ Local History.

The Local History dialog is displayed.
2. Set any of the following as required:

• Days to Keep Files - The number of days that you want to keep records for any one project file.
For example, if you type 20, then a history of saved versions from the last twenty days will be kept.
The default value is 7 days.

• Maximum Entries per File - The number of versions to keep for any one project file. If this
number is exceeded, the oldest changes are discarded to make room for the new changes. The
default is 50 versions per file.

• Maximum File Size (MB) - The maximum file size (in MB) for a project file's local history. If this
size if exceeded, then no more local history is kept for the file. The default size is 1MB.

Note:
The Days to Keep Files and Maximum Entries per File are only applied when the local history is
compacted on server shutdown.

Switching to a different workspace
Switching to a different workspace to use a different group of projects.

1. Click the File menu, click Switch Workspace and click Other.
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2. In the Workspace Launcher, select the required Workspace or expand the Recent Workspaces list
and select the required workspace if it appears in the list.

3. Click OK to restart Altair Analytics Workbench displaying the selected workspace.

Hub Program Packages
Altair Analytics Workbench can be used to create and manage Altair SLC Hub program packages. Altair
SLC Hub Program Packages are collections of programs deployable as one unit within Altair SLC Hub.
Programs can be in the SAS language, R language, or Python language.

Alongside their constituent programs, Altair SLC Hub program packages contain a YAML descriptor file
for the package, and individual YAML descriptor files for each program. Altair Analytics Workbench can
create and manage all of these file types.

Creating a new Altair SLC Hub program package

Creating a new Altair SLC Hub program package from within Altair Analytics Workbench.

1. Click the File menu, click New and then click Other to launch the New wizard.
2. Under Altair, select Hub Deployment Services Package Project.
3. Click Next.
4. Under Project name type a name for the project.
5. Next, choose a storage location for the program package:

• Select Use default location to store the program package in the current Workspace.
• Clear Use default location and specify a location for the program package.

6. Next, choose whether to add the program package to working sets:

• Select Add project to working sets and then choose from the Working sets list. To create a new
working set, click New.

• Clear Add project to working sets to not add the program package to working sets.
7. Click Finish.

The new Altair SLC Hub program package is now visible in the Project Explorer view. No accompanying
YAML file is created at this stage, because an empty program package has no programs for the YAML
file to describe.
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Creating a new Altair SLC Hub program

Creating a new Altair SLC Hub program from Altair Analytics Workbench.

1. In Project Explorer view, locate the program package that you want to create the program within.
2. Right-click the selected program package and select New, then Hub Program.

A New Hub Program wizard opens.
3. From the New Hub Program wizard:

a. From the Program type drop-down, select the language for the program and click Next.
b. At the Enter or select the parent folder step, either click on an existing folder, or type a folder

name in the text entry box. The program will be created in this specified folder.
c. In Program name, type a filename for the program.
d. Click Finish.

The new Altair SLC Hub program is now visible underneath its program package in the Project Explorer
view. If this is the first program in the package, a YAML descriptor file is also created describing the
program. If a program or programs already exist, the existing YAML descriptor file is updated to include
the new program.

Editing an Altair SLC Hub program

Editing an Altair SLC Hub program from within Altair Analytics Workbench. These changes will modify
the parent program package's YAML descriptor file.

To edit an Altair SLC Hub program, locate it in Project Explorer, then right-click on it and click Open.
The program will open in a new tab, which has three sub-tabs:

• Overview: Defines the program's label, description, categories and a file containing the program
code.

• Parameters: Defines the variables in the program, allowing their creation, editing and deletion.
• Results: Defines the output of the program, allowing their creation, editing and deletion.

These sub-tabs are slightly different for each type of program and are described in detail in the following
sections:

• Editing an Altair SLC Hub SAS language program  (page 67)
• Editing an Altair SLC Hub Python language program  (page 69)
• Editing an Altair SLC Hub R language program  (page 71)

Note:
For a more detailed explanation of Altair SLC Hub program options, see the Altair SLC Hub
documentation.
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Editing an Altair SLC Hub SAS language program

Editing an Altair SLC Hub SAS language program from within Altair Analytics Workbench.

To edit a SAS language Altair SLC Hub program, locate it in Project Explorer, then right-click on it
and click Open, or double-click on the program. The program will open in a new tab, with two sub-tabs:
Overview and Description. Once editing is complete, save the program by clicking the Save icon or
pressing Ctrl+S on the keyboard.

Overview sub-tab
The Overview sub-tab is divided into four areas, each covered under a heading below.

General Information
Program File: Specifies the file containing the program code. Two options are available:

• Browse allows you to specify an existing file from your workspace containing the program
code. Clicking this option opens a Select program file window, from which you can select a
program from within the workspace and click OK to return to the Overview sub-tab.

• Program file allows you to create a new program file. Clicking this option opens a New File
window, from which you can browse to a location for the file and specify the name. Finish will
create the file and return to the Overview sub-tab.

Label: The label under which this program is published in the Altair SLC Hub directory. This is
only relevant if the program is included in the list of programs to be published within the package
descriptor file. If not specified, the program's file name, without extension, is used.

Parameters
Parameter style allows you to specify a parameter style for the . Choose from Dataset or Macro
variables.
Below Parameter style is a list of all the parameters for the program. Actions for this list are as
follows:
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• Add. Clicking on this button opens an Add parameter window, where you can enter:

‣ Name: The variable name used in the program code.
‣ Label: The label for the variable presented to the user when running the program.
‣ Prompt: A word or phrase displayed to the user asking them to make their choice.
‣ Hidden: Hides this variable once the program is published.
‣ Required: Forces the user to choose this input variable to continue running the program. If

the variable is not supplied, an HTTP 400 (bad request) response is given.
‣ Type: Choose from: String, Password, Choice, Integer, Float, Boolean, Stream, Date,

Time, and Date & time.

Each Type displays its own set of optional settings. With the exception of Choice, these
optional settings consist of some or all of: a default value (value taken if no other value is
provided), a minimum to validate user input against, and a maximum to validate user input
against. If Choice is specified, further options are presented to create and manage a list of
choices, with each choice consisting of a label and a value.

• Edit: With a parameter selected from the list, this button opens an Edit parameter window.
Options presented are the same as described above for Add.

• Remove: With a parameter selected from the list, this button deletes that parameter.
• Up: With a parameter selected from the list, this button moves that parameter up the list.
• Down: With a parameter selected from the list, this button moves that parameter down the list.

Results
The Results section contains a list of the program's outputs. Actions for this list are as follows:

• Add. Clicking on this button opens an Add result window, where you can enter:

‣ Name: A name for the output.
‣ Result type: Choose from Dataset or Stream.

• Edit: With a result selected from the list, this button opens an Edit parameter window. Options
presented are the same as described above for Add.

• Remove: With a result selected from the list, this button deletes that result.
• Up: With a result selected from the list, this button moves that result up the list.
• Down: With a result selected from the list, this button moves that result down the list.

Categories
The Categories section contains a list of categories (Hub program metadata) under which the
program will be listed in the directory, if it is to be published.
Actions for the Categories list are as follows:

• Add: Adds a new category to the list. To edit the category, click on it and type.
• Remove: Removes the selected category or categories from the list.
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Description sub-tab
The Description sub-tab contains a free text description of the program to place in the directory. This
is only relevant if the program is included in the list of programs to be published within the package
descriptor file.

Editing an Altair SLC Hub Python language program

Editing an Altair SLC Hub Python language program from within Altair Analytics Workbench.

To edit a Python language Altair SLC Hub program, locate it in Project Explorer, then right-click on it
and click Open, or double-click on the program. The program will open in a new tab, with two sub-tabs:
Overview and Description.

Overview sub-tab
The Overview sub-tab is divided into four areas, each covered under a heading below.

General Information
Label: The label under which this program is published in the Altair SLC Hub directory. This is
only relevant if the program is included in the list of programs to be published within the package
descriptor file. If not specified, the program's file name, without extension, is used.
Program File: Specifies the file containing the program code. Two options are available:

• Browse: allows you to specify an existing file from your workspace containing the program
code. Clicking this option opens a Select program file window, from which you can select a
program from within the workspace and click OK to return to the Overview sub-tab.

• Program file: allows you to create a new program file. Clicking this option opens a New File
window, from which you can browse to a location for the file and specify the name. Finish will
create the file and return to the Overview sub-tab.

Initialisation program file: specifies an initialisation program file. Two options are available:

• Browse: allows you to specify an existing file from your workspace. Clicking this option opens
a Select initialisation program file window, from which you can select a file from within the
workspace and click OK to return to the Overview sub-tab.

• Initialisation program file: allows you to create a new Initialisation program file. Clicking this
option opens a New file window, from which you can browse to a location for the file and
specify the name. Finish will create the file and return to the Overview sub-tab.

Parameters
Parameter style allows you to specify a parameter style. Choose from Dataset or Macro
variables.
Below Parameter style is a list of all the parameters for the program. Actions for this list are as
follows:
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• Add. Clicking on this button opens an Add parameter window, where you can enter:

‣ Name: The variable name used in the program code.
‣ Label: The label for the variable presented to the user when running the program.
‣ Prompt: A word or phrase displayed to the user asking them to make their choice.
‣ Hidden: Hides this variable once the program is published.
‣ Required: Forces the user to choose this input variable to continue running the program. If

the variable is not supplied, an HTTP 400 (bad request) response is given.
‣ Type: Choose from: String, Password, Choice, Integer, Float, Boolean, Stream, Date,

Time, and Date & time.

Each Type displays its own set of optional settings. With the exception of Choice, these
optional settings consist of some or all of: a default value (value taken if no other value is
provided), a minimum to validate user input against, and a maximum to validate user input
against. If Choice is specified, further options are presented to create and manage a list of
choices, with each choice consisting of a label and a value.

• Edit: With a parameter selected from the list, this button opens an Edit parameter window.
Options presented are the same as described above for Add.

• Remove: With a parameter selected from the list, this button deletes that parameter.
• Up: With a parameter selected from the list, this button moves that parameter up the list.
• Down: With a parameter selected from the list, this button moves that parameter down the list.

Results
The Results section contains a list of the program's outputs. Actions for this list are as follows:

• Add. Clicking on this button opens an Add result window, where you can enter:

‣ Name: A name for the output.
‣ Result type: Choose from Dataset or Stream.

• Edit: With a result selected from the list, this button opens an Edit parameter window. Options
presented are the same as described above for Add.

• Remove: With a result selected from the list, this button deletes that result.
• Up: With a result selected from the list, this button moves that result up the list.
• Down: With a result selected from the list, this button moves that result down the list.

Categories
The Categories section contains a list of categories (Hub program metadata) under which the
program will be listed in the directory, if it is to be published.
Actions for the Categories list are as follows:

• Add: Adds a new category to the list. To edit the category, click on it and type.
• Remove: Removes the selected category or categories from the list.
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Description sub-tab
The Description sub-tab contains a free text description of the program to place in the directory. This
is only relevant if the program is included in the list of programs to be published within the package
descriptor file.

Editing an Altair SLC Hub R language program

Editing an Altair SLC Hub R language program from within Altair Analytics Workbench.

To edit an R language Altair SLC Hub program, locate it in Project Explorer, then right-click on it and
click Open, or double-click on the program. The program will open in a new tab, with two sub-tabs:
Overview and Description.

Overview sub-tab
The Overview sub-tab is divided into four areas, each covered under a heading below.

General Information
Label: The label under which this program is published in the Altair SLC Hub directory. This is
only relevant if the program is included in the list of programs to be published within the package
descriptor file. If not specified, the program's file name, without extension, is used.
Program File: Specifies the file containing the program code. Two options are available:

• Browse: allows you to specify an existing file from your workspace containing the program
code. Clicking this option opens a Select program file window, from which you can select a
program from within the workspace and click OK to return to the Overview sub-tab.

• Program file: allows you to create a new program file. Clicking this option opens a New File
window, from which you can browse to a location for the file and specify the name. Finish will
create the file and return to the Overview sub-tab.

Initialisation program file: specifies an initialisation program file. Two options are available:

• Browse: allows you to specify an existing file from your workspace. Clicking this option opens
a Select initialisation program file window, from which you can select a file from within the
workspace and click OK to return to the Overview sub-tab.

• Initialisation program file: allows you to create a new Initialisation program file. Clicking this
option opens a New file window, from which you can browse to a location for the file and
specify the name. Finish will create the file and return to the Overview sub-tab.

Parameters
The Parameters section contains a list of parameters for the program. Actions for this list are as
follows:
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• Add. Clicking on this button opens an Add parameter window, where you can enter:

‣ Name: The variable name used in the program code.
‣ Label: The label for the variable presented to the user when running the program.
‣ Prompt: A word or phrase displayed to the user asking them to make their choice.
‣ Hidden: Hides this variable once the program is published.
‣ Required: Forces the user to choose this input variable to continue running the program. If

the variable is not supplied, an HTTP 400 (bad request) response is given.
‣ Type: Choose from: String, Password, Choice, Integer, Float, Boolean, Stream, Date,

Time, and Date & time.

Each Type displays its own set of optional settings. With the exception of Choice, these
optional settings consist of some or all of: a default value (value taken if no other value is
provided), a minimum to validate user input against, and a maximum to validate user input
against. If Choice is specified, further options are presented to create and manage a list of
choices, with each choice consisting of a label and a value.

• Edit: With a parameter selected from the list, this button opens an Edit parameter window.
Options presented are the same as described above for Add.

• Remove: With a parameter selected from the list, this button deletes that parameter.
• Up: With a parameter selected from the list, this button moves that parameter up the list.
• Down: With a parameter selected from the list, this button moves that parameter down the list.

Results
The Results section contains a list of the program's outputs. Actions for this list are as follows:

• Add. Clicking on this button opens an Add result window, where you can enter:

‣ Name: A name for the output.
‣ Result type: Choose from Dataset or Stream.

• Edit: With a result selected from the list, this button opens an Edit parameter window. Options
presented are the same as described above for Add.

• Remove: With a result selected from the list, this button deletes that result.
• Up: With a result selected from the list, this button moves that result up the list.
• Down: With a result selected from the list, this button moves that result down the list.

Categories
The Categories section contains a list of categories (Hub program metadata) under which the
program will be listed in the directory, if it is to be published.
Actions for the Categories list are as follows:

• Add: Adds a new category to the list. To edit the category, click on it and type.
• Remove: Removes the selected category or categories from the list.
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Description sub-tab
The Description sub-tab contains a free text description of the program to place in the directory. This
is only relevant if the program is included in the list of programs to be published within the package
descriptor file.

Running an Altair SLC Hub program

Running an Altair SLC Hub program from Altair Analytics Workbench.

Different ways to run an Altair SLC Hub program
Altair SLC Hub programs can be run in three ways:

• With default settings.
• From a new or saved configuration.
• With the same parameters as a specified past execution.

Running an Altair SLC Hub program with default settings

Running an Altair SLC Hub program with its default settings, as specified in either Altair Analytics
Workbench or the program's YAML descriptor file.

an Altair SLC Hub program can be run with its default settings by highlighting the program in Project
Explorer and then doing one of four things:

• Clicking the run button ( ) on the toolbar.

• Clicking on the Altair drop-down menu and clicking Run Hub Program name (where name is the
name of the Altair SLC Hub program you want to run).

• Pressing Ctrl + R on the keyboard.
• Right-clicking on the Altair SLC Hub program in Project Explorer and clicking Run Program.

If an Altair SLC Hub program variable is specified as Required, then when the program is run for the first
time you will be prompted to enter a value (or to specify a file, if parameter type Stream is selected) by
the Run Configurations dialog box, as described in Running an Altair SLC Hub program from a new or
saved configuration  (page 74). Thereafter, this configuration will be used by default whenever the
program is requested to run with its default settings.
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Running an Altair SLC Hub program from a new or saved
configuration

an Altair SLC Hub program can be associated with one or many configurations, which store values for a
program's parameters. Once a configuration has been created for an Altair SLC Hub program, it can be
run, which runs the related Altair SLC Hub program with the specified parameters.

Opening the Run Configurations window
Configurations are edited from the Run Configurations window. To open the Run Configurations
window, first highlight the program you want to set a configuration for in Project Explorer. Then, from the
main toolbar, click the arrow next to the run button ( ) and click on Run Configurations.

If an Altair SLC Hub program is run with any required, but empty, parameters, then the Run
Configurations window is automatically opened. Once any required, but initially empty, parameters have
been set, and Apply or Run clicked, thereafter this configuration will be invoked by default whenever the
program is run.

Navigating the Run Configurations window
The Run Configurations window has three main areas:

• Configurations pane: On the left-hand side of the window, this is a list of all existing configurations for
all Altair SLC Hub program packages. When you click on a configuration in the list, its details appear
for editing in the two tabs on the right hand side of the window. Above the list of configurations
are a series of buttons for managing the configurations; for more details on these see Managing
Configurations  (page 75).

• The Main tab: Once a configuration has been selected in the configurations pane list, the Main tab
on the right-hand side of the window allows you to edit the project and program that the configuration
applies to. For more details, see Editing Configurations  (page 74).

• The Parameters tab: Once a configuration has been selected in the configurations pane list and a
project and program have been specified in the Main tab, the Parameters tab allows you to specify
the parameters you want to use when executing the program from this configuration. For more details,
see Editing Configurations  (page 74).

Editing Configurations
To edit a configuration, first click on it in the configurations pane on the left hand side of the Run
Configurations window. You can now use the right hand side of the window to change the following:

• Name: At the top of the right hand pane is a Name box, where you can type a new name for the
configuration. Any character, including spaces, are allowed.
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• Project (in the Main tab): Used to specify the Altair SLC Hub program package that contains the
Altair SLC Hub program this configuration will reference. Either type the name of an Altair SLC Hub
program package in your current Workspace, or click Browse to open a Project select window,
where you can browse to and click on the required Altair SLC Hub program package and then click
OK to select it.

• Program to Run (in the Main tab): Used to specify the Altair SLC Hub program that this configuration
will run. Select the program from the drop-down list, which displays all programs within the specified
Altair SLC Hub program package.

• Parameters. The Parameters tab lists all parameters for the specified Altair SLC Hub program. Select
the checkbox next to a parameter to specify a parameter value with this configuration, and then enter
the parameter's value in the box provided. If a parameter's checkbox is left unselected, a parameter
will take its default value, if present in the Altair SLC Hub program configuration.

Click Apply to save any changes made, or Run to save changes and also run the configuration. Click
Revert to discard changes made since the active configuration was selected.

Running a configuration
To run a configuration, thus running the specified Altair SLC Hub program with the settings specified by
the configuration, click Run in the Run Configurations window. This action also saves any changes to
the active configuration.

Managing Configurations
Configurations can be managed from the configurations pane, on the left-hand side of the Run
Configurations window. Icons across the top of this pane are as follows:

• New ( ): Creates a new blank configuration.

• Duplicate ( ): Duplicates the currently selected configuration. The new configuration will be given
the same name as the original, appended with a number in brackets.

• Delete ( ): Deletes the selected configuration.

• Collapse ( ): unused option (collapses tree branches, but you will only ever have one tree branch).

• Filter ( ): Opens the Preferences (Filtered) window with the following checkboxes:

‣ Filter configurations in closed projects: Removes configurations from the configurations pane
listing if they refer to closed projects.

‣ Filter configurations in deleted or missing projects: Hides configurations in the configurations
pane listing if they refer to deleted or unavailable projects.

‣ Filter checked launch configuration types: Hides configurations from the configurations pane
listing if they are selected in the box below this option.

‣ Delete configurations when associated resource is deleted: Deletes configurations if the Altair
SLC Hub program or Altair SLC Hub program package they refer to is deleted or unavailable.
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Running an Altair SLC Hub program with the same parameters as a
specified past execution

Running an Altair SLC Hub program with the same parameters as a specified past execution.

To run an Altair SLC Hub program with the same parameters as a specified past execution, first ensure
you have the Hub Package Program Executions view open. To open this view, from the Window menu
click Show View and then click Other. A Show View dialog box opens. Expand Altair, select Hub
Package Program Executions and then click OK.

In the Hub Package Program Executions view, locate the execution that you want to re-run, right-click
on it and select Re-run execution with these parameters.

File Explorer
The File Explorer view is used to manage SAS language programs and Workflows, along with related
files, programs or datasets on your file system.

Because the File Explorer view does not manage content through projects, you cannot use the local
history, nor use Altair Analytics Workbench functionality to import or export projects or archives.

The File Explorer view enables access to all files that are available on your local file system, and on any
connected remote hosts. The view also displays the following object types:

• Connections: The root node that represents a connection to a host machine. This can be either local
or remote.

• Shortcuts: A directory on a file system selected for management via the  File Explorer view.

• Symbolic linked file (SAS Language Environment only): A file that points to another file in the host file
system via a symbolic link.

• Symbolic linked directory (SAS Language Environment only): A file that points to another directory in
the host file system via a symbolic link.

Selecting an item (other than a connection) in the File Explorer displays information about that item in
the Properties view.

Displaying the view
To display the File Explorer view:

From the Window menu, click Show View and then click File Explorer.

Connections and shortcuts
It is only possible to view files on remote systems when you have an open host connection. The host
connection is opened from the Link Explorer or Workflow Link Explorer views, or when starting Altair
SLC Servers in the Altair SLC Server Explorer view.
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Each host connection can have several directory shortcuts, each providing access to the files and folders
on the associated file system.

To create a new directory shortcut:

1. In the File Explorer view, right-click on the required folder.
2. Click New, and then click Directory Shortcut.
3. Enter a Directory Name in the Directory Shortcut dialog box.

Working with files and folders
It is possible to perform the following operations on files and folders within the File Explorer:

• Create a new directory shortcut, directory or file.
• Selected files and directories to be moved, copied or deleted.
• Run a SAS language program on a selected Altair SLC Server.
• Rename a selected file or directory.
• Analyse the contents of SAS Language Environment programs, and folders containing programs (see

Code Analyser  (page 13) for more information).
• Display the selected file in the system explorer (for example, Windows Explorer in Windows). To do

this, right-click on a file and select Show in System Explorer.
• Upload any local file changes on a remote server connection to the remote machine.
• Compress files or folders into zip or gzip file format.

File Explorer preferences
To display hidden files and folders in the File Explorer view: in the Preferences dialog box, expand the
Altair group, select File Explorer and in the File Explorer panel select Show hidden files and folders.

Managing files in the File Explorer
The File Explorer view can be used to manipulate the various objects in available local and remote file
systems.

When you open files from the File Explorer view, the file is displayed in the most appropriate Editor
view:

• Program files (those with .wps and .sas file extensions) are opened in the SAS editor.
• Text files (.txt) are opened in the Text Editor.
• XML files (.xml) are opened in the Text Editor.
• HTML files (.html) are opened in Altair Analytics Workbench where possible (this is platform-

dependent).
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On some operating systems, the Altair Analytics Workbench attempts to open the application associated
with the file, for example PDF files, even if the file cannot be opened in Altair Analytics Workbench itself.

Creating a new folder in a file system

Folders can be created wherever you have appropriate operating system privileges for the particular local
or remote host.

1. Click the Window menu, click Show View and then click File Explorer to display the File Explorer
view.

2. In the File Explorer view, right-click the required parent directory shortcut or Folder, click New and
click Folder on the shortcut menu.

3. Enter a new Folder name and click Finish.

Creating a new file or program in a file system

Creating a new file or program in a file system using Altair Analytics Workbench.

1. In the File Explorer view, right-click the Directory Shortcut or Folder, click New and then click File on
the shortcut menu.

If you are creating a new SAS language program and are in the SAS Language Environment
perspective, click New and then click Program on the shortcut menu.

If you are creating a new Workflow and are in the Workflow Environment perspective, click New and
then click Workflow on the shortcut menu.

2. In the dialog box, enter a Filename, including file extension, and click Finish.

If you are creating a new SAS language program, the Filename has a default extension of .sas, but
you can change this to .wps if you prefer.

Moving a file in a file system

Moving a file using the File Explorer view.

You can move files to other folders in your local and remote connections. To move objects in the File
Explorer view:

1. Click the Window menu, click Show View and then click File Explorer to display the view.
2. In the File Explorer view, right-click the required object to move and click Cut on the shortcut menu.
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3. Right-click the target directory shortcut or folder to which you want to move the object and click Paste
on the shortcut menu.

Alternatively, you can select the object you want to move and drag the object to the required directory
shortcut or Folder.

Renaming an object in a file system

Renaming an object using the File Explorer view.

To rename a file system object:

1. In the File Explorer view, right-click the required object to rename and click Rename on the shortcut
menu.

2. In the Rename File, enter a new name for the file and click OK.

You may need to refresh the connection in the Link Explorer view to see the change.

Deleting an object from a file system

Deleting an object using the File Explorer view.

To delete an object from a file system, proceed as follows:

1. In the File Explorer view, Right-click on the required object to delete and click Delete on the shortcut
menu.

2. In the Confirm Delete dialog box, click OK to confirm deletion.

Once you confirm the deletion of the object from the file system, the operation cannot be undone.

Compressing an object from a file system

Compressing a file using the File Explorer view.

To compress an object from a file system, proceed as follows:

1. In the File Explorer view, right-click the required file to compress, select Zip/Gzip on the shortcut
menu and then click Add to filename.zip or Add to filename.gzip. Where filename is the specified
filename for compression.

You can also decompress a .zip or .gzip file; to do this, right-click the file, select Zip/Gzip and then
select Extract Here to decompress the file in the current working directory, or Extract to Folder to
extract it to a different directory.

The file is compressed in the current working directory.
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Properties
The Properties view displays the properties of a selected object.

Select an object in one of the following views to show the object details in the Properties view:

• File Explorer view
• Link Explorer view
• Project Explorer view
• Search view
• Altair SLC Server Explorer view

Displaying the view
To display the Properties view

From the Window menu, click Show View and then click Properties.

Link Explorer and Workflow Link Explorer
The Link Explorer in the SAS Language Environment allows you to manage connections to Altair SLC
hosts and any Altair SLC Servers on those connections. Similarly, the Workflow Link Explorer in the
Workflow Environment allows you to manage connections to Altair SLC hosts and any Engines on those
connections.

The Link Explorer and Workflow Link Explorer views are the key views if you are using Link – the
collective term for the technology used to provide a client/server architecture. These views allow you
to connect to a remote machine with an Altair SLC Server installed to run SAS language programs
or Workflows. The output from the remote server can be viewed and manipulated in Altair Analytics
Workbench, in the same manner as a locally executed program or Workflow.

Displaying the Link Explorer view or Workflow Link Explorer view
To display the Link Explorer or Workflow Link Explorer: from the Window menu click Show View and
then click Link Explorer ( ) when in the SAS Language Environment perspective, or Workflow Link
Explorer ( ) when in the Workflow Environment perspective.

Objects displayed
There are two node types visible in this view:

1. A Connection node ( ): this is the root node and represents a connection to a host machine. The
connection can either be a local connection or a connection to a remote machine. The connection
can contain one or more Altair SLC Server nodes. There can only be one local connection, but many
remote connections.
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2. A Server node ( ), representing the Processing Engine installation where you can run your SAS
language programs or Workflows.

Managing the connections and servers
If you right-click on an open connection, the following options are available:

• Open or close a local or remote host connection.
• Export a host connection (see Exporting a host connection definition  (page 35)).
• Define a new Altair SLC Server (see Defining a new Processing Engine  (page 36)).
• Import or export an Altair SLC Server definition (see Importing an Altair SLC Server definition

(page 37) or Exporting an Altair SLC Server definition  (page 37)).

Right-clicking on a server gives you options to stop, start or restart that server.

A server can be moved or copied to a different host connection. A drag-and-drop operation moves the
server from its current host connection to the target host connection. Press and hold the Ctrl key at the
same time to copy the server to the new host connection.

Properties
Right-clicking a connection node and selecting Properties will open a Properties window which has two
tabs:Directory Shortcuts and Workflow properties.

• The Directory Shortcuts tab allows you to enter shortcuts for the host's filing system, which appear
in the File Explorer window.

• The Workflow properties tab contain the following options:

‣ Temporary file path - Enables you to enter a path for temporary files created by Workflows
‣ Limit working dataset storage - Limits the storage space for working datasets created by

Workflows.

Commands (top right corner of the view)
The view contains the following commands

• Collapse All – collapse the view to show just the root nodes.
• Create a new remote host connection – add a new remote connection.
• Import a host connection definition –import a connection definition file. Host connections can be

also imported by dragging Connection Definition Files (with the suffix *.cdx) onto the Link Explorer.
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Log
All SAS language programs, and Workflow blocks that run SAS language code in the background,
produce a log output that can be viewed in the Editor view. The log output is a record of events occurring
during the execution of a SAS language program, along with information about the run environment.

In the SAS Language Environment, the log file contains a record of all activity for the current session.
If multiple programs or Workflows are executed on the same server or engine during a single server
session, the output for all programs is appended to the same log. If you have more than one Altair SLC
Server registered in the Altair Analytics Workbench, each Altair SLC Server creates to its own log file.

In the Workflow Environment, the log only displays log information for the block it was opened from.

There are system options that enable you to customise the log output. A description of these system
options can be found in the Altair SLC Reference for Language Elements.

Opening the log - SAS Language Environment
Opening a log in the SAS Language Environment for a particular Altair SLC Server.

1. Run a SAS language program.
2. From the Window menu click Show View and then click Output Explorer. Output Explorer may

already be visible; if so, click on it to bring it to focus.
3. Under the Altair SLC Server you ran the program on, double-click on Log.

If you have run several programs, log information for all programs is concatenated into a single log file.
To help locate information, you can use the Outline view to navigate the log, see the Outline view
(page 90) for more information.

Opening the log - Workflow Environment
Opening a log in the Workflow Environment for a particular Altair SLC Server.

1. Run a Workflow.
2. Right-click on a Workflow block that runs SAS language code and click Open Log. Blocks that run

code will have a logo with a coloured background.

The log only displays log information for the block it was opened from.
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Saving the log
Saving the log as a text file.

1. Open the log. For more information, see Opening the log - SAS Language Environment  (page
82)) or (Opening the log - Workflow Environment  (page 82).

2. Right-click on the log and select Save As.

A Save As window opens.
3. Choose a location for the file and click Save.

Printing the log
Printing the log.

1. Open the log. For more information, see Opening the log - SAS Language Environment  (page
82)) or (Opening the log - Workflow Environment  (page 82).

2. Right-click on the log and select Print.

A Print window opens.
3. Choose your required print options, then click Print.

Finding an item in a log
Finding an item in a log by searching for a string of characters.

To find an item in a log:

1. Open the log. For more information, see Opening the log - SAS Language Environment  (page
82)) or (Opening the log - Workflow Environment  (page 82).

2. Right-click on the log and select Find.

A Find in Log window opens.
3. Enter a string you wish to search for and then select the search Direction, and any additional

Options.
4. Click Find next to start the search.
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Clearing the log
Logs in the SAS Language Environment can be cleared. This does not apply to Workflow Environment
logs.

To clear the log, right-click on the log and select Clear log.

Note:
To automatically clear the log on each run, see Log preferences  (page 84).

Log preferences
Changing log preferences, including log syntax colouring and changes to the behaviour of the log.

To change log preferences:

1. Open the log. For more information, see Opening the log - SAS Language Environment  (page
82)) or (Opening the log - Workflow Environment  (page 82).

2. Right-click on the log and select Preferences.

A Preferences window opens.
3. By default you are presented with the Log syntax coloring page, which allows you to set colours for

each item within the log, along with whether the text appears in bold or not. For options concerning
the behaviour of the log, select Altair in the left hand pane.

4. To save preferences and exit, click OK.

Autoscroll
Autoscroll automatically scrolls to the bottom of the log as new lines are appended. This feature can be
enabled or disabled.

To change the Autoscroll status:

1. Open the log. For more information, see Opening the log - SAS Language Environment  (page
82)) or (Opening the log - Workflow Environment  (page 82).

2. Right-click on the log.

If Autoscroll is enabled, a tick will be next to the option.
3. To change the Autoscroll status, click on it once.
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SAS Language Environment views
An overview of views specific to the SAS Language Environment, together with a description of the main
actions that are carried out within each view.

To open the SAS Language Environment perspective, click the Window menu, click Perspective,
then Open Perspective and finally SAS Language Environment. A faster way to access the SAS
Language Environment perspective is to click on the SAS Language Environment button at the top right
of the screen: . This button can be made clearer by right-clicking on it and selecting Show Text; this
displays the name of the button on the button itself:

Editor
When you open any type of file in the Altair Analytics Workbench, the file is opened as a tab in the Editor
view.

The Editor view is the main interactive view for creating and editing SAS language programs or
Workflows. The view is also used to display output such as result datasets or log information.

The Editor can be used to edit datasets opened from the Altair SLC Server Explorer view, as well as
files opened from the Project Explorer or File Explorer views. Logs and output files can be viewed but
not edited.

The Editor view can be split to view or modify two or more files together. To split the view, from the
Window menu, click Editor and then click Toggle Split Editor (Vertical). The editor can also be split
horizontally by using Toggle Split Editor (Horizontal), and you can open another copy of the current file
by using the Clone option.

Altair SLC Server Explorer
The Altair SLC Server Explorer view is used to display all Filerefs, libraries, catalogs and datasets
generated from running a SAS language program on an Altair SLC Server.

While the Altair SLC Server is running, the Filerefs and library contents generated from previous SAS
language programs are preserved. To remove these items, you need to restart the server.

Displaying the view
To display Altair SLC Server Explorer view

From the Window menu, click Show View and then click Altair SLC Server Explorer.
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Objects displayed
The view contains an Altair SLC Server node that represents the Altair SLC Server where your SAS
language program has run. Under this node:

• Libraries – a parent node for individual library items.

The libraries node contains a library node called Work. This is the default temporary library used if
one is not specified in a program.

• Library – a collection of catalogs and datasets.

If you use a LIBNAME statement in a SAS language program to specify your own library name, then
you will see a library node with the specified name also listed in the view.

• Catalog – a collection of user-defined items such as formats and informats.
• Dataset – a data file containing numeric and/or character fields.
• Dataset View – a dataset created by invoking a view in the source data.
• Numeric Dataset Field – a dataset field that contains numeric values.
• Character Dataset Field – a dataset field that contains character values.
• Filerefs – The parent node for Fileref items.
• Fileref – an individual reference to a file.

Filerefs are normally generated automatically, but you can create a Fileref using the FILENAME
statement, for example:

filename shops 'c:\Users\fred\Desktop\4.1-Shops.xls';

The link between a Fileref and its associated external file lasts for the duration of the current session,
or until you change it or discontinue it. To keep a Fileref from session to session, then save the
FILENAME statement in the relevant program(s).

If you select an item in the Altair SLC Server Explorer view, information about that item displayed in the
Properties view.

Altair SLC Server properties
Properties and information available for an Altair SLC Server.

Right-click on an Altair SLC Server and then click Properties to see the following information about that
server:

Code Submission
Sets the server working directory to that of the program, that is, any path referenced in a program
is relative to the directory of the program.

Environment
A read-only list describing the server's environment (working directory, process ID and
environment variables). This information is only available when the server is running.
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Macro Variables
A list of the automatic and global macro variables used by the server, and the associated values.
This information is only available when the server is running. Existing variables cannot be
modified, but new variables can be created.

Startup
The main page has an option called Start the server automatically on connection startup.
Ensure that this is selected to automatically start the server whenever the associated connection is
launched. The Initial current directory for server process option specifies the working directory
for the server, determining where the output is generated. If you have %INCLUDE statements in
your program using relative paths, it is important that you start the server in the correct directory to
allow those %INCLUDE statements to find the files.

The Startup page contains:

System Options
Enables you to specify any Altair SLC options to be processed by the server on startup.
Click Add... to specify the name and value of the option. You can then use Edit... and
Remove to modify and delete any previously-created options and values.

Environment Variables
For a local Altair SLC Server only, used to specify any environment variables to be set
before the server is started. Click New..., to specify the name and value of the variable. You
can use Edit... and Remove to modify and delete previously-created environment variables.

System Options
When the Altair SLC Server is running, provides a read-only list of system options and their
values currently set on the server. This information can also be viewed using the OPTIONS
procedure in a SAS language program.

Altair SLC Licence Information
Displays the licence information for the server. The information cannot be modified and is only
available when the server is running.

Altair SLC Software Information
Displays details about the Altair SLC software. The information cannot be modified and is only
available when the server is running.

Bookmarks
The Bookmarks view lists the bookmarks added to any program or file in a project.

You can add bookmarks on any line in any program or file you can open from the Project Explorer view
and edit with the Editor view.

The Bookmarks view lists bookmarks for all programs in all open projects. Bookmarks cannot be
created for programs not managed through the Project view.
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To open a file at the bookmark, double-click the bookmark in the Bookmarks view. The file is opened
in the Editor view, with the bookmarked line highlighted, or at the first line in the file if the entire file was
bookmarked

Displaying the view
To display the Bookmarks view:

From the Window menu, click Show View and then click Bookmarks.

Bookmark anchors
A bookmark is an anchor that you can specify to navigate back to that point at any time.

There is no limit to the number of bookmarks that you can create either against a particular line in the
program, or a program file as a whole.

You can list, and navigate between, all your bookmarks using the Bookmarks view. If you export a
project containing bookmarks, the individual bookmarks are not exported with it.

Adding a bookmark

A bookmark can be added to a particular line in a program.

To add a new bookmark on a particular line in a program:

1. Open the program or file in the Editor view.
2. Right-click in the grey border to the left of the required line and click Add Bookmark on the shortcut

menu.
3. Enter a bookmark name in the Add Bookmark dialog box and click OK.

A bookmark tag ( ) is displayed in the border, and a corresponding entry made in the Bookmarks
view. You can also add a bookmark to a whole file, to do this, select the file in the Project Explorer view,
click Edit menu and then click Add Bookmark.

Deleting a bookmark

Deleting a bookmark from a program.

To delete a bookmark:

1. Click the Window menu, click Show View  and then click Bookmarks.
2. In the Bookmarks view, right-click the bookmark's description and click Delete on the shortcut menu.
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Tasks
The Tasks view lists any tasks added to any program or file in a project.

You can add tasks on any line in any program or file you can open from the Project Explorer view, and
edit with the Editor view.

The Tasks view lists tasks associated with all programs in all open projects. Tasks cannot be created for
programs not managed through the Project view.

You can use the Tasks view to change the priority levels, modify descriptions, and mark them as
completed or leave them uncompleted.

You can add Task markers  (page 89) (reminders) against any line in a program that has been
opened from the Project Explorer  (page 50), and associate each of them with notes and a priority
level. To list, update and navigate between any tasks you have added, you need to use the  Tasks
view.

To open a file associated with a task, double-click the task in the Tasks view. The file is opened in the
Editor view, with the relevant line highlighted.

Displaying the view
To display the Tasks view:

From the Window menu, click Show View and then click Tasks.

Task markers
A task marker represents a reminder about a work item.

Task markers can only be added to programs in a project. You can add a task and associate a short
description and a priority level (one of High, Normal or Low) against any line in a program. You can list
and navigate between all your tasks in the Tasks view.

There is no limit to the number of task markers that you can add to a program. However, if you export a
project, the individual tasks are not exported with it.

Adding a task

Adding a new task marker on a particular line in a program.

To add a task:

1. Open the program or file in the Editor view.
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2. Right-click in the grey border to the left of the required line and click Add Task on the shortcut menu.

A Properties window appears, quoting the program name and location and the line number you have
selected for the task.

3. In the Properties dialog, enter a Description and select the Priority for the task.
4. Click OK to save the task

A task marker ( ) is displayed in the border, and a corresponding entry appears in the Tasks view.

Deleting a task

Deleting a new task marker from a particular line in a program.

To delete a task:

1. Click the Window  menu, click Show View and then click Tasks.
2. Right-click on the task's description, and click Delete on the shortcut menu.

Outline
The Outline view displays structural elements for a file that can be used to locate the line associated
with the element.

Opening or giving focus to a program, log, listing or HTML result file, automatically refreshes the Outline
view to display the structural elements that are relevant to the active item.

Displaying the view
To display the Outline view:

From the Window menu, click Show View and then click Outline.

Displayed structural elements
Viewing programs displays the following structural elements in the Outline view:

•  Global statement

•  DATA step

•  Procedure

•  Macro

Viewing the log file displays the following structural elements in the Outline view:

•  An individual log entry.
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•  Error

•  Warning

Viewing the output results from program execution displays the following structural elements in the
Outline view:

•  Results parent node

•  HTML tabular output

•  Listing tabular output

You can control which structural elements are displayed in the Outline view using the toolbar at the top
of the view panel.

Output Explorer
The Output Explorer view displays the output files generated from running a SAS language program.

Output items are associated with the server on which they were generated, and may be one of the
following types:

• Listing output
• HTML output
• PDF output

Log output is always shown for each server.

To open any output, double-click on it.

Displaying the view
To display the Output Explorer view:

Once you have run a SAS language program, from the Window menu click Show View and then click
Output Explorer.

View output
Double-click on one of the output nodes to open the output type in its associated editor. For output types
other than log output the individual result elements are listed in the Results Explorer view when the
output is opened.
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Results Explorer
The Results Explorer view displays the results from every SAS language program that has been
executed.

The view contains hierarchical links to the results, grouped by server, since the last time that the server
was started.

Displaying the view
To display the Results Explorer view: from the Window menu, click Show View and then click Results
Explorer.

Output
Once a program has been executed, an entry appears under the relevant server for every procedure that
created output. For example PROC PRINT will produce an entry named The PRINT Procedure. Expand
this link to find each type of output that has been generated.

Console
The Console view displays all system standard output and system standard error messages produced by
an Altair SLC Server.

The Console view is automatically opened when a system error is reported. The console log can
be saved to a file, to do this; select Window then Preferences. From the Preferences dialog box,
select Altair SLC and from the Altair pane select Log Console to file and enter the filepath in the
corresponding text box.

Displaying the view
To display the Console view:

From the Window menu, click Show View and then click Console.

Search
The Search view displays the results of searches carried out using the Search dialog box.

When you click an item in the Results view, the file is opened in the Editor view, with the relevant line
highlighted.

To open the Search dialog box, click the Search menu and then click Search. The Search view opens
automatically to display the results.
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Using Altair SLC Hub Authentication Domains
and Library Definitions with the SAS Language
Environment
Altair SLC Hub is an Enterprise Management Tool that, amongst other things, provides centralised
management of access to data sources.

Altair SLC Hub provides two features for use with the SAS Language Environment:

• Authentication Domains securely store access credentials for data sources within Altair SLC Hub,
which can then be accessed from SAS language code by name, removing the need to hard code
credentials in SAS Language code. This improves security and also eliminates multiple code changes
should the credentials change.

• Library Definitions securely store details of libraries and their options within Altair SLC Hub. These
library definitions can then be accessed from SAS language code using Altair SLC Hub user specific
Libname Bindings, which are keywords defined in Altair SLC Hub. These Libname Bindings can take
the place of Libname statements in SAS language code.

To use either of these features, the SAS language code will need to access Altair SLC Hub when it runs,
which can be done in two ways:

• The SAS language code is run from within Altair Analytics Workbench, with Altair Analytics
Workbench logged in to the Altair SLC Hub instance hosting the Authentication Domains or Library
Definitions you require.

• The code includes an OPTIONS statement, specifying Altair SLC Hub connection details. For
example: OPTIONS hub_user="HubUser123" hub_pwd="hubpass" hub_port=8443
hub_server="https://hubserv.abcde.local";

Logging in to Altair SLC Hub from Altair Analytics
Workbench
To use Altair SLC Hub features in Altair Analytics Workbench, you will need to log into an Altair SLC Hub
installation from Altair Analytics Workbench.

Before connecting to Altair SLC Hub, you require details of an Altair SLC Hub host and access
credentials for it. These details will be provided by your Altair SLC Hub administrator.

To log in to an Altair SLC Hub instance from Altair Analytics Workbench:

1. On the Altair drop-down menu in Altair Analytics Workbench, click Hub, then Log in.
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2. In the Hub Login dialog box complete the required information:

a. Select the required Protocol, either HTTP or HTTPS.
b. Enter the Host name provided by your Altair SLC Hub administrator.
c. Enter the Port for Altair SLC Hub. By default, Altair SLC Hub configured for HTTPS will use port

8443, and when configured for HTTP, port 8181, but your Altair SLC Hub administrator may
change these.

d. Enter the Altair SLC Hub Username provided by your Altair SLC Hub administrator.
e. Enter the Altair SLC Hub Password provided by your Altair SLC Hub administrator.

3. Click OK to connect.

If the connection is successful, a message stating Hub: Logged in as username is displayed in the
Altair Analytics Workbench status bar. If the connection fails, an error message is displayed in the Hub
Login dialog box.

Logging in to Altair SLC Hub from SAS language code
To use Altair SLC Hub features in SAS language code, you will need to include Altair SLC Hub login
details in an OPTIONS statement.

To connect a piece of SAS language code with Altair SLC Hub, the code needs to include an OPTIONS
statement specifying Altair SLC Hub connection details.

For example:

OPTIONS hub_user="HubUser123" hub_pwd="hubpass" hub_port=8443 hub_server="https://
hubserv.abcde.local";

Altair SLC Hub Authentication Domains
Authentication Domains securely store access credentials for data sources within Altair SLC Hub, which
can then be accessed from SAS language code by name, removing the need to hard code credentials
in SAS Language code. This improves security and also eliminates multiple code changes should the
credentials change.

To use Authentication Domains, SAS language code must either be run from an instance of Altair
Analytics Workbench connected to Altair SLC Hub (see Logging in to Altair SLC Hub from Altair
Analytics Workbench  (page 93)), or the code itself must log in to Altair SLC Hub (see Logging in to
Altair SLC Hub from SAS language code  (page 94)).

SAS Language statements that require credentials, for example LIBNAME, will also accept an
AUTHDOMAIN option where you can specify the name of an Authentication Domain present in a
connected Altair SLC Hub instance.
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For example, the following libname statement connects to an Oracle database using an Authentication
Domain contained in a connected Altair SLC Hub instance:

libname    L33 oracle
            path='oracle-ab-cl2'
            authdomain="OraAB-AD"
            schema='TEST';

In the above example, the Authentication Domain OraAB-AD is stored within the connected Altair SLC
Hub instance and contains credentials to connect to the oracle-ab-cl2 database.

Altair SLC Hub Library Definitions in the SLE
Library Definitions securely store details of libraries and their options within Altair SLC Hub. These library
definitions can then be accessed from SAS language code using Altair SLC Hub user specific Libname
Bindings, which are keywords defined in Altair SLC Hub. These Libname Bindings can take the place of
Libname statements in SAS language code.

To use Library Definitions, SAS language code must either be run from Altair Analytics Workbench
connected to an instance of Altair SLC Hub (see Logging in to Altair SLC Hub from Altair Analytics
Workbench  (page 93)), or the code itself must log in to Altair SLC Hub (see Logging in to Altair
SLC Hub from SAS language code  (page 94)).

In Altair Analytics Workbench, Libname Bindings from a connected Altair SLC Hub instance are
displayed as Libraries in Altair SLC Server Explorer and may therefore be quoted in SAS language
code statements. Libname Bindings are Altair SLC Hub user specific, so the Libname Bindings displayed
in Altair Analytics Workbench depend on the Altair SLC Hub user that you are logged in as.

Although Library Definition libraries are defined in Altair SLC Hub, the actual library call is still being
made by the user logged in to Altair Analytics Workbench, so that user will need appropriate software
installed to access the library in question.

Hub Package Program Executions
The Hub Package Program Executions view lists details of all executions of Altair SLC Hub Program
Package programs from Altair Analytics Workbench.

Every time an Altair SLC Hub Program Package program is executed from Altair Analytics Workbench,
it generates an entry in the Hub Package Program Executions view. Once a program has finished
executing, its entry can be expanded by clicking the arrow to the left of it ( ), displaying the following
execution details:

• Parameters: the parameters the program was executed with and their values.
• Results: the results the program execution generated, including the log.
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Displaying the view
To display the Hub Package Program Executions view, from the Window menu click Show View
and then click Other. A Show View dialog box opens. Expand Altair, select Hub Package Program
Executions and then click OK.

Alternatively, if you run an Altair SLC Hub program without the Hub Package Program Executions view
displayed, you will be immediately asked if you want to open the view.

The executions list
The Hub Package Program Executions view comprises of a list of execution events for Altair SLC
Hub programs. Each execution event, marked by a program package icon ( ) has a label structured as
follows:

<execution state and code>package name:program name date and time

Where:

• execution state and code: If the program has completed execution, this displays terminated with a
stated exit code as follows:

‣ SAS language: Success: 0, warning: 1, error or fatal: 2, abort: 3, return: 4, abnormal end: 5,
initialisation error: 6.

‣ Python language: Success: 0, failure: -1.
‣ R language: Success: 0, failure: -1.

If the program is still running, execution state and code is blank.
• package name: The name of the Hub package containing the program being run.
• program name: The name of the program being run.

Click the arrow to the left of an execution ( ) to reveal Parameters and Results for that program
execution, if applicable.

Parameters
Click the arrow to the left of the Parameters heading ( ) to reveal a list of the parameters that this
execution ran with. Each parameter in the list is displayed as follows:

name:value

Where:

• name: The name of the parameter, as defined in the Altair Analytics Workbench Altair SLC Hub
program editor, or in the Altair SLC Hub web portal.

• value: The value taken for the parameter for this execution.
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Results
Click the arrow to the left of the Results heading ( ) to reveal a list of the results and output that this
execution produced, including the Log.

Deleting an execution event from the Hub Package Program
Executions view
To delete an execution event from the Hub Package Program Executions view, right click on the
execution to be deleted, then click Delete execution results.

Workflow Environment views
The Workflow Environment perspective contains the views and tools required to create and manage
Workflows. To open the Workflow Environment perspective, click on the Workflow Environment button
at the top right of the screen: .

Workflow files are created and managed in projects using the Project Explorer view, or on a host to
which you have access using the File Explorer view.

The Workflow Editor view is used to create and run Workflows. The Data Profiler view is used to
inspect the contents of a dataset in the Workflow.

The Workflow Link Explorer and File Explorer view enable you to connect to a remote host and specify a
default Workflow Engine on a remote host to run your Workflows.

The Workflow perspective also enables you to create and view tasks and bookmarks in a Workflow.

The SAS language library feature for creating datasets, such as the temporary WORK library, is not
available in a Workflow. Working datasets are created as part of a Workflow, and the Data Profiler view
is used to explore the dataset in the Workflow.

To open the Workflow Environment perspective, click the Window menu, click Perspective, then Open
Perspective and finally Workflow Environment. A faster way to access the Workflow Environment
perspective is to click on the Workflow Environment button at the top right of the screen: . This
button can be made clearer by right-clicking on it and selecting Show Text; this displays the name of the
button on the button itself: .

Note:
Some views and features from the SAS Language Environment are visible when viewing Workflows
in the Workflow Environment, even though they don't functon for Workflows (for example, the Search
facility).

97



Altair Analytics Workbench user guide
Version 2023

Editor
When you open any type of file in the Altair Analytics Workbench, the file is opened as a tab in the Editor
view.

The Editor view is the main interactive view for creating and editing SAS language programs or
Workflows. The view is also used to display output such as result datasets or log information.

The Editor can be used to edit datasets opened from the Altair SLC Server Explorer view, as well as
files opened from the Project Explorer or File Explorer views. Logs and output files can be viewed but
not edited.

The Editor view can be split to view or modify two or more files together. To split the view, from the
Window menu, click Editor and then click Toggle Split Editor (Vertical). The editor can also be split
horizontally by using Toggle Split Editor (Horizontal), and you can open another copy of the current file
by using the Clone option.

Workflow tab
The Workflow tab in the Workflow Editor view contains the canvas on which a Workflow is created.
This tab is displayed by default when opening a Workflow file.

To display the Workflow tab, ensure that you are in the Workflow Environment and displaying a
Workflow file, then click Workflow at the base of the screen.

The Workflow tab has a palette of operations, such as data import, data preparation, machine learning,
coding, scoring, and so on. Each operation is represented by a block. All block are available in a palette
on the left hand side of the Workflow tab. To select the required operation, drag the corresponding block
onto the canvas, where you can connect it with other blocks already on the canvas to create a Workflow.

Most types of blocks that can be added to a Workflow require you to specify properties. Properties are
set in the configuration dialog box that can be accessed through the shortcut menu for a block. To view
or specify block properties, right-click the required block in the canvas and click Configure.

By default, the Workflow automatically runs as blocks are added or edited. You can also right-click on a
block and choose to run the Workflow up to that block. Working datasets created as part of the Workflow
are deleted when the Workflow Editor view is closed. If you automatically run a Workflow, reopening a
saved Workflow automatically recreates all working datasets in the Workflow.

Adding comments to a Workflow and blocks
You can add comments to a Workflow, describing the purpose of the Workflow or identifying the
individual steps in a Workflow when the Workflow is shared.

To create a new comment for the Workflow, right-click in the Workflow Editor view and click Add
comment.  To add a comment to a block, right-click the required block and click Add comment.
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Displaying observation counts for datasets in a Workflow
The number of observations and variables for each dataset can be displayed on the Workflow canvas,
without having to use other tools such as the Data Profiler view.

To enable observation counts for each dataset on the Workflow, right-click in the Workflow Editor view
and click Show all observation counts. To undo this, right-click again in the Workflow Editor view and
click Hide all observation counts.

Workflow navigation

The Workflow Editor view enables you to zoom in and out of a Workflow, to relocate blocks in a
Workflow and move the Workflow within the editor view.

Zoom in and zoom out features in the Workflow Editor view can be controlled from the Zoom tools,
keyboard, or mouse. The zoom tools are grouped in the Altair Analytics Workbench toolbar:

To change the scale of the Workflow view:

• Click Zoom in ( ) to increase the scale of the Workflow view by 10% of the current scale.
Alternatively, press Ctrl+Plus Sign to do the same.

• Click Zoom out ( ) to decrease the scale of the Workflow view by 10% of the current scale.
Alternatively, press Ctrl+ Minus Sign to do the same.

• Click the zoom list ( ) and then select Page to scale the Workflow view to fit the available
screen area in the Workflow Editor.

• Press Ctrl+0 (zero) to set the scale of the Workflow view to 100%.
• Click the zoom list ( ) and then select Height to scale the Workflow view to fit the height

in the available screen area in the Workflow Editor. If the Workflow design is too wide for the scale,
some blocks may be partly-visible or not visible at all after scaling.

• Click the zoom list ( ) and then select Width to scale the Workflow view to fit the width in
the available screen area in the Workflow Editor view. If the Workflow design is too tall for the scale,
some blocks may be partly-visible or not visible at all after scaling.

Moving Workflow blocks in the view
The position of multiple blocks can be changed at the same time in the Workflow view. If blocks are
connected to other blocks in the Workflow, the connections are maintained between the blocks. To
relocate multiple blocks in the Workflow:

1. Click the Workflow Editor view.
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2. Press Ctrl and drag the pointer to cover all the blocks:

The blocks become highlighted (their outlines become blue).
3. Click one of the highlighted blocks, and drag the group of blocks to the required place in the

Workflow.

Move the visible area of the Workflow
You can move the Workflow canvas view to enable you to focus on a specific part of the Workflow. To
move the view, click on a blank area and drag until the required area of the Workflow canvas is in view.

Saving a Workflow

After modifying a Workflow, you should save it to ensure no loss of data. A Workflow can be saved in a
project in the active workspace, or to a location on a local or remote host.

Saving a Workflow to a different file
You can save a Workflow to an alternative file either in the current workspace or to a folder on any host
to which you have access. To save a Workflow to an alternative file, click the File menu and then select
Save As.

• If you use the Project Explorer view to manage files, you can save the Workflow as a different file
in any project in your current workspace, but cannot save a Workflow to a folder that can only be
accessed through the Project Explorer view.

• If you use the File Explorer view to manage files, you can save the Workflow as a different file to any
available folder structure that you can access on each host, but cannot save a Workflow to a project
in the current workspace.

Updating a saved Workflow
To save a Workflow, click the File menu and then click Save. The Workflow file is updated with any
changes you have made.
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Exporting to SAS language program

The Workflow Editor view allows you to export a Workflow as SAS language code, either to the
clipboard or to a specified file.

Note:
To export a Workflow to SAS language code, the Workflow must not contain any failed or out of date
blocks.

Note:
Model Training blocks cannot be exported to SAS language procedures.

To export a Workflow as SAS language code:

1. Ensure that your Workflow is displayed and runs successfully.
2. Right-click on the Workflow background and then click Export to SAS Language Program.

An Export Workflow to SAS Language Program dialog box appears.
3. In Temporary library name, enter a name for the library that will be defined at the start of the SAS

language code.
4. In Directory for temporary datasets, enter a directory for the library to be defined at the start of the

SAS language code.
5. Click Next.

SAS language code for the Workflow is displayed.
6. You can now either copy the code to the clipboard or save it to a file:

• To copy the code to the clipboard, click Copy Code. You can now close the dialog box by clicking
Cancel.

• To save the code to a file, click Next, choose either your Workspace or an External location, and
then click Browse to choose the location and type a filename, including the file extension (.sas
or .wps).

7. Click Finish.

Workflow Settings
The Workflow Settings dialog box contains tools for viewing and managing a Workflow's database
references, parameters, variable lists and optionally, Altair SLC Hub program.

To display the Worklow Settings dialog box, ensure that you are displaying a Workflow file, then click
Workflow Settings at the base of the screen.

For more information on database references, see Database References  (page 175).

For more information on parameters, see Parameters  (page 185).
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For more information on variable lists, see Variable Lists  (page 199).

For more information on the Altair SLC Hub, see the Altair SLC Hub documentation.

Database Explorer view
The Database Explorer view enables you to create a reference to a database and to access references
created and stored in Altair SLC Hub.

A reference specifies the details required to access a database. If you have multiple Workflows that
require access to the same data, you can create a library reference and import data into a Workflow
using the Database Import block.

Displaying the view
To display the Database Explorer view:

1. Click the Window menu option, select Show View and then click Database view.

Objects displayed
There are two node types visible in this view, a host node (1) and a data source node (2):

A host node represents the location where the data source connection information is stored, either Hub
or Workbench.

• The Hub node displays all references available in the authorisation domain in Altair SLC to which
you have connected. For more information, see Using Altair SLC Hub Library Definitions with the
Workflow Environment  (page 121).

• The Workbench node contains all references you have created or imported. These references are
stored in the current project, but can be shared with a Workflow through the Workflow Settings view.

A database node represents the reference element specifying a connection to a specific database.
Previously-created references can be imported from a data source definition file. The settings for any
node created in the Workbench host can be exported to a database definition file.

Adding a new database reference for Workbench
To add a new reference to a database, click the Create a new database button ( ) at the top right of
the Database Explorer view. The Add Database wizard starts. For guidance on completing the wizard,
see Database References  (page 175).
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Importing a database reference for Workbench
An existing database reference can be added to the Database Explorer view if that reference has
previously been saved as a database definition. To add an existing reference you import the database
definition:

1. Click the Import database definitions button ( ) at the top right of the Database Explorer view.

An Open dialog is displayed.
2. Browse to the folder that contains the database definition.

A database definition has the file extension .dsx.
3. Select the definition.

The Open dialog is closed, and a database reference is added to the list of references under the
Workbench host. The name of the reference is extracted from the definition. If the name is the same
as a name already in the list of references, the name is made unique by appending a number.

Renaming a Workbench database reference
A database reference can be renamed. To do this:

1. Right-click the reference you want to rename.
2. In the pop-up menu, click Rename.

The Enter new database name dialog is displayed.
3. Enter a new name in the text box.
4. Click OK.

Click Cancel to close the dialog box and keep the current name.

Exporting an existing Workbench database reference
An existing database reference can be added to the Database Explorer view if that reference has
previously been saved as a database definition. To add an existing reference you import the database
definition:

1. Click the Import database definitions button ( ) at the top right of the Database Explorer view.

A Save As dialog is displayed.
2. Browse to the folder where you want to save contains the database definition.
3. Enter a name for the definition in File name.

A database definition has the file extension .dsx.
4. Click Save.

The Save As dialog is closed.
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Deleting a Workbench database reference
An existing database reference can be deleted from the Database Explorer view. To delete a database
reference:

1. Right-click the reference you want to delete.
2. In the pop-up menu, click Delete.

The Confirm Remove dialog is displayed.
3. Click OK to delete the reference, or Cancel to keep the reference and close the dialog box.

Testing a database connection
You can test whether an existing database reference can connect to a database. You can do this for
databases defined under the Workbench or Hub nodes. To do this:

1. Right-click the reference you want to test.
2. In the pop-up menu, click Test.

The Data Connection Test dialog is displayed. This tells you if a connection was successfully made
to the database.

3. Click OK to close the dialog box.

If you cannot connect to the database, check whether it is running, or whether connection details have
changed since you created the reference.

Adding a database or table to a Workflow by dragging
You can drag a database name or table name from the Database Explorer view onto the Workflow
canvas.

If you drag a database name and drop it on the canvas, a Database Import block is created. You can
then double click on the block to open the Database Import configuration dialog to select the required
tables.

If you drag a table name and drop it on the canvas, a Table block is created. This is a pointer to the table
on the database server, and does not copy data into memory until you connect one or more blocks and
run the Workflow, or view the contents of the table using the Dataset File Viewer.

Table blocks can only be used with the following Workflow blocks:

• Aggregate block
• All language blocks:

‣ Python block
‣ R block
‣ SQL block
‣ SAS block

• Filter block
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• Join block
• Mutate block
• Query block
• Select block

Hub API Executions view
The Hub API Executions view enables you to view the information about an API execution from an Altair
Analytics Workbench Project connected to the Altair SLC Hub.

The Hub API Executions view must be used with a Workflow stored in an Altair Analytics Workbench
Project. For more information see the Altair Analytics Workbench Projects  (page 57) section.

Displaying the view
To display the Hub API Executions view:

1. Click the Window menu option and select Show View.
2. Select the Hub API executions option, if its not in the initial list, select Other... to display the Show

view dialog box, then select Hub API executions and click Open.

Displayed structural elements
Executing an API from an Altair Analytics Workbench Project displays the following structural elements in
the Hub API executions view.

Base Node
Displays information about the last API execution, including the time of execution and execution
status. Expand this node to display the Parameters and Results.

Parameters
Displays all the parameters used in the program execution.

Results
Diplays the program results of the Altair SLC Hub program.

Data Profiler view
The Data Profiler view enables you to view content and details about a dataset.

To open the Data Profiler view, select the required dataset, right-click Open With and then click Data
Profiler in the shortcut menu.
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Summary View .................................................................................................................................. 106
The Summary View lists information about the dataset, including the number of observations and
variables in the dataset as well as variable characteristics.

Data ................................................................................................................................................... 108
The Data panel lists all observations in a dataset and enables you to view, filter, or sort those
observations.

Univariate View ................................................................................................................................. 108
The Univariate view tab displays summary statistics for all numeric univariate variables.

Univariate Charts ...............................................................................................................................108
The Univariate Charts tab enables you to view the frequency distribution table and graphs for a
selected dataset variable.

Correlation Analysis ...........................................................................................................................109
The Correlation Analysis tab enables you to view the strength of the correlation between numeric
variables in the dataset.

Predictive Power ................................................................................................................................111
The Predictive Power tab enables you to view the predictive power of independent variables in
the dataset in relation to a selected dependent variable.

Summary View
The Summary View lists information about the dataset, including the number of observations and
variables in the dataset as well as variable characteristics.

The Summary View contains two panels: Summary and Variables.

Summary
The Summary panel displays summary information about the dataset: the dataset name, the total
number of observations, and the total number of variables in the dataset.

Variables
The Variables panel displays information about the variables in the dataset as follows:

Variable
The name of the variable in the dataset.

Label
The alternative display name for the variable.

Type
The type of the variable. This can be one of:
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• Numeric, for numbers and date and time values.
• Character for character and string data.

Classification
The category of the variable; this can be one of:

• Categorical. A non-numeric variable that can contain a limited number of possible values, and
the limit is below the specified classification threshold.

• Continuous. A numeric variable that can contain an unlimited number of possible values. This
classification is used for numeric variables where the number of distinct values in the variable
is greater than the specified classification threshold.

• Discrete. A numeric variable that can contain a limited number of possible values. This
classification is used for character variables where the number of distinct values in the variable
is less than or equal to the specified classification threshold.

The classification threshold defines a number of unique values above which a variable is
classified as continuous, and below which a variable is either categorical (if non-numeric)
or discrete (if numeric). The classification threshold is specified on the Data panel of the
Preferences dialog box.

Length
The size required to store the variable values. For character types, the number represents
the maximum number of characters found in a variable value. For numeric types, the number
represents the maximum number of bytes required to store the value.

Format
How the variable is displayed when output. For more information about formats see the section
Formats in the Altair SLC Reference for Language Elements.

Informat
The formatting applied to the variable when imported into Altair SLC. For more information, about
informat, see the section Informats in the Altair SLC Reference for Language Elements.

Distinct Values
The number of unique values in the variable. If the variable classification is Continuous, the
display indicates there are more unique values than the specified classification threshold.

Missing Values
The number of missing values in the variable.

Frequency Distribution
For each value in a non-continuous variable, displays a chart showing the number of occurrences
of each value in the variable.
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Data
The Data panel lists all observations in a dataset and enables you to view, filter, or sort those
observations.

The Data panel in the Data Profiler view is a read-only version of the Dataset Viewer. You can modify
the view, or sort and filter data in the Data panel. If you want to edit values in the dataset, you need to
use the Dataset Viewer. For more information about sorting and filtering observations, and about the
Dataset Viewer see Dataset Viewer  (page 115).

Univariate View
The Univariate view tab displays summary statistics for all numeric univariate variables.

The columns displayed in the Univariate View tab are determined using the Calculate Statistics dialog
box. Click Configure Statistics ( ) to open Preferences and select the statistics you want displayed:

Quantiles
Lists quantile points.

Variable Structure
Lists statistics describing the variable, such as number of missing values, and minimum and
maximum values.

Measures of Central Tendency
Lists measures used to identify the central tendency in the values of the variable (mean, median
and mode).

Measures of Dispersion
Lists measures used to show the dispersion of a variable.

Others
Lists other statistics that can be displayed in the statistics table.

Univariate Charts
The Univariate Charts tab enables you to view the frequency distribution table and graphs for a selected
dataset variable.

The information displayed is determined by the variable selected in the Variable Selection list. Each
section in the tab displays the frequency of values occurring in the selected variable.
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Frequency Table
Displays the frequencies of the values in the specified variable, the percentage of the total number of
observations for each value, and cumulative frequencies and percentages.

If the variable type is categorical or discrete, the table displays one row for each value. If the variable
type is continuous, the variable is binned and frequency information is displayed for each bin.

Frequency Chart
Displays the frequency of values as the percentage of the total number of observations for the variable,
either as a histogram, line chart or pie chart.

The chart can be edited and saved. Click Edit chart  to open the Chart Editor from where the chart
can be saved to the clipboard.

Correlation Analysis
The Correlation Analysis tab enables you to view the strength of the correlation between numeric
variables in the dataset.

Options
Specifies the coefficient type to use when comparing variables, and which numeric variables in the
dataset are to be compared.

Coefficient
Specifies the type of coefficient used to compare values.

Pearson
Specifies the Pearson correlation coefficient, which is defined as:

where:

•
 is the mean of variable x

•
 is the mean of variable y
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Spearman's Rho
Specifies the Spearman's rank correlation coefficient, which is defined as:

where:

•  is the rank of 

•
 is the mean of the ranked variable 

•  is the rank of 

•
 is the mean of the ranked variable 

The values of the variables are first ranked and the ranks compared. Using this coefficient
may therefore be more robust to outliers in the data.

Kendall's Tau
Specifies the Kendall rank correlation coefficient, which is defined as:

where:

•

•

•

•  is the number of concordant pairs

•  is the number of discordant pairs

•  is the number of tied values in the i th group of tied values for the first variable

•  is the number of tied values in the j th group of tied values for the second variable

• The difference in the number of concordant and discordant pairs can be expressed as:

The values of the variables are first ranked and the ranks compared. Using this coefficient
may therefore be more robust to outliers in the data.
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Select Variables
Displays a list of numeric variables in the dataset, from which you can select the variables to
compare.

Correlation Coefficient Matrix
The matrix is shown in coloured blocks, with the size and colour of the blocks indicating the relationship
between the compared variables. The scale for the items displayed ranges from 1 a strong positive
correlation to -1 where there is a strong negative correlation.

Correlation Statistics
Displays the correlation statistics and scatter plot for the block selected in the Correlation Coefficient
Matrix. The table displays the variables being compared, the coefficient type and the p-value for the
correlation coefficient being non-zero. The scatter plot displays all values in the dataset, using the same
colour scale as the matrix, as either a plot or heat map if the number observations is very high.

Predictive Power
The Predictive Power tab enables you to view the predictive power of independent variables in the
dataset in relation to a selected dependent variable.

The information displayed is determined by the variable selected as the Dependent Variable. Each
section displays the relationship between the independent variables in the dataset and the specified
Dependent Variable.

Statistics Table
The Statistics Table displays all the variables in the dataset and a series of predictive power statistics.
The statistics displayed are:

• Entropy Variance. Displays the Entropy Variance value for each variable in relation to the specified
Dependent Variable.

• Chi Sq. Displays the Chi-Squared value for each variable in relation to the specified Dependent
Variable.

• Gini. Displays the Gini Variance value for each variable in relation to the specified Dependent
Variable.

For more information about how these values are calculated, see Predictive power criteria  (page
112).
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Entropy Variance Chart
Displays the bar chart of independent variables' entropy variances in relation to the specified Dependent
Variable. The variables are displayed in order from the highest entropy variance to the lowest. The
number of variables displayed in the chart is determined by the preferences set in the Data Profiler
panel of the Preferences dialog box.

The chart can be edited and saved. Click Edit chart  to open the Chart Editor, from where the chart
can be saved to the clipboard.

Frequency Chart
Displays the frequency of each value of the independent variable selected in the Statistics Table for
each value of the specified Dependent Variable.

• Click View whole data  to display the overall predictive relationship between values of an
independent variable selected in the Statistics Table and the specified Dependent Variable.

• Click View breakdown data  to display the frequency of each value of an independent variable,
and its relationship to the outcomes for the specified Dependent Variable.

The chart can be edited and saved. Click Edit chart  to open a the Chart Editor from where the chart
can be saved to the clipboard.

Predictive power criteria

Predictive power is a way of measuring how well a particular input variable can predict the target
variable.

Pearson's chi-squared statistic
Pearson’s chi-squared statistic is a measure of the likelihood that the value of the target variable is
related to the value of the predictor variable.

Each observation in the dataset is allocated to a cell in a contingency table, according to the values of
the predictor and target variables. Pearson’s chi-squared statistic is calculated as the normalised sum
of the squared deviations between the actual number of observations in each cell, and the expected
number of observations in each cell if there were no relationship between the predictor and target
variables.

If a predictor variable has a high Pearson’s chi-squared statistic, it means that the variable is a good
predictor of the target variable, and is likely to be a good candidate to use to split the data in a binning or
tree-building algorithm.
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Pearson’s chi-squared statistic for a discrete target variable is calculated as

where

•  is the number of distinct values of the predictor variable    (these are the rows in the contingency
table)

•  is the number of distinct, discrete values of the target variable    (these are the columns in the
contingency table)

•  is the number of observations for which the predictor variable    has the   th value,   , and the
target variable    has the   th value,    (these are the values in the cells of the contingency table)

•  is the expected value of 

•  is the total number of observations for which the predictor variable    has the   th value, 

•   is the total number of observations for which the target variable    has the   th value, 

•  is the total number of observations in the dataset

Entropy variance
Entropy variance is a measure of how well the value of a predictor variable can predict the value of the
target variable.

If a variable in a dataset has a high entropy variance, it means that the variable is a good predictor of the
target variable, and is likely to be a good candidate to use to split the data in a binning or tree-building
algorithm.

Entropy variance for a discrete target variable is calculated as

where

•  is the number of distinct values of the predictor variable, 
•  is the total number of observations for which the predictor variable    has the   th value, 
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•  is the entropy calculated for just the observations where the predictor variable is 

•  is the total number of observations in the dataset
•  is the entropy calculated for all the observations
•  is the number of distinct, discrete values of the target variable, 
•  is the number of observations for which the predictor variable    has the   th value,   , and the

target variable    has the   th value, 

•   is the total number of observations for which the target variable    has the   th value, 

Gini variance
Gini variance is a measure of how well the value of a predictor variable can predict the target variable.

If a variable in a dataset has a high Gini variance, it means that the variable is a good predictor of the
target variable, and is likely to be a good candidate to use to split the data in a binning or tree-building
algorithm.

Gini variance for a discrete target variable is calculated as

where

•  is the number of distinct values of the predictor variable, 
•  is the total number of observations for which the predictor variable    has the   th value, 

•  is the Gini impurity calculated for just the observations where the predictor variable is 

•  is the total number of observations in the dataset
•    is the Gini impurity calculated for all the observations
•  is the number of distinct, discrete values of the target variable, 
•  is the number of observations for which the predictor variable    has the   th value,   , and the

target variable    has the   th value, 

•   is the total number of observations for which the target variable    has the   th value, 
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Information value
Information value is a measure of the likelihood that the value of the target variable is related to the value
of the predictor variable. The information value measure is only applicable for binary target variables
(that is, target variables that can take one of exactly two values).

If a predictor variable has a high information value, it means that the variable is a good predictor of the
target variable, and is likely to be a good candidate to use to split the data in a binning or tree-building
algorithm.

The information value statistic is calculated as

where:

•  is the number of distinct, discrete values of the predictor variable    (these are the rows in the
contingency table)

•  is the number of observations for which the predictor variable    has the   th value,   , and
the target variable    has the value,    (these are the values in the cells of the    column in the
contingency table)

•  is the number of observations for which the predictor variable    has the   th value,   , and
the target variable    has the value,    (these are the values in the cells of the    column in the
contingency table)

•  and    are the two possible values of the binary target variable 

•   is the total number of observations for which the target variable    has the value, 

•   is the total number of observations for which the target variable    has the value, 

•  is the WOE value for observations where the predictor variable is 

•  is the weight of evidence (WOE) adjustment, a small positive number to avoid infinite values
when    or 

Dataset File Viewer
Enables you to view, filter, sort or modify observations in a dataset.

The contents of a dataset are shown in a grid. The rows of the grid represent dataset observations, and
the columns represent dataset variables.

You can display labels in the column headers of a dataset, re-organise the view by moving columns, and
hide datagrid columns that are not relevant.
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By default, a dataset is opened in browse mode. If required, you can change to edit mode if you want to
make changes to the data. You cannot, however, edit a working dataset created by a block.

To open the Dataset File Viewer, select the required working dataset, right-click Open With and then
click Data File Viewer in the shortcut menu.

Modifying the dataset view
You can modify the dataset view to change the column order and hide variables that are not of interest.

Changes made to the displayed layout in the Dataset File Viewer do not change the underlying data.

Show labels
You can specify whether to use labels as column headings rather than column names. To use labels:

1. Right-click the column header of the variable that you want to show labels for, and select
Preferences.

The Preferences dialog box is displayed.
2. Expand the Altair group and click Dataset Viewer.
3. Click Show labels for column names.
4. Click OK.

The setting is saved, and the Preferences dialog closed.

Hide variables
To hide a datagrid column:

1. Right-click the column header for the variable you want to hide.
2. Click Hide column.

If you hide a column for which filtering is currently active, you need to confirm that you want to remove
the filter and hide the column.

Show hidden variables
To show previously hidden dataset variables:

1. Right-click the dataset header row.
2. Click Show / Hide Columns to display the Show / Hide Columns dialog box.
3. Select the required columns and click OK.
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Move columns
To move a column in the dataset view, click the column and drag to the new location in the view. You can
only move one column at a time.

Editing a dataset
An imported dataset can be opened in edit mode enabling you to add new observations, delete
observations, or edit existing values. Datasets that are part of a Workflow cannot be edited.

To edit an imported dataset, right-click in the grid and click Toggle edit mode. Any changes you make in
the Dataset File Viewer are not written to the dataset until you save the changes. If saving your changes
fails, then any changes that were not written remain visible and details of the failure are written to the
Altair Analytics Workbench log.

Modifying values

The Dataset Viewer enables you to edit values in the dataset.

1. Double-click the value that you want to edit. The variable type affects how the value is edited:

• Numeric or character types: The value is displayed in the cell, where you can enter a new value. If
the variable has formatting applied, to see the current value as a tool tip press and hold Shift+F8.

• Date, datetime or time formatted types: Click on an individual element of a date or time value, and
either enter the required value or use the up or down arrows to increase or decrease it in steps.

2. When you have completed your edits, press Enter.

The entered value is displayed in bold type, and an asterisk (*) is appended to the observation
number in the left margin of the grid.

3. To save the changes to the original dataset, click the File menu, and click Save.

Adding observations

The Dataset Viewer enables you to add new observations to the end of an existing dataset.

To add a new observation to the dataset:

1. Right-click the datagrid and click Add Observation.
2. A new row appears at the end of the dataset. Double-click each cell in the observation and modify the

content as required.
3. To save the changes to the original dataset, click the File menu, and click Save.
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Deleting observations

The Dataset Viewer enables you to remove observations from an existing dataset.

To delete an observation from a dataset:

1. Select the observation that you want to delete by clicking on its observation number in the left hand
column.

2. Right-click the observation and click Delete Observation(s).
3. To save the changes to the original dataset, click the File menu, and click Save.

Missing values

Enables you to set the value of a variable to missing.

1. Select the variable value that you want to set to missing.
2. Right-click the selected cell, and click Set Missing.

If the cell is a:

• Numeric variable type, the Set Missing Value dialog is displayed. The default . (full stop) is used
as the value. Alternatively, you can change the missing value to one of: . (full stop), ._ (full stop
followed by an underscore), or .A to .Z.

• Character variable type, the cell is set to a single space (' ') character.
3. To save the changes to the original dataset, click the File menu, and then click Save.

Filtering a dataset
You can apply one or more filters to restrict the view to show only the data you are interested in.

To filter your dataset view:

1. Click the filter button ( ) below the variable heading for the column you want to filter.

2. Select the criteria by which you want to filter the view and complete as required. The column is now
filtered and shows a generated filter expression next to the filter button ( ).

Dataset filter expressions
You can modify a generated filter expression applied to numeric and character variable types. The
expressions available depend on the variable type. A generated filter expression applied to a variable
with a date, datetime or time format cannot be modified, only cleared and re-entered (to clear the filter for
a variable, click the filter button and then click Clear Filter). Case-insensitive searching can be specified
for character variables by clicking the filter button then selecting Case Insensitive.
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Note:
You can only apply a filter expression to a dataset open in browse mode. Filter criteria can be set on
multiple columns and, as you apply filters, the dataset contents are automatically updated.

The following table shows the supported expression syntax for numeric values.

Criteria Expression Example

Equal to EQ X Is equal to 100

EQ 100

Not equal to NE X Is not equal to 100

NE 100

Less than LT X Is less than 100

LT 100

Greater than GT X Is greater than 100

GT 100

Less than or
equal to

LE X Is less than or equal to 100

LE 100

Greater than
or equal to

GE X Is greater than or equal to 100

GE 100

Between
(inclusive)

BETWEEN X AND y Is between 100 and 200

BETWEEN 100 AND 200

Not between
(inclusive)

NOT BETWEEN X AND y Is not between 100 and 200

NOT BETWEEN 100 AND 200

Is missing IS MISSING IS MISSING

Is not missing IS NOT MISSING IS NOT MISSING

In IN (x,y) Is one of the values 100, 200 or 300 (numeric)

IN (100,200,300)

The following table shows the supported expression syntax for character values.

Criteria Expression Example

Equal to EQ X Is equal to "Blanco" (string)

EQ "Blanco"

Not equal to NE X Is not equal to "Blanco" (string)

NE "Blanco"

119



Altair Analytics Workbench user guide
Version 2023

Criteria Expression Example

In IN (x,y) Is one of the values "Blanco", "Jones" or
"Smith" (character)

IN ("Blanco","Jones","Smith")

Starts with LIKE " s%" Starts with the string "Bla"

LIKE "Bla%"

Ends with LIKE " %S" Ends with the string "nco"

LIKE "%nco"

Contains LIKE " %s%" Contains the string "an"

LIKE "%an%"

Is missing IS MISSING IS MISSING

Is not missing IS NOT MISSING IS NOT MISSING

Sorting a dataset
The dataset displayed in the Dataset Viewer can be sorted using the values in one or more variables.

You can only sort a dataset that is open in Browse mode. Variables that are part of an active sort have
an icon representing the direction of the sort in the header.

To sort a dataset:

1. Right-click the column header for the variable that you want to sort by primarily.
2. Click Ascending Sort or Descending Sort on the shortcut menu to perform the sort.
3. If required, you can apply further sorting (secondary, tertiary, and so on) by selecting another column

and clicking Ascending Sort or Descending Sort.

To remove any column from the sort, right-click the required column and click Clear Sort. The dataset
will remove that sort and revert to any previous sorts, if present.

Bookmarks view and Tasks view
The Bookmarks view lists bookmarks added to a Workflow and the Tasks view lists tasks added to a
Workflow. Both bookmarks and tasks can be used to identify parts of the Workflow that require further
investigation.

To add a bookmark:

1. In the Project Explorer view, select the required Workflow.
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2. Click the Edit menu and then click Add Bookmark.
3. Enter a Description in the Bookmark Properties dialog box.
4. Click OK.

The new bookmark is displayed in the Bookmarks view.

To add a task:

1. In the Project Explorer view, select the required Workflow.
2. Click the Edit menu and then click Add Task.
3. Enter a Description in the Properties dialog box.
4. Click OK.

The new task is displayed in the Tasks view.

You can double-click on a bookmark in the Bookmarks view, or a task in the Tasks view to open the
Workflow in the Workflow Editor view.

Using Altair SLC Hub Library Definitions with the
Workflow Environment
Altair SLC Hub is an Enterprise Management Tool that provides centralised management of access to
data sources.

Altair SLC Hub Library Definitions can be used with the Workflow Environment. Library Definitions
securely store details of libraries and their options within Altair SLC Hub.

Logging in to Altair SLC Hub from Altair Analytics
Workbench
To use Altair SLC Hub features in Altair Analytics Workbench, you will need to log into an Altair SLC Hub
installation from Altair Analytics Workbench.

Before connecting to Altair SLC Hub, you require details of an Altair SLC Hub host and access
credentials for it. These details will be provided by your Altair SLC Hub administrator.

To log in to an Altair SLC Hub instance from Altair Analytics Workbench:

1. On the Altair drop-down menu in Altair Analytics Workbench, click Hub, then Log in.
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2. In the Hub Login dialog box complete the required information:

a. Select the required Protocol, either HTTP or HTTPS.
b. Enter the Host name provided by your Altair SLC Hub administrator.
c. Enter the Port for Altair SLC Hub. By default, Altair SLC Hub configured for HTTPS will use port

8443, and when configured for HTTP, port 8181, but your Altair SLC Hub administrator may
change these.

d. Enter the Altair SLC Hub Username provided by your Altair SLC Hub administrator.
e. Enter the Altair SLC Hub Password provided by your Altair SLC Hub administrator.

3. Click OK to connect.

If the connection is successful, a message stating Hub: Logged in as username is displayed in the
Altair Analytics Workbench status bar. If the connection fails, an error message is displayed in the Hub
Login dialog box.

Altair SLC Hub Library Definitions in the WFE
Using Altair SLC Hub Library Definitions in the WFE.

Once Altair Analytics Workbench is logged into an instance of Altair SLC Hub, Library Definitions
available to that Altair SLC Hub User will be displayed in the Altair Analytics Workbench Database
Explorer view. Library Definitions can dragged from the Database view onto the Workflow canvas.

Although Library Definition libraries are defined in Altair SLC Hub, the actual library call is still being
made by the user logged in to Altair Analytics Workbench, so that user will need appropriate software
installed to access the library in question.
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Working in the SAS Language
Environment
The SAS Language Environment enables you to create, edit and run SAS language programs, along with
their resulting datasets, logs and other output.

To open the SAS Language Environment perspective, click on the SAS Language Environment button
at the top right of the screen: .

Creating a new program
You can create a new program under either the Project Explorer or File Explorer.

To create an empty program file in Altair Analytics Workbench:

1. Click the File menu, click New and then click Untitled Program.
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2. Enter the following example to create a simple dataset:

/* Create a dataset */ 
DATA employees; 
LENGTH Name $10 Age 3 Job $15; 
INPUT Name $ Age Job $; 
/* Here is the data */ 
CARDS; 
Beth 41 Sales-Manager 
Steve 32 Sales 
William 35 Accounts 
Anne 28 Marketing 
Dawn 26 Sales 
Andrew 36 Support 
; 

Altair Analytics Workbench displays the language elements in the program using colour coding to
help you to see the structure of the code, for example:

3. Click the File menu and then click Save as to save your program. Use the Save as dialog box to
select the parent folder and enter a File name for the program.
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4. Click the Altair menu and then click Run File <file name> to run the program on the default server.
Alternatively, you can click Run File <file name> On and then choose another server.

The generated dataset is created in the WORK library of the server upon which the program is run,
displayed in the Altair SLC Server Explorer view:

You can view the dataset properties, or open and edit the dataset in the Editor view (see Editing a
dataset  (page 150) for more information).

Creating a new program file in a project
Creating a new program.

To create a new program file:

1. Click the File menu, click New and then click Program to launch the New Program wizard.
2. Select the required parent folder at the top of the dialog, and enter a File name.
3. If you are creating a new program in a project, you can create a link to an existing program on the file

system:

a. Click Advanced and select Link to file in the file system.
b. Click Browse and use the Select Link Target window to locate the file and click Open.

4. Click Finish to complete the task.

The new program is automatically opened in the Editor view.

Alternatively, you can create an untitled program, and save the program when required. To create an
untitled program, click the File menu, click New and then click Untitled Program.
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Entering Altair SLC code via templates
Defining templates that can be entered as code shortcuts into programs.

You can define templates that can be entered as code shortcuts into programs. These templates can be
accessed through the normal code completion key sequence (typically, CTRL+Space). For example if
you define a code template with the name template1, you can type temp followed by CTRL+Space and
the code completion feature will execute the following actions:

1. Match temp against the list of code templates.
2. Find your template called template1.
3. Enter the Pattern associated with the template into your program.

The Pattern containing the code to be entered into your program can be as simple or as complex as you
like. It could just be a single word. For example, you could define a code template to expand to the name
of a frequently used dataset for which the name is difficult to type. A code template could also define a
large amount of text, for example, a boilerplate invocation of a particular procedure. If you are enter a
variable into a Pattern, it needs to be enclosed  within pairs of '$$' characters.

You can export code templates to an external file, or import them from a previously exported file. This
allows you to share code templates, or to copy code templates between workspaces.

Code Injection
Creating SAS language code to be run before or after your program using the Altair Analytics Workbench
code injection feature.

You can create SAS language code to be run before or after your program using the Altair Analytics
Workbench code injection feature. The code to run is entered in the Code Injection panel of the
Preferences window.

Enable custom pre-code injection
When this option is selected, the code in the text box is executed immediately prior to the
running of a program. This option is similar to the INITSTMT system option, except that this
code is automatically run before each submitted program. (The INITSTMT system option is only
processed on server startup).

Enable custom post-code injection
When this option is enabled, the code in the text box is executed immediately following the
running of a program. This option is similar to the TERMSTMT system option except that this
code is automatically run after each submitted program. (The TERMSTMT system option is only
processed on server shutdown.)
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Using Program Content Assist
The SAS Language editor provides a content assistance feature that suggests language elements.

The SAS Language editor provides a content assistance feature that suggests language elements.
When you select these elements, they are automatically added to your program:

1. Type a keyword into a program that may be associated with language elements.

For example, type the word PROC.
2. After the word, type a single space character. and press CTRL+SPACEBAR.

If there are any expected language elements after the word you typed, a pop-up list is displayed of
these elements.

3. You can filter the list by typing in the first few letters of the language element that you want to use.
4. Double-click the language element you require and it will added to your program.

Syntax Colouring
Customising the colour scheme used by the SAS language editor.

To modify SAS language editor syntax colouring:

1. Click the Window menu and then click Preferences.
2. In the Preferences window, expand the Altair group and select Syntax Colouring.
3. For each different type of language item, specify attributes relating to Color, Background Color and

whether the item should be displayed in Bold or Italic.
4. Click OK to save the changes and close the Preferences window.

Running a program
Running a program; either from inside the Altair Analytics Workbench, or from a command line outside of
the Altair Analytics Workbench.

All libraries, datasets and macro variables are persistent. This means that, once they are assigned during
the execution of a program, they are available to other programs that are run during the same Altair
Analytics Workbench session.

If required you can clear all previous libraries, datasets, variables and output on an Altair SLC Server
for the current session by restarting the server (see Restarting an Altair SLC Server  (page 46)).
Alternatively you can use the Clear Log , Clear Results options on the Altair menu to reset the log and
program output respectively.
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For more information about controlling the output (datasets, logs, results, and so on) generated from the
execution of a program see Working with program output  (page 155).

For information on running an Altair SLC Hub program package program from Altair Analytics
Workbench, see Running an Altair SLC Hub program  (page 73).

Running a program in Altair Analytics Workbench
Running a program in Altair Analytics Workbench.

Note:
When you run a program, the state from previous program executions run on the same Altair SLC
Server, in the same server session, is preserved, so the program can interact with the datasets, Filerefs,
and so on, that have been previously created.

1. Ensure that the program to be run is open and active in the Editor view.
2. Click the Altair menu and click Run File <filename> . Alternatively use the Ctrl + R shortcut key, or

the run button ( ) on the toolbar.

To run the program on a specified server, choose Run File <pathname> On or click the down arrow
next to the run button, and then choose the server.

Alternatively, you can select and run an unopened SAS language program in either the Project Explorer
or File Explorer. To do this, select the program and click the Altair menu, followed by Run File
<filename>, or Run File <pathname> On and choosing the server.

Running a selected section of a program
Executing part of a SAS language program.

1. Ensure that the relevant program is open and active in the Editor view.
2. Highlight the section of code in the program that you want to run.
3. Click the Altair menu, then click Run selected code from <filename>  and then click Local Server

(Substitute the name of your remote Altair SLC Server in place of Local Server). Alternatively use
the Ctrl + R shortcut key.

To run the selected section of code on a specified server, choose Run selected code from
<pathname> On or click the down arrow next to the run button, and then choose the server.
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Running a step
Running a step from a SAS language program.

1. Ensure that the relevant program is open and active in the Editor view.
2. Place the cursor in the step that you want to run.
3. Right-click and, from the context menu, click Run Step. Alternatively use the Ctrl + Alt + R shortcut

key.

To run the step on a specified server, choose Run Step On and then choose the server.

Stopping program execution
Stopping a SAS language program before it has finished.

1. Click the Altair menu, click Cancel and then click Local Server (Substitute the name of your remote
Altair SLC Server in place of Local Server) to stop program execution.

2. Once the progress indicator in the lower right corner of the Altair Analytics Workbench disappears,
this indicates that the program has stopped running.

Depending on the particular step that the program is executing, the program may not stop immediately.

When the program stops, a message similar to ERROR: Execution was cancelled is displayed in the log.

Preferences for running programs
Preferences can be set to control the behaviour of Altair Analytics Workbench during program execution.

The Altair page of the Preferences contains options affecting how SAS language programs are run.
Before running any programs, select your preferred settings from the page:

Save all modified files before running a program

Specifies whether modified programs open in the Editor view are saved before a program is run.
The behaviour can be one of: Always, Never or Prompt. The default, Prompt, displays the Save
and Run dialog box listing modified files.

• If you select Always save resources before run, all modified files open in the Editor view are
saved before the program is run.

• If you select Never save resources before run, no changes to files open in the Editor view
are saved before the program is run. Errors may occur if your program relies on other files open
in Altair Analytics Workbench that have been modified but not saved.
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Close all open datasets before running a program

Specifies whether open datasets are closed before running a program. The behaviour can be one
of: Always, Never or Prompt. The default, Prompt, displays the Datasets are open dialog box
listing all opened datasets.

• If you select Always close datasets before run, all open datasets are closed before the
program is run.

• If you select Never close datasets before run, all datasets are left open when the program is
run. This may cause errors if the program attempts to modify an open dataset.

Show log when an error is encountered running a program

Specifies whether the log file is displayed when an error is encountered in a program. The
behaviour can be one of: Always, Never or Prompt. The default, Prompt, displays the Confirm
Log Display dialog box:

• If you select Remember my decision, the log file is always shown whenever an error is
encountered.

• If you clear Remember my decision, the log file is not shown, even when an error is
encountered.

Close all open datasets when deassigning a library
Specifies whether open datasets are closed when the containing library is deassigned. The
behaviour can be either Always or Prompt. The default, Prompt, displays a dialog listing open
datasets that must be closed to de-assign the library.

Confirm deletions
Specifies whether confirmation is required when deleting an item in the Altair SLC Server
Explorer view.

Confirm server restart
Specifies whether confirmation is required when you restart a server in the Altair SLC Server
Explorer view.

Autoscroll the log
Specifies whether the log output is automatically scrolled (see Autoscroll  (page 84)).

Autoscroll the listing
Specifies whether the listing output is automatically scrolled (see Viewing the listing output
(page 157)).

Show advanced server actions
Controls the context menu options available when restarting Altair SLC Servers (see Restarting
with Advanced Server Actions  (page 46)).

Temporary file location
This field points to the directory where the Altair Analytics Workbench stores temporary files. The
log files created during execution of a program are stored in this directory, as are any ODS HTML
results generated by programs.
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You should be aware that output files, particularly logs, can be sizeable, so you may find that you
need to modify this setting if the field points by default to a location with space restrictions.

Filtering type
Specifies which filtering method to use where applicable, for example, when selecting variables
in the Workflow. This can be either Fuzzy matching or Pattern matching. The default, Fuzzy
matching, enables filtering through approximate matching.  Pattern matching enables filtering
through a regular expression.

Command line mode
Running SAS language programs on an Altair SLC Server from the command line.

To use the Altair SLC Server from a command line, you need to execute the wps.exe program. This
executable file is located in the bin directory of your Altair SLC installation.

When running the Altair SLC Server from a command line, you cannot compile programs into run-time
jobs.

Options
Running wps.exe on its own will not do anything, and so you will need to pass some additional
instructions in the following form:

wps.exe <options> <programFileName>

The <options> arguments can be a list of any of the following:

• -optionname [optionalValue] – specifies a system option.
• -config <configFileName> – specifies a configuration file containing system options.
• -set <envVarName> <envVarValue> – specifies an environment variable that takes effect when

the Altair SLC Server is run.

You can define any number of <options> arguments, but the <programFileName> must always be
the last argument on the command line.

System options
To set a system option specify:

wps -optionname [optionalValue] <programFileName>

You can pass as many -optionname system options to the Altair SLC Server as required. However,
you can only pass single value options, so must specify -optionname [optionalValue] for each
system option.
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Configuration files
System options can be defined in a configuration file, and this file referenced when running the Altair
SLC Server:

wps -configfile <configFileName> <programFileName>

For more information about configuration files and the order in which they are processed, see
Configuration files  (page 521).

Environment variables
To set an environment variable to use with the Altair SLC Server:

wps.exe -set <envVarName> <envVarValue> <programFileName>

You can set as many environment variables as you require. However, you can only pass single value
options, so must specify -set <envVarName> <envVarValue> for each environment variable.

Log output
When you run the Altair SLC Server from the command line, log information is sent to the standard
output (stdout) for the operating system. Once the program has finished running this log information is
lost. To preserve the log output, redirect stdout to a file, for example:

wps program.sas -log program.log

Results output
When you run the Altair SLC Server from the command line, any results generated by the program are
automatically captured into a file called <programFileName>.lst created in the same directory as the
program. For example, a file called Program.lst is output if you run a program called Program.sas.

Libraries and datasets
A library is used to store Altair SLC data files (including datasets), folder locations and database
connections via the LIBNAME statement.

On the majority of operating systems, a library maps directly to an operating system folder. The operating
system folder may contain non-Altair SLC files, but only the files with extensions that Altair SLC
recognises will be visible in Altair Analytics Workbench.

The default Libraries that are visible under each server in the Altair SLC Server Explorer view are:

• SASHELP – a read-only library containing a variety of system metadata.
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• SASUSER – used to store datasets and other information that you want to keep beyond the end of
your Altair SLC session. To use this location, add SASUSER. in front of the name of the relevant
dataset in your program.

• WORK – where your datasets, catalogs and Filerefs are stored by default. WORK is a 'temporary
working space' that is automatically cleared of all data when your Altair SLC Server session ends.

To preserve the output that your program creates, you can redefine the work location to a non-
temporary location (see Setting the WORK location  (page 133)), or use the LIBNAME statement
to write output you want to keep to your own permanent location (such as a directory or database
connection). For example:

LIBNAME mylib '/directories/mydirectory/';

Any directory or database connection that you associate with the alias must already exist before you
assign it. Once a dataset has been created and stored in this location, the associated alias (mylib)
must be used to retrieve the dataset.

Setting the WORK location
Change the WORK location when SAS language programs are run in Altair Analytics Workbench.

To set the pathname for the WORK location that is used every time you start up a particular server:

1. In the Altair SLC Server Explorer view, right-click the required server and click Properties in the
shortcut menu.

2. In the properties list, expand the Startup group and select System Options.
3. On the System Options panel, click Add to display the Startup Option dialog box.
4. In Name enter WORK, and in Value enter the full pathname for the new WORK location.
5. Click OK to save the system option, and click OK on the Properties dialog box to restart the server

and apply your changes.

The WORK location is redefined when using Altair Analytics Workbench to run SAS language programs,
but not if Altair SLC is run from the command line. When running programs in batch mode, the WORK
system option must be set in a configuration file.
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Catalogs
A catalog is a folder in which you can store different types of information (called catalog entries), for
example formats, informats, macros, and graphics output.

For example, you could write a program to generate a catalog (FORMATS) in which to store PICTURE
formats:

PROC FORMAT;  

PICTURE beau  0-HIGH = '00 000 000.09' ; 
PICTURE beaul  0-HIGH = '00 000 000.09' ; 
RUN;
 
PROC CATALOG CATALOG = WORK.FORMATS;
 CONTENTS;
 RUN; 

The PICTURE statement allows you to create templates for printing numbers by defining a format that
allows for special characters, such as: leading zeros, decimal and comma punctuation, fill characters,
prefixes, and negative number representation.

When you run the program, the catalogs are created under the WORK folder:

To view the entries associated with the catalogs, right-click on them and click Properties.

Datasets
A dataset is a file created or imported by an Altair SLC Server, and stored in a library.

A dataset contains rows and columns, known as observations and variables respectively.

• Observations (rows) usually relate to one specific entity (for example, an order or person).
• Variables (columns) describe attributes of an entity (for example, an item ID in an order).
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Example Dataset
In this example dataset, each observation is an item in the order. The variables are Order ID, Item ID,
Quantity and Unit Price.

Order ID Item ID Quantity Unit Price

10001 47853 3 30.75

10001 23104 10 4.90

10002 62091 1 89.99

Open a dataset
You can open a dataset in the Altair SLC Server Explorer view. Expand the required server node,
expand Libraries and double-click the required dataset.

Delete a dataset
You can delete a dataset stored on disk in the Altair SLC Server Explorer view. Expand the required
server node, expand Libraries node and expand the required library. Select the dataset, right-click and
click Delete in the shortcut menu.

Importing datasets
In addition to the datasets created by running SAS language programs, datasets can be created by
importing data from external files.

Supported formats for datasets are:

• Delimited
• Fixed Width
• Microsoft Excel Spreadsheet Files

The Dataset Import Wizard enables you to configure the dataset as it is imported. It is not always
necessary to go through all of the steps in the wizard; you can import a dataset from a file and click
Finish on the first page to accept all the default options. If you import a dataset with the same name as
an existing one, you will overwrite it.

When importing delimited files, Altair Analytics Workbench deduces the delimiter character from the
data. If this delimiter is not correct, you can change it prior to importing the dataset.

When importing fixed width files, Altair Analytics Workbench deduces column start and end from the
data. If this widths are not correct, you can change the widths prior to importing the dataset.

Spreadsheet files may contain several worksheets. By default, Altair Analytics Workbench will select
the first sheet that has data for importing. A sheet may also have names that refer to cell ranges; it is
possible to import data from these names and also from the clipboard.
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You can drag a dataset file from the Project Explorer or File Explorer to the required library on the
Altair SLC Server.

• You can only drag files from the Project Explorer to the Local Server.
• You can drag datasets from any folder accessed through the same connection node as the required

Altair SLC Server. You cannot, for example, drag a dataset from your Local connection to a remote
connection. To do this first use the File Explorer to copy the dataset to the required server, and then
drag the dataset from the new location.

You can also import a dataset using one of the following methods:

• In SAS language code, for example using the XLSX engine:

LIBNAME xlsxlib XLSX ‘myfile.xlsx’ HEADER=YES; 
DATA WORK.IMPORTED;
SET xlsxlib.Sheet1;
RUN;

• The Dataset Import Wizard. When importing Excel Workbooks in either XLS or XLSX format, this
method uses the EXCEL engine and you will therefore need to have the Microsoft ACE OLEDB
engine installed.

If you do not have Microsoft Excel installed, you will need to install the Microsoft Access Database
Engine Redistributable to import datasets.

Importing datasets from files

Importing datasets from files using Altair SLC Server Explorer.

To import files:

1. In the Altair SLC Server Explorer view, right-click local server and click Import Dataset on the
shortcut menu.

Alternatively, you can select a file in from the file system and either drag the file to the local server or
copy and paste the file to the local server.

2. In the Dataset Import dialog box, enter a file name or click Change and open the required file.
3. Select a Library Name for the dataset and, if required, change the Member Name to rename the

dataset.
4. The type of format is inferred from the type of file imported. If required, change the type of Data

Format that best describes the dataset content.
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5. Click Next and Configure the imported dataset depending on the type:

• If you select Fixed width, for each Column modify the Start value and Width value to alter the
width of the exported variable.

• If you select Delimited:

• Select the required delimiter. To define your own delimiter, select Other and enter the delimiter
character.

• Select Include field names on first row to include the names of the columns.
• If you select Excel:

• If required, select a different worksheet in Whole Worksheet. You can also select an existing
Named Range from the existing or new worksheet.

• Select Include first row names as column headers to use the first row as variable names.
6. Click Next and, if required, edit the dataset column properties.

• To change a column name, select a column header in the preview and edit the Column Name.
• To change a column label, select a column header in the preview and edit the Column Label.
• To change the column data type, select a column header in the preview edit the Column Data

Format.
• Select Convert to valid SAS variable names to convert any column names that are invalid.

7. Click Finish to import the dataset.

Importing spreadsheet data

You can use the Dataset Import Wizard to import a range of cells directly from a Microsoft Excel
spreadsheet.

Note:
Data imported will have the last-saved value. Cell formulae are not reevaluated when the spreadsheet is
opened, and the last-saved value is used for these cells.

1. Select the contiguous range in your Excel spreadsheet that you want to import and copy and paste
the content to the required server in the Altair SLC Server Explorer view.

Alternatively, you can drag the selected range to the required library in the required server.
2. In the Dataset Import dialog box, enter a file name or click Change and open the required file.
3. Select a Library Name for the dataset and, if required, change the Member Name to rename the

dataset.
4. The type of format is inferred from the type of file imported. If required, change the type of Data

Format that best describes the dataset content.
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5. Click Next and Configure the imported dataset depending on the type:

• If you select Fixed width, for each Column modify the Start value and Width value to alter the
width of the exported variable.

• If you select Delimited

• Select the required delimiter. To define your own delimiter, select Other and enter the delimiter
character.

• Select Include field names on first row to include the names of the columns.
6. Click Next and, if required, edit the dataset column properties.

• To change a column name, select a column header in the preview and edit the Column Name.
• To change a column label, select a column header in the preview and edit the Column Label.
• To change the column data type, select a column header in the preview edit the Column Data

Format.
• Select Convert to valid SAS variable names to convert any column names that are invalid.

7. Click Finish to import the dataset.

Exporting datasets
Datasets can be exported as delimited and fixed width text, and also as Microsoft Excel Workbooks. The
Dataset Export Wizard allows you to fine tune the contents of export file as required.

To export a dataset:

1. In the Altair SLC Server Explorer view, expand the required server, right-click the required dataset
and click Export Dataset on the shortcut menu.

2. In the Dataset Export Wizard, select the export type, one of: Delimited, Fixed Width or Excel. For
Excel, select the required file format and click Next.

3. Configure the exported dataset depending on the export type:

If you select fixed width, for each Column modify the Start value and Width value to alter the width
of the exported variable.

If you select Delimited:

• Select the required delimiter. To define your own delimiter, select Other and enter the delimiter
character.

• Select Include field names on first row to include the names of the columns.
4. In the Select Destination File panel, enter a file name for the exported dataset and click Finish.
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Removing dataset references
How to remove a dataset reference.

You cannot remove a dataset reference on its own. To remove a dataset reference, you must restart the
required server, which also removes any ODS output, log entries, other libraries, and file references. For
more information, see Restarting an Altair SLC Server  (page 46).

Data Profiler view
The Data Profiler view enables you to view content and details about a dataset.

To open the Data Profiler view, select the required dataset, right-click Open With and then click Data
Profiler in the shortcut menu.

Summary View

The Summary View lists information about the dataset, including the number of observations and
variables in the dataset as well as variable characteristics.

The Summary View contains two panels: Summary and Variables.

Summary
The Summary panel displays summary information about the dataset: the dataset name, the total
number of observations, and the total number of variables in the dataset.

Variables
The Variables panel displays information about the variables in the dataset as follows:

Variable
The name of the variable in the dataset.

Label
The alternative display name for the variable.

Type
The type of the variable. This can be one of:

• Numeric, for numbers and date and time values.
• Character for character and string data.

Classification
The category of the variable; this can be one of:
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• Categorical. A non-numeric variable that can contain a limited number of possible values, and
the limit is below the specified classification threshold.

• Continuous. A numeric variable that can contain an unlimited number of possible values. This
classification is used for numeric variables where the number of distinct values in the variable
is greater than the specified classification threshold.

• Discrete. A numeric variable that can contain a limited number of possible values. This
classification is used for character variables where the number of distinct values in the variable
is less than or equal to the specified classification threshold.

The classification threshold defines a number of unique values above which a variable is
classified as continuous, and below which a variable is either categorical (if non-numeric)
or discrete (if numeric). The classification threshold is specified on the Data panel of the
Preferences dialog box.

Length
The size required to store the variable values. For character types, the number represents
the maximum number of characters found in a variable value. For numeric types, the number
represents the maximum number of bytes required to store the value.

Format
How the variable is displayed when output. For more information about formats see the section
Formats in the Altair SLC Reference for Language Elements.

Informat
The formatting applied to the variable when imported into Altair SLC. For more information, about
informat, see the section Informats in the Altair SLC Reference for Language Elements.

Distinct Values
The number of unique values in the variable. If the variable classification is Continuous, the
display indicates there are more unique values than the specified classification threshold.

Missing Values
The number of missing values in the variable.

Frequency Distribution
For each value in a non-continuous variable, displays a chart showing the number of occurrences
of each value in the variable.
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Data

The Data panel lists all observations in a dataset and enables you to view, filter, or sort those
observations.

The Data panel in the Data Profiler view is a read-only version of the Dataset Viewer. You can modify
the view, or sort and filter data in the Data panel. If you want to edit values in the dataset, you need to
use the Dataset Viewer. For more information about sorting and filtering observations, and about the
Dataset Viewer see Dataset Viewer  (page 115).

Univariate View

The Univariate view tab displays summary statistics for all numeric univariate variables.

The columns displayed in the Univariate View tab are determined using the Calculate Statistics dialog
box. Click Configure Statistics ( ) to open Preferences and select the statistics you want displayed:

Quantiles
Lists quantile points.

Variable Structure
Lists statistics describing the variable, such as number of missing values, and minimum and
maximum values.

Measures of Central Tendency
Lists measures used to identify the central tendency in the values of the variable (mean, median
and mode).

Measures of Dispersion
Lists measures used to show the dispersion of a variable.

Others
Lists other statistics that can be displayed in the statistics table.

Univariate Charts

The Univariate Charts tab enables you to view the frequency distribution table and graphs for a selected
dataset variable.

The information displayed is determined by the variable selected in the Variable Selection list. Each
section in the tab displays the frequency of values occurring in the selected variable.
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Frequency Table
Displays the frequencies of the values in the specified variable, the percentage of the total number of
observations for each value, and cumulative frequencies and percentages.

If the variable type is categorical or discrete, the table displays one row for each value. If the variable
type is continuous, the variable is binned and frequency information is displayed for each bin.

Frequency Chart
Displays the frequency of values as the percentage of the total number of observations for the variable,
either as a histogram, line chart or pie chart.

The chart can be edited and saved. Click Edit chart  to open the Chart Editor from where the chart
can be saved to the clipboard.

Correlation Analysis

The Correlation Analysis tab enables you to view the strength of the correlation between numeric
variables in the dataset.

Options
Specifies the coefficient type to use when comparing variables, and which numeric variables in the
dataset are to be compared.

Coefficient
Specifies the type of coefficient used to compare values.

Pearson
Specifies the Pearson correlation coefficient, which is defined as:

where:

•
 is the mean of variable x

•
 is the mean of variable y
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Spearman's Rho
Specifies the Spearman's rank correlation coefficient, which is defined as:

where:

•  is the rank of 

•
 is the mean of the ranked variable 

•  is the rank of 

•
 is the mean of the ranked variable 

The values of the variables are first ranked and the ranks compared. Using this coefficient
may therefore be more robust to outliers in the data.

Kendall's Tau
Specifies the Kendall rank correlation coefficient, which is defined as:

where:

•

•

•

•  is the number of concordant pairs

•  is the number of discordant pairs

•  is the number of tied values in the i th group of tied values for the first variable

•  is the number of tied values in the j th group of tied values for the second variable

• The difference in the number of concordant and discordant pairs can be expressed as:

The values of the variables are first ranked and the ranks compared. Using this coefficient
may therefore be more robust to outliers in the data.
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Select Variables
Displays a list of numeric variables in the dataset, from which you can select the variables to
compare.

Correlation Coefficient Matrix
The matrix is shown in coloured blocks, with the size and colour of the blocks indicating the relationship
between the compared variables. The scale for the items displayed ranges from 1 a strong positive
correlation to -1 where there is a strong negative correlation.

Correlation Statistics
Displays the correlation statistics and scatter plot for the block selected in the Correlation Coefficient
Matrix. The table displays the variables being compared, the coefficient type and the p-value for the
correlation coefficient being non-zero. The scatter plot displays all values in the dataset, using the same
colour scale as the matrix, as either a plot or heat map if the number observations is very high.

Predictive Power

The Predictive Power tab enables you to view the predictive power of independent variables in the
dataset in relation to a selected dependent variable.

The information displayed is determined by the variable selected as the Dependent Variable. Each
section displays the relationship between the independent variables in the dataset and the specified
Dependent Variable.

Statistics Table
The Statistics Table displays all the variables in the dataset and a series of predictive power statistics.
The statistics displayed are:

• Entropy Variance. Displays the Entropy Variance value for each variable in relation to the specified
Dependent Variable.

• Chi Sq. Displays the Chi-Squared value for each variable in relation to the specified Dependent
Variable.

• Gini. Displays the Gini Variance value for each variable in relation to the specified Dependent
Variable.

For more information about how these values are calculated, see Predictive power criteria  (page 112).
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Entropy Variance Chart
Displays the bar chart of independent variables' entropy variances in relation to the specified Dependent
Variable. The variables are displayed in order from the highest entropy variance to the lowest. The
number of variables displayed in the chart is determined by the preferences set in the Data Profiler
panel of the Preferences dialog box.

The chart can be edited and saved. Click Edit chart  to open the Chart Editor, from where the chart
can be saved to the clipboard.

Frequency Chart
Displays the frequency of each value of the independent variable selected in the Statistics Table for
each value of the specified Dependent Variable.

• Click View whole data  to display the overall predictive relationship between values of an
independent variable selected in the Statistics Table and the specified Dependent Variable.

• Click View breakdown data  to display the frequency of each value of an independent variable,
and its relationship to the outcomes for the specified Dependent Variable.

The chart can be edited and saved. Click Edit chart  to open a the Chart Editor from where the chart
can be saved to the clipboard.

Predictive power criteria

Predictive power is a way of measuring how well a particular input variable can predict the target
variable.

Pearson's chi-squared statistic
Pearson’s chi-squared statistic is a measure of the likelihood that the value of the target variable is
related to the value of the predictor variable.

Each observation in the dataset is allocated to a cell in a contingency table, according to the values of
the predictor and target variables. Pearson’s chi-squared statistic is calculated as the normalised sum
of the squared deviations between the actual number of observations in each cell, and the expected
number of observations in each cell if there were no relationship between the predictor and target
variables.

If a predictor variable has a high Pearson’s chi-squared statistic, it means that the variable is a good
predictor of the target variable, and is likely to be a good candidate to use to split the data in a binning or
tree-building algorithm.
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Pearson’s chi-squared statistic for a discrete target variable is calculated as

where

•  is the number of distinct values of the predictor variable    (these are the rows in the contingency
table)

•  is the number of distinct, discrete values of the target variable    (these are the columns in the
contingency table)

•  is the number of observations for which the predictor variable    has the   th value,   , and the
target variable    has the   th value,    (these are the values in the cells of the contingency table)

•  is the expected value of 

•  is the total number of observations for which the predictor variable    has the   th value, 

•   is the total number of observations for which the target variable    has the   th value, 

•  is the total number of observations in the dataset

Entropy variance
Entropy variance is a measure of how well the value of a predictor variable can predict the value of the
target variable.

If a variable in a dataset has a high entropy variance, it means that the variable is a good predictor of the
target variable, and is likely to be a good candidate to use to split the data in a binning or tree-building
algorithm.

Entropy variance for a discrete target variable is calculated as

where

•  is the number of distinct values of the predictor variable, 
•  is the total number of observations for which the predictor variable    has the   th value, 
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•  is the entropy calculated for just the observations where the predictor variable is 

•  is the total number of observations in the dataset
•  is the entropy calculated for all the observations
•  is the number of distinct, discrete values of the target variable, 
•  is the number of observations for which the predictor variable    has the   th value,   , and the

target variable    has the   th value, 

•   is the total number of observations for which the target variable    has the   th value, 

Gini variance
Gini variance is a measure of how well the value of a predictor variable can predict the target variable.

If a variable in a dataset has a high Gini variance, it means that the variable is a good predictor of the
target variable, and is likely to be a good candidate to use to split the data in a binning or tree-building
algorithm.

Gini variance for a discrete target variable is calculated as

where

•  is the number of distinct values of the predictor variable, 
•  is the total number of observations for which the predictor variable    has the   th value, 

•  is the Gini impurity calculated for just the observations where the predictor variable is 

•  is the total number of observations in the dataset
•    is the Gini impurity calculated for all the observations
•  is the number of distinct, discrete values of the target variable, 
•  is the number of observations for which the predictor variable    has the   th value,   , and the

target variable    has the   th value, 

•   is the total number of observations for which the target variable    has the   th value, 
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Information value
Information value is a measure of the likelihood that the value of the target variable is related to the value
of the predictor variable. The information value measure is only applicable for binary target variables
(that is, target variables that can take one of exactly two values).

If a predictor variable has a high information value, it means that the variable is a good predictor of the
target variable, and is likely to be a good candidate to use to split the data in a binning or tree-building
algorithm.

The information value statistic is calculated as

where:

•  is the number of distinct, discrete values of the predictor variable    (these are the rows in the
contingency table)

•  is the number of observations for which the predictor variable    has the   th value,   , and
the target variable    has the value,    (these are the values in the cells of the    column in the
contingency table)

•  is the number of observations for which the predictor variable    has the   th value,   , and
the target variable    has the value,    (these are the values in the cells of the    column in the
contingency table)

•  and    are the two possible values of the binary target variable 

•   is the total number of observations for which the target variable    has the value, 

•   is the total number of observations for which the target variable    has the value, 

•  is the WOE value for observations where the predictor variable is 

•  is the weight of evidence (WOE) adjustment, a small positive number to avoid infinite values
when    or 

Dataset Viewer
You can view, filter or sort a dataset within the viewer. You can also edit observation variables, remove
observations, and also add new observations.

The contents of the dataset are shown in a datagrid. The rows of the grid represent the dataset's
observations, and the columns represent dataset variables.

You can display labels in the column headers of a dataset, re-organise the view by moving columns, and
if some of the columns are irrelevant for a task, you can hide them.
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Mode
A dataset is opened in a read-only Browse mode, but can be converted to Edit mode if you want to make
changes to the data. To edit the dataset content, click the Data menu and then click Toggle Edit Mode.

Organising the dataset

Manipulating how a dataset appears.

You can manipulate the view of the dataset so that you hide variables you do not need, and move
columns so that they are in a different order. Any changes made in this view do not change the
underlying data.

Show labels
You can specify whether to display labels for columns rather than column names. In the Preferences
window click Altair, click Dataset Viewer and then click Show labels for column names.

Hide variables
To hide a datagrid column:

1. Right-click the column header for the variable you want to hide.
2. Click Hide column(s).

The datagrid column disappears from the view. If you hide a column for which filtering is currently active,
you need to confirm that you want to remove the filter and hide the column.

Show hidden variables
To show previously hidden dataset variables:

1. Right-click the dataset header row.
2. Click Show / Hide Columns.
3. In the Show / Hide Columns dialog, select the columns to show and click OK.

Move columns
You can move columns in the dataset view:

1. Left-click and hold the mouse button on the column header.
2. Drag the column to where you want it to be.

You will see a thick grey line appear between columns, indicating where the column will appear.
3. Release the mouse button, and the column appears in the indicated location.
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Editing a dataset

Editing or deleting observations from a dataset.

You can edit observations, and also add and delete them, if the dataset is in Edit mode.

Controls for editing a dataset are available from the Data menu, from the toolbar, and also from the
dataset context menu.

If the dataset is open in Browse mode, you can switch to Edit mode by clicking  Edit:

You can make as many changes as required. Changes are not automatically written to the dataset,
you must choose to save changes. If saving your changes fails, then any changes that were not written
remain visible and details of the failure are written to the Altair Analytics Workbench log

Modifying observations

Editing observation variables (cells) as raw values.

You can edit observation variables (cells) as raw values. If your variables have any formatting applied,
you will not see this during editing; once edit is complete the formatted observation is displayed.

1. Double-click the cell that you want to edit:
Variable Type Description
Numeric The raw, unformatted value is displayed in the cell where you can

enter a new value. If you want to see how the current cell appears
when formatted , press Shift +F8 and it will be shown as a tooltip.

DATE, DATETIME or TIME DATE, DATETIME and TIME values are edited as their respective
types. You can click on any individual element of a date or time
(such as a year or hour) in-place, and use the keyboard arrow keys
or mouse wheel to increase or decrease them in steps. Numeric
elements can also be overtyped with replacement values.
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Variable Type Description
You can use the alternative edit control associated with each type.
DATE values have a  calendar, times have a  time picker,
and DATETIME values have a  DATETIME picker combination.
Click on the button to the right of the in-place value and the
appropriate editor will appear.

String The raw, unformatted value is displayed in the cell where you can
enter a new value. If you want to see how the current cell appears
when formatted , press Shift +F8 and it will be shown as a tooltip.

2. When you have completed your edits, press Enter.

If the value you entered is different from the original saved value, then the observation value is
displayed in bold type with an asterisk (*) next to the observation number in the left margin of the grid.

3. Changes are not saved to the dataset immediately. To save the changes to the original dataset, click
the File menu, and then click Save. If the changes have been made in error, you can undo all edits
(see Cancelling changes  (page 152)).

Adding observations

Adding new observations to a dataset.

New observations can be added to a dataset. They are always added to the end of the  dataset,
regardless of your current position within it. To add a new  observation:

1. Click the Data menu and then click Add Observation.
2. The new row will appear in bold type, and a plus character (+) will appear next to the observation

number in the left margin of the grid. Double-click each cell in the observation and modify the content
as required.

3. Changes are not saved to the dataset immediately. To save the changes to the original dataset, click
the File menu, and then click Save. If the changes have been made in error, you can undo all edits
(see Cancelling changes  (page 152)).

Deleting observations

Deleting observations from a dataset.

To delete an observation from a dataset:

1. Select the observation that you want to delete by clicking on its observation number in the left hand
column. To delete multiple observations, hold down the CTRL key while selecting the observations
you want to delete.
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2. Click the Data menu, and then click Delete Observation.
3. Changes are not saved to the dataset immediately. To save the changes to the original dataset, click

the File menu, and then click Save. If the changes have been made in error, you can undo all edits
(see Cancelling changes  (page 152)).

Cancelling changes

Cancelling unsaved changes to a dataset.

You can cancel any changes that you have made but not yet saved. To cancel unsaved changes:

1. Click the Data menu and then click  Cancel edits.
2. In the Confirm Cancel Edits, click Yes to undo any changes.

Missing values

Setting an observation as missing.

You can set an observation variable to missing using the Set Missing option.

Note:
When numeric variables are formatted as DATE, DATETIME or TIME, this is the only way to set these
variables as missing.

1. Select the observation variable (cell) you want to set as missing.

Only one variable at a time can be set to missing in a single operation.
2. Right-click the selected cell, and click Set Missing in the shortcut menu.

1. If the cell is a character variable type, the cell is set to a single space (' ') character.
2. If the cell is a numeric variable type, the Set Missing Value dialog is used to set the missing

value. If the observation variable is already set to a missing value, then the current raw value
is shown. If the observation variable is not set to missing, the default . (full stop) value is used.
If required, you can change the missing value to the value to one of: . (full stop), ._ (full stop 
followed by an underscore), or .A to .Z.

3. Changes are not saved to the dataset immediately. To save the changes to the original dataset, click
the File menu, and then click Save. If the changes have been made in error, you can undo all edits
(see Cancelling changes  (page 152)).
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Filtering a dataset

You can filter the contents of the dataset by variable to show only the data that you need.

Filters are cumulative, if you filter on more than one variable, all filters apply. You can cancel any of the
filters at any time.

You can set filter criteria on multiple columns and, as you apply filters, the dataset contents are
automatically updated.

To filter your dataset view:

1. Click the filter  button below the variable heading for the column that you want to filter.

2. Select the criteria by which you want to filter the view and Complete the criteria for the filter by
entering the appropriate details.
Data Type Criteria
DATE,
DATETIME or
TIME

Most expressions based on a date or time variable are set in another dialog. Use
the calendar and clock controls to set the date criteria. For DATETIME values, click
the clock  button to set the time component of the filter value.

Other numeric
or string

The expression for the filter is shown below the variable header. Enter the value or
values necessary to complete the expression in the edit box.

For a list of supported filter expressions, see Dataset filter expressions  (page 153).

To clear the filter for a variable, click the filter button and then click Clear Filter. Case-insensitive
searching can be specified for character variables by clicking the filter button then selecting Case
Insensitive.

Dataset filter expressions

Syntax for editing dataset filter expressions.

For variable types other than DATE, DATETIME or TIME formats, you can edit the filter expression that is
generated. You cannot edit the expressions of DATE, DATETIME or TIME variable filters; these can only
be cleared and re-entered.

Filter Expression Syntax
The table shows the supported expression syntax.

Criteria Expression Examples

Equal to EQ  x   or  EQ  s Is equal to 100 (numeric)

EQ 100
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Criteria Expression Examples
Is equal to "Blanco" (string)

EQ "Blanco"

Not equal to NE  x   or  NE  s Is not equal to 100 (numeric)

NE 100

Is not equal to "Blanco" (string)

NE "Blanco"

Less than LT  x Is less than 100

LT 100

Greater than GT  x Is greater than 100

GT 100

Less than or
equal to

LE  x Is less than or equal to 100

LE 100

Greater than
or equal to

GE  x Is greater than or equal to 100

GE 100

Between
(inclusive)

BETWEEN  x  AND  y Is between 100 and 200

BETWEEN 100 AND 200

Not between
(inclusive)

NOT BETWEEN  x  AND  y Is not between 100 and 200

BETWEEN 100 AND 200

Is missing IS MISSING IS MISSING

Is not missing IS NOT MISSING IS NOT MISSING

In IN ( x ,  y )  or  IN ( s1 ,

s2 )

Is one of the values 100, 200 or 300

IN (100,200,300)

Is one of the values "Blanco", "Jones" or "Smith"

IN ("Blanco","Jones","Smith")

Starts with LIKE  " s% " Starts with the string "Bla"

LIKE "Bla%"

Ends with LIKE  "%s " Ends with the string "nco"

LIKE "%nco"

Contains LIKE  "%s% " Contains the string "an"

LIKE "%an%"
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Sorting a dataset

Sorting a dataset by one or many variables.

You can sort the contents of a dataset on several variables. Variables that are part of an active sort have
an icon representing the direction of the sort in the header:  for ascending sort and  for descending
sort. The size of the icon indicates the significance of the variable in the sort.

Sorting is not available if the dataset is open in Edit mode. If you attempt to switch to Edit mode while a
sort is currently active, the entire dataset to be rewritten to match the current sort order, to allow it to be
edited in-place.

To sort a dataset:

1. Right-click the column header for the variable that you want to sort by primarily.
2. Click Ascending Sort or Descending Sort on the shortcut menu to perform the sort.
3. If required, you can apply further sorting (secondary, tertiary, and so on) by selecting another column

and clicking Ascending Sort or Descending Sort.

To remove any column from the sort, right-click the required column and click Clear Sort. The dataset
will remove that sort and revert to any previous sorts, if present.

Working with program output
An overview of the various types of program output.

Output from programs is accessible from the following views:

• Altair SLC Server Explorer  (page 85) – Provides access to the datasets, catalogs, library
references (for example, the default Work library), file references, and so on, generated for the
particular server.

• Output Explorer  (page 91) – Provides access to the logs and output generated by the Output
Delivery System (ODS), such as the listing, HTML or PDF output formats.

• Results Explorer  (page 92) – Provides access to the output results of procedures run as part of the
SAS language program.

• Outline  (page 90) – Provides access to the structural elements of the currently selected program,
log, listing or HTML output.

Log output for a server in the SAS Language Environment is cumulative and shows information and
errors from each program that has been run during the current session. For more information on logs,
see Log  (page 82).

Listing output is cumulative for a server and shows the results of every program that has been executed
during the current session.

HTML and PDF output show the results of the programs, but neither are cumulative.
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The Altair SLC Server itself can be restarted without restarting Altair Analytics Workbench (see
Restarting an Altair SLC Server  (page 46) for more information). This clears the log, listing and HTML
output, and deletes temporary files library references, datasets and macro variables set up on the server.

Dataset generation
If your program produces or amends a dataset, then this can be viewed from the relevant library in Altair
SLC Server Explorer.

For example, each time you run the following sample program the associated dataset is updated in the
Work library:

DATA longrun;
  DO I = 1 TO 5000000000;
    OUTPUT;
  END;
RUN;

To view the details associated with the dataset, in Altair SLC Server Explorer view, expand the Work
library under the Local server, right-click on the dataset name and click Properties on the shortcut
menu.

For more information about the use of libraries on a server, see Libraries and datasets  (page 132).
For details about viewing and amending datasets, see Dataset Viewer  (page 148).

Managing ODS output
Working with the Output Delivery System.

Once you have run a program that produces some output using the ODS (Output Delivery System), you
can view it in the Results Explorer view.

The ODS destinations and the location of the generated output, can either be automatically managed by
Altair Analytics Workbench, or controlled through statements in the SAS language program.

Automatically manage ODS destinations
Managing ODS destinations for different result types.

Preferences to control the ODS destinations are automatically created when a SAS language program
is run in Altair Analytics Workbench. To output the ODS destinations in a program not running in Altair
Analytics Workbench, you will need to add the required ODS creation statements to your program.
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Automatically Manage Result Types
Click Yes to create ODS destinations for each of the result types selected. Click No to manage the
output within the SAS language program.

Result Types
Select the ODS destination to be automatically created. Altair Analytics Workbench creates a
temporary file for each destination type for each SAS language program run. When a different
program is run, or the same program run again, new temporary files are created.

Show generated injected code in the log
Click to show the automatically created code for each ODS destination in the log output.

Listing output
This section of the guide looks at the  listing output of results.

Listing Colouring Preferences

Setting preferences for listing results.

The preferences that you can set regarding the different items contained in listing results are found under
Window, Preferences…, Altair then  Listing Syntax Coloring  :

For each different type of item contained in a listing, you can specify attributes for Colour, Background
Colour, and whether or not the item should be displayed in Bold.

Viewing the listing output

Viewing the Output Explorer listing output.

To view the listing output:

1. Ensure you have the  Output Explorer open ( Window ➤ Show View  ➤   Output Explorer).

2. If there is more than one server, open the required server node to display the associated output.
3. Either double-click the  Listing node, or right-click it and select   Open from the context menu.

The listing output opens and is given focus.

If you have performed several runs, the previous listing output will be concatenated into the existing
results. If you want to clear the output, to ensure that when you next run a program the listing only
contains results for that run, then you can proceed in accordance with either of the following:
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•  Clearing the results output  (page 161) (which will also clear any HTML output  (page
159)).

•  Restarting an Altair SLC Server  (page 46) (which will clear the log and all results, datasets,
library and Filerefs).

Navigating the listing output

Navigating the output contained in the listing file.

If you have executed several programs, or several instances of the same program, and have not
cleared the results for the particular server by either  Clearing the results output  (page 161) or

 Restarting an Altair SLC Server  (page 46), then each instance of listing output will have been
appended to the existing listing file in order of execution.

To navigate the output contained in the listing file:

1. Open the results in accordance with Viewing the listing output  (page 157).
2. Ensure that you have the  Outline  (page 90) view open ( Window ➤ Show View  ➤   Outline).

3. In this view you will see nested output for the various programs, with nodes for the different output
elements. Click on any of these nodes and the corresponding section in the listing file will be
displayed.

Saving the listing output to a file

Saving the Output Explorer listing output to a file.

To save the listing output to a file:

1. Ensure that you have the  Output Explorer open ( Window ➤ Show View  ➤   Output
Explorer).

2. Do one of the following:

• Right-click on the  Listing node, and, from the context menu, select   Save As....

• Open the listing in the editor (see Viewing the listing output  (page 157)), and then right-click
in the editor window and select   Save As….

• Open the listing in the editor and then select File ➤   Save As... from the main menu.

3. Use the Save As dialog to save the file to the required location.
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Printing the listing output

Printing the listing output for a server.

To print the listing output for a particular server:

1. Ensure that you have the  Output Explorer open ( Window ➤ Show View  ➤   Output
Explorer).

2. If there is more than one server, open the required server node to display the associated output.
3. Do one of the following:

• Right-click on the  Listing node, and, from the context menu, select   Print Results....

• Open the listing in the editor (see Viewing the listing output  (page 157)), and then right-
click in the editor window and either select   Print… or press Ctrl+P on Windows (Cmd-P on
MacOS).

• Open the listing in the editor and then select File ➤   Print... from the main menu.

4. Use the Print dialog to send the results to your required printer.

HTML output
How to view and print output from HTML.

If the HTML output automatically managed by the Altair Analytics Workbench (see Automatically
manage ODS destinations  (page 156)), then each run will create a new HTML file. However, if you
have executed several programs, or several instances of the same program, and have not cleared the
results for the particular server by either Clearing the results output  (page 161) or Restarting an
Altair SLC Server  (page 46), then the previous HTML output will still be visible in output.

Viewing HTML output

Viewing the Output Explorer HTML output.

To view the HTML output:

1. Ensure you have the Output Explorer open ( Window ➤ Show View  ➤   Output Explorer).

2. If there is more than one server, open the required server node to display the associated output.
3. Either double-click the  HTML node, or right-click it and select Open from the context menu.

The HTML output file opens and is given focus.
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Printing HTML output

Printing the Output Explorer HTML output.

To print the HTML output:

1. Ensure that you have the Output Explorer open ( Window ➤ Show View  ➤  Output Explorer).

2. If there is more than one server, open the required server node to display the associated output.
3. Do one of the following:

• Right-click on the  HTML node and,click  Print Results.
• Open the HTML file in the editor (see Viewing HTML output  (page 159)), and then right-

click in the editor window and either select   Print… or press Ctrl+P on Windows (Cmd-P on
MacOS).

• Open the HTML file in the editor and then select File ➤  Print... from the main menu.

4. Use the Print dialog to send the results to your required printer.

PDF output
This section of the guide looks at the PDF output of results.

To set up the automatic management of PDF output, refer to Automatically manage ODS destinations
(page 156).

The default settings for PDF output are as specified in the wps.cfg file (see Configuration files  (page
521)), and are as follows:

• -BOTTOMMARGIN 1cm

• -LEFTMARGIN 1cm

• -RIGHTMARGIN 1cm

• -TOPMARGIN 1cm

• -ORIENTATION portrait

The PAPERSIZE is determined automatically by the locale of Altair Analytics Workbench (see
Processing Engine  LOCALE and ENCODING settings  (page 43)). It can be reset using unmanaged
output (see below).

The startpage option, which determines whether or not the output from each PROC starts on a new
page, is not configurable inside Altair Analytics Workbench. It is initially set to STARTPAGE=yes in the
ODS software, which means that each PROC does start on a new page. The option can also be reset
using unmanaged output (see below).
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You create unmanaged output by entering code directly into your programs, as per the example below:

options orientation=landscape;
options papersize=A4;
options topmargin=0.75in;
options bottommargin=0.5in;
options leftmargin=0.5in;
options rightmargin=0.5in;  
ods pdf        
  file="body.pdf"       
  startpage=no; 
  /* Startpage=no means that new pages are not generated between PROCs  */       
 /* Insert PROCs to generate output */ 
ods_all_ close;

Note:
Relevant parts of the code can also be used as code injections  (page 126).

Clearing the results output
Clearing the results output for a server.

1. To save your output before clearing it, save your PDF elsewhere if you have been using the  PDF
destination, or proceed as in Saving the listing output to a file  (page 158).

2. Clear the output results for the required server by doing one of the following:

• From the main menu, select  Altair,   Clear Results, then click  Local Server (or substitute the
name of your remote Altair SLC Server in place of Local Server).

• Use the keyboard shortcut Ctrl + Alt + O to remove the results from the default server.

Note:
If you have more than one Altair SLC Server registered, then the above action will clear the
results for the Default Processing Engine  (page 41). If in doubt as to which is the default server,
use the tooltip for the toolbar button  to show which server's results will be cleared.

• From the toolbar, click  to clear the results from the default server, or click the drop-down 
next to this button to select a non-default server.

• Ensure that you have the  Output Explorer open ( Window ➤ Show View  ➤   Output
Explorer), right-click on the  listing output,  HTML output or  PDF output for the required
server, and from the context menu, select  Clear All Results.

All output will now be blank.

Note:
The effects of this option are different from Restarting an Altair SLC Server  (page 46) in that you
preserve the context of what you are currently doing, and do not lose your temporary work.
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Text-based editing features
Text based features in Altair Analytics Workbench that help you write and modify programs and other
project files.

You can use these features with the SAS Editor  (page 163) to help you write and modify programs
and other project files. The same features are available with the Text Editor  (page 164), with the
exception of Colour Coding of Language Elements. These features are not available when managing
files through the File Explorer view.

Left hand borders
The left hand borders are used to display different features:

• In the outer left grey border, you will see annotations.
• In the inner left white border, you will see the expand and collapse controls for blocks of related

language items. The white border is also used to display quick difference indicators.

Annotations
These can consist of the following displayed in the outer left grey border of a file:

•  Bookmark anchors  (page 88)

•  Task markers  (page 89)

•  Search results

Quick difference indicators
A quick difference indicator in the inner left white border of a program shows that something has
changed in that line of code since it was last saved:

•  Indicates that a change has been made to the line of code.

If you hover the mouse over this coloured block, a pop-up window will show you the code as it was
prior to the change.

•  Indicates that there is a new, additional line of code.
•  Indicates the position where one or more lines of code have been deleted.

When you save a program, the quick difference indicators will be cleared from the margin.

Navigating between annotations and quick difference indicators
You can navigate between annotations within an individual program by using the Navigate menu options.
The  Next option moves to the next annotation, the  Previous option moves to the previous annotation.

You can also use  Next Annotation and  Previous Annotation on the Altair Analytics Workbench's main
button bar to move between annotations and quick difference indicators.
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Layout preferences
The display controls for a program, including the current line, foreground and background colours, and
whether to display line numbers, are user defined. See Text Editor Preferences  (page 165) for more
details.

Colour Coding of Language Elements
The colours used to display language elements in a program can be controlled via the Preferences.
See Syntax Colouring  (page 127) for more information.

Working with editors
In any Altair Analytics Workbench perspective, the Editor window is always displayed, so that you can
continue to write and modify files. This section describes the various ways of opening files in the Editor
window with the different editors.

Only one file can be active at any one time. This is the file that currently has focus within the Editor
window.

You can open programs using either the Project Explorer view or File Explorer view. The Project
Explorer view offers more control than the File Explorer view, which determines the most suitable editor
automatically, based on the file name extension of the file being opened.

Editing files within projects allows you to use local history to help you manage changes. See Local
history  (page 61) for more information

SAS Editor
The SAS Editor view provides features suitable for editing SAS language programs, such as syntax
colouring.

Programs can be opened either via a project or directly from one of the available file systems. Only files
with an extension .wps or .sas can be opened in this editor.

To open a program in the SAS Editor view:

1. Click the Window menu, click Show View and then click Project Explorer.

If you are using the File Explorer view, Click the Window menu, click Show View and then click File
Explorer.

2. Navigate to the program you want to open and double-click on the program name.
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Text Editor
The Altair Analytics Workbench has a basic Text Editor view. You can open a program with this editor
but the contents are treated as regular text file.

To open a file in the Text Editor view :

1. Click the Window menu, click Show View and then click Project Explorer.

If you are using the File Explorer view, Click the Window menu, click Show View and then click File
Explorer.

2. Navigate to the file you want to open. If the file is a text file, then double-click on it. Otherwise, right-
click on the file, and, from the context menu, select Open With ➤   Text Editor.

System Editor
If a file has an extension associated with an application installed on your computer (for example, .doc
may be associated with Microsoft Word), the System Editor will launch that application with the file in a
new window outside the Altair Analytics Workbench. This type of editor is known as a System Editor.

To open a file with the System Editor:

1. Click the Window menu, click Show View and then click Project Explorer.

If you are using the File Explorer view, Click the Window menu, click Show View and then click File
Explorer.

2. Navigate to the program you want to open and double-click on the program name.

In-Place Editor
The Altair Analytics Workbench supports OLE (Object Linking and Embedding) document editing. For
example, if you have a Microsoft Word document in your project and use the In-Place Editor, the Word
document will open in the Altair Analytics Workbench's Editor  (page 85), with Microsoft Word's pull-
down menu options being integrated into the menu bar of the view.

To open a file with the In-Place Editor:

1. Click the Window menu, click Show View and then click Project Explorer.
2. Right-click on the required file, click Open With and then click  In-Place Editor on the shortcut menu.

If the file has an associated OLE editor, the file is opened in the In-Place Editor in the Editor view and
the menus and options associated with the linked application are available.
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Text Editor Preferences
Text editor preferences can be set from the main Altair Analytics Workbench preferences window.

To edit text editor preferences:

1. Click the Window menu and then click Preferences.
2. In the Preferences window, expand the General group, expand the Editors group and select the

Text Editors group.

You can use the preferences to determine how programs are displayed in the SAS language editor and
the text editor. For example, to set the background colour, in the Appearance colour options, select
Background colour, clear System Default, and then select the required Colour.

These preferences only apply to files opened within the Project Explorer view.

Some of the Preferences that can be configured are:

• Undo history size – The number of operations able to be undone.
• Displayed tab width – the width of the tab used in files
• Show line numbers – whether line numbers are displayed in the margin
• Colours – current line, foreground, background, and so on.

Closing files
Closing files from the Editor view.

Any file that is opened in the Editor view has a tab labelled with the file name. To stop displaying the file
in the Editor view click the File menu and then click Close. Alternatively click  Close on the tab.

Jumping to a particular project location
Jumping to a particular location in a project file using a bookmarked location, a task, a line number, or
the location of the last edit.

You can jump to a particular location in a project file:

To jump to a bookmarked location:

1. Open the  Bookmarks view ( Window ➤ Show View  ➤   Bookmarks).

2. Either double-click on the required bookmark description, or right-click on it, and, from the context
menu, select   Go To.

3. The relevant file will then be opened (if it was closed), and the bookmarked line will be highlighted (or
else the first line in the file if the entire file was bookmarked).
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To jump to a task:

1. Open the  Tasks view (Window ➤ Show View  ➤   Tasks).

2. Either double-click on the required task description, or right-click on it, and, from the context menu,
select   Go To.

3. The relevant file will then be opened (if it was closed), and the line containing the task will be
highlighted.

To jump to a particular line number:

1. Select Navigate ➤  Go to Line....

2. Enter the required number in the Go to Line dialog.
3. Either press Enter on your keyboard, or click OK, to complete the operation and close the dialog.

To jump to the last edit:

1. Select  Last Edit Location from either the toolbar or Navigate menu.

The relevant file will be opened (if it was closed), the last line you edited will be highlighted, and the
cursor will be placed at the end of the last piece of text you edited.

Navigation between multiple project files
Switching between different project files.

You can have as many projects open in the Altair Analytics Workbench as you like and each of these
projects can contain any number of programs.

You can open any number of programs and other files from the different projects in the Editor view (see
Editor  (page 85)). For each program that is open, a corresponding  tab is displayed. An open
program can be given focus in the Editor view by clicking on its tab.

Moving backwards and forwards between programs
The main menu options Navigate ➤   Back and Navigate ➤   Forward (or  and on the
toolbar) are analogous to the back and forward buttons on a web browser. However, unlike a web
browser, when you close and reopen Altair Analytics Workbench, it still has the navigational information.

•  Back navigates to the previous resource that was viewed in the Editor window.

•  Forward displays the program that was active prior to selection of the previous Back command.
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Searching and replacing strings
Finding a text string in an open program and, if required, replacing that string with another.

You can find any text string in an open program, as follows:

1. Ensure that the program to be searched is open in the  File Explorer ( Window ➤ Show View ➤ 
 File Explorer).

2. Display the Find/Replace dialog by either selecting Edit ➤ Find/Replace... from the menu, or
pressing CTRL + F on your keyboard.

The Find/Replace dialog is displayed, which allows you to specify the term to be found, and, if
required, the term with which it is to be replaced.

Note:
The default Scope is All, which means that the whole file is searched (you can amend this to
Selected lines if required). The other options are those that you would expect to find in any search
dialog and are self-explanatory.

3. Click Find to find the first instance of the word and then proceed as required, clicking Find to move to
each new instance of the text string.

Note:
If you select Close to remove the dialog, then the string is remembered, and selecting Edit ➤ Find
Next and Edit ➤ Find Previous will conduct the same search, forwards and then backwards, without
re-opening the dialog.

Undoing and redoing your edits
Undoing and redoing changes to a project file.

There is a multiple undo facility for project file edits, as follows:

1. Either select Edit ➤   Undo from the menu, or press CTRL + Z on your keyboard.

The last change you made is undone.
2. Repeat the above step for each previous edit that you want to undo.

Note:
The number of undo actions that can be performed is determined by Undo history size in the Text
Editor Preferences  (page 165).

Note:
You can also redo any undone edits on an incremental basis, by either selecting Edit ➤   Redo
from the menu, or pressing CTRL + Y on your keyboard, the requisite number of times.
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Working in the Workflow
Environment
The Workflow Environment is a graphical development environment with features for data mining,
predictive modelling tasks, and a range of Machine Learning capabilities.

To open the Workflow Environment perspective, click the Workflow Environment button at the top right
of the screen: .

Creating a new Workflow
Creating a new Workflow in either the Project Explorer view or the File Explorer view.

A Workflow is a program sequence visually represented by connected, colour-coded graphical elements
(blocks) through which the background code runs from start to end.

A Workflow enables collaboration between the project stakeholders; it provides a project framework so
the projects can be easily replicated or audited and can be used as a framework to carry out projects in
standardised manner.

Any datasets you need to use with your Workflow must be located on the same host as the Workflow
Engine you will use to run the Workflow. If your Workflow requires a connection to a database, you must
have the appropriate database client software installed on the same host as the Workflow Engine.

You can create a new Workflow in either the Project Explorer view or the File Explorer view.

• If you select Project Explorer view, the Workflow can be created in any folder in the current
workspace, and the file is saved on your local workstation.

• If you select File Explorer view, the Workflow can be created in any folder on the local workstation, or
any remote hosts in which you have permission to create files.

1. Open the Workflow Environment perspective, by clicking on the Workflow Environment button
at the top right of the screen: . The function of this button can be made clearer by right-
clicking on it and selecting Show Text; this displays the name of the button on the button itself:

.

2. Click the File menu, click New and click Workflow.
3. In the Workflow pane, select the required folder for the new Workflow, specify a File name and click

Finish.

168



Altair Analytics Workbench user guide
Version 2023

Adding blocks to a Workflow
Adding blocks to a Workflow.

A Workflow visually represents a program's logical steps using blocks. The blocks include colours, icons,
and labels to identify the block type. Blocks can be connected together to represent program steps and
specific operations within each step.

Most Workflows begin by importing a dataset, for example by using a Permanent Dataset block.

To add a Permanent Dataset block to a Workflow:

1. Ensure that you are in the Workflow Environment.
2. Add the block to the Workflow canvas. This may be done in one of four ways:

• Expand the block's group (Import in this case) from the palette on the left hand side, then click
and drag the Permanent Dataset block on to the Workflow canvas.

• Right-click the Workflow Editor view, in the shortcut menu click Add, click Import, and then click
Permanent Dataset.

• Double-click on the Workflow canvas, then either scroll to find the block or use the search facility.
• In the case of the Permanent Dataset block, a WPD file may also be dragged and dropped onto

the Workflow canvas from a Windows Explorer window. This also applies to CSV files and Excel
files for their import blocks.

3. Right-click the Permanent Dataset block and click Rename Block in the shortcut menu.
4. In the Rename dialog box, enter a Block label to describe the dataset, for example Base dataset

and click OK. The name entered is displayed as the label of the block on the Workflow Editor view.
5. Right-click the Permanent Dataset block and click Configure in the shortcut menu (or just double-

click on the block).
6. In the Configure Permanent Dataset dialog box, select a file location, either Workspace or

External, and click Browse to locate an existing WPD-format dataset.
7. Click OK to save the changes.

If the dataset is successfully loaded, the execution status in the Output port of the block is green:

You can then add other blocks to the editor and connect them together to create a Workflow.
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Connecting blocks in a Workflow
Blocks can be connected together using connectors to create a Workflow.

Connectors are linked to the block at either the Input port located at the top of a block, or an Output port
located at the bottom of the block. You can connect the output from the Output port of one block to the
Input port of one or more other blocks.

For example, you can randomly divide a dataset into two or more datasets using a Partition block. To
partition the Base dataset created in the section Add blocks to a Workflow:

1. In the Workflow Editor view, click the Data Preparation group in the group palette.
2. Select the Partition block, and drag onto the working area. By default, two partitions are created and

the Partition block has two working datasets:

3. Right-click the Partition block and click Rename Block in the shortcut menu. In the Rename dialog
box, enter a Block label  to describe the partition, for example Train and validate and click OK.

4. Click the Base dataset  block Output port and drag towards the Input port of the Train and validate 
block. A connector appears as you drag. Drag this until it connects to the Input port.

5. When the Base dataset  block is connected to the Train and validate  block:

a. Select the Partition1 dataset and change the Block label to Training dataset.
b. Select the Partition2 dataset and change the Block label to Validation dataset.

More blocks can be connected to the output datasets following the same approach to create a Workflow
that produces, for example, a credit risk scorecard.
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Removing blocks from a Workflow
Blocks can be excluded from a Workflow path by deleting the connectors leading to the Input port of the
block. Blocks can also be permanently deleted from a Workflow.

Connections between blocks can be removed from the block at either end of the connection using
the shortcut menu for the block. Where multiple connectors are linked to the Input port of a block, the
shortcut menu displays all connectors identified by the block label.

Connectors leading to the Input port of a working dataset cannot be removed.

To exclude the train and validate block from the Workflow:

1. In the Workflow Editor view, right-click the train and validate block.

2. Click Remove input connection in the shortcut menu.

Note:
To completely and permanently remove a block from a Workflow, right-click on it and select Delete.

Removing blocks enables you to alter the Workflow, for example to attach a different dataset to the
train and validate partition block to create new training and validation datasets for use in the rest of the
Workflow.

Deleting Workflow blocks
Blocks and any associated working datasets can be deleted from a Workflow. To delete a block, select
the required block, right-click and click Delete Block in the shortcut menu.

Deleting a block deletes:
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• Any associated working datasets created by the block.
• Any connectors leading to the Input port.
• Any connectors leading from the Output port of the block.
• If the block automatically creates working datasets, any connectors leading from the Output port for

every working dataset created by the block.

To delete one or many blocks:

1. Select one or many blocks.

• To select a single block, click on it. This will also select the block's output if applicable.
• To select multiple blocks, hold down Ctrl and then either use the left mouse button to drag a box

around the blocks you want to select, or click individually on each block. Keep Ctrl held down.
2. With the block or blocks selected, click the Edit drop-down menu and click Delete. You may also

press Delete on the keyboard, or right-click and click delete from the pop-up menu, but note that this
latter method does not work with multiple block selections.

Cutting, Copying and pasting blocks
Blocks can be cut, copied and pasted, either within the same Workflow or to another Workflow.

If a cut or copied block has options or variables configured which are specific to a source dataset, then
when the block is pasted and connected to another dataset, if the datasets are similar then the Workflow
Editor will attempt to retain those configured options or variables. It is always recommended that you
check the configuration of a pasted block.

Copy and paste will only function on the block itself and not the connections to and from the block. To
copy and paste the connections with a single block, use the duplicate function (see Duplicating blocks
(page 173)).

Comments attached to blocks will be copied and pasted along with the block.

To cut or copy and then paste one or more Workflow blocks with any relevant connections:

1. Select one or many blocks.

• To select a single block, click on it. This will also select the block's output if applicable.
• To select multiple blocks, hold down Ctrl and then either use the left mouse button to drag a box

around the blocks you want to select, or click individually on each block. Keep Ctrl held down.
2. With the block or blocks selected, click the Edit drop-down menu and click Copy if you wish to store

the selection in the clipboard and retain the selection on the Workflow canvas, or Cut if you want
to do this but remove the selection from the Workflow canvas. You may also press Ctrl+C on the
keyboard for copy, or Ctrl+X for cut (these shortcuts may vary, depending on your operating system).
Alternatively, right-click and click copy or cut from the pop-up menu, but note that this latter method
does not work with multiple block selections.
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3. Right-click where you want to paste the block and select Paste. You may also click the Edit drop-
down window and click Paste, or use the keyboard shortcut Ctrl+V. If using Ctrl+V, the block will be
pasted at the top left of the current Workflow canvas view.

Duplicating blocks
Individual blocks may be duplicated, which performs a copy and paste in one action and also preserves
connections to and from the block.

To duplicate a block, right-click on the block and select Duplicate.

Undoing Workflow actions
Many actions in the Workflow Environment can be undone.

To undo an action, select Undo from the Edit menu, or press Ctrl+Z (this shortcut may vary, depending
on your operating system). Actions that can be undone include, but are not limited to: creating blocks,
deleting blocks, changing block preferences and setup, adding connections and typing words in some
comment boxes and expression boxes. If you have a configuration window open, the Edit menu will not
be accessible and pressing Ctrl+Z is the only undo method available.

Redoing Workflow actions
Any undone Workflow action may be redone, restoring the action that undo reversed.

To redo an action, select Redo from the Edit menu, or press Ctrl+Y (this shortcut may vary, depending
on your operating system). If you have a configuration window open, the Edit menu will not be accessible
and pressing Ctrl+Y is the only redo method available.

Note:
If you have undone changes, then once you edit the Workflow, you will lose the ability to redo those
undone changes.

Deleting a working dataset
Working datasets cannot be deleted; to delete a working dataset you must either delete the block that
created the dataset, or change the number of working datasets created by the block.

For example, to remove a partition working dataset created using the Partition block:
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1. Right-click the Partition block and in the shortcut menu click Configure.
2. In the Configure dialog box, select the partition to be removed and click Remove Partition.

Note:
You cannot delete the default partitions created when you drag a Partition block onto the Workflow
Editor view.

Workflow execution
Workflows can run automatically or manually, as specified in the Workflow preferences in the Workflow
panel of the Workbench Preferences dialog box.

Automatically running Workflows
If a Workflow runs automatically, additions to the Workflow are evaluated when you connect new blocks
to a Workflow. If you make any changes to blocks, the Workflow is automatically re-run for blocks
downstream of the change. Individual blocks can have their automatic running disabled if required (for
example, if a block is known to take a long time to run), by right-clicking on the block and deselecting
Include in Auto Run.

Manually running Workflows
If the Workflow is manually run, right-click on the Workflow canvas and select Run. This will run the
Workflow, using any output from previously-run blocks in the Workflow.

Alternatively, you can manually run sections of the Workflow by right-clicking on a block and selecting:

• Run to here – evaluates the additions to the Workflow up to the block clicked on, but uses the output
from any previously-run blocks in the Workflow.

• Force run to here – reruns the whole Workflow up to the block clicked on, evaluating all blocks in the
Workflow and recreating all working datasets.

Workflow magnifier
When the zoom percentage in the Workflow is below 100%, holding down the SHIFT key displays the
Workflow magnifier.

The Workflow magnifier is a small window providing a view that is centred on the current mouse pointer
location and zoomed by 100%.

The Workflow magnifier can be used as a tool to view specific blocks in a large workflow where the
zoom percentage is set to a low value.
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Workflow grid
The Workflow can be specified to display a layout grid on the Workflow canvas and blocks can be
automatically aligned to the Workflow grid.

The Workflow grid can be used as a tool to align blocks and keep them in fixed positions.

To use the Workflow grid, from the toolbar, select the Toggle grid snap button to enable the edges of
blocks to always position on the grid lines. Select the Toggle grid visibility button to show the grid on
the Workflow.

Database References
Workbench can store access details for databases (known as Database References), which can then be
used in Workflows. The Add Database wizard guides you through the steps to create a new database
reference to a local or remote database for subsequent access throughout Workflow.

The Add Database wizard can be accessed from a number of points in the Workflow Environment:
The Settings tab, the Database Explorer view, the Database Import block and the Database Export
block.

The path through the wizard is slightly different depending on which database you want to access:

• DB2: see Adding a DB2 database reference  (page 176).
• MySQL: see Adding a MySQL database reference  (page 176).
• Oracle: see Adding an Oracle database reference  (page 177).
• ODBC: see Adding an ODBC database reference  (page 178).
• PostgreSQL: see Adding a PostgreSQL database reference  (page 179).
• SQL Server: see Adding an SQL Server database reference  (page 179).
• Snowflake: see Adding a Snowflake database reference  (page 180)
• AWS Redshift: see Adding an AWS Redshift database reference  (page 181)
• MS Azure SQL Data Warehouse: see Adding an MS Azure SQL Data Warehouse database

reference  (page 182)
• Teradata: see Adding a Teradata database reference  (page 182)
• Hadoop: see Adding a Hadoop cluster reference  (page 183)
• Google BigQuery: see Adding a Google BigQuery database reference  (page 184)

For more information about installing database clients, see the knowledge base on the World
Programming support website (https://support.worldprogramming.com).
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Adding a DB2 database reference
Using the Add Database wizard to add a new DB2 database reference.

Before adding a new reference to a DB2 database, you must ensure that a DB2 database client
connector is installed and accessible from the Workflow Engine used to run the Workflow.

To create a new DB2 database reference, initiate the Add Database wizard and then follow these steps:

1. Select DB2 from the Database type list.
2. Click Next.
3. Enter the Database Name.
4. Choose the authentication method from the Authentication drop-down list.

• If you choose Credentials, then enter a Username and Password.
• If you choose Auth domain, then choose an Auth domain from the drop-down list.

5. Click Connect.

If the connection is successful, the Connection successful message is displayed. Click OK to close
this message and continue at the next step. If the connection is unsuccessful, the Connection failed
message is displayed. Click Details to view details of the connection failure and OK to close this
message and try the previous step again.

6. Click Next.
7. Choose the Schema.
8. Click Next.
9. In the Name box, enter a name to use to refer to the database in the Workflow Environment.
10.Click Finish.

Adding a MySQL database reference
Using the Add Database wizard to add a new MySQL database reference.

Before adding creating a new reference to a MySQL database, you must ensure that a MySQL database
client connector is installed and accessible from the Workflow Engine used to run the Workflow.

To create a new MySQL database reference, initiate the Add Database wizard and then follow these
steps:

1. Select MySQL from the Database type list.
2. Click Next.
3. Enter the Host name.
4. Enter the Port.
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5. Choose the authentication method from the Authentication drop-down list.

• If you choose Credentials, then enter a Username and Password.
• If you choose Auth domain, then choose an Auth domain from the drop-down list.

6. To use SSL for the connection, select Use SSL and then specify all four of the fields beneath:

• SSL CA: The file path and file name of the Certificate Authority (CA) file in PEM format.
• SSL CA path: The path to a folder that contains SSL CA files in PEM format.
• SSL certificate: The X.509 SSL certificate in PEM format. This will either be the client public key

certificate or server public key certificate.
• SSL key: the SSL private key file in PEM format. This will either be the client private key or server

private key.
7. Click Connect.

If the connection is successful, the Connection successful message is displayed. Click OK to close
this message and continue at the next step. If the connection is unsuccessful, the Connection failed
message is displayed. Click Details to view details of the connection failure and OK to close this
message and try the previous step again.

8. Choose the Database from the drop-down list.
9. Click Next.
10.In the Name box, enter a name to use to refer to the database in the Workflow Environment.
11.Click Finish.

Adding an Oracle database reference
Using the Add Database wizard to add a new Oracle database reference.

Before adding creating a new reference to an Oracle database, you must ensure that an Oracle database
client connector is installed and accessible from the Workflow Engine used to run the Workflow.

To create a new Oracle database reference, initiate the Add Database wizard and then follow these
steps:

1. Select Oracle from the Database type drop-down list.
2. Click Next.
3. Enter the Net service name.
4. Choose the authentication method from the Authentication drop-down list.

• If you choose Credentials, then enter a Username and Password.
• If you choose Auth domain, then choose an Auth domain from the drop-down list.
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5. Click Connect.

If the connection is successful, the Connection successful message is displayed. Click OK to close
this message and continue at the next step. If the connection is unsuccessful, the Connection failed
message is displayed. Click Details to view details of the connection failure and OK to close this
message and try the previous step again.

6. Click Next.
7. Choose the Schema.
8. Click Next.
9. In the Name box, enter a name to use to refer to the database in the Workflow Environment.
10.Click Finish.

Adding an ODBC database reference
Using the Add Database wizard to add a new ODBC database reference.

Before adding creating a new reference to an ODBC database, you must ensure that a ODBC database
client connector is installed and accessible from the Workflow Engine used to run the Workflow.

To create a new ODBC database reference, initiate the Add Database wizard and then follow these
steps:

1. Select ODBC from the Database type list.
2. Click Next.
3. Enter the Data source name.
4. Choose the Authentication method from the drop-down list:

• If you choose Credentials, then optionally enter a Username and Password (if required by the
specified database).

• If you choose Auth domain, then choose an Auth domain from the drop-down list.
• Use ODBC Credentials.

5. Click Connect.

If the connection is successful, the Connection successful message is displayed. Click OK to close
this message and continue at the next step. If the connection is unsuccessful, the Connection failed
message is displayed. Click Details to view details of the connection failure and OK to close this
message and try the previous step again.

6. Click Next.
7. Optionally, and if supported, choose the Schema.
8. Click Next.
9. In the Name box, enter a name to use to refer to the database in the Workflow Environment.
10.Click Finish.
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Adding a PostgreSQL database reference
Using the Add Database wizard to add a new PostgreSQL database reference.

Before adding creating a new reference to a PostgreSQL database, you must ensure that a PostgreSQL
database client connector is installed and accessible from the Workflow Engine used to run the
Workflow.

To create a new PostgreSQL database reference, initiate the Add Database wizard and then follow
these steps:

1. Select PostgreSQL from the Database type list.
2. Click Next.
3. Enter the Host name.
4. Enter the Port.
5. Choose the authentication method from the Authentication drop-down list.

• If you choose Credentials, then enter a Username and Password.
• If you choose Auth domain, then choose an Auth domain from the drop-down list.

6. Click Connect.

If the connection is successful, the Connection successful message is displayed. Click OK to close
this message and continue at the next step. If the connection is unsuccessful, the Connection failed
message is displayed. Click Details to view details of the connection failure and OK to close this
message and try the previous step again.

7. Click Next.
8. Choose the Database from the drop-down list.
9. Click Next.
10.In the Name box, enter a name to use to refer to the database in the Workflow Environment.
11.Click Finish.

Adding an SQL Server database reference
Using the Add Database wizard to add a new SQL Server database reference.

Before adding creating a new reference to a SQL Server database, you must ensure that a SQL
Server database client connector is installed and accessible from the Workflow Engine used to run the
Workflow.

To create a new SQL Server database reference, initiate the Add Database wizard and then follow these
steps:

1. Select SQL Server from the Database type list.
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2. Click Next.
3. Enter the Host name.
4. Enter the Port.
5. Choose the authentication method from the Authentication drop-down list.

• If you choose Credentials, then enter a Username and Password.
• If you choose Auth domain, then choose an Auth domain from the drop-down list.

6. Click Connect.

If the connection is successful, the Connection successful message is displayed. Click OK to close
this message and continue at the next step. If the connection is unsuccessful, the Connection failed
message is displayed. Click Details to view details of the connection failure and OK to close this
message and try the previous step again.

7. Click Next.
8. Choose the Database from the drop-down list.
9. Click Next.
10.In the Name box, enter a name to use to refer to the database in the Workflow Environment.
11.Click Finish.

Adding a Snowflake database reference
Using the Add Database wizard to add a new Snowflake database reference.

Before adding a new reference to a Snowflake database, you must ensure that a Snowflake database
client connector is installed and accessible from the Workflow Engine used to run the Workflow.

To create a new Snowflake database reference, initiate the Add Database wizard and then follow these
steps:

1. Select Snowflake from the Database type list.
2. Click Next.
3. Enter the Server and Warehouse.
4. Choose the authentication method from the Authentication drop-down list.

• If you choose Credentials, then enter a Username and Password.
• If you choose Auth domain, then choose an Auth domain from the drop-down list.

5. Click Connect.

If the connection is successful, the Connection successful message is displayed. Click OK to close
this message and continue at the next step. If the connection is unsuccessful, the Connection failed
message is displayed. Click Details to view details of the connection failure and OK to close this
message and try the previous step again.
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6. Click Next.
7. Choose the Database and Schema from the drop-down lists.
8. Click Next.
9. In the Name box, enter a name to use to refer to the database in the Workflow Environment.
10.Click Finish.

Adding an AWS Redshift database reference
Using the Add Database wizard to add a new AWS Redshift database reference.

Before adding a new reference to a AWS Redshift database, you must ensure that a AWS Redshift
database client connector is installed and accessible from the Workflow Engine used to run the
Workflow.

To create a new AWS Redshift database reference, initiate the Add Database wizard and then follow
these steps:

1. Select Amazon Redshift from the Database type list.
2. Click Next.
3. Enter the Host name.
4. Enter the Port.
5. Enter the Database.
6. Choose the authentication method from the Authentication drop-down list.

• If you choose Credentials, then enter a Username and Password.
• If you choose Auth domain, then choose an Auth domain from the drop-down list.

7. Click Connect.

If the connection is successful, the Connection successful message is displayed. Click OK to close
this message and continue at the next step. If the connection is unsuccessful, the Connection failed
message is displayed. Click Details to view details of the connection failure and OK to close this
message and try the previous step again.

8. Click Next.
9. Choose the Schema from the drop-down list.
10.Click Next.
11.In the Name box, enter a name to use to refer to the database in the Workflow Environment.
12.Click Finish.
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Adding an MS Azure SQL Data Warehouse
database reference
The Add Database wizard can be used to add a new MS Azure SQL Data Warehouse database
reference.

Before adding a new reference to a MS Azure SQL Data Warehouse database, you must ensure that a
MS Azure SQL Data Warehouse database client connector is installed and accessible from the Workflow
Engine used to run the Workflow.

To create a new MS Azure SQL Data Warehouse database reference, initiate the Add Database wizard
and then follow these steps:

1. Select Sql Azure Warehouse from the Database type list.
2. Click Next.
3. Enter the Host name.
4. Enter the Port.
5. Choose the authentication method from the Authentication drop-down list.

• If you choose Credentials, then enter a Username and Password.
• If you choose Auth domain, then choose an Auth domain from the drop-down list.

6. Click Connect.

If the connection is successful, the Connection successful message is displayed. Click OK to close
this message and continue at the next step. If the connection is unsuccessful, the Connection failed
message is displayed. Click Details to view details of the connection failure and OK to close this
message and try the previous step again.

7. Click Next.
8. Choose the Database and Schema from the drop-down list.
9. Click Next.
10.In the Name box, enter a name to use to refer to the database in the Workflow Environment.
11.Click Finish.

Adding a Teradata database reference
Using the Add Database wizard to add a new Teradata database reference.

Before adding creating a new reference to an Teradata database, you must ensure that a Teradata
database client connector is installed and accessible from the Workflow Engine used to run the
Workflow.
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To create a new Teradata database reference, initiate the Add Database wizard and then follow these
steps:

1. Select Teradata from the Database type list.
2. Click Next.
3. Enter the Host name.
4. Choose the Authentication method from the drop-down list:

• If you choose Credentials, then optionally enter a Username and Password (if required by the
specified database).

• If you choose Auth domain, then choose an Auth domain from the drop-down list.
5. Click Connect.

If the connection is successful, the Connection successful message is displayed. Click OK to close
this message and continue at the next step. If the connection is unsuccessful, the Connection failed
message is displayed. Click Details to view details of the connection failure and OK to close this
message and try the previous step again.

6. Click Next.
7. Optionally, and if supported, choose the Schema.
8. Click Next.
9. In the Name box, enter a name to use to refer to the database in the Workflow Environment.
10.Click Finish.

Adding a Hadoop cluster reference
Using the Add Database wizard to add a new Hadoop cluster reference.

Before adding creating a new reference to an Hadoop database, you must ensure that a Hadoop
database client connector is installed and accessible from the Workflow Engine used to run the
Workflow.

To create a new Hadoop database reference, initiate the Add Database wizard and then follow these
steps:

1. Select Hadoop from the Database type list.
2. Click Next.
3. Enter the Host name.
4. Choose the Authentication method from the drop-down list:

• If you choose Credentials, then optionally enter a Username and Password (if required by the
specified database).

• If you choose Auth domain, then choose an Auth domain from the drop-down list.
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5. Click Connect.

If the connection is successful, the Connection successful message is displayed. Click OK to close
this message and continue at the next step. If the connection is unsuccessful, the Connection failed
message is displayed. Click Details to view details of the connection failure and OK to close this
message and try the previous step again.

6. Click Next.
7. Optionally, and if supported, choose the Schema.
8. Click Next.
9. In the Name box, enter a name to use to refer to the database in the Workflow Environment.
10.Click Finish.

Adding a Google BigQuery database reference
Using the Add Database wizard to add a new Google BigQuery database reference.

Before adding creating a new reference to an Google BigQuery database, you must ensure that a
Google BigQuery database client connector is installed and accessible from the Workflow Engine used
to run the Workflow.

To create a new Google BigQuery database reference, initiate the Add Database wizard and then follow
these steps:

1. Select Google BigQuery from the Database type list.
2. Click Next to go to the next screen in the wizard.
3. Enter the refresh token in the Refresh token box and the catalog in the Catalog box.
4. Click Connect.

If the connection is successful, the Connection successful message is displayed. Click OK to close
this message and continue at the next step. If the connection is unsuccessful, the Connection failed
message is displayed. Click Details to view details of the connection failure and OK to close this
message and try the previous step again.

5. Click Next.
6. Optionally, and if supported, choose a Dataset.
7. Click Next.
8. In the Name box, enter a name to use to refer to the database in the Workflow Environment.
9. Click Finish.

184



Altair Analytics Workbench user guide
Version 2023

Parameters
A Workflow can store global variables, known as parameters, that can be used throughout that Workflow
in block configuration windows in place of user specified values. Parameters can represent open
values that can be used in any character or numeric entry box, or specific values from a drop-down list.
Parameters are saved with the Workflow they are created in and can only be used with that Workflow.

Parameters can be added either from the location in the user interface that you want the parameter to be
used from, or from the Settings tab of a Workflow. Parameters associated with drop-down lists can only
be added from their location in the user interface. The Settings tab is also used to manage parameters.

A parameter consists of:

• Name: Used to refer to the parameter when using or managing it.
• Type, which is one of:

‣ String: Alphanumeric and used in fields that accept a character input (such as names and labels).
‣ Password: String recommended for use in fields as a password.
‣ Choice: Used as a selection from a pre-defined list.
‣ Integer: Numeric and used in fields for integers.
‣ Float: Numeric and used in fields for numbers containing a decimal, for example, irrational

numbers.
‣ Boolean: True or false.
‣ Stream: Used for a dynamic flow of data.
‣ Date: Used for fields with the format dd/mm/yyyy.
‣ Time: Used for fields with the format hh:mm representing a 24 hour clock.
‣ Date & Time: Used for fields with the format dd/mm/yyyy hh:mm.
‣ Variable Name(Custom block Workflow only): Used for a variable name from a dataset.
‣ Dataset(Custom block Workflow only): Used for an existing dataset.

• Value: The value of the parameter.
• Prompt: Whether to display a prompt when using the parameter to change the local value.

Adding a parameter from the Workflow Settings

Adding a string parameter from the Workflow Settings
Adding a string parameter from the Settings of a Workflow file.

To add a parameter for use with a text or numeric entry box:
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1. Open an existing Workflow file in Altair Analytics Workbench, or create a new one.
2. Click Workflow Settings ( ) at the base of the screen.

3. From the left-hand pane, click Parameters.
4. Click Add.

A Create Parameter dialog box opens.
5. Complete the Create Parameter dialog box as follows:

a. Name: Enter a name for the parameter. This will be used to refer to the parameter elsewhere in
Workflow.

b. Type: From the list, select String.
6. Complete the following optional arguments as required:

a. Label: Enter a label for the parameter.
b. Prompt: Enter a prompt for the parameter.
c. Required: Specify if the parameter is required or not.
d. Default Value: Enter the default value that you want the parameter to have.
e. Autocomplete service URL: Enter a URL for a web service for autocompleting fields in an Altair

SLC Hub program.
f. Promptable: Specifies if the parameter requires a prompt when used.

7. Click Apply and Close.

The new string parameter appears in the list of parameters.

Adding a password parameter from the Workflow
Settings
Adding a password parameter from the Settings of a Workflow file.

To add a parameter for use as a password:

1. Open an existing Workflow file in Altair Analytics Workbench, or create a new one.
2. Click Workflow Settings ( ) at the base of the screen.

3. From the left-hand pane, click Parameters.
4. Click Add.

A Create Parameter dialog box opens.
5. Complete the Create Parameter dialog box as follows:

a. Name: Enter a name for the parameter. This will be used to refer to the parameter elsewhere in
Workflow.

b. Type: From the list, select Password.
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6. Complete the following optional arguments as required:

a. Label: Enter a label for the parameter.
b. Prompt: Enter a prompt for the parameter.
c. Required: Specify if the parameter is required or not.
d. Provide maximum length: Specify whether a maximum length is required. If this is selected, a

maximum length can be entered in the Maximum length box.
e. Promptable: Specifies if the parameter requires a prompt when used.

7. Click Apply and Close.

The new password parameter appears in the list of parameters.

Adding a choice parameter from the Workflow Settings
Adding a choice parameter from the Settings of a Workflow file.

To add a choice parameter:

1. Open an existing Workflow file in Altair Analytics Workbench, or create a new one.
2. Click Workflow Settings ( ) at the base of the screen.

3. From the left-hand pane, click Parameters.
4. Click Add.

A Create Parameter dialog box opens.
5. Complete the Create Parameter dialog box as follows:

a. Name: Enter a name for the parameter. This will be used to refer to the parameter elsewhere in
Workflow.

b. Type: From the list, select Choice.
c. Select your source of choices, selecting From List or From Service as required.
d. From List: Click Add to open an Add choice dialog box, then use the Value box to enter a value.

Optionally, use the Label box to enter a label, then click OK. Repeat this step as required.
e. From Service: Enter a URL for a web service that populates choices in the Service URL box.

6. Complete the following optional arguments as required:

a. Label: Enter a label for the parameter.
b. Prompt: Enter a prompt for the parameter.
c. Required: Specify if the parameter is required or not.
d. Default Value: Enter the default value that you want the parameter to have.
e. Promptable: Specifies if the parameter requires a prompt when used.

7. Click Apply and Close.
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The new choice parameter appears in the list of parameters.

Adding an integer parameter from the Workflow Settings
Adding a parameter from the Settings of a Workflow file.

To add a parameter for use with a numeric entry box:

1. Open an existing Workflow file in Altair Analytics Workbench, or create a new one.
2. Click Workflow Settings ( ) at the base of the screen.

3. From the left-hand pane, click Parameters.
4. Click Add.

A Create Parameter dialog box opens.
5. Complete the Create Parameter dialog box as follows:

a. Name: Enter a name for the parameter. This will be used to refer to the parameter elsewhere in
Workflow.

b. Type: From the list, select Integer.
6. Complete the following optional arguments as required:

a. Label: Enter a label for the parameter.
b. Prompt: Enter a prompt for the parameter.
c. Required: Specify if the parameter is required or not.
d. Provide default value: Specify whether a default value is required. If this is selected, a default

value can then be entered in the Default value box.
e. Provide minumum value: Specity whether a minimum value is required. If this is selected, a

minimum value can then be entered in the  Minimum value box.
f. Provide maximum value: Specify whether a maximum value is required. If this is selected, a

maximum value can then be entered in the Maximum value box.
g. Promptable: Specifies if the parameter requires a prompt when used.

7. Click Apply and Close.

The new integer parameter appears in the list of parameters.

Adding a float parameter from the Workflow Settings
Adding a float parameter from the Settings of a Workflow file.

To add a float parameter:

1. Open an existing Workflow file in Altair Analytics Workbench, or create a new one.
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2. Click Workflow Settings ( ) at the base of the screen.

3. From the left-hand pane, click Parameters.
4. Click Add.

A Create Parameter dialog box opens.
5. Complete the Create Parameter dialog box as follows:

a. Name: Enter a name for the parameter. This will be used to refer to the parameter elsewhere in
Workflow.

b. Type: From the list, select Float.
6. Complete the following optional arguments as required:

a. Label: Enter a label for the parameter.
b. Prompt: Enter a prompt for the parameter.
c. Required: Specify if the parameter is required or not.
d. Default Value: Enter the default value that you want the parameter to have.
e. Minimum Value: Enter the minimum value that you want the parameter to have.
f. Maximum Value: Enter the maximum value that you want the parameter to have.
g. Promptable: Specifies if the parameter requires a prompt when used.

7. Click Apply and Close.

The new float parameter appears in the list of parameters.

Adding a boolean parameter from the Workflow Settings
Adding a parameter from the Settings of a Workflow file.

To add a parameter for use with a text or numeric entry box:

1. Open an existing Workflow file in Altair Analytics Workbench, or create a new one.
2. Click Workflow Settings ( ) at the base of the screen.

3. From the left-hand pane, click Parameters.
4. Click Add.

A Create Parameter dialog box opens.
5. Complete the Create Parameter dialog box as follows:

a. Name: Enter a name for the parameter. This will be used to refer to the parameter elsewhere in
Workflow.

b. Type: From the list, select Boolean.
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6. Complete the following optional arguments as required:

a. Label: Enter a label for the parameter.
b. Prompt: Enter a prompt for the parameter.
c. Required: Specify if the parameter is required or not.
d. Default Value: Enter the default value that you want the parameter to have. This can be True or

False.
e. Promptable: Specifies if the parameter requires a prompt when used.

7. Click Apply and Close.

The new boolean parameter appears in the list of parameters.

Adding a stream parameter from the Workflow Settings
Adding a stream parameter from the Settings of a Workflow file.

To add a stream parameter:

1. Open an existing Workflow file in Altair Analytics Workbench, or create a new one.
2. Click Workflow Settings ( ) at the base of the screen.

3. From the left-hand pane, click Parameters.
4. Click Add.

A Create Parameter dialog box opens.
5. Complete the Create Parameter dialog box as follows:

a. Name: Enter a name for the parameter. This will be used to refer to the parameter elsewhere in
Workflow.

b. Type: From the list, select Stream.
c. Content Type: Select the content type of the parameter. If you require a Custom content type,

click Select to open a Select content type dialog box, then use the drop down box to select a
content type, using the text box to filter.

d. Default File Location: Select the file source of the stream. If you have stored the file in your
Workbench Workspace, select Workspace, or if you have stored it in your file system select
External. Then under Path, either enter the filepath or click Browse, browse to the file and click
Finish

6. Complete the following optional arguments as required:

a. Label: Enter a label for the parameter.
b. Prompt: Enter a prompt for the parameter.
c. Required: Specify if the parameter is required or not.
d. Promptable: Specifies if the parameter requires a prompt when used.
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7. Click Apply and Close.

The new stream parameter appears in the list of parameters.

Adding a date parameter from the Workflow Settings
Adding a date parameter from the Settings of a Workflow file.

To add a date parameter:

1. Open an existing Workflow file in Altair Analytics Workbench, or create a new one.
2. Click Workflow Settings ( ) at the base of the screen.

3. From the left-hand pane, click Parameters.
4. Click Add.

A Create Parameter dialog box opens.
5. Complete the Create Parameter dialog box as follows:

a. Name: Enter a name for the parameter. This will be used to refer to the parameter elsewhere in
Workflow.

b. Type: From the list, select Date.
6. Complete the following optional arguments as required:

a. Label: Enter a label for the parameter.
b. Prompt: Enter a prompt for the parameter.
c. Required: Specify if the parameter is required or not.
d. Provide default date: Specify whether a default date is required. If this is selected, a default date

can then be entered in the Default date box.
e. Provide minimum date: Specify whether a minimum date is required. If this is selected, a

minimum date can then be entered in the  Minimum date box.
f. Provide maximum date: Specify whether a maximum date is required. If this is selected, a

maximum date can then be entered in the Maximum date box.
g. Promptable: Specifies if the parameter requires a prompt when used.

7. Click Apply and Close.

The new date parameter appears in the list of parameters.
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Adding a time parameter from the Workflow Settings
Adding a time parameter from the Settings of a Workflow file.

To add a time parameter:

1. Open an existing Workflow file in Altair Analytics Workbench, or create a new one.
2. Click Workflow Settings ( ) at the base of the screen.

3. From the left-hand pane, click Parameters.
4. Click Add.

A Create Parameter dialog box opens.
5. Complete the Create Parameter dialog box as follows:

a. Name: Enter a name for the parameter. This will be used to refer to the parameter elsewhere in
Workflow.

b. Type: From the list, select Time.
6. Complete the following optional arguments as required:

a. Label: Enter a label for the parameter.
b. Prompt: Enter a prompt for the parameter.
c. Required: Specify if the parameter is required or not.
d. Provide default time: Specify whether a default time is required. If this is selected, a default time

can then be entered in the Default time box.
e. Provide minimum time: Specify whether a minimum time is required. If this is selected, a

minimum time can then be entered in the  Minimum time box.
f. Provide maximum time: Specify whether a maximum time is required. If this is selected, a

maximum time can then be entered in the Maximum time box.
g. Promptable: Specifies if the parameter requires a prompt when used.

7. Click Apply and Close.

The new time parameter appears in the list of parameters.

Adding a date & time parameter from the Workflow
Settings
Adding a date & time parameter from the Settings of a Workflow file.

To add a date & time parameter :

1. Open an existing Workflow file in Altair Analytics Workbench, or create a new one.
2. Click Workflow Settings ( ) at the base of the screen.
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3. From the left-hand pane, click Parameters.
4. Click Add.

A Create Parameter dialog box opens.
5. Complete the Create Parameter dialog box as follows:

a. Name: Enter a name for the parameter. This will be used to refer to the parameter elsewhere in
Workflow.

b. Type: From the list, select Date & time.
6. Complete the following optional arguments as required:

a. Label: Enter a label for the parameter.
b. Prompt: Enter a prompt for the parameter.
c. Required: Specify if the parameter is required or not.
d. Provide default date and time: Specify whether a default date and time is required. If this is

selected, a default date and time can then be entered in the Default date and time box.
e. Provide minimum date and time: Specify whether a minimum date and time is required. If this is

selected, a minimum date & time can then be entered in the  Minimum date and time box.
f. Provide maximum date and time: Specify whether a maximum date and time is required. If this

is selected, a maximum date & time can then be entered in the Maximum date and time box.
g. Promptable: Specifies if the parameter requires a prompt when used.

7. Click Apply and Close.

The new date & time parameter appears in the list of parameters.

Adding a variable name parameter from the Workflow
Settings
Adding a variable name parameter from the Settings of a Workflow file.

This parameter type can only be added as part of a Custom block Workflow, for more information see
Creating a Custom block Workflow  (page 500). To add a variable name parameter:

1. Open an existing Workflow file in Altair Analytics Workbench, or create a new one.
2. Click Workflow Settings ( ) at the base of the screen.

3. From the left-hand pane, click Parameters.
4. Click Add.

A Create Parameter dialog box opens.
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5. Complete the Create Parameter dialog box as follows:

a. Name: Enter a name for the parameter. This will be used to refer to the parameter elsewhere in
Workflow.

b. Type: From the list, select Variable Name.
6. Complete the following optional arguments as required:

a. Label: Enter a label for the parameter.
b. Prompt: Enter a prompt for the parameter.
c. Required: Specify if the parameter is required or not.
d. Variable type: Specify a required variable type.
e. Promptable: Specify if the parameter is promptable or not.

7. Click Apply and Close.

The new variable name parameter appears in the list of parameters.

Adding a dataset parameter from the Workflow Settings
Adding a dataset parameter from the Settings of a Workflow file.

This parameter type can only be added as part of a Custom block Workflow, for more information see
Creating a Custom block Workflow  (page 500). To add a dataset parameter:

1. Open an existing Workflow file in Altair Analytics Workbench, or create a new one.
2. Click Workflow Settings ( ) at the base of the screen.

3. From the left-hand pane, click Parameters.
4. Click Add.

A Create Parameter dialog box opens.
5. Complete the Create Parameter dialog box as follows:

a. Name: Enter a name for the parameter. This will be used to refer to the parameter elsewhere in
Workflow.

b. Type: From the list, select Dataset.
c. Default File Location: Select the file source of the dataset. If you have stored the file in your

Workbench Workspace, select Workspace and if you have stored it in your file system select
External. Then under Path, either enter the filepath or click Browse, browse to the file and click
Finish

d. Required Variables: Select all required variables from the dataset. To do this, move all required
variables from the Unselected Required Variables list to the Selected Required Variables
list by either double clicking each variable or selecting one or more variables and using the
corresponding arrow buttons.
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6. Complete the following optional arguments as required:

a. Label: Enter a label for the parameter.
b. Prompt: Enter a prompt for the parameter.
c. Required: Specify if the parameter is required or not.
d. Promptable: Specifies if the parameter requires a prompt when used.

7. Click Apply and Close.

The new dataset parameter appears in the list of parameters.

Adding a parameter from its place of use
Adding a parameter from the location in the user interface that you want the parameter to be used.

To add a parameter from its place of use:

1. Open an existing Workflow file in Altair Analytics Workbench, or create a new one.
2. Locate the Workflow block configuration window that contains the entry box you want to use a

parameter with. Click the small blue ring to the right of the box: .

3. Click Add Binding.

A Bind Workflow Parameters window appears.
4. Click Add parameter ( ).

A Create Parameter window opens.
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5. Complete the Create Parameter window as follows:

a. Name: Enter a name for the parameter. This will be used to refer to the parameter elsewhere in
Workflow.

b. Type: This will be greyed out if only one type is applicable. Otherwise, choose the type of the
variable from:

• String: Alphanumeric and used in fields that accept a character input (such as names and
labels).

• Number: Numeric and used in fields that accept a numeric input.
• Boolean: True or false.
• Password: String recommended for use in fields as a password.
• Password: String recommended for use in fields as a password.
• Float: Numeric and used in fields for numbers containing a decimal, for example, irrational

numbers.
• Integer: Numeric and used in fields for integers.
• Choice: Used as a selection from a pre-defined list.
• Date: Used for fields with the format dd/mm/yyyy.
• Time: Used for fields with the format hh:mm representing a 24 hour clock.
• Date & Time: Used for fields with the format dd/mm/yyyy hh:mm.

c. Complete any other required options for your specified parameter type. More information for
specific parameter type dialog boxes can be found in the Adding a parameter from the Workflow 
Settings  (page 185) section.

6. Click OK.
7. At the Bind Workflow Parameters window, click OK.

Viewing parameters
Viewing parameters from the Settings tab of a Workflow file.

To view a list of parameters:

1. Open an existing Workflow file in Altair Analytics Workbench, or create a new one.
2. Click Workflow Settings ( ) at the base of the screen.

3. From the left-hand pane, click Parameters.

A list of parameters is displayed.
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Editing a parameter
Editing parameters using the Settings tab of a Workflow file.

Parameter names and values can be changed, but not parameter types (which could conflict with their
usage throughout the interface).

To edit a parameter:

1. Open an existing Workflow file in Altair Analytics Workbench, or create a new one.
2. Click Workflow Settings ( ) at the base of the screen.

3. From the left-hand pane, click Parameters.
4. Select a Parameter and click Edit Parameter.

An Edit Parameter window opens.
5. Change the Name or Value of the Parameter as required.
6. Click OK.

The parameter has now been edited. An alternative method for editing local parameter values for specific
Workflows is to right click the Workflow canvas and select Parameter values, then change the value as
required.

Deleting a parameter
Deleting parameters from the Settings tab of a Workflow file.

To delete a parameter:

1. Open an existing Workflow file in Altair Analytics Workbench, or create a new one.
2. Click Workflow Settings ( ) at the base of the screen.

3. From the left-hand pane, click Parameters.
4. Click the parameter that you want to delete.
5. Click Remove Parameter.

The parameter has now been deleted.

Binding a parameter to an option
Selected options throughout the Workflow Environment perspective can have parameters bound to them,
so that they take on the value of that parameter. This allows the values of variables to be defined once in
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a central location, and therefore edited only once if necessary. Parameters are defined for each Workflow
file, and can only be used within that file.

Before you begin, ensure that the Workflow file already has an appropriate parameter defined.

To bind an existing parameter to a variable:

1. Open an existing Workflow file in Altair Analytics Workbench, or create a new one.
2. Locate an input box that is compatible with the parameters function, which can be identified by a

small blue ring to the right of the box: .

3. Click the blue ring and then either:

• Click a parameter from the displayed list of compatible parameters.
• Click Add Binding  to display a Bind Workflow Parameter window, where you can choose a

Parameter and view its current Value. Once you have selected the parameter you want, click OK.

The chosen input box will now be greyed out and show the current value of the selected parameter. The

blue ring will become a solid circle ( ). The chosen variable and parameter are now linked; so if the

parameter is changed, the value of the chosen variable will take on this new value automatically.

Using parameters in code
In blocks that require code to function, for example the Mutate block, parameters can be referenced as
a macro processor statement by writing the parameter name, prefixed with an ampersand (&). These
statements are then resolved into the parameter value during block execution. For more information see
the section Macro processor statements in the Altair SLC Reference for Language Elements.

Before you begin, ensure that the Workflow file already has an appropriate parameter defined.

Note:
Parameters are currently not supported in the Python block or R block.

To use an existing parameter in code or an expression:

1. Open an existing Workflow file in Altair Analytics Workbench, or create a new one.
2. Locate a text or expression box that allows usage of parameters in SAS language and SQL language.
3. Reference the parameter by typing an ampersand (&), then the full name of the parameter. For

example a parameter named myPar  can be referenced by typing &myPar.

The chosen code or expression box will now contain a reference to the selected parameter, which
evaluates to the value upon block execution.   The parameter reference and parameter value are now
linked; so if the parameter is changed, the value of the parameter reference will take on this new value
automatically.
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Editing a parameter binding
Editing an existing parameter binding, assigning a different parameter to the variable in question.

To edit a parameter binding:

1. Open an existing Workflow file in Altair Analytics Workbench, or create a new one.
2. Locate a bound variable, which can be identified by a solid blue circle to the right of an input box:

.

3. Click the blue circle and then either:

• Click a parameter from the displayed list of compatible parameters.
• Click Edit Binding to display a Bind Workflow Parameter window, where you can choose a

Parameter and view its current Value. Once you have selected the parameter you want, click OK.

The parameter binding has now been edited.

Removing a parameter binding
Removing an existing parameter binding, returning the Workflow interface option to an editable box.
When a parameter binding is removed, the last entered value for the option is restored.

To remove a parameter binding:

1. Open an existing Workflow file in Altair Analytics Workbench, or create a new one.
2. Locate a bound variable, which can be identified by a solid blue circle to the right of an input box:

.

3. Click the blue circle and then click Remove Binding.

The parameter binding has now been removed.

Variable Lists
A Workflow can store global variables lists that can be used throughout the Workflow in places where
variables are specified. A variable list is an entity that consists of one or more variables. Variable lists are
saved with the Workflow they are created in and can only be used with that Workflow.

Variable lists can be created from the data profiler. The Settings tab is used to manage variable lists.

A variable list consists of:

• Name: Used to refer to the variable list when using or managing it.
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• Description: Used to give a description for the variable list when using or managing it.
• Variables: The variables used to make the variable list.

Creating a variable list from the Data Profiler
Creating a variable list from the Data Profiler view of a dataset.

To add a variable list for use with Workflow:

1. Open an existing Workflow file in Altair Analytics Workbench, or create a new one.
2. Import a dataset into the Workflow. Importing a dataset is described in the Workflow Block

Reference  (page 203).
3. Open the data profiler by right clicking on the dataset and selecting Open With.. and Data Profiler.

The data profiler opens in a new tab.
4. From the Variables pane in the Summary view tab, click Create variable list ( ).

A Create Variable List window opens. Alternatively, this can also be opened from the Univariable
View tab and Predictive Power tabs.

5. Complete the Create Variable List window as follows:

a. Name: Enter a name for the variable list. This is used to refer to the variable list elsewhere in
Workflow.

b. Description (optional): Enter a description for the variable list. This adds additional information
about the variable list.

c. Variables: Select the variables that you want to include in the variable list. To move an item from
one list to the other, double-click on it. Alternatively, click on the item to select it and use the
corresponding single arrow button. You can also select a contiguous list using Shift and click, or a
non-contiguous list by using Ctrl and click. Use the Select all button ( ) or Deselect all button

( ) to move all the items from one list to the other. Use the filter box ( ) on either list to limit

the variables displayed, either using a text filter, or a regular expression. This choice can be set
in the Altair page in the Preferences window. As you enter text or an expression in the box, only
those variables containing the text or expression are displayed in the list.

6. Click OK.

The new variable list is created and ready to use in the Workflow.
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Applying a variable list
Applying the variable list in the variable selection panel of a Workflow block.

To apply a variable list in the variable selection panel of a Workflow block:

1. Open an existing Workflow file in Altair Analytics Workbench, or create a new one.
2. Open the settings of a supported block that uses variable selection, for example the Select block.

From the variable selection pane, click Apply variable lists ( ).

3. Complete the Apply variable list window. To do this:

a. Select the Import box for each variable list you want to apply.
b. From the Import variables as: panel, select the list you want the variables in.

4. Click OK.

All variables in the variable list are added to the list in the variable selection panel.

Editing a variable list
Editing a variable list from the Workflow Settings dialog box.

To edit an existing variable list:

1. Open an existing Workflow file in Altair Analytics Workbench, or create a new one.
2. From the bottom left of the Workflow view, open the Workflow Settings.
3. From the Variable Lists tab, click Edit to open the Edit Variable List dialog box.
4. From the Edit Variable List window, you can change the following:

a. Name: The name of the variable list. This is used to refer to the variable list elsewhere in
Workflow.

b. Description: The description of the variable list. This adds additional information about the
variable list.

c. Variables: The variables included in the variable list. To move an item from one list to the other,
double-click on it. Alternatively, click on the item to select it and use the corresponding single
arrow button. You can also select a contiguous list using Shift and click, or a non-contiguous list
by using Ctrl and click. Use the Select all button ( ) or Deselect all button ( ) to move

all the items from one list to the other. Use the filter box ( ) on either list to limit the variables
displayed, either using a text filter, or a regular expression. This choice can be set in the Altair
page in the Preferences window. As you enter text or an expression in the box, only those
variables containing the text or expression are displayed in the list.
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5. Click on the Advanced option to display the following further options are available for Variables:

a. Treatment: Specifies the variable treatment; you can choose between Interval, Nominal or
Ordinal.

b. Dependent: Specifies whether the variable is dependent or not.
c. Target Category: Specifies the target value of a dependent variable.

6. Once you have finished editing, click OK.

The variable list is saved with your changes.

Importing a variable list
Importing the variable list in the variable selection panel of a Workflow block.

To import a variable list into the Workflow:.

1. Open an existing Workflow file in Altair Analytics Workbench, or create a new one.
2. From the bottom left of the Workflow view, open the Workflow Settings.
3. From the Variable Lists tab, click Import from File....
4. Complete the Import Variable Lists window. To do this:

a. Select Workspace or External and enter the filepath in Path, alternatively browse for the file by
selecting Browse...

b. Click OK to close the Import Variable Lists window.
5. Click Apply and Close.

The variable list has been imported into the Workflow.

Exporting a variable list
Exporting the variable list to an external file.

To export a variable list to an external file:

1. Open an existing Workflow file in Altair Analytics Workbench, or create a new one.
2. From the bottom left of the Workflow view, open the Workflow Settings.
3. From the Variable Lists tab, select a variable list from the table, then click Export to File....
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4. Complete the Export Variable Lists window. To do this:

a. Select the file type using the File type drop down list.
b. Select Workspace or External and enter the filepath in Path, alternatively click Browse... to

locate the file.
c. Click OK to close the Export Variable Lists window.

5. Click Apply and Close.

The variable list has been exported into a file from the Workflow.

Workflow block reference
This section is a guide to the blocks currently supported by the Workflow Editor view.

Blocks
Blocks are the individual items that make up a Workflow.

Blocks are used to represent:

• Datasets, either imported into the Workflow or created by the Workflow.
• Programming code such as Python language, R language or SAS language.
• Functionality that manipulates data to prepare a dataset for analysis.
• Modelling operations.

Blocks can be connected together to create a Workflow using connectors, or by docking blocks together.
Blocks typically contain an Output port and an Input port. These ports enable you to link the output from
one block to become the input to one or more other blocks. For example, Permanent Dataset blocks
have an Output port located at the bottom of the block:

Block input and output ports
Blocks that manipulate a dataset have an Input port located at the top of a block, and an Output port
located at the bottom of either the block, or the automatically-created output dataset of the block:
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The execution status in the Output port of the block indicates the state of the block when the Workflow is
run.

• If there are no errors and the block has run, the execution status is green.
• If the execution status is grey:

‣ There is an error in a connected upstream block.
‣ The block does not yet have an input.
‣ The block has Include in Auto Run disabled and a change has occurred.

• If the execution status is red there are errors in the block. You can review the error by reading the log
output. Blocks that execute SAS language code each contain their own log file; to view such a log,
right-click the block and click Open Log on the shortcut menu:

Block configuration status
The configuration status (the right-hand bar of a block) indicates whether all the required details have
been specified for the block. If the configuration status is grey, the block is complete and can be used in
a Workflow. If the configuration status is red, then some details are missing. In this event, hover over the
bar to see what information is required to complete the block:

Configuring blocks
To configure a block, either double-click on it, or right-click on it and click Configure. What happens next
depends on the block:
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• For some blocks, a configuration dialog box will open. Use the dialog box to specify settings for
the block. When finished, click OK to save the configuration, close the dialog box and return to the
Workflow.

• For other blocks, a full-screen editor will open. The title of the editor matches the block, so if you've
renamed the block, this new title will be used for identification purposes. Use the full-screen editor
to specify settings for the block. When finished, save the configuration by pressing Ctrl+S on the
keyboard or clicking the save icon on the toolbar. Click the cross to close the full-screen editor view
and return to the Workflow.

Inserting blocks
In an existing Workflow, it is possible to insert a new block between two connected blocks. To do this,
drag a new block between two existing connected blocks. Position the new block so its Input port meets
the output port of the block above it. The block turns yellow to indicate it can be dropped at that location
and connected. Only blocks that contain both an input and output port can be inserted, for example,
blocks from the Import group are not suitable.

Block shortcut menu
You can configure, modify and delete blocks functionality using the block's shortcut menu. To do this,
right-click the required block and choose the appropriate option:

• Copy Block - Copy the block to the clipboard so it can be subsequently pasted elsewhere, either
within the current Workflow or within another Workflow.

• Delete Block – remove the block from the Workflow. All connectors leading to and from the deleted
block are also removed.

• Rename Block – enter a new display label for the block.
• Remove output connection – delete a connector linked to the Output port of the block. If there are

multiple connections, you will see the option Remove connection to, which when highlighted opens
a further menu to select the connection required.

• Remove input connection – delete a connector linked to the Input port of the block. If there are
multiple connections, you will see the option Remove connection from, which when highlighted
opens a further menu to select the connection required.

• Configure – opens a configuration window or full screen editor to specify the details of the block.
• Configure Outputs. Some blocks have multiple possible outputs; clicking this option enables you to

choose which outputs you want the block to produce.

Some blocks have additions to the shortcut menu. For example, the Permanent Dataset block and
working datasets have Open  and Open with options that enable you to view the dataset content with
either the Dataset File viewer or in the Data Profiler view. You specify which viewer opens when you
click Open on the shortcut menu using the File Associations panel in the Preferences dialog box.

Where the block runs some SAS language code, for example the Partition block, the menu contains an
Open Log option that enables you to view the log created by the Workflow Engine. This log includes the
SAS language code run in the background by the block.

205



Altair Analytics Workbench user guide
Version 2023

Block Workflow palette
The Workflow palette provides tools to import and prepare datasets for analysis, and to then use those
datasets to create and train models for use in, for example, scoring applications.

Palette Settings
The Workflow palette can be configured by clicking the cog ( ) to open the Palette Settings dialog
box.

The following options are available in the Palette Settings dialog box:

Palette Groups
Defines the groups in the Workflow palette for editing.

Show
Specifies whether the palette group is visible in the Workflow or not.

Group Name
Specifies the name of the palette group.

Colour
Specifies the colour of the palette group.

Palette Blocks
Defines the blocks that belong to a palette group. Click on a palette group to display the
containing blocks.

Show
Specifies whether the block is visible in the Workflow or not.

Group Name
Specifies the name of the block.

Colour
Specifies the colour of the block.

Import group ...................................................................................................................................... 207
Contains blocks that enable you to import data into your Workflow.

Data Preparation group ..................................................................................................................... 229
Contains blocks that enable you to work with the datasets in your Workflow to create new,
modified datasets.

Code Blocks group ............................................................................................................................339
Contains blocks that enable you to add a new program to the Workflow.

Model Training group ........................................................................................................................ 349
Contains blocks that enable you to discover predictive relationships in your data.
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Scoring group .................................................................................................................................... 444
Contains blocks that enable you to analyse and score models.

Export group ......................................................................................................................................461
Contains blocks that enable you to export data from a Workflow.

SLC Hub group ................................................................................................................................. 491
Contains the blocks that enables you to deploy a Workflow to the Altair SLC Hub.

Custom .............................................................................................................................................. 498
Contains the Custom block that enables you to build a customised Workflow.

Import group
Contains blocks that enable you to import data into your Workflow.

Database Import block ...................................................................................................................... 208
Enables you to use a data source reference to connect to a relational database management
system (RDBMS) to import datasets from tables and views into a Workflow.

Excel Import block .............................................................................................................................209
Enables you to import a worksheet from a Microsoft Excel workbook.

JSON Import block ............................................................................................................................ 214
Enables you to import a JSON-format file into the Workflow.

Parameter Import block ..................................................................................................................... 216
Enables you to import one or more Workflow parameters into the Workflow as a dataset.

Permanent Dataset block .................................................................................................................. 218
Enables you to specify a WPD-format dataset to import into the Workflow.

Text File Import block ........................................................................................................................220
Enables you to import a text file into the Workflow. The file may have any file extension.

Dataset Import block ......................................................................................................................... 225
Enables you to import and configure one or more WPD format datasets (.wpd) into the Workflow.
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Database Import block

Enables you to use a data source reference to connect to a relational database management system
(RDBMS) to import datasets from tables and views into a Workflow.

You can use the Database Import block to import multiple tables and views into a Workflow in a single
step. The library reference used and available library connections stored with the Workflow are managed
using the Configure Database Import dialog box.

To open the Configure Database Import dialog box, double-click the Database Import block. If no
database is currently configured, an Add Database wizard will start to guide you through connecting to a
database. For help using the wizard, see Database References  (page 175).

This block may be invoked by dragging a database table from the Database Explorer panel onto the
Workflow canvas.

Database
Specifies the source database used. If any databases have already been configured with
Workflow, these are available to choose from in the drop-down list. To add another database, click
the Create a new database button ( ) to open an Add Database wizard. For help using the
wizard, see Database References  (page 175).

Tables
Displays the tables defined in the specified database. The upper list of Unselected Tables shows
tables that can be specified for inclusion, and the lower list of Selected Tables shows tables that
have been specified for inclusion. To move an item from one list to the other, double-click on it.
Alternatively, click on the item to select it and use the appropriate single arrow button. A selection
can also be a contiguous list chosen using Shift and click, or a non-contiguous list using Ctrl and
click. Use the Select all button ( ) or Deselect all button ( ) to move all the items from one

list to the other. Use the Apply variable lists button ( ) to move a set of variables from one

list to another. Use the filter box ( ) on either list to limit the variables displayed, either using a
text filter, or a regular expression. This choice can be set in the Altair page in the Preferences
window. As you enter text or an expression in the box, only those variables containing the text or
expression are displayed in the list.

Views
Displays the views defined in the specified database. Views are a table-like object displaying
the data from one or more tables that meet the selection requirements of the view. The upper
list of Unselected Views shows views that can be specified for inclusion, and the lower list of
Selected Views shows views that have been specified for inclusion. To move an item from one list
to the other, double-click on it. Alternatively, click on the item to select it and use the appropriate
single arrow button. A selection can also be a contiguous list chosen using Shift and click, or a
non-contiguous list using Ctrl and click. Use the Select all button ( ) or Deselect all button

( ) to move all the items from one list to the other. Use the Apply variable lists button ( )
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to move a set of variables from one list to another. Use the filter box ( ) on either list to limit the
variables displayed, either using a text filter, or a regular expression. This choice can be set in the
Altair page in the Preferences window. As you enter text or an expression in the box, only those
variables containing the text or expression are displayed in the list.

Output
Output datasets from the Database Import block ( ) are references to the tables stored in the

database. Data from these tables are not copied to the Workflow until required by another block.
If required, the table can be copied to the Workflow using the Copy block. Using these tables
with other Workflow blocks can be more efficiently carried out by the database server by passing
the functionality to the server for processing and importing the results into the Workflow. This can
improve performance in the Workflow that would otherwise import and process large amounts of
data.

Excel Import block

Enables you to import a worksheet from a Microsoft Excel workbook.

This block can be invoked in two ways:

• By dragging an Excel Import block onto the Workflow canvas, then configuring the block to specify
one or more datasets.

• By dragging a Microsoft Excel workbook file onto the Workflow canvas, then opening the block's
configuration page and confirming the configuration.

Once the Excel Import block is on the Workflow canvas, double-click it to open the Configure Excel
Import dialog box. If you choose to invoke the block by dragging an Excel file onto the Workflow canvas,
before the block can be used you must first open the Configure Excel Import dialog box and confirm its
settings by clicking OK.

You can import data from a single sheet or a named range in a Workbook. Headers can be imported as
the names of variables and the data types modified during import.

Options in the Configure Excel Import dialog box are as follows:

File Tab
File Properties

Specifies where the file is stored.

Workspace
Specifies that the location of the file is in the current workspace.

Workpace files specified using Workspace can only be imported when using the Local
Engine.
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External
Specifies that the location of the file is on the file system accessible from the device running
the Workflow Engine.

External files specified using External can be imported when using either a Local Engine
or a Remote Engine.

Path
Specifies the full path for the file containing the required dataset. If you enter the path:

• When importing a dataset from the Workspace, the root of the path is the Workspace. For
example, to import a file from a project named datasets, the path is:

/datasets/filename

.
• When importing a file from an external location, the path is the absolute (full) path to the file

location.

The path to the file is only valid for the Workflow Engine enabled when the Workflow is created.
This path will need to be re-entered if the Workflow is used with a different Workflow Engine.

If you do not know the path to the file, click Browse and navigate to the required dataset in the
Choose file dialog box.

Data Format
Specifies the import range and formats of the variables in the working dataset.

Locale
Specifies the locale of the dataset. Options include:

• English/UK
• English/US
• French/France
• Spanish/Spain
• Japanese/Japan

Sheets
Import data from a sheet in the workbook. Available sheets are listed in the Sheets box.

Named Ranges
Import data from a named range on a sheet in the workbook. Available named-ranges are
listed in the Name box.

Use first row as headers
Specifies the data contains column labels in the first row that are variable labels and not
part of the imported data. The headers become the variable name and label displayed in
the Data Profiler view.

Preview
Displays a preview of the dataset being imported
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When importing a dataset from the Workspace, the preview section will show the output rows and
columns of the dataset. Columns can be reconfigured in the Column Properties tab if the output
is unexpected.

Column selection tab
Specifies the columns to select for output.

Unselected Variables and Selected Variables
Allows you to specify variables for the output dataset. The two boxes show Unselected
Variables and Selected Variables. To move an item from one list to the other, double-click on it.
Alternatively, click on the item to select it and use the appropriate single arrow button. A selection
can also be a contiguous list chosen using Shift and click, or a non-contiguous list using Ctrl and
click. Use the Select all button ( ) or Deselect all button ( ) to move all the items from one

list to the other. Use the Apply variable lists button ( ) to move a set of variables from one

list to another. Use the filter box ( ) on either list to limit the variables displayed, either using a
text filter, or a regular expression. This choice can be set in the Altair page in the Preferences
window. As you enter text or an expression in the box, only those variables containing the text or
expression are displayed in the list.

Preview
Displays a preview of the dataset being imported

When importing a dataset from the Workspace, the preview section will show the output rows and
columns of the dataset.

Column Properties tab
Column Properties

Automatically rename
Specifies any variable containing invalid characters is renamed by changing any invalid
character to an underscore.

Restore defaults
Changes any edited variable names back to its original name.

Original Name
Specifies the original name of each variable before any changes.

Name
Specifies the name of each variable in the output dataset.

Label
Specifies the label of each variable in the output dataset.
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Type
Specifies the type of each variables. This determines the options available in the Input
format and Output format columns. The following options are available:

Character
Specifies the column as a character type in the working dataset. The Width specified
determines the maximum length of the character string in the working dataset.

Numeric
Specifies the column as a numeric type in the working dataset.

Date
Specifies the column as a date type in the working dataset.

Custom
Specifies a custom format for the column in the working dataset. Text boxes are
displayed in the Input format and Output format columns to type in, instead of drop-
down boxes.

Date & time
Specifies the column as a date-time type in the working dataset.

Time
Specifies the column as a time type in the working dataset.

Width
Specifies the width of each character variable in the output dataset.

Input format
Specifies a format to assign to each variable during the data reading process.

Output format
Specifies the format for each variable for presenting on output.

Preview
Displays a preview of the dataset being imported.

When importing a dataset from the Workspace, the preview section will show the output rows and
columns of the dataset.

Errors tab
Remove rows with errors

Allows you to remove rows that contain errors from the output dataset. An error occurs in a row if
one or more of its values isn't parsed correctly, for example applying a numeric format to a string
value. A separate dataset containing the errors is made available through the Configure Outputs 
option when right-clicking the block.

Preview
Displays a preview of the dataset being imported.
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When importing a dataset from the Workspace, the preview section will show the output rows and
columns of the dataset.

Excel Import block basic example

This example demonstrates how the Excel Import block can be used to import a Microsoft Excel file
(.xlsx).

In this example, a dataset in Microsoft Excel Workbook format named bananas.xlsx is imported into a
blank Workflow.

Workflow Layout

Dataset used

The file used in this example can be found in the samples distributed with Altair SLC.

This example uses a dataset in Microsoft Excel Workbook format named bananas.xlsx. Each
observation in the dataset describes a banana, with numeric variables Length(cm) and Mass(g) giving
each banana's measured length in centimetres and mass in grams respectively.

Importing a Microsoft Excel file using the Excel Import block

Using the Excel Import block to import data from a Microsoft Excel Workbook file into a Workflow.

1. Expand the Import group in the Workflow palette, then click and drag an Excel Import block onto the
Workflow canvas.

2. Double-click on the Excel Import block.

A Configure Excel Import dialog box opens.
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3. In the Configure Excel Import dialog box:

a. Under File Properties, if you have stored bananas.xlsx in your Workbench Workspace, select
Workspace, otherwise select External.

b. Under Path, either enter the filepath, including the filename for bananas.xlsx; or click Browse,
browse to the file and click Finish.

A preview of the specified Microsoft Excel Workbook file is displayed in the Preview pane.
c. In the Sheets drop-down list, select Sheet1.
d. Select the Use first row as headers checkbox.

The Column Types box is populated with the variables from the dataset, showing their column
name and type.

e. Click Apply and Close.

The Configure Excel Import dialog box closes. A green execution status is displayed in the
Output port of the Excel Import block and the Output port of the Working Dataset.

You now have imported a Microsoft Excel Workbook file onto the Workflow canvas. An alternative
method for importing this file is to click and drag bananas.xlsx from your Workbench Workspace or
File Explorer onto the Workflow canvas, then repeat steps 2 and 3.c to 3.e inclusive.

JSON Import block

Enables you to import a JSON-format file into the Workflow.

This block can be invoked in two ways:

• By dragging a JSON Import block onto the Workflow canvas, then configuring the block to specify
one or more datasets.

• By dragging a JSON-format file onto the Workflow canvas, then opening the block's dialog box and
confirming the configuration.

If you choose to invoke the block by dragging a JSON formatted file onto the Workflow canvas, before
the block can be used, you must first open the Configure JSON Import dialog box and confirm its
settings by clicking OK.

Once the JSON Import block is on the Workflow canvas, double-click it to open the Configure JSON
Import dialog box. Options in the Configure JSON Import dialog box are as follows:

Workspace
Specifies that the location of the file is in the current workspace.

Workpace files specified using Workspace can only be imported when using the Local
Engine.
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External
Specifies that the location of the file is on the file system accessible from the device running
the Workflow Engine.

External files specified using External can be imported when using either a Local Engine
or a Remote Engine.

Path
Specifies the full path for the file containing the required dataset. If you enter the path:

• When importing a dataset from the Workspace, the root of the path is the Workspace. For
example, to import a file from a project named datasets, the path is:

/datasets/filename

.
• When importing a file from an external location, the path is the absolute (full) path to the file

location.

The path to the file is only valid for the Workflow Engine enabled when the Workflow is created.
This path will need to be re-entered if the Workflow is used with a different Workflow Engine.

If you do not know the path to the file, click Browse and navigate to the required dataset in the
Choose file dialog box.

JSON Import block basic example

This example demonstrates how the JSON Import block can be used to import a JSON data file (.json).

In this example, a dataset named results.json is imported into a blank Workflow.

Workflow Layout

Dataset used

The file used in this example can be found in the samples distributed with Altair SLC.

This example uses a dataset named results.json. Each entry in the dataset describes results of a
football match, with variables such as Home, Away and PlayedOn.
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To create this dataset, go to the Samples folder in your Altair SLC installation and run the SAS language
script 14.0-json-procedure.sas. Replace instances of <file-path> with a valid file path on your
machine.

Importing a JSON data file using the JSON Import block

Using the JSON Import block to import a dataset in JSON format into a Workflow.

1. Expand the Import group in the Workflow palette, then click and drag a JSON Import block onto the
Workflow canvas.

2. Double-click on the JSON Import block.

A Configure JSON Import dialog box opens.
3. In the Configure JSON Import dialog box:

a. Under Path, either enter the filepath, including the filename results.json, or click Browse,
browse to the file and click Finish.

b. Click Apply and Close.

The Configure JSON Import dialog box closes. The datasets are created underneath the JSON
Import block and a green execution status is displayed in the Output port.

You have now imported a JSON file onto the Workflow canvas.

Parameter Import block

Enables you to import one or more Workflow parameters into the Workflow as a dataset.

The Parameter Import block can be invoked by dragging the block onto the Workflow canvas and
configuring the block to specify one or more parameters. The Parameter Import block, then generates
an output dataset containing those parameters.

The importing of parameters into the Workflow is configured using the Configure Parameter Import
dialog box. To open the Configure Parameter Import dialog box, double-click the Parameter Import
block.

Unselected Parameters and Selected Parameters
Allows you to specify parameters for the output dataset. The two boxes show Unselected
Parameters and Selected Parameters. To move an item from one list to the other, double-click
on it. Alternatively, click on the item to select it and use the appropriate single arrow button. A
selection can also be a contiguous list chosen using Shift and click, or a non-contiguous list using
Ctrl and click. Use the Select all button ( ) or Deselect all button ( ) to move all the items

from one list to the other. Use the Apply variable lists button ( ) to move a set of variables
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from one list to another. Use the filter box ( ) on either list to limit the variables displayed,
either using a text filter, or a regular expression. This choice can be set in the Altair page in
the Preferences window. As you enter text or an expression in the box, only those variables
containing the text or expression are displayed in the list.

Parameter Import block basic example

This example demonstrates how the Parameter Import block can be used to import a WPD data file
(.wpd).

In this example, a parameter named Parameter1 is imported into a blank Workflow as a dataset.

Workflow Layout

Importing a parameter using the Parameter Import block

Using the Parameter Import block to output a parameter into a Workflow as a dataset.

1. Click the Settings tab under the Workflow, from the left-hand pane select Parameters, then click the
Add button.

A Create Parameter dialog box opens.
2. In the Create Parameter dialog box:

a. Under Name type Parameter1.
b. Under Default value type test.
c. Click Apply and Close.

The Create Parameter dialog box closes.
3. Expand the Import group in the Workflow palette, then click and drag a Parameter Import block onto

the Workflow canvas.
4. Double-click on the Parameter Import block.

A Configure Parameter Import dialog box opens.
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5. From the Configure Parameter Import dialog box:

a. From the Unselected Parameters box, double-click on Parameter1 to move it to the Selected
Parameters box.

b. Click Apply and Close.

The Configure Parameter Import dialog box closes. A green execution status is displayed in the
Output ports of the Parameter Import block and of the new dataset Working Dataset.

You have now imported a parameter onto the Workflow canvas as a dataset.

Permanent Dataset block

Enables you to specify a WPD-format dataset to import into the Workflow.

This block can be invoked by dragging a Configure Permanent Dataset dialog box onto the Workflow
canvas, then configuring the block to specify a dataset to import.

The dataset can be imported from a project in the current workspace, or from a location on the file
system. Importing a dataset is configured using the Configure Permanent Dataset dialog box.

Note:
You can also specify .sas7bdat file format datasets for this block to import into the Workflow.

To open the Configure Permanent Dataset dialog box, double-click the Permanent Dataset block.

Workspace
Specifies that the location of the file is in the current workspace.

Workpace files specified using Workspace can only be imported when using the Local
Engine.

External
Specifies that the location of the file is on the file system accessible from the device running
the Workflow Engine.

External files specified using External can be imported when using either a Local Engine
or a Remote Engine.

Path
Specifies the full path for the file containing the required dataset. If you enter the path:

• When importing a dataset from the Workspace, the root of the path is the Workspace. For
example, to import a file from a project named datasets, the path is:

/datasets/filename

.
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• When importing a file from an external location, the path is the absolute (full) path to the file
location.

The path to the file is only valid for the Workflow Engine enabled when the Workflow is created.
This path will need to be re-entered if the Workflow is used with a different Workflow Engine.

If you do not know the path to the file, click Browse and navigate to the required dataset in the
Choose file dialog box.

Permanent Dataset block basic example

This example demonstrates how the Permanent Dataset block can be used to import a WPD data file
(.wpd).

In this example, a dataset named bananas.wpd is imported into a blank Workflow.

Workflow Layout

Dataset used

The file used in this example can be found in the samples distributed with Altair SLC.

This example uses a dataset named bananas.wpd. Each observation in the dataset describes a
banana, with numeric variables Length(cm) and Mass(g) giving each banana's measured length in
centimetres and mass in grams respectively.

Importing a WPD data file using the Permanent Dataset block

Using the Permanent Dataset block to import a dataset in WPD format into a Workflow.

1. Expand the Import group in the Workflow palette, then click and drag a Permanent Dataset block
onto the Workflow canvas.

2. Double-click on the Permanent Dataset block.

A Configure Permanent Dataset dialog box opens.
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3. In the Configure Permanent Dataset dialog box:

a. Under Path, either enter the filepath, including the filename for bananas.wpd; or click Browse,
browse to the file and click Finish.

b. Click Apply and Close.

The Configure Permanent Dataset dialog box closes. The name of the Permanent Dataset
block changes to the dataset name, bananas and a green execution status is displayed in the
Output port.

You have now imported a WPD file onto the Workflow canvas.

Text File Import block

Enables you to import a text file into the Workflow. The file may have any file extension.

This block can be invoked in two ways:

• By dragging a Text File Import block onto the Workflow canvas, then configuring the block to specify
one or more datasets.

• By dragging a text file onto the Workflow canvas, then opening the block's configuration page and
confirming the configuration.

Importing a dataset is configured using the Configure Text File Import dialog box. To open the
Configure Text File Import dialog box, double-click the Text File Import block

File Tab
File Properties

Specifies where the file is stored.

Workspace
Specifies that the location of the file is in the current workspace.

Workpace files specified using Workspace can only be imported when using the Local
Engine.

External
Specifies that the location of the file is on the file system accessible from the device running
the Workflow Engine.

External files specified using External can be imported when using either a Local Engine
or a Remote Engine.

URL
Specifies that the location of the dataset is hosted on a web site accessible from the device
running the Workflow Engine. Only files specified using the HTTP or HTTPS protocols can
be imported.
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Path
Specifies the full path for the file containing the required dataset. If you enter the path:

• When importing a dataset from the Workspace, the root of the path is the Workspace. For
example, to import a file from a project named datasets, the path is:

/datasets/filename

.
• When importing a file from an external location, the path is the absolute (full) path to the file

location.

The path to the file is only valid for the Workflow Engine enabled when the Workflow is created.
This path will need to be re-entered if the Workflow is used with a different Workflow Engine.

If you do not know the path to the file, click Browse and navigate to the required dataset in the
Choose file dialog box.

Encoding
Specifies the character encoding of the dataset. Options include:

• UTF-8
• UTF-16
• UTF-32
• Windows Latin 1
• Latin 1
• Latin 9
• Shift JIS

Defaults to: UTF-8.

Data Format
Specifies the file delimiter and formats of the variables in the working dataset.

Delimiter
Specifies the character used to mark the boundary between variables in an observation of
the imported dataset.

If the required delimiter is not listed, select Other and enter the character to use as the
delimiter for the imported dataset.

Locale
Specifies the locale of the dataset.

Use first row as headers
Specifies the data contains column labels in the first row that are variable labels and not
part of the imported data. The headers become the variable name and label displayed in
the Data Profiler view.
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Preview
Displays a preview of the dataset being imported.

When importing a dataset from the Workspace, the preview section will show the output rows and
columns of the dataset. Columns can be reconfigured in the Column Properties tab if the output
is unexpected.

Column selection tab
Specifies the columns to select for output.

Unselected Variables and Selected Variables
Allows you to specify variables for the output dataset. The two boxes show Unselected
Variables and Selected Variables. To move an item from one list to the other, double-click on it.
Alternatively, click on the item to select it and use the appropriate single arrow button. A selection
can also be a contiguous list chosen using Shift and click, or a non-contiguous list using Ctrl and
click. Use the Select all button ( ) or Deselect all button ( ) to move all the items from one

list to the other. Use the Apply variable lists button ( ) to move a set of variables from one

list to another. Use the filter box ( ) on either list to limit the variables displayed, either using a
text filter, or a regular expression. This choice can be set in the Altair page in the Preferences
window. As you enter text or an expression in the box, only those variables containing the text or
expression are displayed in the list.

Preview
Displays a preview of the dataset being imported.

When importing a dataset from the Workspace, the preview section will show the output rows and
columns of the dataset.

Column Properties tab
Column Properties

Automatically rename
Specifies any variable containing invalid characters is renamed by changing any invalid
character to an underscore.

Restore defaults
Changes any edited variable names back to its original name.

Original Name
Specifies the original name of each variable before any changes.

Name
Specifies the name of each variable in the output dataset.

Label
Specifies the label of each variable in the output dataset.
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Type
Specifies the type of each variables. This determines the options available in the Input
format and Output format columns. The following options are available:

Character
Specifies the column as a character type in the working dataset. The Width specified
determines the maximum length of the character string in the working dataset.

Numeric
Specifies the column as a numeric type in the working dataset.

Date
Specifies the column as a date type in the working dataset.

Custom
Specifies a custom format for the column in the working dataset. Text boxes are
displayed in the Input format and Output format columns to type in, instead of drop-
down boxes

Date & time
Specifies the column as a date-time type in the working dataset.

Time
Specifies the column as a time type in the working dataset.

Width
Specifies the width of each character variable in the output dataset.

Input format
Specifies a format to assign to each variable during the data reading process.

Output format
Specifies the format for each variable for presenting on output.

Preview
Displays a preview of the dataset being imported.

When importing a dataset from the Workspace, the preview section will show the output rows and
columns of the dataset.

Errors tab
Remove rows with errors

Allows you to remove rows that contain errors from the output dataset. An error occurs in a row if
one or more of its values isn't parsed correctly, for example applying a numeric format to a string
value. A separate dataset containing the errors is made available through the Configure Outputs 
option when right-clicking the block.

Preview
Displays a preview of the dataset being imported.
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When importing a dataset from the Workspace, the preview section will show the output rows and
columns of the dataset.

Text File Import block basic example

This example demonstrates how the Text File Import block can be used to import a comma separated
value file (.csv).

In this example, a dataset named bananas.csv is imported into a blank Workflow.

Workflow Layout

Dataset used

The file used in this example can be found in the samples distributed with Altair SLC.

This example uses a dataset named bananas.csv. Each observation in the dataset describes a
banana, with numeric variables Length(cm) and Mass(g) giving each banana's measured length in
centimetres and mass in grams respectively.

Importing a text data file using the Text File Import block

Using the Text File Import block to import data into a Workflow, with entries separated by a common
value (delimiter).

1. Expand the Import group in the Workflow palette, then click and drag a Text File Import block onto
the Workflow canvas.

2. Double-click on the Text File Import block.

A Configure Text File Import dialog box opens.
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3. In the Configure Text File Import dialog box:

a. Under File Properties, if you have stored bananas.csv in your Workbench Workspace, select
Workspace and if you have stored it in your file system select External.

b. Under Path, either enter the filepath, including the filename for bananas.csv; or click Browse,
browse to the file and click Finish.

A preview of the specified file is displayed in the Preview pane.
c. In the Delimiter drop-down list, select Comma.
d. In the Locale drop-down list, select English/UK.
e. Select the Use first row as headers checkbox.

The Preview pane will update, with headers for each column.
f. Click Apply and Close.

The Configure Text File Import dialog box closes. A green execution status is displayed in the
Output port of the Text File Import block and the Output port of the Working Dataset.

You now have imported a CSV file onto the Workflow canvas. An alternative method for importing this file
is to click and drag Bananas.csv from your Workbench Workspace or File Explorer onto the Workflow
canvas, then repeat steps 2 and then 3.c to 3.f inclusive.

Dataset Import block

Enables you to import and configure one or more WPD format datasets (.wpd) into the Workflow.

This block can be invoked in two ways:

• By dragging a Dataset Import block onto the Workflow canvas, then configuring the block to specify
one or more datasets. When browsing for a file, multiple WPD files can be specified by using CTRL or
SHIFT and clicking. If more than one WPD file is specified, these files are concatenated together into
one output.

• By dragging a WPD file onto the Workflow canvas.

Importing a dataset is configured using the Configure Dataset Import dialog box. To open the
Configure Dataset Import dialog box, double-click the Dataset Import block.

Workspace
Specifies that the location of the file is in the current workspace.

Workpace files specified using Workspace can only be imported when using the Local
Engine.

External
Specifies that the location of the file is on the file system accessible from the device running
the Workflow Engine.
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External files specified using External can be imported when using either a Local Engine
or a Remote Engine.

Path
Specifies the full path for the file containing the required dataset. If you enter the path:

• When importing a dataset from the Workspace, the root of the path is the Workspace. For
example, to import a file from a project named datasets, the path is:

/datasets/filename

.
• When importing a file from an external location, the path is the absolute (full) path to the file

location.

The path to the file is only valid for the Workflow Engine enabled when the Workflow is created.
This path will need to be re-entered if the Workflow is used with a different Workflow Engine.

If you do not know the path to the file, click Browse and navigate to the required dataset in the
Choose file dialog box.

Import Policy
Specifies the treatment of the file once imported.

Import once
Specifies the dataset is preserved through any changes to the original file.

Re-import if input dataset is out of date
Specifies the dataset is re-imported if any changes are made to the original file.

Note:
These options are currently only available for locally stored datasets, and not any stored on a
remote server.

Unselected Variables and Selected Variables
Allows you to specify variables for the output dataset. The two boxes show Unselected
Variables and Selected Variables. To move an item from one list to the other, double-click on it.
Alternatively, click on the item to select it and use the appropriate single arrow button. A selection
can also be a contiguous list chosen using Shift and click, or a non-contiguous list using Ctrl and
click. Use the Select all button ( ) or Deselect all button ( ) to move all the items from one

list to the other. Use the Apply variable lists button ( ) to move a set of variables from one

list to another. Use the filter box ( ) on either list to limit the variables displayed, either using a
text filter, or a regular expression. This choice can be set in the Altair page in the Preferences
window. As you enter text or an expression in the box, only those variables containing the text or
expression are displayed in the list.
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Dataset Import block basic example

This example demonstrates how the Dataset Import block can be used to import a WPD data file (.wpd).

In this example, a dataset named bananas.wpd is imported into a blank Workflow.

Workflow Layout

Dataset used

The file used in this example can be found in the samples distributed with Altair SLC.

This example uses a dataset named bananas.wpd. Each observation in the dataset describes a
banana, with numeric variables Length(cm) and Mass(g) giving each banana's measured length in
centimetres and mass in grams respectively.

Importing a WPD data file using the Dataset Import block

Using the Dataset Import block to import a dataset in WPD format into a Workflow.

1. Expand the Import group in the Workflow palette, then click and drag a Dataset Import block onto
the Workflow canvas.

2. Double-click on the Dataset Import block.

A Configure Dataset Import dialog box opens.
3. In the Configure Dataset Import dialog box:

a. If you have stored bananas.wpd in your Workbench Workspace, select Workspace, otherwise
select External.

b. Click Browse.

A Choose file dialog box opens.
c. From the Choose file dialog box, select both files using CTRL and clicking.
d. Click Apply and Close.

The Configure Dataset Import dialog box closes. The name of the Dataset Import block
changes to the dataset name, bananas.wpd and a green execution status is displayed in the
Output port.
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You have now imported a WPD file onto the Workflow canvas. An alternative method for importing
this file is to click and drag bananas.wpd from your Workbench Workspace or File Explorer onto the
Workflow canvas.

Dataset Import block example: importing multiple datasets as one
output

This example demonstrates how the Dataset Import block can be used to import two WPD data files
(.wpd) and concatenate the results into a singular output.

In this example, two datasets named blood_pressure_old.wpd and blood_pressure_new.wpd
are imported into a blank Workflow.

Workflow Layout

Dataset used

The files used in this example can be found in the samples distributed with Altair SLC.

The datasets used in this example are:

• A dataset about loans, named blood_pressure_old.wpd. Each observation in the dataset
describes a blood pressure reading, with variables such as Date, Sys and Pulse.

• A more recent dataset, also about blood pressure, named blood_pressure_new.wpd. This
dataset contains the same variables as blood_pressure_old.wpd.

Importing two WPD data files into one output using the Dataset Import block

Using the Dataset Import block to import a dataset in WPD format into a Workflow.

1. Expand the Import group in the Workflow palette, then click and drag a Dataset Import block onto
the Workflow canvas.

2. Double-click on the Dataset Import block.

A Configure Dataset Import dialog box opens.
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3. In the Configure Dataset Import dialog box:

a. Under File Location, if you have stored blood_pressure_old.wpd and
blood_pressure_new.wpd in your Workbench Workspace, select Workspace, otherwise
select External.

b. Click Browse.

A Choose file dialog box opens.
c. From the Choose file dialog box, select both files using CTRL and clicking.
d. Close all the dialog boxes by clicking Apply and Close on each one.

The Configure Dataset Import dialog box closes. A green execution status is displayed in the
Output port.

You have now imported several WPD files, concatenated to one output onto the Workflow canvas.

Data Preparation group
Contains blocks that enable you to work with the datasets in your Workflow to create new, modified
datasets.

Aggregate block ................................................................................................................................ 231
Enables you to apply a function to create a single value from a set of variable values grouped
together using other variables in the input dataset.

Binning block .....................................................................................................................................237
Enables you to bin a variable in a dataset. This block can then output a dataset including a new
variable showing a bin allocation for each observation. The block can also be configured to output
a binning model.

Copy block ........................................................................................................................................ 243
Enables you to duplicate an existing dataset.

Deduplicate block .............................................................................................................................. 244
Enables you to remove duplicate rows from an input dataset.

Filter block .........................................................................................................................................248
Enables you to reduce the total number of observations in a large dataset by selecting
observations based on the value of one or more variables.

Impute block ...................................................................................................................................... 261
Enables you to assign or calculate values to fill in missing values in a variable.

Join block .......................................................................................................................................... 268
Enables you to combine observations from two datasets into a single working dataset.
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Merge block .......................................................................................................................................271
Enables you to combine two datasets into a single working dataset.

Mutate block ......................................................................................................................................275
Enables you to add new variables to the working dataset. These variables can be independent of
variables in the existing dataset, or derived from them.

Partition block ....................................................................................................................................284
Enables you to divide the observations in a dataset into two or more working datasets, where
each working dataset contains a random selection of observations from the input dataset with a
specified weighting for the split.

Query block ....................................................................................................................................... 290
Enables you to create SQL code to join and interrogate database tables or datasets.

Rank block ........................................................................................................................................ 301
Enables you to rank observations in an input dataset using one or more numeric variables.

Sampling block ..................................................................................................................................310
Enables you to create a working dataset that contains a small representative sample of
observations in the input dataset.

Select block .......................................................................................................................................314
Enables you to create a new dataset containing specific variables from an input dataset.

Sort block .......................................................................................................................................... 318
Enables you to sort a dataset.

Text Transform block .........................................................................................................................322
Enables you to transform strings in one or more variables.

Top Select block ............................................................................................................................... 329
Enables you to create a working dataset containing a dependent variable and its most influential
independent variables.

Transpose block ................................................................................................................................ 334
Enables you to create a new dataset with transposed variables.
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Aggregate block

Enables you to apply a function to create a single value from a set of variable values grouped together
using other variables in the input dataset.

Block Overview
This block can be invoked by dragging the block from the Workflow palette to the Workflow canvas and
then dragging a connection from a dataset to the Input port of the block. The aggregation of values is
configured using the Configure Aggregate dialog box. To open the Configure Aggregate dialog box,
double-click the Aggregate block.

The Configure Aggregate dialog box has two tabs:

• Expressions
• Grouping Variable Selection

Expressions
Variable

Specifies one or more variables to which an aggregation function is applied. Click on the Variable
edit box to open the Aggregate Variable Selection  dialog box.

Aggregate Variable Selection
Specifies the variables in which an aggregate function is applied.

Two lists are presented for selecting one or more variabes, Unselected Variables
and Selected Variables. To move an item from one list to the other, double-click on it.
Alternatively, click on the item to select it and use the appropriate single arrow button. A
selection can also be a contiguous list chosen using Shift and click, or a non-contiguous list
using Ctrl and click. Use the Select all button ( ) or Deselect all button ( ) to move

all the items from one list to the other. Use the Apply variable lists button ( ) to move

a set of variables from one list to another. Use the filter box ( ) on either list to limit the
variables displayed, either using a text filter, or a regular expression. This choice can be set
in the Altair page in the Preferences window. As you enter text or an expression in the box,
only those variables containing the text or expression are displayed in the list.

You can add a prefix or suffix to the output variable names by selecting the Prefix or Suffix
option and entering a prefix or suffix in the corresponding text box.

Function
Specifies the aggregation function to use. Before the function is applied, the dataset is collected
into groups, and the function is applied to the values in the specified variable in the required
grouping. Only functions that apply to the specified aggregation variable are displayed.

• Average: Returns the arithmetic mean of the specified variable. This function can only be used
with numeric values.
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• Count: Returns the number of occurrences of a numeric value or string in the specified
variable.

• Count(*): Returns the number of observations in a group.
• Count (Distinct): Returns the number of unique occurrences of a numeric value or string in the

specified variable.
• Minimum: Returns the minimum value in the input dataset for the specified variable.

For character values, the returned value is the lowest value when the values are put in
lexicographical order.

• Maximum: Returns the maximum value in the input dataset for the specified variable.
For character values, the returned value is the highest value when the values are put in
lexicographical order.

• Percent Frequency: Returns the number of observations in a group as a proportion of the
whole dataset. This proportion is expressed as a decimal value between 0 and 1.

• Sum: Returns the total of all values in the specified variable. This function can only be used
with numeric values.

• Number of missings: Returns the number of missing values in the specified variable.
• Range (maximum - minimum): Returns the difference between Maximum and Minimum.
• Standard deviation: Returns the standard deviation for values in the specified variable.
• Standard error: Returns the standard error for values in the specified variable.
• Variance: Returns the variance for values in the specified variable.
• Skewness: Returns the skewness for values in the specified variable.
• Kurtosis: Returns the kurtosis for values in the specified variable.
• 1st Percentile: Returns a value equivalent to the 1st percentile of the specified variable.
• 5th Percentile: Returns a value equivalent to the 5th percentile of the specified variable.
• 10th Percentile: Returns a value equivalent to the 10th percentile of the specified variable.
• 25th Percentile / Q1: Returns a value equivalent to the 25th percentile of the specified

variable.
• 75th Percentile / Q3: Returns a value equivalent to the 75th percentile of the specified

variable.
• 90th Percentile: Returns a value equivalent to the 90th percentile of the specified variable.
• 95th Percentile: Returns a value equivalent to the 95th percentile of the specified variable.
• 99th Percentile: Returns a value equivalent to the 99th percentile of the specified variable.
• Median: Returns the median for values in the specified variable.
• Mode: Returns the mode for values in the specified variable.
• Corrected sum of squares: Returns the corrected sum of squares for values in the specified

variable.
• Coefficient of variation: Returns the coefficient of variation for values in the specified variable.
• Lower confidence limit: Returns the lower confidence limit for values in the specified variable.
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• Upper confidence limit: Returns the upper confidence limit for values in the specified variable.
• Two tailed p-value for Student's t statistic: Returns the two tailed p-value for the Student's t

statistic for values in the specified variable.
• Quartile range (Q3 - Q1): Returns the difference between the values equivalent to the Q3/75th

and Q1/25th percentiles for the specified variable.
• Student's t statistic for zero mean: Returns the value of the student's t statistic for a zero

mean for the specified variable.
• Uncorrected sum of squares: Returns the value of the uncorrected sum of squares for the

specified variable.

New Variable
Specifies the name for the aggregated variable in the output dataset.

Grouping Variable Selection
Specifies the variables to use when grouping observations in the dataset.

Two lists are presented: Unselected Grouping Variables showing variables available for grouping, and
Selected Grouping Variables showing variables selected for grouping. To move an item from one list
to the other, double-click on it. Alternatively, click on the item to select it and use the appropriate single
arrow button. A selection can also be a contiguous list chosen using Shift and click, or a non-contiguous
list using Ctrl and click. Use the Select all button ( ) or Deselect all button ( ) to move all the

items from one list to the other. Use the Apply variable lists button ( ) to move a set of variables

from one list to another. Use the filter box ( ) on either list to limit the variables displayed, either using a
text filter, or a regular expression. This choice can be set in the Altair page in the Preferences window.
As you enter text or an expression in the box, only those variables containing the text or expression are
displayed in the list.

Aggregate block basic example

This example demonstrates how the Aggregate block can be used to generate basic statistics.

In this example, a dataset named bananas.csv is imported into a blank Workflow. The dataset
contains the length and mass of bananas, with each observation representing an individual banana. The
Aggregate block is configured to generate basic statistics from this dataset.
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Workflow Layout

Dataset used

The file used in this example can be found in the samples distributed with Altair SLC.

This example uses a dataset named bananas.csv. Each observation in the dataset describes a
banana, with numeric variables Length(cm) and Mass(g) giving each banana's measured length in
centimetres and mass in grams respectively.

Using the Aggregate block to generate basic statistics

Using the Aggregate block to calculate the mean average and standard deviation of a variable in a
dataset.

1. Import the bananas.csv dataset into a blank Workflow. Importing a CSV file is described in Text File
Import block  (page 220).

2. Expand the Data Preparation group in the Workflow palette, then click and drag an Aggregate block
onto the Workflow canvas, beneath the bananas.csv dataset.

3. Click on the Output port of the bananas.csv dataset block and drag a connection towards the Input
port of the Aggregate block.

Alternatively, you can dock the Aggregate block onto the dataset block directly.
4. Double-click on the Aggregate block.

A Configure Aggregate dialog box opens.
5. From the Expressions tab:

a. From the Variable drop-down list, select Mass(g).
b. From the Function drop-down list, select Average.

The New variable entry box is automatically populated with the name Mass(g)_AVG.
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6. Click Add expression below ( ).

Another set of three options is displayed.
7. For the new set of options:

a. From the Variable drop-down list, select Mass(g).
b. From the Function drop-down list, select Standard deviation.

The New variable entry box is automatically populated with the name Mass(g)_STD.
8. Click Apply and Close.

The Configure Aggregate dialog box closes. A green execution status is displayed in the Output
port of the Aggregate block.

9. Double-click the Working Dataset under the Aggregate block to view the results.

The mean average and standard deviation of the variable Income are displayed.

Aggregate block example: grouping results by variables

This example demonstrates how the Aggregate block can be used to generate basic statistics for
groupings determined by a categorical variable.

In this example, a dataset named loandata.csv is imported into a blank Workflow. Each observation
in the dataset describes a completed loan and the person who took the loan out. The Aggregate
block is configured to generate basic statistics for an Income variable and group these according to a
categorical variable Employment_Type.

Workflow Layout

Datasets used

The file used in this example can be found in the samples distributed with Altair SLC.

This example uses a dataset about loans, named loandata.csv. Each observation in the dataset
describes a completed loan and the person who took the loan out, with variables such as Income,
Loan_Period and Other_Debt.
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Using the Aggregate block to generate basic statistics

This example demonstrates how the Aggregate block can be used to generate basic statistics for
groupings determined by a categorical variable.

1. Import the loandata.csv dataset into a blank Workflow. Importing a CSV file is described in Text
File Import block  (page 220).

2. Expand the Data Preparation group in the Workflow palette, then click and drag an Aggregate block
onto the Workflow canvas, beneath the loandata.csv dataset.

3. Click on the Output port of the loandata.csv dataset and drag a connection towards the Input port
of the Aggregate block.

Alternatively, you can dock the Aggregate block onto the dataset block directly.
4. Double-click on the Aggregate block.

A Configure Aggregate dialog box opens.
5. From the Expressions tab:

a. From the Variable drop-down list, select Income.
b. From the Function drop-down list, select Average.

The New variable entry box is automatically populated with the name Income_AVG.
6. From the left hand side of the Configure Aggregate dialog box, click Grouping Variable Selection.

The Grouping Variable Selection pane is displayed.
7. For the Grouping Variable Selection pane, locate and double-click on Employment_Type.

The Employment_Type variable is moved from the Unselected Grouping Variables list to the
Selected Grouping Variables list.

8. Click Apply and Close.

The Configure Aggregate dialog box closes. A green execution status is displayed in the Output
port of the Aggregate block.

9. Double-click the Working Dataset under the Aggregate block to view the results.

The mean average Income is displayed for each unique value in the Employment_Type variable.
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Binning block

Enables you to bin a variable in a dataset. This block can then output a dataset including a new variable
showing a bin allocation for each observation. The block can also be configured to output a binning
model.

Block Overview
This block can be invoked by dragging the block from the Workflow palette to the Workflow canvas and
then dragging a connection from a dataset to the Input port of the block. If the binning type is optimal,
then you can set values that effect optimal binning. You can view the result of the binning, and adjust the
settings if necessary. The block creates a working dataset in which a new variable is created for each
observation. This variable contains the value for the bin into which the observation is placed.

The aggregation of values is configured using the Binning editor. To open the Binning editor, double-
click the Binning block.

Configure Binning dialog
Use the Configure Binning dialog to specify the details required by block.

Binning variables
Specifies the variable or variables to be binned. The upper list of Unselected Variables shows
variables that can be specified for binning and the lower list of Selected Variables shows
variables that have been specified for binning. To move an item from one list to the other, double-
click on it. Alternatively, click on the item to select it and use the appropriate single arrow button. A
selection can also be a contiguous list chosen using Shift and click, or a non-contiguous list using
Ctrl and click. Use the Select all button ( ) or Deselect all button ( ) to move all the items

from one list to the other. Use the Apply variable lists button ( ) to move a set of variables

from one list to another. Use the filter box ( ) on either list to limit the variables displayed,
either using a text filter, or a regular expression. This choice can be set in the Altair page in
the Preferences window. As you enter text or an expression in the box, only those variables
containing the text or expression are displayed in the list.

Binning type
Specifies the type of binning. The available types depend on the format of the variable. Click on
the box to display a list of types, and then select a type. There might only be one type listed. The
types of binning that can be selected are:

Optimal
Bins are created using optimal binning. If this option is chosen, a dependent variable and
dependent variable treatment must be specified.

Equal Height
Bins are created using equal height binning.
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Equal Width
Bins are created using equal width binning.

Winsorised
Bins are created after the data has been Winsorised.

Optimal Binning
The controls in this group are only displayed if you select Optimal as the binning type for a
variable.

Dependent variable
Specifies the dependent variable used for optimal binning. Click the box to display a list
variables, and then select the required variable from the list.

Dependent Variable treatment
Specifies how the variable should be treated by the binning process. Click the box to
display a list variables, and then select the required treatment from the list. The supported
treatments are:

Binary
Specifies a dependent variable that can take one of two values.

Nominal
Specifies a discrete dependent variable with no implicit ordering.

Ordinal
Specifies a discrete dependent variable with an implicit category ordering.

Creating the bins
When you have selected the variable to be binned and specified the parameters for optimal binning,

if required, you can create the bins. To do this, click Bin Variables ( ). The bins are

then created and displayed in the View Bins panel. The bins are created using values specified in the
Preferences dialog. See the section Binning panel  (page 510) for details.

The list box underneath the control lists the bins created by the binning process. These bins might be
adequate, in which case you can click OK. The Configure Binning dialog is then closed, and a working
dataset containing the binning variable is created.

If you decide the bins are not adequate, you can change the binning preferences. To do this, click
Binning Preferences ( ). This opens the Binning panel in Workflow in Preferences. See the section
Binning panel  (page 510) for details. To see your changes reflected, it is necessary to recreate the

bins by clicking Bin Variables ( ).

View Bins
The View Bins panel displays the bins you have created.
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To split a bin, right-click on a bin heading and select Split. After performing a split, you can selectively
combine the resulting items back into a bin by selecting the required items (press Shift and click for a
contiguous list, or hold Ctrl and click to create a non-contiguous list), then right-clicking and selecting
Combine.

To remove items from a bin, select them as required (press Shift and click for a contiguous list, or hold
Ctrl and click to create a non-contiguous list), then right-click and select Remove.

Binning Output
Output types available for the Binning block are:

• Working dataset: The same dataset as input, but with an additional variable showing a bin allocation
for each observation.

• Binning Model.

To specify output, right-click the Binning block and select Configure Outputs. Two boxes are
presented:

• Unselected Output, listing the output types that are not created when the block is run.
• Selected Output, listing the output types  that will be created when the block is run.

Output types can be moved between the unselected and selected output lists.

• A single output type can be moved by dragging the item from one list to the other. Alternatively, click
on the item to select it and use the Select button or Deselect button to move all the item.

• Multiple output types can also be a contiguous list chosen using Shift and click, or a non-contiguous
list using Ctrl and click. Use the Select all button or Deselect all button to move all the items.

Binning block basic example

This example demonstrates how the Binning block can be used to allocate bins to observations.

In this example, a dataset named loan_data.csv is imported into a blank Workflow. Each observation
in the dataset describes a completed loan and the person who took the loan out, with variables such as
Income, Loan_Period and Other_Debt. The Binning block is configured to generate bins of equal
width for the variable Income, and then append each observation with a new variable stating the bin that
the observation belongs in.

Workflow Layout
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Datasets used

The file used in this example can be found in the samples distributed with Altair SLC.

This example uses a dataset about loans, named loan_data.csv. Each observation in the dataset
describes a completed loan and the person who took the loan out, with variables such as Income,
Loan_Period and Other_Debt.

Using the Binning block to allocate bins to observations

Using the Binning block to allocate observations to bins based on a specified numeric variable.

1. Import the loan_data.csv dataset into a blank Workflow. Importing a CSV file is described in Text
File Import block  (page 220).

2. Expand the Data Preparation group in the Workflow palette, then click and drag a Binning block
onto the Workflow canvas, beneath the loan_data.csv dataset.

3. Click on the loan_data.csv dataset block's Output port and drag a connection towards the Input
port of the Binning block.

Alternatively, you can dock the Binning block onto the dataset block directly.
4. Double-click on the Binning block.

The Binning editor is displayed.
5. Click the Binning preferences icon ( ).

6. Set Default bin count to 8 and click OK.
7. From the Binning Variables pane on the left hand side, double click Income.

The variable Income moves from the Unselected Variables list to the Selected Variables list.
8. Ensure that Income is highlighted and, from the Binning Type pane, click on the Binning Type drop-

down list and select Equal Width.
9. Click Bin Variables ( ).

In the View Bins tab, 8 equal width bins for values of Income are displayed. The Bin Statistics pane
shows the number of observations in each bin and the percentage of the total number of observations
they represent.

10.Press Ctrl+S to save the configuration.
11.Click the cross in the Binning tab to close the Binning editor view.

The Binning editor view closes. A green execution status is displayed in the Output port of the
Binning block.

Binning is now complete. The Binning block output dataset contains the original dataset plus a new
variable that states which bin each observation belongs in.
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Binning block example: Creating an optimal binning model and then
applying that model to another dataset

This example demonstrates how the Binning block can be used to for optimal binning of observations
based on the value of a specified variable in each observation and a dependent variable. The binning
model is then applied to another compatible dataset.

In this example, a dataset of completed loans named loan_data.csv is imported into a blank
Workflow. The dataset contains details of past loan applications and whether or not each loan defaulted.
The Binning block is configured to generate bins for the variable Income using an optimal binning type,
with a dependent variable of Part_Of_UK.

The Binning block is configured to output its model and, using a Score block, this model is applied
against a dataset of new loan applications called loan_applications.csv.

Workflow Layout

Datasets used

The files used in this example can be found in the samples distributed with Altair SLC.

The datasets used in this example are:

• A dataset about loans, named loan_data.csv. Each observation in the dataset describes a loan
and the person who took the loan out, with variables such as Income, Loan_Period and Other_Debt.
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• A dataset about loan applications, named loan_applications.csv. Each observation in
the dataset describes an application for a loan. This dataset contains the same variables as
loan_data.csv, but without a Default variable.

Using the Binning block to create a binning model and apply that binning model to another
dataset

Using the Binning block to allocate bins to observations based on a specified numeric variable.

1. Import the loan_data.csv and loan_applications.csv datasets into a blank Workflow.
Importing a CSV file is described in Text File Import block  (page 220).

2. Expand the Data Preparation group in the Workflow palette, then click and drag a Binning block
onto the Workflow canvas, beneath the loandata.csv dataset.

3. Click on the loan_data.csv dataset block's Output port and drag a connection towards the Input
port of the Binning block.

Alternatively, you can dock the Binning block onto the dataset block directly.
4. Double-click on the Binning block.

The Binning editor is displayed.
5. Click the Binning preferences icon ( ).

6. Set Default bin count to 10 and click OK.
7. From the Binning Variables pane on the left hand side, double click Income.

The variable Income moves from the Unselected Variables list to the Selected Variables list.
Income is automatically selected.

8. Ensure that Income is highlighted. This should be automatic if you have just added it, but if not, click
on it in the Selected Variables list to highlight it.

9. From the Binning Type pane:

a. Click on the Binning Type drop-down list and select Optimal.
b. From the Dependent variable drop-down list, select Part_Of_UK.
c. From the Dependent variable treatment drop-down list, select Nominal.

10.Click Bin Variables ( ).

In the View Bins tab, 10 bins for values of Income are displayed. The Bin Statistics pane shows
the number of observations in each bin and the percentage of the total number of observations they
represent.

11.Press Ctrl+S to save the configuration.
12.Click the cross to close the Binning editor view.

The Binning editor view closes. A green execution status is displayed in the Output port of the
Binning block.
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13.Right-click on the Binning block and select Configure Outputs.

An Outputs window is displayed.
14.From the Outputs window, click the Select all icon:  and then click Apply and Close.

15.From the Scoring grouping in the Workflow palette, click and drag a Score block onto the Workflow
canvas, below the new Binning Model block and the loan_applications dataset block.

A Score block and empty dataset block are created on the Workflow canvas. Note that the Score
block's configuration status (the right-hand bar of the block) is red and displays a screentip stating
that the block requires a model and a dataset input.

16.Click on the loan_applications dataset block's Output port and drag a connection towards the
Input port of the Score block.

17.Click on the Binning Model Output port and drag a connection towards the Input port of the Score
block.

The execution status of the Score block turns green and its dataset output is populated with the
original dataset and the scored variables.

The binning model has now been applied to the loan_applications dataset using a Score block.
The Score block's output dataset contains the original dataset plus a new variable that states which bin
each observation belongs in.

Copy block

Enables you to duplicate an existing dataset.

This block can be invoked by dragging the block from the Workflow palette to the Workflow canvas and
then dragging a connection from a dataset to the Input port of the block.

When you copy a dataset using the Copy block, the input dataset remains unchanged and a new
working dataset is created containing an exact copy of the input dataset.

Copy block basic example

This example demonstrates how the Copy block can be used to duplicate a dataset.

In this example, a dataset named bananas.csv is imported into a blank Workflow. The Copy block is
used to create an exact duplicate of the dataset.

243



Altair Analytics Workbench user guide
Version 2023

Workflow Layout

Dataset used

The file used in this example can be found in the samples distributed with Altair SLC.

This example uses a dataset named bananas.csv. Each observation in the dataset describes a
banana, with numeric variables Length(cm) and Mass(g) giving each banana's measured length in
centimetres and mass in grams respectively.

Using the Copy block to duplicate a dataset

1. Import the bananas.csv dataset onto a blank Workflow canvas. Importing a WPD file is described in
Dataset Import block  (page 220).

2. Expand the Data Preparation group in the Workflow palette, then click and drag a Copy block onto
the Workflow canvas, beneath the bananas.csv dataset.

3. Click on the bananas.csv dataset block's Output port and drag a connection towards the Input port
of the Copy block.

Alternatively, you can dock the Copy block onto the dataset block directly.

You have now made a copy of the bananas.csv dataset.

Deduplicate block

Enables you to remove duplicate rows from an input dataset.

This block can be invoked by dragging the block from the Workflow palette to the Workflow canvas and
then dragging a connection from a dataset to the Input port of the block.

The method of deduplication is specified using the Configure Deduplicate dialog box. To open the
Configure Deduplicate dialog box, double-click the Deduplicate block.
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Configure Deduplicate
The Configure Deduplicate dialog box has two methods for removing duplicate rows:

• Basic - Make all observations unique: Specifies that only the first unique observations are
kept and any further identitical observations are discarded.

• Advanced - Keep first observation based on specific variables and order: Specifies that
duplicate observations are removed based on specified variables. Two lists are presented:

‣ Sorted variables - Specifies variables on which the dataset is sorted. For observations that
are duplicated, the first observation found in the sorted dataset is output, and duplicates
deleted. The sort order of each variable can be set to Ascending, Descending and None,
the default is None

‣ Unique variables - Specifies variables in which the values define unique observations. The
first observation is output for each unique combination of values in this variable list, and
subsequent observations with the same values are discarded. At least one variable must be
specified in this column.

To move an item from one list to the other, double-click on it. Alternatively, click on the item
to select it and use the appropriate single arrow button. A selection can also be a contiguous
list chosen using Shift and click, or a non-contiguous list using Ctrl and click. Use the Select
all button ( ) or Deselect all button ( ) to move all the items from one list to the other.

Use the Apply variable lists button ( ) to move a set of variables from one list to another.

Use the filter box ( ) on either list to limit the variables displayed, either using a text filter, or
a regular expression. This choice can be set in the Altair page in the Preferences window.
As you enter text or an expression in the box, only those variables containing the text or
expression are displayed in the list..

Deduplicate block basic example

This example demonstrates how the Deduplicate block can be used to remove duplicate observations
from a dataset.

In this example, a dataset about iris flowers named iris.csv is imported into a blank Workflow. The
Deduplicate block is used to remove a duplicate observation from the dataset.

Workflow Layout
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Dataset used

The dataset used in this example is the publicly available iris flower dataset (Ronald A. Fisher, "The
use of multiple measurements in taxonomic problems." Annals of Eugenics, vol.7 no.2, (1936); pp.
179—188.)

Each observation in the dataset iris.csv describes an iris flower, with variables such as species,
sepal_length and petal_width.

Using the Deduplicate block to deduplicate a dataset

Using the Deduplicate block to deduplicate values in a dataset.

1. Import the iris.csv dataset onto a blank Workflow canvas. Importing a CSV file is described in Text
File Import block  (page 220).

2. Expand the Data Preparation group in the Workflow palette, then click and drag a Deduplicate block
onto the Workflow canvas, beneath the iris.csv dataset.

3. Click on the iris.csv dataset block's Output port and drag a connection to the Input port of the
Deduplicate block.

Alternatively, you can dock the Deduplicate block onto the dataset block directly.
4. Double-click on the Deduplicate block.

A Configure Deduplicate dialog box opens.
5. From the Configure Deduplicate dialog box, Ensure the Basic - Make all observations unique

option is selected and click Apply and Close.

You now have a new dataset, that only contains only unique observations from iris.csv.

Deduplicate block example: removing duplicates where values of
variables match

This example demonstrates how the Deduplicate block can be used to remove duplicate variable values
from a dataset.

In this example, a dataset about iris flowers named iris.csv is imported into a blank Workflow. The
Deduplicate block is used to keep an observation for each species from the dataset.
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Dataset used

The dataset used in this example is the publicly available iris flower dataset (Ronald A. Fisher, "The
use of multiple measurements in taxonomic problems." Annals of Eugenics, vol.7 no.2, (1936); pp.
179—188.)

Each observation in the dataset iris.csv describes an iris flower, with variables such as species,
sepal_length and petal_width.

Using the Deduplicate block to deduplicate a dataset

Using the Deduplicate block to deduplicate values in a dataset.

1. Import the iris.csv dataset onto a blank Workflow canvas. Importing a CSV file is described in Text
File Import block  (page 220).

2. Expand the Data Preparation group in the Workflow palette, then click and drag a Deduplicate block
onto the Workflow canvas, beneath the iris.csv dataset.

3. Click on the iris.csv dataset block's Output port and drag a connection towards the Input port of
the Deduplicate block.

Alternatively, you can dock the Deduplicate block onto the dataset block directly.
4. Double-click on the Deduplicate block.

A Configure Deduplicate dialog box opens.
5. From the Configure Deduplicate dialog box:

a. Select the Advanced - Keep first observation based on specific variables and order option

Two variable lists named Sorted Variables and Unique variables appear.
b. From the Sorted Variables list, double click species to move it to the Unique variables list.
c. Click Apply and Close.

You now have a new dataset, that only contains an observation for each species from iris.csv.
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Filter block

Enables you to reduce the total number of observations in a large dataset by selecting observations
based on the value of one or more variables.

This block can be invoked by dragging the block from the Workflow palette to the Workflow canvas and
then dragging a connection from a dataset to the Input port of the block. When you filter a dataset using
the Filter block, the input dataset remains unchanged and a working dataset is created containing only
the observations selected with the filter.

Filtering datasets
To filter datasets:

1. Drag the Filter block onto the Workflow canvas, and connect the required dataset to the Input port of
the block.

2. Double-click the Filter block.

The Filter Editor view displays and contains two tabs:

• The Basic tab that enables you to create a filter that is either a logical conjunction (logical AND) or
a logical disjunction (logical OR) of expressions.

• The Advanced tab that enables you to create a complex filter statements that combines both the
logical conjunction and logical disjunction of expressions .

3. Using either the Basic or Advanced filter tabs, specify a filter for the input dataset.

Basic filter

Creating a single filter that is either a logical OR expression or a logical AND expression.

The Basic view cannot be used to create a filter containing a combination of logical OR and logical AND
expressions.

Create a filter expression
To create a filter expression, click Add expression ( ) to create a child node, and complete the
Expression Properties for the node. When a filter contains two or more expressions, select AND for a
logical AND filter, or select OR for a logical OR filter.

Expression settings
Expressions define individual nodes as part of a larger filter.

Variable
The variable in the input dataset to be filtered.
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Operator
Specifies the operation used to select observations. The available operators are determined by the
variable type.

The following operators are available for character data variables.

Equal to Includes observations in the working dataset if the value of the
variable is equal to the specified Value specified.

Not equal to Includes observations in the working dataset if the value of the
variable is not equal to the specified Value.

In Includes observations in the working dataset if the value of the
variable is contained in the defined list of values. The list is specified
in the Edit dialog box accessed from the Configure Filter dialog box.

Starts with Includes observations in the working dataset if the value of the
variable starts with the specified Value.

Ends with Includes observations in the working dataset if the value of the
variable ends with the specified Value.

The following filter operators are available for numeric data variables.

= Includes observations in the working dataset if the value of the
variable is equal to the specified Value specified.

!= Includes observations in the working dataset if the value of the
variable is not equal to the specified Value.

In Includes observations in the working dataset if the value of the
variable is contained in the defined list of values. The list is specified
in the Edit dialog box accessed from the Configure Filter dialog box.

< Includes observations in the working dataset if the value of the
variable is less than the specified Value.

<= Includes observations in the working dataset if the value of the
variable is less than, or equal to, the specified Value.

> Includes observations in the working dataset if the value of the
variable is greater than the specified Value.

>= Includes observations in the working dataset if the value of the
variable is greater than, or equal to, the specified Value.

Value
The variable value used as the test in the filter. All character data entered in the Value box is
case-sensitive.

Drawing Connections
By clicking and dragging from node to node you can draw connections between existing filter blocks. For
example, you can take the output of two blocks and combine into another block for further filtering.
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Advanced filter

Creating a complex filter statement using simple or expression nodes.

Overview
A filter is a sequence visually represented by connected nodes in a similar manner to a Workflow. The
filter path for each branch represents a logical AND expression sequence. Each branch from dataset root
are joined together as a logical OR sequence in the filter.

The Advanced filter contains the following:

• The filter canvas, which contains a visual representation of the filter.
• A box across the bottom of the filter canvas, which contains the version of the filter that can be copied

to a SAS language program for testing or production use.
• A box on the right, which enables you specify the properties for a node in the filter in two forms:

‣ Simple node: A simple statement containing a variable, an operator and a value. For example:
age >= 65.

‣ Expression node: A SQL language expression.

Creating a filter node
You can create complex filters by connecting the ports on the nodes in the filter canvas.

To add a logical AND expression, hover over the plus icon ( ) below the node. The location of the new
node is shown as a child of the current node on the filter canvas:

The settings for the highlighted node can be completed in the righthand pane.

To add a logical OR node, hover over the plus icon ( ) to the right of the node. The location of the new
node is shown as a child of the parent node on the filter canvas:
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The settings for the highlighted node can be completed in the righthand pane.

Drawing Connections
By clicking and dragging from node to node you can draw connections between existing filter blocks. For
example, you can take the output of two blocks and combine into another block for further filtering.

Advanced filter simple nodes

Filters data with simple statements that contain a variable, an operator and a value.

Editing the filter node
To edit the filter node's properties, click the node and modify the properties for that node in the Edit
Node section.

To delete the expression either click the  icon in the Edit Node box, or right-click the node in the filter
canvas and click Delete expression.

Edit Node Settings
If the Node Type is set to Simple, the node is defined by three parameters as follows:

Variable
The variable in the input dataset to be filtered.

Operator
Specifies the operation used to select observations. The available operators are determined by the
variable type.

The following operators are available for character data variables.

Equal to Includes observations in the working dataset if the value of the
variable is equal to the specified Value specified.
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Not equal to Includes observations in the working dataset if the value of the
variable is not equal to the specified Value.

In Includes observations in the working dataset if the value of the
variable is contained in the defined list of values. The list is specified
in the Edit dialog box accessed from the Configure Filter dialog box.

Starts with Includes observations in the working dataset if the value of the
variable starts with the specified Value.

Ends with Includes observations in the working dataset if the value of the
variable ends with the specified Value.

The following filter operators are available for numeric data variables.

= Includes observations in the working dataset if the value of the
variable is equal to the specified Value specified.

!= Includes observations in the working dataset if the value of the
variable is not equal to the specified Value.

In Includes observations in the working dataset if the value of the
variable is contained in the defined list of values. The list is specified
in the Edit dialog box accessed from the Configure Filter dialog box.

< Includes observations in the working dataset if the value of the
variable is less than the specified Value.

<= Includes observations in the working dataset if the value of the
variable is less than, or equal to, the specified Value.

> Includes observations in the working dataset if the value of the
variable is greater than the specified Value.

>= Includes observations in the working dataset if the value of the
variable is greater than, or equal to, the specified Value.

Value
The variable value used as the test in the filter. All character data entered in the Value box is
case-sensitive.
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Example

In the above example, each path is a different filter for the dataset. The alternate paths are joined at the
point closest to the dataset root. Expressions can be shared between filter paths:

age <= 25 AND workclass='pt'
OR
age >= 25 AND workclass='pt'

Advanced filter expression nodes

Filters data with SQL language statements. Each node is an SQL SELECT WHERE expression.

Editing the filter node
To edit the filter node's properties, click the node and modify the properties for that node in the Edit
Node section.

To delete the expression either click the  icon in the Edit Node box, or right-click the node in the filter
canvas and click Delete expression.
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It is possible to create a node initially as a Simple node and then switch to Expression for more
advanced editing.

Edit Node Settings
If the Node Type is set to Expression, the node is defined by an SQL expression entered in the
provided box.

Click Open in Editor to open the Filter Expression Builder window. At the top of the window is a text
box where an SQL expression can be entered manually. Alternatively, an expression can be created by
double-clicking on or dragging the input variables, functions and operators provided below the text box.
When typing manually, press Ctrl-Spacebar to show a list of suggested terms.

Example

In the above example, census data is filtered into two streams: one where education contains the
strings nth, st, nd or rd, capturing school grades reached (1st, 2nd, 3rd, and so on); and another
where education contains "grad", capturing graduate status.

Filter block basic example

This example demonstrates how a Filter block can be used to filter a dataset, creating a new dataset
with only specified observations retained.

In this example, a dataset named loan_data.csv is imported into a blank Workflow. The dataset is
connected to a Filter block, which is configured to only retain observations with the value of the variable
Income greater than or equal to 50000 per year.
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Datasets used

The file used in this example can be found in the samples distributed with Altair SLC.

This example uses a dataset about loans, named loan_data.csv. Each observation in the dataset
describes a completed loan and the person who took the loan out, with variables such as Income,
Loan_Period and Other_Debt.

Using a Filter block to filter a dataset

Using a Filter block to filter a dataset and only retain observations where the value of a specified
variable meets a specified criteria.

1. Import the loan_data.csv dataset into a blank Workflow. Importing a CSV file is described in Text
File Import block  (page 220).

2. Expand the Data Preparation group in the Workflow palette, then click and drag a Filter block onto
the Workflow canvas, beneath the loan_data.csv dataset.

3. Click on the Output port of the loan_data.csv dataset block and drag a connection towards the
Input port of the Filter block.

Alternatively, you can dock the Filter block onto the dataset block directly.
4. Double-click on the Filter block.

The Filter Editor view is displayed.
5. Click on the Basic tab.
6. From the Variable drop-down list, select Income.
7. From the Operator drop-down list, select >=.
8. In the Value box, type 50000.
9. Press Ctrl+S to save the configuration.
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10.Click the cross in the Filter tab to close the Configure Filter dialog box view.

The Configure Filter dialog box view closes. A green execution status is displayed in the Output port
of the Filter block.

11.Right-click on the dataset output from the Filter block, click Rename and type Income >= £50,000
pa.

The original dataset has now been filtered, creating a new dataset with only specified observations
retained.

Filter block example: splitting a dataset

This example demonstrates how two Filter blocks can be used to split a dataset into two, based on the
value of a specified variable.

In this example, a dataset named loandata.csv is imported into a blank Workflow. Each observation
in the dataset describes a completed loan and the person who took the loan out. The whole dataset is
passed to two Filter blocks, each configured to filter for mutually exclusive age ranges, the end result
being the splitting of the dataset into two new datasets, one for each of the specified age ranges.

Workflow Layout

Datasets used

The file used in this example can be found in the samples distributed with Altair SLC.

This example uses a dataset about loans, named loandata.csv. Each observation in the dataset
describes a completed loan and the person who took the loan out, with variables such as Income,
Loan_Period and Other_Debt.
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Using two Filter blocks to split a dataset into two output datasets

Using the Filter blocks to split a dataset into two output datasets, depending on specified criteria.

1. Import the loandata.csv dataset into a blank Workflow. Importing a CSV file is described in Text
File Import block  (page 220).

2. Expand the Data Preparation group in the Workflow palette, then click and drag two Filter blocks
onto the Workflow canvas, beneath the loandata.csv dataset.

3. Click on the Output port of the loandata.csv dataset block and drag a connection towards the
Input port of one of the Filter blocks. Repeat for the second Filter block.

4. Double-click on one of the Filter blocks.

The Filter Editor view is displayed.
5. Ensure Node Type is set to Simple.
6. In the Edit Node section:

a. From the Variable drop-down list, select Age.
b. From the Operator drop-down list, select <=.
c. In the Value box, type 40.

7. Press Ctrl+S to save the configuration.
8. Click the cross in the Filter tab to close the Configure Filter dialog box view.

The Configure Filter dialog box view closes. A green execution status is displayed in the Output port
of the Filter block.

9. Right-click on the dataset output from the Filter block, click Rename and type a summary of the filter
settings (for example: Age <= 40).

10.Repeat steps 4 through to 8 for the other Filter block, selecting > from the Operator drop-down list.
Rename the dataset output from this Filter block to Age > 40.

The original dataset has now been split into two datasets: one only containing the observations for loan
applicants with Age less than or equal to 40, and the other containing observations for applicants with
Age greater than 40.

Filter block example: filtering on multiple criteria

This example demonstrates how a Filter block can be used to filter a dataset on multiple criteria.

In this example, a dataset named loandata.csv is imported into a blank Workflow. The dataset is
connected to a Filter block, which is configured to filter the loandata.csv dataset on multiple criteria.

The filter criteria are set to retain observations if they meet either one of two sets of criteria:

• If they have Employment_Type equal to Private, Income equal to 40000 or greater, and
Has_CCJ equal to 0.

257



Altair Analytics Workbench user guide
Version 2023

• If they have Employment_Type equal to Public and Income equal to 30000 or greater, and
Has_CCJ equal to 0.

Workflow Layout

Datasets used

The file used in this example can be found in the samples distributed with Altair SLC.

This example uses a dataset about loans, named loandata.csv. Each observation in the dataset
describes a completed loan and the person who took the loan out, with variables such as Income,
Loan_Period and Other_Debt.

Using a Filter block to filter on multiple criteria

Using a Filter block to filter a dataset on multiple criteria.

1. Import the loandata.csv dataset into a blank Workflow. Importing a CSV file is described in Text
File Import block  (page 220).

2. Expand the Data Preparation group in the Workflow palette, then click and drag a Filter block onto
the Workflow canvas, beneath the loandata.csv dataset.

3. Click on the Output port of the loandata.csv dataset block and drag a connection towards the
Input port of the Filter block.

Alternatively, you can dock the Filter block onto the dataset block directly.
4. Double-click on the Filter block.

The Filter Editor view is displayed.
5. Ensure You are viewing the Advanced tab and Node Type is set to Simple.
6. In the Edit Node section on the right hand side of the view:

a. From the Variable drop-down list, select Employment_Type.
b. From the Operator drop-down list, select Equal to.
c. In the Value box, type Private.
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7. Click the plus sign ( ) on the base of the Employment_Type = 'Private' node you have just
configured.

A new blank node is created.
8. Ensure the new blank node is selected and repeat step 6 to configure the node to filter for the

Variable named Income, with Operator >= and Value 40000.
9. Click the plus sign ( ) on the base of the Income >= 40000 node you have just configured.

A new blank node is created.
10.Ensure the new blank node is selected and repeat step 6 to configure the node to filter for the

Variable named Has_CCJ, with Operator = and Value 0.
11.To create the other set of filter criteria, click the plus sign ( ) on the base of the root Filter node.

A new blank node is created on a second branch, to the right of the first branch that you've just
created.

12.Ensure the new blank node is selected and repeat step 6 to configure the node to filter for the
Variable named Employment_Type, with Operator Equal to and Value Public.

13.Click the plus sign ( ) on the base of the Employment_Type = 'Public' node you have just
configured.

A new blank node is created.
14.Ensure the new blank node is selected and repeat step 6 to configure the node to filter for the

Variable Income, with Operator >= and Value 30000.
15.Click the plus sign ( ) on the base of the Employment_Type = 'Public' node you have just

configured.

A new blank node is created.
16.Ensure the new blank node is selected and repeat step 6 to configure the node to filter for the

Variable Has_CCJ, with Operator = and Value 0.
17.Press Ctrl+S to save the configuration.
18.Click the cross in the Filter tab to close the Configure Filter dialog box view.

The Configure Filter dialog box view closes. A green execution status is displayed in the Output port
of the Filter block.

19.Right-click on the dataset output from the Filter block, click Rename and type a summary of the filter
settings (for example: Loan candidates).

The original dataset has now been filtered, creating a new dataset with only the specified observations
retained.
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Filter block example: filtering using an expression

This example demonstrates how a Filter block can be used to filter a dataset using an SQL language
expression.

In this example, a dataset containing information about basketball shots, named
basketball_shots.csv is imported into a blank Workflow. The dataset contains information about
basketball shots and the players that made them. The dataset is connected to a Filter block, which is
configured to use an SQL language expression to filter observations. The SQL language expression
uses the variables height and weight to calculate each player's Body Mass Index (BMI), which is then
used to filter observations.

Workflow Layout

Datasets used

The file used in this example can be found in the samples distributed with Altair SLC.

This example uses a dataset about basketball shots, named basketball_shots.csv. Each
observation in the dataset describes an attempt to score and the person shooting, with variables such as
height, weight and distance_feet.

Using a Filter block to filter using an expression

Using a Filter block to filter a dataset using an expression.

1. Import the basketball_shots.csv dataset into a blank Workflow. Importing a CSV file is
described in Text File Import block  (page 220).

2. Expand the Data Preparation group in the Workflow palette, then click and drag a Filter block onto
the Workflow canvas, beneath the basketball_shots.csv dataset.

3. Click on the Output port of the basketball_shots.csv dataset block and drag a connection
towards the Input port of the Filter block.

Alternatively, you can dock the Filter block onto the dataset block directly.
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4. Double-click on the Filter block.

The Filter Editor view is displayed.
5. Ensure that you are viewing the Advanced tab, then under Node Type select Expression.
6. Under Edit Note, click Open in Editor.

A Filter Expression Builder window opens.
7. In the text entry window, type (weight/((height/100)**2))>25.

The variable names, operators and other syntax can either be typed or added using the buttons.
8. Click Apply and Close.

The Filter Expression Builder window closes.
9. Press Ctrl+S to save the configuration.
10.Click the cross in the Filter tab to close the Configure Filter dialog box view.

The Configure Filter dialog box view closes. A green execution status is displayed in the Output port
of the Filter block.

11.Right-click on the dataset output from the Filter block, click Rename and type BMI > 25).

The original dataset has now been filtered, creating a new dataset with only the specified observations
retained.

Impute block

Enables you to assign or calculate values to fill in missing values in a variable.

This block can be invoked by dragging the block from the Workflow palette to the Workflow canvas and
then dragging a connection from a dataset to the Input port of the block. The available methods for
replacing missing values are determined by variable type and are specified in the Configure Impute
dialog box. You can define expressions to replace missing values in all variables in a single Impute
block. To add expressions to the block click Add Expression ( ) and complete the information for the
expression.

Imputation of missing values is configured using the Configure Impute dialog box. To open the
Configure Impute dialog box, double-click the Impute block.

Configure Impute
Variable

Specifies one or more variables in the dataset with missing values. Variable is pre-populated with
variables in the dataset. Click on the Variable edit box to open the Impute Variable Selection 
dialog box.

Impute Variable Selection
Specifies the variables in which the impute methods are applied.
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Two lists are presented for selecting one or more variabes, Unselected Variables
and Selected Variables. To move an item from one list to the other, double-click on it.
Alternatively, click on the item to select it and use the appropriate single arrow button. A
selection can also be a contiguous list chosen using Shift and click, or a non-contiguous list
using Ctrl and click. Use the Select all button ( ) or Deselect all button ( ) to move

all the items from one list to the other. Use the Apply variable lists button ( ) to move

a set of variables from one list to another. Use the filter box ( ) on either list to limit the
variables displayed, either using a text filter, or a regular expression. This choice can be set
in the Altair page in the Preferences window. As you enter text or an expression in the box,
only those variables containing the text or expression are displayed in the list.

Numeric and character variables are separated, you can switch between numeric and
character variable lists by selecting the Numeric or Character option.

Method
Specifies the impute method used for missing values in the specified variable.

Character variables

The following impute methods are available for character variables.

Constant
Replaces missing values for the variable with the specified value. Specify the
replacement in Value.

Distribution
Replaces missing values in the specified variable with randomly selected values
present elsewhere in the variable. The replacement values are selected based on
their probability of occurrence in the input dataset.

Mode
Replaces missing values in the specified variable with the mode of the specified
variable.

Numeric variables

The following imputation methods are available for numeric variables. In the SAS language,
numeric variables include all variables formatted as date-, datetime- and time.

Gaussian simulation
Replaces missing values in the specified variable with a random number from a
Normal distribution based on the mean and standard deviation of that distribution.
The mean and standard deviation are calculated from the input dataset and displayed
in the Mean and Standard deviation fields respectively.

You can specify different mean and standard deviation values in the fields, but
altering the values too far from those calculated might increase the amount of noise
in the data.

262



Altair Analytics Workbench user guide
Version 2023

If you choose a Gaussian simulation imputation method and output a model
from the Impute block, then the Mean and Standard deviation values used will be
from the original dataset connected to the Impute block or specified in the original
imputation model, not from the new dataset that the model is applied to using the
Score block.

Max
Replaces missing values in the specified variable with the maximum value of the
specified variable.

Mean
Replaces missing values in the specified variable with the mean of the specified
variable.

Median
Replaces missing values in the specified variable with the median of the specified
variable.

Min
Replaces missing values in the specified variable with the minimum value of the
specified variable.

Constant
Replaces missing values for the variable with a specified value. Specify the
replacement in Value.

Distribution
Replaces missing values in the specified variable with randomly-selected values
present in the variable. Replacement values are selected based on the frequency
with which they occur in the input dataset.

Mode
Replaces missing values in the specified variable with the mode of the specified
variable.

Trimmed mean
Replaces missing values in the specified variable with the mean value calculated,
after removing the specified proportion of largest and smallest values. For example,
if you specify a proportion of 0.25, the smallest and largest quarters of values are
removed from the calculation. The interquartile mean value replaces all missing
values in the variable.

The percentage of values removed from the calculation is specified in the
Percentage field.

Uniform simulation
Replaces missing values in the specified variable with a random number from a
Uniform distribution. By default, the distribution range is based on the minimum and
maximum values for the specified variable, displayed in the Min field and Max field.
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Only values within the specified boundaries are used to replace missing values in the
variable, not the values specified in Min and Max.

Winsorized mean
Replaces missing values in the specified variable with the calculated Winsorized
mean value, after replacing the specified proportion of largest and smallest values.
For example, if you specify 0.05, the largest 5% of values are replaced with the value
of the 95th percentile; the lowest 5% of values are replaced with the value of the fifth
percentile; and all non-missing values in the specified variable are used to calculate
the Winsorized mean.

The percentage of values replaced before the calculation occurs is specified in the
Percentage field.

Seed
Specifies whether the same set of imputed values is generated each time the Impute block is
executed.

• To generate the same sequence of observations, set Seed to a positive value greater than or
equal to 1.

• To generate a different sequence of observations, set Seed to 0 (zero).

Block Outputs
The Impute block can generate one or both of the following outputs:

• Working Dataset: A new dataset containing the imputed variables.
• Impute Model: The imputation model, suitable for use with a Score block.

To specify the outputs, right-click on the Impute block and select Configure Outputs. Two boxes are
presented: Unselected Output, showing outputs that are not selected , and Selected Output, showing
selected outputs. To move an item from one list to the other, double-click on it. Alternatively, click on
the item to select it and use the appropriate single arrow button. A selection can also be a contiguous
list chosen using Shift and click, or a non-contiguous list using Ctrl and click. Use the Select all button
( ) or Deselect all button ( ) to move all the items from one list to the other. Use the Apply

variable lists button ( ) to move a set of variables from one list to another. Use the filter box ( ) on

either list to limit the variables displayed, either using a text filter, or a regular expression. This choice
can be set in the Altair page in the Preferences window. As you enter text or an expression in the box,
only those variables containing the text or expression are displayed in the list.
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Impute block basic example: imputing missing values

This example demonstrates how the Impute block can be used to fill in missing values in a dataset.

In this example, an incomplete dataset of books named lib_books.csv is imported into a blank
Workflow. The dataset is incomplete due to some missing values in its Price variable. The Impute
block is used to fill in the missing values and output a complete dataset named books_complete.

Workflow Layout

Dataset used

The file used in this example can be found in the samples distributed with Altair SLC.

This example uses about dataset of books, named lib_books.csv. Each observation in the dataset
describes a book, with variables such as Title, ISBN and Author.

Using the Impute block to impute missing values

Using the Impute block to impute missing values in a dataset.

1. Import the lib_books.csv dataset onto a blank Workflow canvas. Importing a CSV file is described
in Text File Import block  (page 220).

2. Expand the Data Preparation group in the Workflow palette, then click and drag an Impute block
onto the Workflow canvas, beneath the lib_books.csv dataset.

3. Click on the lib_books.csv dataset block's Output port and drag a connection towards the Input
port of the Impute block.

Alternatively, you can dock the Impute block onto the dataset block directly.
4. Double-click on the Impute block.

A Configure Impute dialog box opens.
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5. From the Configure Impute dialog box:

a. From the Variable drop-down list, select Price.
b. From the Method drop-down list, select Distribution.
c. Click Apply and Close.

The Configure Impute dialog box closes. A green execution status is displayed in the Output
ports of the Impute block and of the new dataset Working Dataset.

6. Right-click on the new dataset Working Dataset, click Rename and type books_complete.

You now have a new dataset, books_complete, with no missing values in the variable Price.

Impute block example: using the model output

This example demonstrates how the Impute block's optional model output can be applied to another
dataset.

In this example, an Impute block is used to fill in missing values in a lib_books.csv dataset.
The Impute block is then configured to output its model, which is then applied to another dataset,
lib_books2.csv, using a Score block. The Score block generates an output dataset BOOKS 2
COMPLETE.

Workflow Layout

Datasets used

The file used in this example can be found in the samples distributed with Altair SLC.

The datasets used in this example are:
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• A dataset about books, named lib_books.csv. Each observation in the dataset describes a book,
with variables such as Title, ISBN and Author.

• A second dataset of books, with the same variables as the lib_books.csv dataset.

Using the Impute block's model output

Imputing missing values in a dataset using the Impute block and then using the Impute block's model
output to impute missing values in another dataset.

1. Import the lib_books.csv dataset onto a blank Workflow canvas. Importing a CSV file is described
in Text File Import block  (page 220).

2. Drag an Impute block onto the Workflow canvas, beneath the LIB_BOOKS dataset.
3. Draw a connection between the lib_books.csv dataset block output port and the Impute block

input port.
4. Double-click on the Impute block to open the Configure Impute dialog box, and then configure as

follows:

a. Set Variable to Price.
b. Set Method to Distribution.
c. Click Apply and Close.

The Configure Impute dialog box closes. A green execution status is displayed in the Output ports
of the Impute block and of the new dataset Working Dataset.

5. Import the lib_books2.csv dataset onto the Workflow canvas. Importing a CSV file is described in
Text File Import block  (page 220).

6. Right-click on the Impute block and select Configure Outputs.

An Outputs window is displayed. By default, the Working Dataset is in Selected Output and the
Impute Model is in Unselected Output.

7. Double-click on Impute Model to move it into the Selected Output list.

Selected Output lists both Working Dataset and Impute Model.
8. Click Apply and Close.

The Outputs window is closed, and on the Workflow canvas the Impute block can be seen to have
both a dataset and model output.

9. From the Scoring grouping in the Workflow palette, click and drag a Score block onto the Workflow
canvas, below the new Impute Model block and the LIB_BOOKS 2 dataset block.

A Score block and empty dataset block are created on the Workflow canvas. Note that the Score
block's configuration status (the right-hand bar of the block) is red and displays a screentip stating
that the block requires a model and a dataset input.

10.Click on the LIB_BOOKS 2 dataset block's Output port and drag a connection towards the Input port
of the Score block.
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11.Click on the Impute Model Output port and drag a connection towards the Input port of the Score
block.

The execution status of the Score block turns green and its dataset output is populated.
12.Right-click on the Score block's output dataset block and click Rename. Type BOOKS 2 COMPLETE

and click OK.

The imputation model output from the Impute block has imputed the missing values in the LIB_BOOKS
2 dataset and generated a complete dataset, now named BOOKS 2 COMPLETE.

Join block

Enables you to combine observations from two datasets into a single working dataset.

This block can be invoked by dragging the block from the Workflow palette to the Workflow canvas and
then dragging a connection from two or more datasets to the Input port of the block. Rows are joined
using a common column. For example, if the two tables have observations that specify an identifier
(perhaps using the variable ID in one, and identifier in another), the observations in which the
identifiers have the same value are joined together in the same observation.

Datasets can be joined in various ways, and the condition used to join records does not have to be one
of equality.

Joining datasets
To join datasets, firstly connect the Output ports of all datasets to be joined to the Input port of the Join
block. Secondly, double-click on the Join block to open the Join Editor.

The Join Editor displays each dataset connected to the Join block as a tile containing a list of variables.
To join two datasets, find a common variable in each dataset and drag a line between those variables.

Configuring the join properties
To configure the join properties, double-click the connector between variables. This displays the Join
Properties dialog.

The following properties can be configured:

Join type
Specifies the type of join used to combine the values in the left and right datasets. Inner and
outer joins use a condition to select observations, enabling you to select the variables you want to
compare. The variable condition is defined using Join operator.

Inner
Creates a working dataset that includes observations from both datasets where the
specified condition matches for the specified variable.
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Left Outer
Creates a working dataset that contains all observations in the left dataset and the values of
those variables from observations in the right dataset where the specified condition matches
for the specified variable.

Right Outer
Creates a working dataset that contains all observations in the right dataset and the values
of those variables from observations in the left dataset where the specified condition
matches for the specified variable.

Full Outer
Creates a working dataset that contains all observations from either or both of the right
dataset and the left dataset where the specified variable matches the specified condition.

Cross
Creates a working dataset that consists of all observations in the left dataset joined with
every observation in the right dataset.

Natural
Creates a working dataset using commonly-named variables in the left and right datasets.
The dataset only includes observations where the variable in the left dataset has a value
that matches the variable in the right dataset. Any other observations are ignored.

Join operator
Specifies the type of operator for the join. The condition uses the operator and the specified
columns to define which observations are included or excluded by a join type. The operators
available are:

= Equal to
!= Not equal to
>= Greater than or equal to
< Less than
<= Less than or equal to

Left dataset
Identifies the left dataset in the join, and the columns on which to join. Although the left dataset is
initially defined when you connect the dataset in the Join Editor, you can change the left dataset
here:

Dataset
Select the dataset to be used as the left dataset. This is set by default if you connect
datasets using the dataset representation in the Join Editor.

Column
Specify the variable in the left dataset to be used in the join. This is set by default if you
connect datasets using the dataset representation in the Join Editor.
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Right dataset
Identifies the right dataset in the join and the columns. Although the left dataset is initially defined
when you connect the dataset in the Join Editor, you can change the left dataset here:

Dataset
Select the dataset to be used as the right dataset. This is set by default if you connect
datasets using the dataset representation in the Join Editor.

Column
Specify the variable in the right dataset to be used in the join. This is set by default if you
connect datasets using the dataset representation in the Join Editor.

Join block basic example: joining two datasets

This example demonstrates how a Join block can be used to join two datasets using a common variable.

In this example, two datasets are imported into a blank Workflow: lib_books.csv, which contains
a list of books and information about those books; and ddn_subjects.csv, which contains a list of
subjects. A Join block is configured to join the two datasets using a common variable.

Workflow Layout

Datasets used

The files used in this example can be found in the samples distributed with Altair SLC.

The datasets used in this example are:

• A dataset about books, named lib_books.csv. Each observation in the dataset describes a book,
with variables such as Title, ISBN and Author.

• A dataset linking numbers in the Dewey Decimal Number system to subjects, named
ddn_subjects.csv.
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Using a Join block to join two datasets

Using a Join block to join two datasets using a common variable.

1. Import the datasets lib_books.csv and ddn_subjects.csv into a blank Workflow. Importing a
CSV file is described in Text File Import block  (page 220).

2. Right-click on the lib_books.csv dataset output, click Rename and type Lib Books.
3. Right-click on the ddn_subjects.csv dataset output, click Rename and type Book Subjects.
4. Expand the Data Preparation group in the Workflow palette, then click and drag a Join block onto the

Workflow canvas, beneath the two imported datasets.
5. Click on the Output port of the Lib Books dataset block and drag a connection towards the Input

port of the Join block. Repeat for the Book Subjects dataset.
6. Double-click on the Join block.

The Join Editor is displayed, showing a table for each dataset, with each table containing the
dataset's variable names.

7. From the Lib Books table, click on the variable Dewey_Decimal_Number and, holding the left
mouse button down, drag across to the DDN variable in the Book Subjects table, then release the left
mouse button.

A connection is drawn between Dewey_Decimal_Number in Lib Books and DDN in Book
Subjects.

8. Press Ctrl+S to save the configuration.
9. Close the Join Editor.

The Join Editor closes. A green execution status is displayed in the Output port of the Join block.
10.Right-click on the dataset output from the Join block, click Rename and type Lib Books with

Subjects.

The two datasets have been joined, creating a new dataset containing variables from both.

Merge block

Enables you to combine two datasets into a single working dataset.

Block Overview

This block can be invoked by dragging the block from the Workflow palette to the Workflow canvas and
then dragging a connection from two or more datasets to the Input port of the block. To configure a
merge block, double-click to open the Configure Merge dialog box.
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Options tab
Dataset order

Lists the order that the datasets will be combined in. To move a dataset in the order, click on that
dataset and use the arrow keys to move it.

Merge operation

Concatenate
Joins one dataset onto another. Variables from each dataset will remain distinct with no
merging between observations. In both cases, variables and observations in datasets will be
concatenated in the order specified in Dataset order.

One-to-one
Joins datasets together so that observations are merged. Variables and observations in
datasets will be joined in the order specified in Dataset order.

Interleave
Available for selection if source datasets contain common variables (dictated by variable
name and type). Observations from common variables will be joined so that they belong to
the same variable. Variables and observations in datasets will be interleaved in the order
specified in Dataset order.

One-to-one including excess rows
Joins datasets together so that observations are merged. Variables and observations in
datasets will be joined in the order specified in Dataset order.
Excess observations are included, such that the smaller dataset contains blank
observations for rows beyond its original size.

By Variables
For the Merge operation selection Interleave, allows you to specify variables to sort by. Two lists are
presented: Unselected By Variables showing variables available, and Selected By Variables showing
variables selected. To move an item from one list to the other, double-click on it. Alternatively, click on
the item to select it and use the appropriate single arrow button. A selection can also be a contiguous
list chosen using Shift and click, or a non-contiguous list using Ctrl and click. Use the Select all button
( ) or Deselect all button ( ) to move all the items from one list to the other. Use the Apply

variable lists button ( ) to move a set of variables from one list to another. Use the filter box ( ) on

either list to limit the variables displayed, either using a text filter, or a regular expression. This choice
can be set in the Altair page in the Preferences window. As you enter text or an expression in the box,
only those variables containing the text or expression are displayed in the list.
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Merge block example: concatenating two datasets

This example demonstrates how a Merge block can be used to concatenate two datasets together.

In this example, two datasets are imported into a blank Workflow: bananas.csv and bananas2.csv.
Both datasets contain the length and mass of bananas, with each observation representing an individual
banana. A Merge block is configured to concatenate the two datasets together, one placed after the
other so they form one larger dataset.

Workflow Layout

Datasets used

The files used in this example can be found in the samples distributed with Altair SLC.

This example uses two datasets, named bananas.csv and bananas2.csv. Each observation in the
datasets describes a banana, with numeric variables Length(cm) and Mass(g) giving each banana's
measured length in centimetres and mass in grams respectively.

Using a Merge block to concatenate two datasets

Using a Merge block to concatenate two datasets together so they form one larger dataset.

1. Import the datasets bananas.csv and bananas2.csv into a blank Workflow. Importing a CSV file
is described in Text File Import block  (page 220).

2. Right-click on the bananas.csv dataset output and type Bananas.
3. Right-click on the bananas2.csv dataset output and type Bananas2.
4. Expand the Data Preparation group in the Workflow palette, then click and drag a Merge block onto

the Workflow canvas, beneath the two imported datasets.
5. Click on the Output port of the Bananas dataset block and drag a connection towards the Input port

of the Merge block. Repeat for the Bananas2 dataset so both are connected to the Merge block.
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6. Double-click on the Merge block.

The Configure Merge dialog box is displayed.
7. From the Merge operation drop-down list, select Concatenate.
8. Click Apply and Close.

The Configure Merge dialog box closes. A green execution status is displayed in the Output port of
the Merge block.

9. Right-click on the dataset output from the Merge block, click Rename and type Bananas
Concatenated.

The two datasets have been merged, creating a new dataset containing one dataset followed by the
other.

Merge block example: interleaving two datasets

This example demonstrates how a Merge block can be used to interleave and then sort two datasets.

In this example, two datasets are imported into a blank Workflow: Bananas.csv and Bananas2.csv,
which both contain the length and mass of bananas, with each observation representing an individual
banana. A Merge block is configured to interleave the two datasets together and then sort the resulting
dataset by the Length(cm) variable. The end result is one larger dataset of all the observations, sorted
by the Length(cm) variable.

Workflow Layout

Datasets used

The files used in this example can be found in the samples distributed with Altair SLC.

This example uses two datasets, named Bananas.csv and Bananas2.csv. Each observation in the
datasets describes a banana, with numeric variables Length(cm) and Mass(g) giving each banana's
measured length in centimetres and mass in grams respectively.
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Using a Merge block to interleave two datasets

Using a Merge block to interleave and sort two datasets.

1. Import the datasets Bananas.csv and Bananas2.csv into a blank Workflow. Importing a CSV file
is described in Text File Import block  (page 220).

2. Right-click on the Bananas.csv dataset output and type Bananas.
3. Right-click on the Bananas2.csv dataset output and type Bananas2.
4. Expand the Data Preparation group in the Workflow palette, then click and drag a Merge block onto

the Workflow canvas, beneath the two imported datasets.
5. Click on the Output port of the Bananas dataset block and drag a connection towards the Input port

of the Merge block. Repeat for the Bananas2 dataset so both are connected to the Merge block..
6. Double-click on the Merge block.

The Configure Merge dialog box is displayed.
7. From the Merge operation drop-down list, select Interleave.
8. Click By Variables.

The By Variables tab is displayed.
9. Double-click Length to move it from Unselected By Variables to Selected By Variables.
10.Click Apply and Close.

The Configure Merge dialog box closes. A green execution status is displayed in the Output port of
the Merge block.

11.Right-click on the dataset output from the Merge block, click Rename and type Bananas
Interleaved.

The two datasets have been interleaved and sorted. The output is a new dataset containing all the
observations from both input datasets, sorted by the Length(cm) variable.

Mutate block

Enables you to add new variables to the working dataset. These variables can be independent of
variables in the existing dataset, or derived from them.

This block can be invoked by dragging the block from the Workflow palette to the Workflow canvas
and then dragging a connection from a dataset to the Input port of the block. The new variable name,
type and format are set and the content based on an SQL expression. You can, for example, use the
expression to duplicate the content of a variable into the new variable, or apply a function to create a
new variable based on the value of an existing variable in the dataset.

The input dataset remains unchanged, and any variables created using the Mutate block are appended
to the output working dataset.
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New variables are defined using the Mutate view. To open the Mutate view, double-click the Mutate
block.

Mutate tab
Mutated Variables

The main panel in this section gives a list of new mutated variables created by this block. Each variable
name can be changed by clicking on it.

Add variable( )
Add a new mutated variable. This will enable the fields in the Variable Definition section and add
a new entry to the Mutated Variables list.

Duplicate variable( )
Copies an existing variable from the Mutated Variables list.

Remove( )

Deletes a selected variable from the Mutated Variables list.

Configure variable( )
Opens the Mutated variable properties window.

Mutated variable properties

Variable tab

Name
Displays the output variable name. This can be edited in the Mutate view.

Type
Select the SAS language type for the new variable:

• Character, for all character and string-based variables.
• Numeric, for all numeral-based variables including any date, time or datetime variables.

Label
Specifies the display name that can be used when outputting graphical interpretation of the
variable.

Length
Specifies the maximum length of a variable.

Format
The display format for the new variable. The format applied does not affect the underlying
data stored in the DATA step. For more information see the section Formats in the Altair
SLC Reference for Language Elements.
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Informat
The format applied to data as it is read. For more information see the section Informats in
the Altair SLC Reference for Language Elements.

Grouping Variable Selection tab

Grouping variable selection

Enables you apply the new variable expressions over one or more specified variables in the
output.

The two boxes in the Grouping Variable Selection panel show Unselected Grouping
Variables and Selected Grouping Variables that will be used in the output.To move an
item from one list to the other, double-click on it. Alternatively, click on the item to select
it and use the appropriate single arrow button. A selection can also be a contiguous list
chosen using Shift and click, or a non-contiguous list using Ctrl and click. Use the Select
all button ( ) or Deselect all button ( ) to move all the items from one list to the

other. Use the Apply variable lists button ( ) to move a set of variables from one

list to another. Use the filter box ( ) on either list to limit the variables displayed, either
using a text filter, or a regular expression. This choice can be set in the Altair page in the
Preferences window. As you enter text or an expression in the box, only those variables
containing the text or expression are displayed in the list.

Output tab

Name
Specifies the variable name displayed when the working dataset is viewed in the Data
Profiler view or the Dataset File Viewer.

Type
Select the SAS language type for the new variable:

• Character, for all character and string-based variables.
• Numeric, for all numeral-based variables including any date, time or datetime variables.

Output expression as single variable
Specifies the expression output as a single variable.

Output expression as multiple variables
Specifies the expression output as multiple variables. This option enables the Multiple
Output Variable Properties panel.

Multiple Output Variable Properties panel

Select variables to apply expression to:
Enables you to specify the variables that the expression applies to. The two
boxes in the panel show Unselected Variables and Selected Variables that
will be used in the output.To move an item from one list to the other, double-
click on it. Alternatively, click on the item to select it and use the appropriate
single arrow button. A selection can also be a contiguous list chosen using
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Shift and click, or a non-contiguous list using Ctrl and click. Use the Select
all button ( ) or Deselect all button ( ) to move all the items from one

list to the other. Use the Apply variable lists button ( ) to move a set of

variables from one list to another. Use the filter box ( ) on either list to limit
the variables displayed, either using a text filter, or a regular expression. This
choice can be set in the Altair page in the Preferences window. As you enter
text or an expression in the box, only those variables containing the text or
expression are displayed in the list.

Include in output variable name
Specifies the selected variables that are included in the output. The text box
can be used to add a prefix or suffix to the variable names.

Prefix
Specifies the text to add as a prefix to the output variable names.

Suffix
Specifies the text to add as a suffix to the output variable names.

Variable name placeholder to use in expression
Specifies a name to represent the multiple variables in the expression.

Do not output this variable
Specifies that the variable is not included in the block output.

Informat
The format applied to data as it is read. For more information see the section Informats in
the Altair SLC Reference for Language Elements.

Expression
Defines the new mutated variable to be created.

Expression
Defines the data content of the new variable with an SQL expression. The expression can either
be written into this area manually, or created by double-clicking on or dragging in the input
variables, functions and operators given below the Expression entry area, which will populate the
Expression area for you. When typing manually, press Ctrl-Spacebar to show a list of suggested
terms.

The expression can be used to duplicate an existing variable by entering that variable's name;
conditionally create new values using the SQL procedure CASE expression, or create values that
are independent from existing variables.

Most SAS language DATA step functions can also be entered.
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For example, you can create a variable containing the current date and time using the SAS
language function DATETIME. This can be located in the Functions section or manually entered.
Specifying a format such as DATETIME. for the variable enables the content to be displayed in a
readable date and time format.

Variables
Lists the existing variables from the input dataset along with any newly created variables. Double-
clicking a variable will add it to the expression in the Expression area. Alternatively, variables
can be dragged into the Expression area. Variable names with spaces that are dragged in are
automatically enclosed in quotes and suffixed with an 'n' to define them as name literals.

Functions
Lists supported SQL and DATA step functions. Double-clicking a function will add it to the
Expression area. Alternatively, functions can be dragged into the Expression area. Supported
SQL language functions are:

• AVG and MEAN: Both return the arithmetic mean of a list of numeric values in a specified
variable. AVG is an alias of MEAN.

• COUNT: Can be used in three forms:

‣ Count(*): returns the total number of observations.
‣ Count(variable): returns the number of non-missing values in the specified variable.
‣ Count(variable,"string"): returns true (1) for each observation where the specified

string occurs in the specified variable, otherwise returns false (0).
• FREQ and N: Both return a count of the number of observations for a specified variable, with

behaviour dependent on the variable type:

‣ If a numeric variable is specified, missing values are included.
‣ If a string variable is specified, missing values are excluded.

FREQ is an alias of N.
• CSS: Returns the corrected sum of squares of a list of numeric values.
• CV: Returns the coefficient of variation (standard deviation as a percentage of the mean) for a

list of numeric values.
• MAX:

‣ If a numeric variable is specified, returns the maximum value.
‣ If a string variable is specified, returns the longest string.

• MIN:

‣ If a numeric variable is specified, returns the minimum value.
‣ If a string variable is specified, returns the shortest string.

• NMISS: Returns the number of missing values in a list of string or numeric values.
• PRT: Returns the probability that a randomly drawn value from the Student's t-distribution is

greater than the t-statistic for a numeric variable.
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• RANGE: Returns the difference between the maximum and minimum value in a list of numeric
values.

• STD: Returns the standard deviation of a list of numeric values.
• STDERR: Returns the standard error of the mean of a list of numeric values.
• SUM: Returns the sum of values from a list of numeric values.
• SUMWGT: Returns the sum of weights.
• T: Returns the t statistic for a variable.
• USS: Returns the uncorrected sum of squares of a list of numeric values.
• VAR: Returns the variance of a list of numeric values.
• COALESCE: Returns the first non-missing value in a list of numeric values.
• COALESCEC: Returns the first string that contains characters other than all spaces or null.
• MONOTONIC: Can only be used without arguments. Generates a new variable populated with

observation numbers, starting at 1 and finishing at the final observation.

Each function is accompanied with its decription, syntax, argument and return type. More
information on DATA step functions can be found in the Altair SLC Reference for Language
Elements.

Preview Mutated Variables
Displays a dataset preview of the output variables.

View top
Displays the first rows of the dataset preview.

View bottom
Displays the last rows of the dataset preview.

Preview tab
Displays a dataset preview of the output dataset.

Mutate block basic example

This example demonstrates how the Mutate block can be used to create a new variable.

In this example, a dataset of completed loans named loan_data.csv is imported into a blank
Workflow. The Mutate block is then used to create a new variable using a basic expression.
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Workflow Layout

Datasets used

The file used in this example can be found in the samples distributed with Altair SLC.

This example uses a dataset about loans, named loan_data.csv. Each observation in the dataset
describes a past loan and the person who took loan out, with variables such as Income, Loan_Period
and Other_Debt.

Using the Mutate block create a new variable in a dataset

Using the Mutate block to add a variable to a dataset.

1. Import the loan_data.csv dataset onto a blank Workflow canvas. Importing a CSV file is described
in Text File Import block  (page 220).

2. Expand the Data Preparation group in the Workflow palette, then click and drag a Mutate block onto
the Workflow canvas, beneath the loan_data.csv dataset.

3. Click on the loan_data.csv dataset block's Output port and drag a connection towards the Input
port of the Mutate block.

Alternatively, you can dock the Mutate block onto the dataset block directly.
4. Double-click on the Mutate block.

A Mutate view opens, by default, a single variable named NewVariable with a blank expression is
included in the block configuration.

5. Click on the NewVariable variable and rename it by typing Is_Human?.
6. In the Expression text box, type 'Yes'.
7. Press Ctrl+S to save the configuration.
8. Close the Mutate view.

The Mutate view closes. A green execution status is displayed in the Output port of the Mutate block
and the resulting dataset, Working Dataset.
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You now have appended the loan_data.csv with a new variable.

Mutate block example: creating new variables from a formula

This example demonstrates how the Mutate block can be used to create new variables using functions
and existing variables.

In this example, a dataset of basketball shots named basketball_shots.csv is imported into a blank
Workflow. The Mutate block is used to create a new variable using a formula.

Workflow Layout

Datasets used

The file used in this example can be found in the samples distributed with Altair SLC.

This example uses a dataset about basketball shots, named basketball_shots.csv. Each
observation in the dataset describes an attempt to score and the person shooting, with variables such as
height, weight and distance_feet.

Using the Mutate block create a new variables in a dataset

Using the Mutate block to build expressions and add multiple variables to a dataset.

1. Import the basketball_shots.csv dataset onto a blank Workflow canvas. Importing a CSV file is
described in Text File Import block  (page 220).

2. Expand the Data Preparation group in the Workflow palette, then click and drag a Mutate block onto
the Workflow canvas, beneath the basketball_shots.csv dataset.
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3. Click on the basketball_shots.csv dataset block's Output port and drag a connection towards
the Input port of the Mutate block.

Alternatively, you can dock the Mutate block onto the dataset block directly.
4. Double-click on the Mutate block.

A Mutate view opens, by default, a single variable named NewVariable with a blank expression is
included in the block configuration.

5. Click on the NewVariable variable and rename it by typing horizontal_distance.
6. In the Expression text box, type distance_feet*cos((angle*constant('pi')/180)).
7. Click on the Configure button ( ).

A Mutated Variable Properties window opens.
8. From the Mutated Variable Properties window, click the Type drop-down box, select Numeric and

close the window by clicking Apply and Close.
9. Click on the Add variable button ( ).

A new variable appears, by default, named NewVariable with a blank expression.
10.Click on the NewVariable variable and rename it by typing vertical_distance.
11.In the Expression text box, type distance_feet*sin((angle*constant('pi')/180)).
12.Click on the Configure button ( ).

A Mutated Variable Properties window opens.
13.From the Mutated Variable Properties window, click the Type drop-down box, select Numeric and

close the window by clicking Apply and Close.
14.Press Ctrl+S to save the configuration.
15.Close the Mutate view.

The Mutate view closes. A green execution status is displayed in the Output port of the Mutate block
and the resulting dataset, Working Dataset.

You now have appended the basketball_shots.csv dataset with the horizontal and vertical
distances from the net using a formula consisting of functions and a variable.
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Partition block

Enables you to divide the observations in a dataset into two or more working datasets, where each
working dataset contains a random selection of observations from the input dataset with a specified
weighting for the split.

Block Overview
This block can be invoked by dragging the block from the Workflow palette to the Workflow canvas and
then dragging a connection from a dataset to the Input port of the block. A Partition block is typically
used to create training and validation working datasets for model training.

By default, the weighting is set to 50:50, so two working datasets are created that each contain roughly
50% of the input dataset observations. You can add or remove output datasets in the Configure dialog
box, alter the weighting to reflect the relative importance of the output datasets created, and introduce a
seed to replicate the split of datasets.

Data partitioning is configured using the Configure Partition dialog box. To open the Configure
Partition dialog box, double-click the Partition block.

Defining partitions
The Configure Partition dialog box contains a list of all partitions that will be created.

• To create a new partition, click Add Partition. The new partition has a weight of 1.00.
• To delete a partition, select the partition in the Partition column and click Remove Partition.
• To rename a partition, select the partition in the Partition column and enter a new name.
• To change the weighting applied to a partition, select the value in Weight column and enter a new

weighting value.

Controlling observations in a partition
Every time the Partition block is executed, the partition weighting is persisted, but the sequence of
observations in the working datasets may change. The Seed field enables you to recreate the same
sequence of observations each time the Partition block is executed.

• To generate the same sequence of observations, set seed to a positive value greater than or equal to
1.

• To generate a different sequence of observations, set seed to 0 (zero).

Partition block basic example

This example demonstrates how the Partition block can be used to divide a dataset.

In this example, a dataset about iris flowers named iris.csv is imported into a blank Workflow. The
Partition block is used to divide the dataset into three parts, evenly splitting the observations.
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Workflow Layout

Datasets used

The dataset used in this example is the publicly available iris flower dataset (Ronald A. Fisher, "The
use of multiple measurements in taxonomic problems." Annals of Eugenics, vol.7 no.2, (1936); pp.
179—188.)

Each observation in the dataset describes an iris flower, named iris.csv with variables such as
species, sepal_length and petal_width.

Using the Partition block to split up a dataset

Using the Partition block to divide up a dataset into equal parts.

1. Import the iris.csv dataset onto a blank Workflow canvas. Importing a CSV file is described in Text
File Import block  (page 220).

2. Expand the Data Preparation group in the Workflow palette, then click and drag a Partition block
onto the Workflow canvas, beneath the iris.csv dataset.

3. Click on the iris.csv dataset block's Output port and drag a connection towards the Input port of
the Partition block.

Alternatively, you can dock the Partition block onto the dataset block directly.
4. Double-click on the Partition block.

A Configure Partition dialog box opens.
5. Click on the Add partition button ( ).

A third partition named Partition3 is added to the Configure Partition dialog box.
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6. Click Apply and Close.

The Configure Partition dialog box saves and closes. A green execution status is displayed in the
Output port of the Partition block and the resulting datasets: Partition1, Partition2 and
Partition3.

You now have a divided the iris.csv dataset into three equal parts.

Partition block example: Use of the Partition block in a modelling
process

This example demonstrates how the Partition block can be used to create training, testing and validation
data as input to a model.

In this example, a dataset containing information about basketball players, named
basketball_players.csv is imported into a blank Workflow. The dataset contains observations
about each basketball player, with their position through the position variable. The Partition block
splits the dataset into a training, testing and validation dataset, named Train, Test and Validation
respectively. The MLP block uses these datasets to estimate the position of each basketball player. The
model is then applied to the original dataset, basketball_players.csv, using a Score block. The
Score block generates an output dataset MLP Scored.
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Workflow Layout

Datasets used

The file used in this example can be found in the samples distributed with Altair SLC.

This example uses a dataset about basketball players, named basketball_players.csv. Each
observation in the dataset describes a basketball player, with variables such as height, weight and
firstName.

Using an Partition block as input to a predictive model

Using the Partition block to split up a dataset used as input to a predictive model that predicts the
position of a player in basketball.

1. Import the basketball_players.csv dataset onto a blank Workflow canvas. Importing a CSV file
is described in Text File Import block  (page 220).

2. Expand the Data Preparation group in the Workflow palette, then click and drag a Partition block
onto the Workflow canvas, beneath the basketball_players.csv dataset.
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3. Double-click on the Partition block.

A Configure Partition dialog box opens.
4. Click on the Add partition button ( ).

A third partition named Partition3 is added to the Configure Partition dialog box.
5. Rename your partitions:

a. Click on Partition1 and type Train to rename the partition. Click on its corresponding weight and
type 85.

b. Click on Partition2 and type Validate to rename the partition. Click on its corresponding weight
and type 10.

c. Click on Partition3 and type Test to rename the partition. Click on its corresponding weight and
type 5.

d. Click Apply and Close.

The Configure Partition dialog box saves and closes. A green execution status is displayed in the
Output port of the Partition block and the resulting datasets: Train, Test and Validate.

6. Expand the Model Training group in the Workflow palette, then click and drag an MLP block onto the
Workflow canvas, beneath the basketball_shots.csv dataset.

7. Click on the Train, Test and Validate dataset block's Output port and drag a connection towards
the Input port of the MLP block for each dataset.

8. Double-click on the MLP block.

A Multilayer Perceptron view opens, along with an MLP Preferences dialog box.
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9. From the MLP Preferences dialog box:

a. In the Train drop-down list, select Train.
b. In the Validate drop-down list, select Validate.
c. In the Test drop-down list, select Test.
d. Click on the Variable Selection tab.
e. In the Dependent variable drop-down list, select position.
f. From the Unselected Independent Variables box, double-click on the variables height, weight

and  goals_scored to move them to the Selected Independent Variables box.
g. Click on the Optimiser tab from the Optimiser drop-down list, select ADAM.
h. Click on the Stopping Criteria tab, set the Max training time (s) to 15.
i. Click Apply and Close.

The MLP Preferences dialog box closes and the Multilayer Perceptron view is displayed.
j. Click on the Train button ( ) to train the MLP model.

A graph appears on the right hand side showing the live training error during model training.
k. Press Ctrl+S to save the configuration.
l. Close the Multilayer Perceptron view.

The Multilayer Perceptron view closes. A green execution status is displayed in the Output port
of the MLP block.

10.From the Scoring grouping in the Workflow palette, click and drag a Score block onto the Workflow
canvas, below the MLP block.

A Score block and empty dataset block are created on the Workflow canvas. Note that the Score
block's configuration status (the right-hand bar of the block) is red and displays a screentip stating
that the block requires a model and a dataset input.

11.Click on the basketball_players.csv dataset block's Output port and drag a connection
towards the Input port of the Score block.

12.Click on the MLP block Output port and drag a connection towards the Input port of the Score block.

The execution status of the Score block turns green and its dataset output is populated with the
original dataset and the scored variables.

13.Right-click on the Score block's output dataset block and click Rename. Type MLP Scored and
click OK.

You now have an MLP model that predicts the probability of the position of each player.
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Query block

Enables you to create SQL code to join and interrogate database tables or datasets.

Block Overview
This block can be invoked by dragging the block from the Workflow palette to the Workflow canvas and
then dragging a connection from one or more datasets to the Input port of the block. A Query block
enables you to create SQL code that you can use to join database tables or datasets, to get specific
data from one or more database tables or datasets. The terms dataset and tables, and variables and
columns, are equivalent for this block. To create the SQL code, double-click the block to open the Query
full screen editor. The editor consists of three tabs:

• Query – Select this tab to create your query. The tab is described in more detail below.
• SQL – Select this tab to view the SQL code that results from the query you create.
• Preview – Select this tab to preview the results of the query you have created. This displays the data

that is written to the working dataset by the block when you save it.

Query tab
The Query tab contains the following panels:

• Tables – This shows the database tables that have been connected to the block, enables you to
select columns for the query and to join the tables if you have connected more than one table to the
block.

• Columns – Lists the columns from the tables that the query will use.
• Where – Enables you to specify WHERE clauses for the columns in the query.
• Having – Enables you to specify a HAVING clause for grouped columns. This panel is only displayed

if you select Group for a column in the Columns panel.

The working dataset created by this block contains the selected columns from an input table or from
joined tables. You can create expressions based on a selected column and create new columns based
on the results, or write the result of the expression into the same column.

Saving the query
Press Ctrl+S to save the configuration..

Tables

Enables you to select columns (variables) to be used in the query, and to join tables if more than one
has been connected to the block.

This panel displays the tables connected to the block. You can:
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• Join the tables, if there is more than one.
• Select columns from the tables for the query.

To join tables, select a column in one table and drag it on to a column in another table. The tables are
then joined on these two columns. This creates an inner join between the tables. The table on which
you click first is the left-hand table in the join. To create a different kind of join, you need to configure the
join. You can configure the join using the Join Properties dialog. You can also specify the columns to
connect, and the left table, using the Join Properties dialog.

If you want to create a natural or cross join for the tables, select the heading of one table, and drag it
onto the heading of the other table. This created a natural join by default. If you want to change it to a
cross join, use the Join Properties dialog.

Configuring the join properties
To configure the join properties, double-click the line that connects the tables. This displays the Join
Properties dialog.

The following properties can be configured:

Join type
Specifies the type of join used to combine the values in the left and right tables. Inner and outer
joins use a condition to select rows, enabling you to select the columns you want to compare. The
column condition is defined using Join operator.

Inner
Creates a working dataset that includes rows from both tables where the specified condition
matches for the specified column.

Left Outer
Creates a working dataset that contains all rows in the left table and the values of those
columns from rows in the right table where the specified condition matches for the specified
column.

Right Outer
Creates a working dataset that contains all rows in the right table and the values of those
columns from rows in the left table where the specified condition matches for the specified
column.

Full Outer
Creates a working dataset that contains all rows from either or both of the right table and
the left table where the specified column matches the specified condition.

Cross
Creates a working dataset that consists of all rows in the left table joined with every row in
the right table.
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Natural
Creates a working dataset using commonly-named columns in the left and right tables. The
table only includes rows where the column in the left table has a value that matches the
column in the right dataset. Any other rows are ignored.

You can display the type of join that currently applies between tables can be displayed if you
hover the mouse pointer over the line connecting the tables.

Join operator
Specifies the type of operator for the join. The condition uses the operator and the specified
columns to define which rows are included or excluded by a join type. The operators available are:

= Equal to
!= Not equal to
>= Greater than or equal to
< Less than
<= Less than or equal to

Left dataset
Identifies the left dataset (table) in the join, and the columns on which to join.

Dataset
Select the table to be used as the left table. This is set by default if you have already
connected the tables by dragging.

Column
Specify the column in the left table to be used in the join. This is set by default if you have
already connected tables using the table representation in the Join Editor.

Right dataset
Identifies the right dataset (table) in the join and the columns on which to join.

Dataset
Select the table to be used as the right table. This is set by default if you connect tables
using the table representation in the Join Editor.

Column
Specify the column in the right table to be used in the join. This is set by default if you have
already connected tables using the table representation in the Join Editor.

Columns

Lists the columns that will be included in the SQL query and enables you to create expressions.

The Columns pane specifies the columns used in the query. You can also define expressions to be
applied to the columns.
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Columns panel
The Columns panel lists the columns that are used to populate the working dataset that results from this
block.

You can add a column to this panel by:

Dragging

Click a column name in a table in the Tables panel and then drag it to the Columns panel. A
dragged column is added to the end of those already listed. If you need more control over the
order of columns in the output, use the Add Columns dialog box instead.

You can add all columns from a table by dragging the table header into the Columns panel. This
adds an entry to Column of the form table-name.*, where table-name is the name of the table
you dragged, and * is the wildcard that specifies all columns in that table.

Double clicking

You can enter a column name in the Columns panel by double clicking a column in a table in the
Tables panel. The column is added to the end of those already listed. If you need more control
over the order of columns in the output, use the Add Columns dialog box instead.

You can add all columns from a table by double clicking the table header. This adds an entry to
Column of the form table-name.*, where table-name is the name of the table you dragged,
and * is the wildcard that specifies all columns in that table.

Using the Add Columns dialog box

You can enter a column name in the Columns panel by clicking on the Add Columns ( ) icon in
the panel. This opens the Add Columns dialog box.

The Add Columns dialog box enables you to specify which columns are to be included. Two lists
are presented:

• Available columns, which shows the columns available for selection.
• Columns to add, which shows the columns that have been selected.

To move an item from one list to the other, double-click on it. Alternatively, click on the item
to select it and use the appropriate single arrow button. A selection can also be a contiguous
list chosen using Shift and click, or a non-contiguous list using Ctrl and click. Use the Select
all button ( ) or Deselect all button ( ) to move all the items from one list to the other.

Use the Apply variable lists button ( ) to move a set of variables from one list to another.

Use the filter box ( ) on either list to limit the variables displayed, either using a text filter, or a
regular expression. This choice can be set in the Altair page in the Preferences window. As you
enter text or an expression in the box, only those variables containing the text or expression are
displayed in the list.

The list of variables contains *, which can be used to specify that all variables from all tables are
used in the query, and table-name.*, which can be used to specify that all variables from the
table table-name are included in the query.
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Editing a row in Columns
You can double click in Column in an empty row to enter a column name directly. When you
have entered the column name, press the Return key. The Select, Sort and Group controls then
become available, and you can edit the corresponding Alias.

The working dataset consists of the columns listed (if they remain selected), and any columns created as
a result of SQL expressions you create using the Expression Builder.

The Columns panel contains the following:

Column
Specifies the name of a column that is used in the SQL query to create the working dataset.

Alias

Specifies an alternative name for a column. If you do not specify an alias using this column, then
the name specified in Column is the name used in the working dataset.

If you create an SQL expression based on the column name, a new column is created with a
system-generated name to hold the result; Alias remains blank by default. However, if you enter
a name in this cell, the result is held in a column with that name. Alternatively, if the column
name specified here is the same as the name in Column, then the values created using an SQL
expression are written to that column rather than to a column with a system-generated name; that
is, the result of the expression replaces the existing value of the column.

Select
The column is used in the SQL SELECT statement in the SQL query that is created to generate
the working dataset. By default, when you add a column to the Columns pane, it is selected.
However, you can deselect it if required.

Sort
Specifies the sort order for the column. Click on the box to cycle through the choices: ascending
(↑), descending (↓), or none (–); none is the default.

Group
Specifies that the column is an SQL GROUP BY column, enabling you to group results.

You can rearrange the order of the columns using the up (  or down ( ) controls. The order of the
columns affects the order of the columns in the SELECT clause of the SQL query, and might therefore
affect the result of the query.

Expression Builder
The Expression Builder enables you to specify an SQL expression that creates a new value for the table.
This value is written to a column with a system-generated name, written to a column with a user-defined
name, or replaces the value in the column for which the expression is created. The SQL expression can
created either entirely manually, or by using the controls in the Expression Builder.

To open the Expression Builder you can do one of the following:

• Double click a column name in the Columns panel.
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• Right click a column in the Columns panel. A pop-up is displayed. Click Edit with Expression
Builder. The Expression Builder dialog box opens.

At the top of the dialog box is the SQL Expression area, into which you can manually enter an SQL
expression. You can also enter most SAS language DATA step functions in this box. For example, you
can create a column that contains the current date and time by manually entering the SAS language
function DATETIME. Specifying a format such as DATETIME. for the column enables the content to be
displayed in a readable date and time format.

If your SQL expression creates another value, this value is stored in a temporary column with a system-
generated name, unless you specify a column name in Alias.

The other controls in this dialog box enable you to create the elements of an expression in the SQL
Expression box. To enter an element into the area, you can double click an element, or drag it. The
elements available are provided in two lists:

Operators
Lists SQL operators that can be used with columns and functions. Click an operator to add it to the
SQL Expression area.

Input variables
The columns (variables) that can be used in the SQL expression are listed in Input variables. If
the query consists of more than one table, the column name is prefixed with the table name, so
the column name has the form table-name.column-name.

Functions
Lists supported SQL functions. Double-clicking an SQL function will add it to the SQL Expression
area. Alternatively, functions can be dragged into the SQL Expression area. Supported functions
are:

AVG
This is an alias of MEAN.

MEAN
Returns the arithmetic mean of a list of numeric values in a specified column.

COUNT
Can be used in three forms:

• Count(*): returns the total number of rows.
• Count(column): returns the number of non-missing values in the specified column.
• Count(column,"string"): returns true (1) for each observation where the specified

string occurs in the specified column, otherwise returns false (1).

FREQ
This is an alias of N.

N
Returns a count of the number of rows for a specified column, with behaviour dependent on
the column type:
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• If the column contains numeric data, missing values are included.
• If the column contains character data, missing values are excluded.

CSS
Returns the corrected sum of squares of a list of numeric values.

CV
Returns the coefficient of variation (standard deviation as a percentage of the mean) for a
list of numeric values.

MAX

• If a numeric column is specified, returns the maximum value.
• If a string column is specified, returns the longest string.

MIN

• If a numeric column is specified, returns the minimum value.
• If a string column is specified, returns the shortest string.

NMISS
Returns the number of missing values in a list of string or numeric values.

PRT
Returns the probability that a randomly drawn value from the Student T distribution is
greater than the T statistic for values in the column.

RANGE
Returns the difference between the maximum and minimum value in a list of numeric
values.

STD
Returns the standard deviation of a list of numeric values.

STDERR
Returns the standard error of the mean of a list of numeric values.

SUM
Returns the sum of values from a list of numeric values.

SUMWGT
Returns the sum of weights.

T
Returns the t statistic for a column.

USS
Returns the uncorrected sum of squares of a list of numeric values.
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VAR
Returns the variance of a list of numeric values.

COALESCE
Returns the first non-missing value in a list of numeric values.

COALESCEC
Returns the first string that contains characters other than all spaces or null.

MONOTONIC
Can only be used without arguments. Generates a new column populated with observation
numbers, starting at 1 and finishing at the final observation.

WHERE and HAVING edit box

Enables you to specify a WHERE or HAVING clause for the SQL query.

The SQL query you create acts on every row of the table unless you specify a WHERE or HAVING
clause to limit the rows selected. Both clauses specify that only those rows where a condition is met are
used for further processing.

You specify a WHERE clause using the WHERE edit box. You directly enter the required clause in this
box. The HAVING edit box appears if you select the GROUP option for a column. You use HAVING with
grouped rows, and WHERE with individual rows. You can use both WHERE and HAVING in the same query.

You can add a variable or function to the WHERE or HAVING edit box by typing the required variable or
function. You can alternatively use the Variables or Functions box below the editor. To do this, double-
click a required function or variable to add it to the WHERE or HAVING edit box.

Query block example: selecting specified rows

This example demonstrates how the Query block can be used to create a query that results in only the
selected rows being written to an output dataset.

In this example, a comma separated variable file of books named lib_books.csv is imported into a
blank Workflow. The output required is a working dataset that contains the titles of books by a particular
author that are no longer in the library collection.
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Workflow Layout

Dataset used

The file used in this example can be found in the samples distributed with Altair SLC.

This example uses about dataset of books, named lib_books.csv. Each observation in the dataset
describes a book, with variables such as Title, ISBN and Author.

Using the Query block to create a basic query

Creating a query that writes only the specified rows and variables to the working dataset.

1. Import the file lib_books.csv into a blank Workflow canvas. Importing a CSV file is described in
Text File Import block  (page 220).

2. Drag a Query block onto the Workflow canvas, beneath the lib_books.csv block.
3. Draw a connection between the Working Dataset output port of the LIB_BOOKS.csv block and the

Query block input port.
4. Double-click the Query block.

The Query editor is displayed.
5. In the Tables panel, in the Working Dataset, double click Title and then In_stock.

The Title and In_stock rows are added to the Columns panel.
6. Ensure the columns are included in the query by selecting Select, if necessary. This control is

selected by default when you enter a column in the Columns table.
7. Enter the following in the Where box:

author EQ "Rendell, Ruth" AND In_Stock EQ "n"

This specifies that only those rows where the Author column contains the text Rendell, Ruth
and the In_Stock column contains n, are output to the working dataset.

8. Press Ctrl+S to save the configuration..
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9. Close the Query editor.

The Query editor closes. A green execution status is displayed in the Output port of the Query block.

You now have a working dataset containing the selected rows.

Query block example: joining tables and selecting rows

This example demonstrates how the Query block can be used to create a query that joins two tables and
selects specified rows from the joined table.

In this example, there are two comma separated variable files; one contains a list of books and
information about those books (LIB_BOOKS.CSV), the other contains information about book subjects
(DDN_SUBJECTS.CSV). These are imported into a blank Workflow. The working dataset contains the
output required from the input file, which is a list non-fiction book subjects and the number of books with
that subject, for a specified author.

Workflow Layout

Datasets used

The file used in this example can be found in the samples distributed with Altair SLC.

The datasets used in this example are:

• A dataset about books, named lib_books.csv. Each observation in the dataset describes a book,
with variables such as Title, ISBN and Author.

• A dataset linking numbers in the Dewey Decimal Number system to subjects, named
DDN_SUBJECTS.CSV.
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Using the Query block to join tables and to group output

Creating a query that joins two tables, acts only on the specified rows, and outputs grouped data.

1. Import the LIB_BOOKS.CSV and the DDN_SUBJECTS.CSV files into a blank Workflow canvas.
Importing a CSV file is described in Text File Import block  (page 220).

The working datasets of both datasets created by the blocks is called Working Dataset. Because this
might be confusing, you can rename the datasets. To do this for each working dataset, right click-on
it, click Rename and enter a suitable name. In this example, lib_books and ddn_subjects have
been used for the corresponding working datasets.

2. Drag a Query block onto the Workflow canvas, beneath the Text File Import blocks.
3. Draw a connection between the output ports of the working datasets and the Query block input port.
4. Double-click the Query block.

The Query editor is displayed.
5. In the Tables panel, in the Subjects table, drag the column DDN over the variable

Dewey_Decimal_Number in the Lib_books table.

An inner join is created between the two tables. This is the default join. The Subjects table is the
left dataset in the join. A line is drawn between the variables in the two tables.

6. Double click Subject in the Subjects table.

The Subject row is added to the Columns panel.
7. Right click on Subject.

The Edit with Expression Builder context menu is displayed.
8. Click Edit with Expression Builder.

The Expression Builder is displayed. The SQL Expression editor box contains the column name
Select.

9. Click Count in the Function list.

The function COUNT() is added to the SQL Expression editor.
10.Edit the contents of SQL Expression so that the expression is COUNT(Subject).

This expression provides a total count of subject names. The expression replaces the column name
in the Columns pane. The value returned by COUNT is written into a column with a system-generated
name, unless you specify an alias. The next steps shows how to do this.

11.Click the Alias box in the row that now contains COUNT(Subject). The box becomes editable. Type
a name for the column: Number in category. This replaces the system-generated name.

12.Enter the following in the Where box:

author EQ "Wilson, Colin"

This specifies that the only rows used in the query are those where the Author column contains the
text Wilson, Colin.
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13.In the first row of Column, click Group.

This ensures that the rows are grouped by the values of Subject; the total number of each group of
subjects is then returned to the column Number in category.

The Having edit box is also displayed. This enable you to enter an SQL HAVING clause for the group
if required.

14.Enter the following in the Having box:

subject NE "English fiction"

This ensures that only non-fiction subjects for the specified author are counted.
15.Double click Subject in the Subjects table again.

The Subject row is added as another row in the Columns panel, beneath the first row.
16.Press Ctrl+S to save the configuration..

The following SQL query is created:

select COUNT(Subject) as 'Number in category'n,
 Subjects.Subject 
from  Subjects as Subjects inner join lib_books as lib_books on
 lib_books.Dewey_Decimal_Number = Subjects.DDN
where author EQ "Wilson, Colin"
group by Subject
having subject NE "English fiction"

You can see this by clicking the SQL tab in the Query editor. The working dataset contains the selected
values:

                 Subject                       Number in category
Communities                                                     1
Conscious mental processes & intelligence                       1
English essays                                                  1
Social interaction                                              2
Specific topics in parapsychology & occultism                   4

Rank block

Enables you to rank observations in an input dataset using one or more numeric variables.

This block can be invoked by dragging the block from the Workflow palette to the Workflow canvas and
then dragging a connection from a dataset to the Input port of the block. The input dataset remains
unchanged, and any rank variables created using the Rank block are appended to the output working
dataset.

Rank scores are defined using the Configure Rank dialog box. To open the Configure Rank dialog box,
double-click the Rank block.
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Variable Selection panel
Specifies which variables are to be ranked. The upper list of Unselected Variables shows variables
that can be specified for ranking and the lower list of Selected Variables shows variables that have
been specified for ranking. To move an item from one list to the other, double-click on it. Alternatively,
click on the item to select it and use the appropriate single arrow button. A selection can also be a
contiguous list chosen using Shift and click, or a non-contiguous list using Ctrl and click. Use the Select
all button ( ) or Deselect all button ( ) to move all the items from one list to the other. Use the

Apply variable lists button ( ) to move a set of variables from one list to another. Use the filter box

( ) on either list to limit the variables displayed, either using a text filter, or a regular expression. This
choice can be set in the Altair page in the Preferences window. As you enter text or an expression in
the box, only those variables containing the text or expression are displayed in the list.

Parameters panel
Enables you to specify how the rank scores for observations in the dataset are calculated.

General
Specifies ranking order and how identical results are ranked.

Rank order
Specifies the order in which ranking scores are applied to observations ordered by the
variables specified in the Variable Selection panel.

Ascending
Rank scores are specified in ascending order, with the lowest rank applied to the
smallest observation.

Descending
Rank scores are specified in descending order, with the highest rank applied to the
smallest observation.

Use default treatment for ties
When selected, Tie Treatment is chosen automatically based on the Ranking Method
selected:

• If Ranking Method is specified as Fractional, Fractional (N + 1), or Percent, Tie
Treatment is automatically set to High.

• If Ranking Method is specified as Ordinal, Savage, Groups, or Normal, then Tie
Treatment is automatically set to Mean.

Tie Treatment
Specifies the ranking of identical results.

The following input dataset contains the result of the IAAF 2015 World Championships 100
Meters Men – Final, and is used in the examples below.
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Name Time

Bolt, Usain 9.79

Bromell, Trayvon 9.92

De Grasse, Andre 9.92

Gatlin, Justin 9.80

Gay, Tyson 10.00

Powell, Asafa 10.00

Vicaut, Jimmy 10.00

Rodgers, Mike 9.94

Su, Bingtian 10.06

Dense
Ranks the variable using the dense tie resolution. The method assigns the same rank
value to all tied variables and the next variable is assigned the immediately-following
rank.

Applying Dense to the input dataset above, creates the following working dataset:

Name Time Time_RANK

Bolt, Usain 9.79 1

Bromell, Trayvon 9.92 3

De Grasse, Andre 9.92 3

Gatlin, Justin 9.80 2

Gay, Tyson 10.00 5

Powell, Asafa 10.00 5

Vicaut, Jimmy 10.00 5

Rodgers, Mike 9.94 4

Su, Bingtian 10.06 6

High
Ranks the variable using the high tie resolution. The method assigns the highest rank
value to all tied variables.

Applying High to the input dataset described above creates the following working
dataset:

Name Time Time_RANK

Bolt, Usain 9.79 1

Bromell, Trayvon 9.92 4

De Grasse, Andre 9.92 4
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Name Time Time_RANK

Gatlin, Justin 9.80 2

… … …

Bromell, Trayvon and De Grasse, Andre have the same time, and ranks 3 and 4.
Specifying High gives both a rank of 4.

Low
Ranks the variable using low tie resolution. The method assigns the lowest rank
value to all tied variables.

Applying LOW to the input dataset described above creates the following dataset:

Name Time Time_RANK

Bolt, Usain 9.79 1

Bromell, Trayvon 9.92 3

De Grasse, Andre 9.92 3

Gatlin, Justin 9.80 2

… … …

Bromell, Trayvon and De Grasse, Andre have the same time, and ranks 3 and 4.
Specifying Low gives both a rank of 3.

Mean
Ranks the variable using mean tie resolution. The method assigns the mean rank
value to all tied variables.

Applying Mean to the input dataset described above creates the following working
dataset:

Name Time Time_RANK

Bolt, Usain 9.79 1

Bromell, Trayvon 9.92 3.5

De Grasse, Andre 9.92 3.5

Gatlin, Justin 9.80 2

… … …

Bromell, Trayvon and De Grasse, Andre have the same time, and ranks 3 and 4.
Specifying Mean gives both a rank of 3.5.

Ranking Method
Specifies how the rank value for each observation is calculated.

Ordinal
Assigns an incrementing rank number to each observation.
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Fractional
Each rank value is calculated as the ordinal ranking method divided by the number of
observations in the dataset.

Fractional (N+1)
Each rank value is calculated as the ordinal ranking method divided by the one plus the
number of observations in the dataset.

Percent
Each rank value is calculated as the ordinal ranking method divided by the number of
observations in the dataset, expressed as a percentage.

Savage
The rank values for the observations are transformed to an exponential distribution using
the Savage method. Subtracting one from the transformation result centres the rank score
around zero (0):

Where:

• R is the rank score.

• N is the number of observations.

Groups
Divides the observations into the specified number of groups based on the ranking score.
Observations with tied ranking scores are allocated to the same group.

Normal
The rank values for the observations are transformed to a standard normal distribution using
the selected method:

Blom
Creates the standard normal distribution of rank scores using a Blom transformation:

Where:

• R is the rank score.

• N is the number of observations.

Tukey
Creates the standard normal distribution of rank scores using a Tukey transformation:
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Where:

• R is the rank score.

• N is the number of observations.

VW
Creates the standard normal distribution of rank scores using a Van der Waerden
transformation:

Where:

• R is the rank score.

• N is the number of observations.

Rank block basic example

This example demonstrates how the Rank block can be used to assign ranking values to observations
within a dataset, and generate a new variable containing those ranks.

In this example, a dataset of exam scores named exam_results.csv is imported into a blank
Workflow. The Rank block is used to rank the MockResult variable and append the dataset with an
ranking variable.

Workflow Layout

Dataset used

The file used in this example can be found in the samples distributed with Altair SLC.
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ExamResults dataset
This example uses a dataset of exam results, named exam_results.csv. Each observation in
the dataset describes a student, with a numeric variable HoursStudy giving their hours of study
for an exam, and a binary variable Pass? indicating whether they passed the exam or not.

Using the Rank block to rank a variable in a dataset

Using the Rank block to rank students based on their test scores.

1. Import the exam_results.csv dataset onto a blank Workflow canvas. Importing a CSV file is
described in Text File Import block  (page 220).

2. Expand the Data Preparation group in the Workflow palette, then click and drag a Rank block onto
the Workflow canvas, beneath the exam_results.csv dataset.

3. Click on the exam_results.csv dataset block's Output port and drag a connection towards the
Input port of the Rank block.

Alternatively, you can dock the Rank block onto the dataset block directly.
4. Double-click on the Rank block.

A Configure Rank dialog box opens.
5. From the Configure Rank dialog box Variable selection tab, double-click on the MockResult

variable to move it from the Unselected Variables box to the Selected Variables box.
6. From the Configure Rank dialog box Parameters tab:

a. Under the Rank order dialog box, select Descending.
b. Clear the Use default treatment for ties checkbox.

The Tie treatment dialog box becomes available for configuration.
c. Under Tie treatment dialog box select Low.
d. Click Apply and Close.

The Configure Rank dialog box closes. A green execution status is displayed in the Output ports
of the Rank block and of the new dataset Working Dataset.

You now have a new dataset that includes a ranking variable to rank students in the
exam_results.csv dataset, based on their test result.
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Rank block example: summarising and ranking a dataset

This example demonstrates how Rank block can be used to draw a rank a dataset that has been
summarised.

In this example, a dataset containing information about basketball shots, named
basketball_shots.csv is imported into a blank Workflow. The dataset contains information
about a basketball shots and whether they score through the Scored variable. The Aggregate
block summarises the dataset into a list of players and how often they score by creating the variable
Score_Ratio and it generates an output dataset named Player Agg. The Rank block uses the
summarised Score_Ratio variable to rank each basketball player and generate an output dataset
named Player Ranking.

Workflow Layout

Datasets used

The file used in this example can be found in the samples distributed with Altair SLC.

This example uses a dataset about basketball shots, named basketball_shots.csv. Each
observation in the dataset describes an attempt to score and the person shooting, with variables such as
height, weight and distance_feet.
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Using the Rank block to rank a dataset

Using the Rank block to assign rankings to a dataset that has been summarised.

1. Import the basketball_shots.csv dataset onto a blank Workflow canvas. Importing a CSV file is
described in Text File Import block  (page 220).

2. Expand the Data Preparation group in the Workflow palette, then click and drag an Aggregate block
onto the Workflow canvas, beneath the basketball_shots.csv dataset.

3. Click on the basketball_shots.csv dataset block's Output port and drag a connection towards
the Input port of the Aggregate block.

Alternatively, you can dock the Aggregate block onto the dataset block directly.
4. Double-click on the Aggregate block.

A Configure Aggregate dialog box opens.
5. From the Configure Aggregate dialog box Expressions tab:

a. From the Variable drop-down box, select Score box.
b. From the Function drop-down box, select Average box.
c. Click the New variable box, type in Score_Ratio.

6. From the Configure Aggregate dialog box Grouping Variable Selection tab:

a. From the Unselected Grouping Variables box, double-click on the variables firstName,
lastName and  Position to move them to  the Selected Grouping Variables box.

b. Click Apply and Close.

The Configure Aggregate dialog box closes. A green execution status is displayed in the Output
ports of the Rank block and of the new dataset Working Dataset.

7. Right-click on the Aggregate block output dataset block and click Rename. Type Player Agg and
click OK.

8. From the Data Preparation group in the Workflow palette, click and drag a Rank block onto the
Workflow canvas, beneath the Aggregate block.

9. Click on the Aggregate block Player Agg dataset block Output port and drag a connection towards
the Input port of the Rank block.

Alternatively, you can dock the Rank block onto the dataset block directly.
10.Double-click on the Rank block.

A Configure Rank dialog box opens.
11.From the Configure Rank dialog box Variable selection tab, double-click on the Score_Ratio

variable to move it from the Unselected Variables box to the Selected Variables box.
12.From the Configure Rank dialog box Parameters tab, in the Rank order drop-down list, select

Descending.
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13.Click Apply and Close.

The Configure Rank dialog box closes. A green execution status is displayed in the Output ports of
the Rank block and of the new dataset Working Dataset.

14.Right-click on the Rank block output dataset block and click Rename. Type Player Ranking and
click OK.

You now have a new dataset that summarises basketball players in basketball_shots.csv dataset
and ranks them.

Sampling block

Enables you to create a working dataset that contains a small representative sample of observations in
the input dataset.

This block can be invoked by dragging the block from the Workflow palette to the Workflow canvas and
then dragging a connection from a dataset to the Input port of the block. A sample is configured using
the Configure Sampling dialog box. To open the Configure Sampling dialog box, double-click the
Sampling block.

Sample Type
Specifies the type of samples, either Random or Stratified.

Random Sampling
A working dataset is created by selecting a random set of observations to match the required
sample size.

Sample Size
Specifies how the sample is constructed:

• Percentage of obs specifies the percentage of observations in the input dataset to
include in the output working dataset.

• Fixed number of obs specifies the absolute number of observations in the input
dataset to include in the output working dataset.

Stratified Sampling
The dataset is divided in groups where observations contain similar characteristics. Sampling is
applied to each group, ensuring that each group is represented in the output working dataset.

Strata Variable
Specifies the variable in the dataset to use when dividing the whole dataset into groups.

Sample Size
Specifies how the sample is constructed:

• Percentage of stratum obs specifies the percentage of each group to include in the
output working dataset.
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• Custom enables you to determine the number of observations from each group, allowing
you to increase or decrease the weight of each group in the output working dataset.

Use Probability Proportional to Size Sampling
Specifies that samples are taken using the same probability used to divide the input dataset
into groups.

Size variable
Specifies a variable that indicates sample sizes.

Seed
Specifies whether the same set of observations is included in the output working dataset each
time the Sampling block is executed. A Seed can be applied to either a random sample or a
stratified sample.

• To generate the same sequence of observations, set Seed to a positive value greater than or
equal to 1.

• To generate a different sequence of observations, set Seed to 0 (zero).

Sampling block basic example

This example demonstrates how the Sampling block can be used to take samples of a dataset.

In this example, a dataset of books named lib_books.csv is imported into a blank Workflow. The
Sampling block is used to filter the columns and output a subset of the dataset.

Workflow Layout

Dataset used

The file used in this example can be found in the samples distributed with Altair SLC.

This example uses a dataset of books, named lib_books.csv. Each observation in the dataset
describes a book, with variables such as Title, ISBN and Author.
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Using the Sampling block to sample columns in a dataset

Using the Sampling block to restrict rows in a dataset.

1. Import the lib_books.csv dataset onto a blank Workflow canvas. Importing a CSV file is described
in Text File Import block  (page 220).

2. Expand the Data Preparation group in the Workflow palette, then click and drag a Sampling block
onto the Workflow canvas, beneath the lib_books.csv dataset.

3. Click on the lib_books.csv dataset block's Output port and drag a connection towards the Input
port of the Sampling block.

Alternatively, you can dock the Sampling block onto the dataset block directly.
4. Double-click on the Sampling block.

A Configure Sampling dialog box opens.
5. From the Configure Sampling dialog box:

a. Under Sampling Type, select Random box.
b. Under Random Sampling select Percentage of obs and enter 10.
c. Click Apply and Close.

The Configure Sampling dialog box closes. A green execution status is displayed in the Output
ports of the Sampling block and of the new dataset Working Dataset.

You now have a new dataset that samples 10% of the original lib_books.csv dataset.

Sampling block example: taking a stratified sample

This example demonstrates how Sampling block can be used to draw a stratified sample.

In this example, a dataset of books named lib_books.csv is imported into a blank Workflow. The
Sampling block is used to take a stratified sample of the dataset.

Workflow Layout
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Dataset used

The file used in this example can be found in the samples distributed with Altair SLC.

This example uses a dataset of books, named lib_books.csv. Each observation in the dataset
describes a book, with variables such as Title, ISBN and Author.

Using the Sampling block to take a stratified sample of a dataset

Using the Sampling block to sample a dataset and maintain proportions of a variable in the output
sample.

1. Import the lib_books.csv dataset onto a blank Workflow canvas. Importing a CSV file is described
in Text File Import block  (page 220).

2. Expand the Data Preparation group in the Workflow palette, then click and drag a Sampling block
onto the Workflow canvas, beneath the lib_books.csv dataset.

3. Click on the lib_books.csv dataset block's Output port and drag a connection towards the Input
port of the Sampling block.

Alternatively, you can dock the Sampling block onto the dataset block directly.
4. Double-click on the Sampling block.

A Configure Sampling dialog box opens.
5. From the Configure Sampling dialog box:

a. Under Sampling Type, select Stratified.

A new set of options appear for creating a stratified sample. A frequency table of the strata
variable in the input dataset and output dataset are also shown.

b. In the Strata variable drop-down list, select In_Stock.
c. Under Sample size, select Percentage of stratum obs and enter 10.
d. Click Apply and Close.

The Configure Sampling dialog box closes. A green execution status is displayed in the Output
ports of the Sampling block and of the new dataset Working Dataset.

You now have a new dataset that takes a stratified sample of the lib_books.csv dataset.
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Select block

Enables you to create a new dataset containing specific variables from an input dataset.

This block can be invoked by dragging the block from the Workflow palette to the Workflow canvas
and then dragging a connection from a dataset to the Input port of the block. Variables included in the
working dataset are specified using the Configure Select dialog box. To open the Configure Select
dialog box, double-click the Select block.

The Configure Select dialog box enables you to specify which variables are to be included. Two lists
are presented: Unselected Variables showing variables available for selection, and Selected Variables
showing variables selected. Required variables can be moved between the lists:

• To move an item from one list to the other, double-click on it. Alternatively, click a list item and then
click Select to move the item between lists.

• To select multiple items, press Shift and click the first and last required items for a contiguous list, or
hold Ctrl and click individual items to create a non-contiguous list. Use the Select all button (  ) or
Deselect all button (  ) to move all the items from one list to the other.

• Use the Apply variable lists button to move a set of variables from one list to another. Variables are
added to a list in the Data Profiler panel

• Use the filter box on either list to limit the variables displayed, either using a text filter, or a regular
expression. This choice can be set in the Altair page in the Preferences window. As you enter text or
an expression in the box, only those variables containing the text or expression are displayed in the
list.

Select block basic example

This example demonstrates how the Select block can be used to retain variables in a dataset.

In this example, an incomplete dataset of books named lib_books.csv is imported into a blank
Workflow. The Select block is used to retain the variables and output a subset of the dataset.
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Workflow Layout

Dataset used

The file used in this example can be found in the samples distributed with Altair SLC.

This example uses a dataset of books, named lib_books.csv. Each observation in the dataset
describes a book, with variables such as Title, ISBN and Author.

Using the Select block to select columns in a dataset

Using the Select block to keep or discard certain columns in a dataset.

1. Import the lib_books.csv dataset onto a blank Workflow canvas. Importing a CSV file is described
in Text File Import block  (page 220).

2. Expand the Data Preparation group in the Workflow palette, then click and drag a Select block onto
the Workflow canvas, beneath the lib_books.csv dataset.

3. Click on the lib_books.csv dataset block's Output port and drag a connection towards the Input
port of the Select block.

Alternatively, you can dock the Select block onto the dataset block directly.
4. Double-click on the Select block.

A Configure Select dialog box opens.

315



Altair Analytics Workbench user guide
Version 2023

5. From the Configure Select dialog box:

a. From the Unselected Variables box, double-click on the variable Author to move it to the
Selected Variables box.

b. Click Apply and Close.

The Configure Select dialog box closes. A green execution status is displayed in the Output
ports of the Select block and of the new dataset Working Dataset.

You now have a new dataset that contains only the Author variable from the lib_books.csv dataset.

Select block example: using the variable selection filter

This example demonstrates how the filter tool in the variable selection panel can be used to select
specific columns.

In this example, a Select block is used to filter variables in the Tables.csv dataset. Two Select blocks
are configured to output two different subsets of Tables.csv, the Select blocks generate the output
datasets Table A and Table 10.

Workflow Layout

Datasets used

The file used in this example can be found in the samples distributed with Altair SLC.

This example uses a dataset of numbers, named Tables.csv. Each variable is distinguished by letters
A-D and numbers 1-20, with variables such as A1, B7 and C15.
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Using the Select block to get subsets of a table

Making use of the variable selection filter in the Select block to quickly filter columns in a dataset of
many variables.

1. Import the Tables.csv dataset onto a blank Workflow canvas. Importing a CSV file is described in
Text File Import block  (page 220).

2. From the Data Preparation grouping in the Workflow palette, click and drag two Select blocks onto
the Workflow canvas, beneath the Tables.csv dataset.

3. Click the Tables.csv dataset block Output port and drag a connection towards the Input port of
each Select block.

4. Configure the first Select block:

a. Double-click on a Select block.

A Configure Select dialog box opens.
b. From the Unselected Variables pane, click on the filter box with the filter icon ( ) and type A.

The variable list is filtered to only display variables that contain the letter A.
c. Click on the Select all button ( ) to move all unselected variables to the Selected variables

pane.
d. Click Apply and Close.

The Configure Select dialog box closes. A green execution status is displayed in the Output
ports of the Select block and of the new dataset Working Dataset.

e. Right-click on the Select block's output dataset block and click Rename. Type Table A and click
OK.

5. Configure the second Select block:

a. Double-click on the other Select block.

A Configure Select dialog box opens.
b. From the Unselected Variables pane, click on the filter box with the filter icon ( ) and type 10.

The variable list is filtered to only display variables that contain the number 10
c. Click on the Select all button ( ) to move all unselected variables to the Selected variables

pane.
d. Click Apply and Close.

The Configure Select dialog box closes. A green execution status is displayed in the Output
ports of the Select block and of the new dataset Working Dataset.

e. Right-click on the Select block's output dataset block and click Rename. Type Table 10 and
click OK.

You now have two subsets of the Tables.csv dataset, with help from the variable selection tools.

317



Altair Analytics Workbench user guide
Version 2023

Sort block

Enables you to sort a dataset.

This block can be invoked by dragging the block from the Workflow palette to the Workflow canvas and
then dragging a connection from a dataset to the Input port of the block. You can sort a dataset using
one or more variables. For example, if you were sorting a dataset containing book titles and author
names, you could first sort by author name, to get all authors in alphabetical order, and then title, so that
the titles for each author are also sorted alphabetically. You can sort in ascending or descending order,
and you can specify what happens with duplicate records and keys.

The sorting of values is configured using the Configure Sort dialog box. To open the Configure Sort
dialog box, double-click the Sort block.

The dataset is sorted according to the variables and sort order you specify, and a working dataset
containing the sorted dataset is created.

Variable list

Two lists are presented: Unselected Variables showing variables available for sorting, and
Selected Variables showing variables selected for sorting. To move an item from one list to
the other, double-click on it. Alternatively, click on the item to select it and use the appropriate
single arrow button. A selection can also be a contiguous list chosen using Shift and click, or a
non-contiguous list using Ctrl and click. Use the Select all button ( ) or Deselect all button

( ) to move all the items from one list to the other. Use the Apply variable lists button ( )

to move a set of variables from one list to another. Use the filter box ( ) on either list to limit the
variables displayed, either using a text filter, or a regular expression. This choice can be set in the
Altair page in the Preferences window. As you enter text or an expression in the box, only those
variables containing the text or expression are displayed in the list.

Remove Duplicate Keys
Specifies that, for observations that have duplicate keys, only the first of the observations with a
duplicated key is included in the sort and written to the working dataset.

Remove Duplicate Records
Specifies that, for observations that are exactly the same, only the first of the duplicated
observations is included in the sort and written to the working dataset.

Maintain Order of Duplicates
Specifies that, for observations that are exactly the same, the order of the duplicate observations
in the sorted dataset remain the same as in the original dataset.
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Sort block basic example

This example demonstrates how the Sort block can be used to sort a dataset.

In this example, a dataset of books named lib_books.csv is imported into a blank Workflow. The
Sort block is used to sort the dataset based on values in the Author variable and output the sorted
dataset.

Workflow Layout

Dataset used

The file used in this example can be found in the samples distributed with Altair SLC.

This example uses a dataset of books, named lib_books.csv. Each observation in the dataset
describes a book, with variables such as Title, ISBN and Author.

Using the Sort block to sort a dataset

Using the Sort block to sort values in a dataset.

1. Import the lib_books.csv dataset onto a blank Workflow canvas. Importing a CSV file is described
in Text File Import block  (page 220).

2. Expand the Data Preparation group in the Workflow palette, then click and drag a Sort block onto the
Workflow canvas, beneath the lib_books.csv dataset.

3. Click on the lib_books.csv dataset block's Output port and drag a connection towards the Input
port of the Sort block.

Alternatively, you can dock the Sort block onto the dataset block directly.
4. Double-click on the Sort block.

A Configure Sort dialog box opens.
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5. From the Configure Sort dialog box:

a. From the Unselected Variables box, double-click on the variable Author to move it to the
Selected Variables box.

b. Click Apply and Close.

The Configure Sort dialog box closes. A green execution status is displayed in the Output ports
of the Sort block and of the new dataset Working Dataset.

You now have a new dataset, that sorts the lib_books.csv by its Author variable.

Sort block example: creating a list of unique values

This example demonstrates how the additional options in the Sort block can be configured to output a
list of unique values.

In this example, a Select block is used to select the Author variable in the lib_books.csv dataset.
The Sort block is then configured to output a sorted list of unique values in the Author variable. The
Sort block generates an output dataset Author List.

Workflow Layout

Datasets used

The file used in this example can be found in the samples distributed with Altair SLC.
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This example uses a dataset of books, named lib_books.csv. Each observation in the dataset
describes a book, with variables such as Title, ISBN and Author.

Using the Sort block to output a list of unique values

Making use of the Sort block options to extract unique values of a variable in a dataset.

1. Import the lib_books.csv dataset onto a blank Workflow canvas. Importing a CSV file is described
in Text File Import block  (page 220).

2. Drag a Select block onto the Workflow canvas, beneath the lib_books.csv dataset.
3. Click and drag a connection between the lib_books.csv dataset block output port and the Select

block input port.
4. Double-click on the Select block.

A Configure Select dialog box opens.
5. From the Configure Select dialog box:

a. From the Unselected Variables box, double-click on the variable Author to move it to  the
Selected Variables box.

b. Click Apply and Close.

A green execution status is displayed in the Output ports of the Impute block and of the new dataset
Working Dataset.

6. From the Data Preparation group in the Workflow palette, click and drag a Sort block onto the
Workflow canvas, beneath the lib_books.csv dataset and Select block.

7. Click on the Select block Working Dataset Output port and drag a connection towards the Input
port of the Sort block.

Alternatively, you can dock the Sort block onto the dataset block directly.
8. Double-click on the Sort block.

A Configure Sort dialog box opens.
9. From the Configure Sort dialog box:

a. From the Unselected Variables box, double-click on the variable Author to move it to  the
Selected Variables box.

b. Select the Remove duplicate keys checkbox.
c. Click Apply and Close.

The Configure Sort dialog box closes. A green execution status is displayed in the Output port of
the Sort block and of the new dataset Working Dataset.

10.Right-click on the new dataset Working Dataset, click Rename and type Author List.

You now have a list of unique authors from the lib_books.csv dataset, sorted in ascending order.
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Text Transform block

Enables you to transform strings in one or more variables.

This block can be invoked by dragging the block from the Workflow palette to the Workflow canvas and
then dragging a connection from a dataset to the Input port of the block. Text can be changed using
one or more operations. The transformed text can replace the contents of the existing variable, or can
be placed in a new variable.  Text is transformed using operations, which are defined using the Text
Transform editor. To open the Text Transform editor, double-click the Text Transform block.

Text Transform editor view

Enables you to define the operations used to transform the contents of character variables from the input
dataset.

Operations
Lists the operations being used in the Text Transform block.

Note:
Operations can only be applied to character variables.

Label
Specifies the name of the operation. This can be changed by clicking on the field and typing a
new value.

Operations
Specifies the type operation being used. This can be changed by clicking on the operation value
and selecting a new value.

Input variable(s)
Displays one or more input variables set in the Operation Configuration pane.

Output variable(s)
Displays one or more output variables set in the Operation Configuration pane.

Operation Configuration
Enables you to define and configure a specified operation.

Variables

Specifies which variables the operation applies to. The options are:

Apply to single variable
Specifies that the operation is applied to one variable. When using this option, the following
options become available:
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Input Variable
Specifies the input variable to which the operation is applied.

Output Variable
Specifies the name of the output variable, that is, the variable to which the
transformed text is written. This can be an existing variable, in which case, the
transformed text overwrites the current value in the variable.

Include in output dataset
Specifies whether the result is included in the output dataset.

Apply to multiple variables
Specifies that the operation is applied to multiple variables. When using this option, a table
is displayed containing the following fields:

Input Name
Specifies the input variable to which the operation is applied. Input variables can be
added to the table using the Select button.

Output Name
Specifies the name of the output variable, that is, the variable to which the
transformed text is output. This can be specified as an existing variable, in which
case, instead of creating a new variable, will overwrite the existing variable.

Include in output
Specifies whether the result is included in the output dataset. This is selected by
default.

Select (Apply to multiple variables only)
Selects the variables. When you click this, a Select Variables window appears with the
following options:

Unselected Variables
Specifies the variables not included in the operation. Double click a variable in this
list to move it to the Selected Variables list.

Selected Variables
Specifies the variables to include in the operation. The Input Name, Output Name
and Include in output are present. Output Name can be changed by clicking on the
value and entering a new name. Include in output can be changed by selecting the
checkbox. Double click a variable in this list to move it to the Unelected Variables
list.

Include all
Moves all variables to the Selected Variables list.

Exclude all
Moves all variables to the Unselected Variables list.
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Output name
Specifies a prefix or suffix for the output variable names, specified by the Prefix and
Suffix options.

Apply to All Variables
Applies the specified prefix or suffix to the output variable names, this can be seen in
the Output Name column in the Selected Variables table.

Reset Output Names
Resets the values in the Output Name column from the Selected Variables list to
the original variable name.

Operations

Defines the operation. The options are:

Remove
Specifies removal of one or more characters from the text . When using this option,
the following options become available:

Whitespace
Specifies that whitespace is removed from the text. This option can remove
ASCII spaces (0x20), ASCII tabs (0x09), and linebreaks, which remove both
line feeds (0x0A) and carriage returns (0x0D). The following options can also
be selected:

All whitespace
Specifies that all whitespace is removed. Selecting this option selects all
the other whitespace options.

Trailing whitespace
Specifies that all whitespace after the last non-whitespace character in
the string is removed.

Duplicate whitespace
Specifies that whitespace is removed when next to another whitespace.
If there are more than two consecutive whitespace characters in the
string, all whitepace is removed until there is only one.

Spaces
Specifies that all spaces (0x20) are removed from the string.

Tabs
Specifies that all tabs (0x09) are removed from the string.

Line breaks
Specifies that all line breaks (0x0A and 0x0D) are removed from the
string.
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Character set
Specifies that all characters belonging to a character set are removed from the
string. The following options are available:

Standard
Specifies a type of character to remove from the string. You can choose
one or more of the following options:

Numeric
Removes all numeric characters from the string. For example, the
value 01-JAN-1970 is transformed to -JAN-.

Alphabetic
Removes all letters from the string. For example, the value 01-
JAN-1970 is transformed to 01--1970.

Punctuation
Removes all punctuation from the string. For example, the value
01-JAN-1970 is transformed to 01JAN1970.

Inverted
Specifies all characters apart from one type of character is removed
from the string. You can choose one or more of the following options:

Non-Numeric
Removes all non-numeric characters from the string. For example,
the value 01-JAN-1970 is transformed to 011970.

Non-Alphabetic
Removes all non-alphabetic characters from the string. For
example, the value 01-JAN-1970 is transformed to JAN.

Non-Punctuation
Removes all non-punctuation characters from the string. For
example, the value 01-JAN-1970 is transformed to --.

Pattern
Specifies removal of text through pattern matching. This is defined using find
functionality. The following options are available:

Find
Specifies the text for removal.

Case Sensitive
Specifies that the text in Find is case sensitive.

Regular Expression
Specifies that regular expression syntax is used for the Find field.

Replace
Specifies that text is found and replaced. The following options are available:
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Find
Specifies the text for replacement.

Replace
Specifies the text that replaces the text in the Find field.

Case Sensitive
Specifies the text in the Find field is case sensitive.

Regular Expression
Specifies regular expression syntax is used for the Find field

Count Matches
Counts the number of occurences of a specified string. The following options are
available:

Find
Specifies the text for which occurrences are counted.

Case Sensitive
Specifies the text in the Find field is case sensitive.

Regular Expression
Specifies regular expression syntax is used in the Find field

Change Case
Specifies the case of the text. The following options are available:

Upper Case
Specifies that the string to change to upper case.

Lower Case
Specifies that the string to change to lower case.

Title Case
Specifies the string to change to title case.

Preview tab
Displays a dataset preview of the output dataset.

Text Transform block basic example

This example demonstrates how the Text Transform block change the text of a variable.

In this example, a dataset of books named lib_books.csv is imported into a blank Workflow. The
Text Transform block is then used to remove punctuation from a variable.
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Workflow Layout

Dataset used

The file used in this example can be found in the samples distributed with Altair SLC.

This example uses about dataset about books, named lib_books.csv. Each observation in the
dataset describes a book, with variables such as Title, ISBN and Author.

Using the Text Transform block to manipulate a variable in a dataset

Using the Text Transform block to change the text of a variable in a dataset.

1. Import the lib_books.csv dataset onto a blank Workflow canvas. Importing a CSV file is described
in Text File Import block  (page 220).

2. Expand the Data Preparation group in the Workflow palette, then click and drag a Text Transform
block onto the Workflow canvas, beneath the lib_books.csv dataset.

3. Click on the lib_books.csv dataset block's Output port and drag a connection towards the Input
port of the Text Transform block.

Alternatively, you can dock the Text Transform block onto the dataset block directly.
4. Double-click on the Text Transform block.

A Text Transform editor opens. By default, a single operation exists named Operation1 ready for
configuration.

5. In the Input Variable drop-down list, select LastAccessed.
6. In the Remove drop-down list, select Character set, then select Punctuation.
7. Press Ctrl+S to save the configuration.
8. Close the Text Transform editor.

The Text Transform editor closes. A green execution status is displayed in the Output port of the
Text Transform block and the resulting dataset, Working Dataset.

You now have a new dataset that contains removed punctation from a variable in the lib_books.csv
dataset.
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Text Transform block example: transforming multiple variables

This example demonstrates how the Text Transform block can be used to tranform multiple variables
with a single operation.

In this example, a dataset of books named lib_books.csv is imported into a blank Workflow. The
Text Transform block is then used to extract the months from two different date variables in one
operation.

Workflow Layout

Dataset used

The file used in this example can be found in the samples distributed with Altair SLC.

This example uses about dataset about books, named lib_books.csv. Each observation in the
dataset describes a book, with variables such as Title, ISBN and Author.

Using the Text Transform block to transform multiple variables in a dataset

Using the Text Transform block to extract the month of date variables in a dataset.

1. Import the lib_books.csv dataset onto a blank Workflow canvas. Importing a CSV file is described
in Text File Import block  (page 220).

2. Expand the Data Preparation group in the Workflow palette, then click and drag a Text Transform
block onto the Workflow canvas, beneath the lib_books.csv dataset.

3. Click on the lib_books.csv dataset block's Output port and drag a connection towards the Input
port of the Text Transform block.

Alternatively, you can dock the Text Transform block onto the dataset block directly.
4. Double-click on the Text Transform block.

A Text Transform editor opens. By default, a single operation exists named Operation1 ready for
configuration.
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5. Select the Apply to multiple variables checkbox, then click the Select button.

A new Select window opens that enables addition of multiple variables to the operation.
6. In the Select window, from the Unselected Variables list, double click the variables DatePurchased

and LastAccessed to move them to the Selected Variables list.
7. Under Output Name ensure Suffix is selected and type _month.
8. Click Apply to all variables to apply the suffix for the new variable names and click OK.

The Select window closes.
9. Under the Remove drop-down list, select Character set
10.Under the Character set options select Inverted, then select Non-alphabetic.
11.Press Ctrl+S to save the configuration.
12.Close the Text Transform editor.

The Text Transform editor closes. A green execution status is displayed in the Output port of the
Text Transform block and the resulting dataset, Working Dataset.

You now have a new dataset that contains the extracted months from two variables in the
lib_books.csv dataset.

Top Select block

Enables you to create a working dataset containing a dependent variable and its most influential
independent variables.

This block can be invoked by dragging the block from the Workflow palette to the Workflow canvas and
then dragging a connection from a dataset to the Input port of the block. Creating a working dataset
enables you to reduce the number of variables as input to model training, for example when growing a
decision tree or for logistic regression.

The dataset is configured using the Configure Top Select dialog box. To open the Configure Top
Select dialog box, double-click the Top Select block.

Choose a Dependent Variable from the drop-down list.

To choose an independent variable, two lists are presented: Unselected Independent Variables
showing available independent variables, and Selected Independent Variables showing chosen
independent variables. To move an item from one list to the other, double-click on it. Alternatively, click
on the item to select it and use the appropriate single arrow button. A selection can also be a contiguous
list chosen using Shift and click, or a non-contiguous list using Ctrl and click. Use the Select all button
( ) or Deselect all button ( ) to move all the items from one list to the other. Use the Apply
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variable lists button ( ) to move a set of variables from one list to another. Use the filter box ( ) on

either list to limit the variables displayed, either using a text filter, or a regular expression. This choice
can be set in the Altair page in the Preferences window. As you enter text or an expression in the box,
only those variables containing the text or expression are displayed in the list.

When selecting independent variables:

• You should avoid selecting an independent variable with an entropy variance of 1 (one) as the values
will typically be too random to provide a good predictive power and may lead to overfitting a model.

• You should avoid selecting an independent variable where the entropy value is 0 (zero) as this has a
very low predictive power.

• Typically, you would select a group of independent variables where the difference in the entropy
variance of the variables is small.

For more information about how the entropy variance is calculated see Predictive power criteria  (page
112).

Top Select block example: use in a modelling process

This example demonstrates how a Top Select block can be used to choose variables to retain in a
dataset based on their entropy values.

In this example, a dataset named loandata.csv is imported into a blank Workflow. Each observation
in the dataset describes a completed loan and the person who took the loan out, with variables such as
Income, Loan_Period and Other_Debt.

The loandata.csv dataset is passed to a Top Select block, which is configured with a specified
dependent variable. Entropy values are then displayed for the remaining variables and these values are
used to help choose the variables to retain in the block's output dataset.

Workflow Layout

Datasets used

The file used in this example can be found in the samples distributed with Altair SLC.
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This example uses a dataset about loans, named loan_data.csv. Each observation in the dataset
describes a completed loan and the person who took the loan out, with variables such as Income,
Loan_Period and Other_Debt.

Using the Top Select block

Using a Top Select block to choose variables to retain in a dataset based on their entropy values.

1. Import the dataset loandata.csv into a blank Workflow. Importing a CSV file is described in Text
File Import block  (page 220).

2. Expand the Data Preparation group in the Workflow palette, then click and drag a Top Select block
onto the Workflow canvas, beneath the loan_data.csv dataset.

3. Click on the Output port of the loan_data.csv dataset block and drag a connection towards the
Input port of the Top Select block.

4. Double-click on the Top Select block.

The Configure Top Select dialog box is displayed.
5. From the Dependent variable drop-down list, select Default.
6. At the top of the Unselected Independent Variables list, click Entropy Variance to sort the list in

descending order of Entropy Variance.

The list is sorted. This may take a few seconds to complete.
7. Click on the first variable in the list, Loan_Period.
8. Hold down the Shift key and click the fifth variable in the list, Employment_Type.

The five variables with the highest entropy variance are selected.
9. Click the select button ( ).

The selected variables are moved from the Unselected Independent Variables list to the Selected
Independent Variables list.

10.Click Apply and Close.

The Configure Top Select dialog box closes. A green execution status is displayed in the Output
port of the Top Select block.

The Top Select block outputs a new dataset with only the specified dependent and independent
variables from the input dataset.
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Top Select block modelling example

This example demonstrates how a Top Select block can be used to choose variables to retain in a
dataset based on their entropy values. This reduced dataset is then be passed to a Decision Tree block.

In this example, a dataset named loandata.csv is imported into a blank Workflow. Each observation
in the dataset describes a completed loan and the person who took the loan out, with variables such as
Income, Loan_Period and Other_Debt.

The loandata.csv dataset is passed to a Top Select block, which is configured with a specified
dependent variable. Entropy values are then displayed for the remaining variables and these values are
used to choose the variables to retain in the block's output dataset, which is then passed to a Decision
Tree block.

Workflow Layout

Datasets used

The file used in this example can be found in the samples distributed with Altair SLC.

This example uses a dataset about loans, named loandata.csv. Each observation in the dataset
describes a completed loan and the person who took the loan out, with variables such as Income,
Loan_Period and Other_Debt.

Using the Top Select block to limit model input

Using a Top Select block to choose variables to retain in a dataset based on their entropy values. This
reduced dataset is then be passed to a Decision Tree block.

1. Import the dataset loandata.csv into a blank Workflow. Importing a CSV file is described in Text
File Import block  (page 220).

2. Expand the Data Preparation group in the Workflow palette, then click and drag a Top Select block
onto the Workflow canvas, beneath the loandata.csv dataset.
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3. Click on the Output port of the loandata.csv dataset block and drag a connection towards the
Input port of the Top Select block.

4. Double-click on the Top Select block.

The Configure Top Select dialog box is displayed.
5. From the Dependent variable drop-down list, select Default.
6. At the top of the Unselected Independent Variables list, click Entropy Variance to sort the list in

descending order of Entropy Variance.

The list is sorted. This may take a few seconds to complete.
7. Select the top five variables in the Entropy Variance list. To do this, click on the first variable in the

list, hold down the Shift key and click the fifth variable in the list.
8. Click the select button ( ).

The selected variables are moved from the Unselected Independent Variables list to the Selected
Independent Variables list.

9. Click Apply and Close.

The Configure Top Select dialog box closes. A green execution status is displayed in the Output
port of the Top Select block. The Top Select block has output a new dataset with only the specified
dependent variable and independent variables from the input dataset.

10.Expand the Model Training group in the Workflow palette, then click and drag a Decision Tree block
onto the Workflow canvas, beneath the Top Select block output dataset.

11.Click on the Output port of the Top Select block output dataset block and drag a connection towards
the Input port of the Decision Tree block.

12.Double-click on the Decision Tree block.

The Decision Tree editor view is displayed with the Decision Tree Preferences dialog box on top.
13.In the Decision Tree Preferences dialog box:

a. From the Dependent variable drop-down list, select Default.

Tree type is set to Classification and Dependent variable treatment is set to Nominal. Leave
these values as they are.

b. From the Target category drop-down list, select 1.
c. From the buttons between the lists of Unselected Independent Variables and Selected

Independent Variables, click Select all ( ).

d. Click Apply and Close.
14.Click Grow Tree (C4.5). You may get a warning; if you do, click OK to proceed.

A decision tree is created, using only the variables selected using the Top Select block.
15.Press Ctrl+S to save the configuration.
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16.Click the cross to close the Decision Tree editor view.

The Decision Tree editor view closes.

You now have a decision tree model using only the variables selected using the Top Select block.

Transpose block

Enables you to create a new dataset with transposed variables.

This block can be invoked by dragging the block from the Workflow palette to the Workflow canvas
and then dragging a connection from a dataset to the Input port of the block. Enables a dataset to be
transposed, converting columns (variables) to rows (observations) and vice versa.

Note:
Altair SLC imposes a 32,000 variable (column) limit on datasets. If a transpose would result in this limit
being breached, the transpose block will warn you that the dataset will be truncated.

Transpose view
Double-click on the transpose block to open the Transpose view. It has the following panels:

Transpose type
Specifies the type of transpose. The following options are available:

• Columns-to-rows: Transposes the dataset so each specified variable corresponds to
one or more rows.

• Rows-to-columns: Transposes the dataset so each row is mapped to one or more
columns.

Group by
Enables you to group the output rows by unique variable values. The Unselected Variables
and Selected Variables lists are used to select the required variables. To move an item
from one list to the other, double-click on it. Alternatively, click on the item to select it and
use the appropriate single arrow button. A selection can also be a contiguous list chosen
using Shift and click, or a non-contiguous list using Ctrl and click. Use the Select all button
( ) or Deselect all button ( ) to move all the items from one list to the other. Use the

Apply variable lists button ( ) to move a set of variables from one list to another. Use

the filter box ( ) on either list to limit the variables displayed, either using a text filter, or a
regular expression. This choice can be set in the Altair page in the Preferences window.
As you enter text or an expression in the box, only those variables containing the text or
expression are displayed in the list.

Transpose variables
Specifies variables for transposing. The options available depend on what you select as the
Transpose Type:
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Rows-to-Columns transpose
Specifies one or more variables for transposing. The Unselected Variables and
Selected Variables lists are used to select the required variables. To move an item
from one list to the other, double-click on it. Alternatively, click on the item to select
it and use the appropriate single arrow button. A selection can also be a contiguous
list chosen using Shift and click, or a non-contiguous list using Ctrl and click. Use the
Select all button ( ) or Deselect all button ( ) to move all the items from one

list to the other. Use the Apply variable lists button ( ) to move a set of variables

from one list to another. Use the filter box ( ) on either list to limit the variables
displayed, either using a text filter, or a regular expression. This choice can be set in
the Altair page in the Preferences window. As you enter text or an expression in the
box, only those variables containing the text or expression are displayed in the list.
The following options are also available:

• Column ID: Specifies a variable from the source dataset in which the values are
used to name the variables in the output dataset.

• Make rows unique: Output only one row for each combination of selected
variable values in the Group by panel.

Columns-to-Rows transpose
Specifies groups of one or more variables for transposing; groups can be controlled
using the Add, Edit and Remove buttons. The Add button opens an Edit Transpose
Variable window

Edit Transpose Variable

• Output Name: Specifies the name for the columns in the output dataset.
• Include ID Column in Output: Specifies whether to include an ID column

in the output dataset. Selecting this option enables the ID Column Name
and ID Value Prefix Length options.

• ID Column Name: Specifies the name of the ID column.
• ID Value Prefix Length: Truncates the length of values in the ID column by

the specified amount.
• Transpose Variables: Presents a list of Unselected Variables and

Selected Variables for transposing. To move an item from one list to the
other, double-click on it. Alternatively, click on the item to select it and use
the appropriate single arrow button. A selection can also be a contiguous
list chosen using Shift and click, or a non-contiguous list using Ctrl and
click. Use the Select all button ( ) or Deselect all button ( ) to move

all the items from one list to the other. Use the Apply variable lists button

( ) to move a set of variables from one list to another. Use the filter box
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( ) on either list to limit the variables displayed, either using a text filter,
or a regular expression. This choice can be set in the Altair page in the
Preferences window. As you enter text or an expression in the box, only
those variables containing the text or expression are displayed in the list..

Advanced Settings
Specifies further options for the Transpose view. Click the cog ( ) in the top right-hand
corner to open the Transpose Advanced Setting dialog box. The following options are
available:

• Keep Variables: Enables you to specify one or more variables from the input dataset
that are kept the same in the output. To move an item from one list to the other, double-
click on it. Alternatively, click on the item to select it and use the appropriate single arrow
button. A selection can also be a contiguous list chosen using Shift and click, or a non-
contiguous list using Ctrl and click. Use the Select all button ( ) or Deselect all

button ( ) to move all the items from one list to the other. Use the Apply variable

lists button ( ) to move a set of variables from one list to another. Use the filter box

( ) on either list to limit the variables displayed, either using a text filter, or a regular
expression. This choice can be set in the Altair page in the Preferences window. As
you enter text or an expression in the box, only those variables containing the text or
expression are displayed in the list.

• Include Names Column: Specifies whether to include a name column in the output. The
name of this column is specified in the adjacent text box.

• Include Label Column: Specifies whether to include a label column in the output. The
name of this column is specified in the adjacent text box.

.

Preview
Displays a dataset preview of the output dataset

Transpose block basic example

This example demonstrates how the Transpose block can be used to restructure a dataset.

In this example, a dataset of loans named loan_data_sample.csv is imported into a blank Workflow.
The dataset contains details of completed loans, with each observation (row) representing an individual
customer and their loan. The Transpose block is used to change the dataset structure into each column
representing an individual customer.
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Workflow Layout

Datasets used

The file used in this example can be found in the samples distributed with Altair SLC.

This example uses a dataset about loans, named loan_data_sample.csv. Each observation in
the dataset describes a past loan and the person who took loan out, with variables such as Income,
Loan_Period and Other_Debt.

Using the Transpose block to restructure a dataset

Using the Transpose block to swap rows and columns in a dataset.

1. Import the loan_data_sample.csv dataset onto a blank Workflow canvas. Importing a CSV file is
described in Text File Import block  (page 220).

2. Expand the Data Preparation group in the Workflow palette, then click and drag a Transpose block
onto the Workflow canvas, beneath the loandatasample.csv dataset.

3. Click on the loan_data_sample.csv dataset block's Output port and drag a connection towards
the Input port of the Transpose block.

Alternatively, you can dock the Transpose block onto the dataset block directly.
4. Double-click on the Transpose block.

A Transpose view opens.
5. From the Transpose Type drop-down box, select Columns-to-rows.
6. From the Transpose Variables panel, click Add to display the Add Transpose Variable window.
7. From the Add Transpose Variable window:

a. In the Output Name text box, type Customer.
b. Click the Select all button ( ) to move all variables from the Unselected Variables box to the

Selected Variables box.
c. Click Apply and Close
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8. Press Ctrl+S to save the configuration.
9. Close the Transpose view.

The Transpose view closes. A green execution status is displayed in the Output port of the
Transpose block and the resulting dataset Working Dataset.

You now have transposed the loan_data_sample.csv dataset where each column represents a loan
customer, rather than each row.

Transpose block example: multiple transposed based on variables

This example demonstrates how the Transpose block can be used to transpose a dataset multiple times
based on groupings of variable values.

In this example, a dataset of loans named loan_data_sample.csv is imported into a blank Workflow.
The dataset contains details of completed loans, with each observation (row) representing an individual
customer and their loan. The Transpose block is used to change the dataset structure into each column
representing listing individual customers that belong to different subsets of the dataset.

Workflow Layout

Datasets used

The file used in this example can be found in the samples distributed with Altair SLC.

This example uses a dataset about loans, named loandatasample.csv. Each observation in
the dataset describes a past loan and the person who took loan out, with variables such as Income,
Loan_Period and Other_Debt.
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Using the Transpose block to restructure a dataset applying a transpose multiple times

Using the Transpose block to transpose a dataset for each grouping of variable values.

1. Import the loan_data_sample.csv dataset onto a blank Workflow canvas. Importing a CSV file is
described in Text File Import block  (page 220).

2. Expand the Data Preparation group in the Workflow palette, then click and drag a Transpose block
onto the Workflow canvas, beneath the loandatasample.csv dataset.

3. Click on the loan_data_sample.csv dataset block's Output port and drag a connection towards
the Input port of the Transpose block.

Alternatively, you can dock the Transpose block onto the dataset block directly.
4. Double-click on the Transpose block.

A Transpose view opens.
5. From the Transpose Type drop-down box, select Columns-to-rows.
6. From the Transpose Variables panel, click Add to display the Add Transpose Variable window.
7. From the Add Transpose Variable window:

a. In the Output Name text box, type Customer.
b. Click the Select all button ( ) to move all variables from the Unselected Variables box to the

Selected Variables box.
c. Double-click on the Part_Of_UK and Default variables to move them back to the Unselected

Transpose Variables box.
d. Click Apply and Close

8. From the Group By panel, double-click on the Part_Of_UK and Default variables to them from
the Unselected Variables box to the Selected Variables box.

9. Press Ctrl+S to save the configuration.
10.Close the Transpose view.

The Transpose view closes. A green execution status is displayed in the Output port of the
Transpose block and the resulting dataset Working Dataset.

You now have transposed the loandatasample.csv dataset where each column represents several
loan customers, based on their region and loan default status.

Code Blocks group
Contains blocks that enable you to add a new program to the Workflow.

Although programming is not a prerequisite for creating a Workflow, if you have the required
programming skills you can carry out more advanced tasks in a Workflow, using one or more of the
available coding blocks.
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Python block ......................................................................................................................................340
Enables you to use Python language programs in a Workflow.

R block .............................................................................................................................................. 342
Enables you to use R language programs in a Workflow.

SAS block ..........................................................................................................................................345
Enables you to use SAS language programs in a Workflow.

SQL block ..........................................................................................................................................347
Enables you to create a dataset using the SQL language SELECT statements in a Workflow.

Python block

Enables you to use Python language programs in a Workflow.

This block can be invoked by dragging the block from the Workflow palette to the Workflow canvas
and if required, dragging a connection from one or more datasets to the Input port of the block. To use
the Python block, you must have a Python interpreter installed and correctly configured on the local or
remote host on which the Workflow Engine is run. As a minimum, you must include the pandas module in
the Python installation.

The Python block can be used to access either existing Python language modules such as scikit-learn
or your own modules for your Workflows.

Reference names for the input dataset are displayed in the Inputs list. Output working dataset names
are displayed in the Outputs list.

Workflow interaction with the Python language, including managing input and output datasets is
configured using the Python editor view. To open the Python editor view, double-click the Python block.
To save changes made, press Ctrl+S.

Python editor
This editor is used to enter the code for the Python language program. Program code must follow
the same indentation rules as Python language programs created outside a Workflow.

All code for the program must be present in the editor, you cannot import program code from
an external file. Modules located in the Python site package folders can be imported into your
program.

Inputs
Lists the input datasets and variables in the dataset. You can drag a name label to the Python
editor rather than typing a label.

Outputs
Lists the pandas DataFrames created in the Python language program that are made available to
other blocks in the Workflow. You can drag a name label to the Python editor rather than typing a
label.
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Input datasets
Input datasets displayed in the Inputs list represent the working datasets connected to the Python block.

To create a new input dataset, on the Workflow canvas, drag a connector from the Output port of the
working dataset to the Input port of the Python block.

To modify the dataset name click Edit ( ), and enter a new name for the dataset in the Inputs list. If
the dataset is already referenced in your Python language program, the references are not automatically
updated and must be manually modified for the Python block to run successfully.

Output datasets
Output datasets displayed in the Outputs list represent the mapping between a dataset created or
modified in the Python language program, and the working dataset made available to other blocks in the
Workflow.

To create a new output working dataset, click Add ( ). To use the new output dataset reference in the
Python editor, drag the label to the editor.

To delete the output dataset name click Delete ( ). If the dataset is already referenced in your Python
language program, the references are not automatically updated and the references to the dataset must
be manually modified for the Python block to run successfully.

To modify the dataset name click Edit ( ), and enter a new name for the dataset in the Outputs list. If
the dataset is already referenced in your Python language program, the references are not automatically
updated and must be manually modified for the Python block to run successfully.

Python block example: Using Python language as part of a Workflow

This example demonstrates how the Python block can be used to sort a dataset.

In this example, a dataset of books named lib_books.csv is imported into a blank Workflow. A
Python block is configured to use Python code to sort the dataset on its Author variable. This example
outputs the same result as the Sort block basic example  (page 319).

Dataset used

The file used in this example can be found in the samples distributed with Altair SLC.

This example uses a dataset of books, named lib_books.csv. Each observation in the dataset
describes a book, with variables such as Title, ISBN and Author.
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Using the Python block to sort a variable in a dataset

Using a Python block to sort a dataset by values of a variable.

Ensure that you have configured Python to run with Altair SLC on your machine. For more information,
see the Altair SLC Python procedure user guide and reference.

1. Import the lib_books.csv dataset onto a blank Workflow canvas. Importing a CSV file is described
in Text File Import block  (page 220).

2. Expand the Code Blocks group in the Workflow palette, then click and drag a Python block onto the
Workflow canvas, beneath the lib_books.csv dataset.

3. Click on the lib_books.csv dataset block's Output port and drag a connection towards the Input
port of the Python block.

Alternatively, you can dock the Python block onto the dataset block directly.
4. Double-click on the Python block.

A Python editor view opens.
5. In the Variable Definition pane:

a. In the Outputs section, click on the Add new output dataset button( ).

A new output is created, named Output_1
b. In the large text box on the left hand side, on a new line type: Output_1 =

Input_1.sort_values(by=['Author']).
6. Press Ctrl+S to save the configuration.
7. Close the Python editor view.

The Python editor view closes. A green execution status is displayed in the Output port of the
Python block and the resulting datatset, Working Dataset.

You have now sorted the lib_books.csv dataset using the Python block.

R block

Enables you to use R language programs in a Workflow.

This block can be invoked by dragging the block from the Workflow palette to the Workflow canvas and
if required, dragging a connection from one or more datasets to the Input port of the block. To use the R
block, you must have an R interpreter installed and correctly configured on the local or remote host on
which the Workflow Engine is run.

The R block can be used to access existing R language modules or create your own modules for your
Workflows.
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Workflow interaction with the R language, including managing input and output datasets is configured
using the R Language editor view. To open the R Language editor view, double-click the R block. To
save changes made, press Ctrl+S.

R language editor
Used to enter the code for the R language program.

All code for the program must be present in the editor, you cannot import program code from an
external file using the source() command. Packages located in folders referenced in the R
.libPaths variable can be imported into your program.

Inputs
Lists the input datasets and variables in the dataset. You can drag a name label to the R editor
rather than typing a label

Outputs
Lists the data frames created in the R language program that are made available to other blocks in
the Workflow. You can drag a name label to the R editor rather than typing a label.

Input datasets
Input datasets displayed in the Inputs list represent the working datasets connected to the R block.

To create a new input dataset, on the Workflow canvas, drag a connector from the Output port of the
working dataset to the Input port of the R block.

To modify the dataset name click Edit ( ), and enter a new name for the dataset in the Inputs list.
If the dataset is already referenced in your R language program, the references are not automatically
updated and must be manually modified for the R block to run successfully.

Output datasets
Output datasets displayed in the Outputs list represent the mapping between a dataset created or
modified in the R language program, and the working dataset made available to other blocks in the
Workflow.

To create a new output working dataset, click Add ( ). To use the new output dataset reference in the
R editor, drag the label to the editor.

To delete the output dataset name click Delete ( ). If the dataset is already referenced in your R
language program, the references are not automatically updated and the references to the dataset must
be manually modified for the R block to run successfully.

To modify the dataset name click Edit ( ), and enter a new name for the dataset in the Outputs list.
If the dataset is already referenced in your R language program, the references are not automatically
updated and must be manually modified for the R block to run successfully.
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R block example: Using R language as part of a workflow

This example demonstrates how the R block can be used to restrict a dataset to a single column.

In this example, a dataset of books named lib_books.csv is imported into a blank Workflow. An R
block uses R code to retain and output the Author variable. This example outputs the same result as
the Select block basic example  (page 314).

Dataset used

The file used in this example can be found in the samples distributed with Altair SLC.

This example uses a dataset of books, named lib_books.csv. Each observation in the dataset
describes a book, with variables such as Title, ISBN and Author.

Using the R block select a variable in a dataset

Using the R block to restrict a dataset to a single column.

Ensure that you have configured R to run with Altair SLC on your machine. For more information, see the
Altair SLC R procedure user guide and reference.

1. Import the lib_books.csv dataset onto a blank Workflow canvas. Importing a CSV file is described
in Text File Import block  (page 220).

2. Expand the Code Blocks group in the Workflow palette, then click and drag a R block onto the
Workflow canvas, beneath the lib_books.csv dataset.

3. Click on the lib_books.csv dataset block's Output port and drag a connection towards the Input
port of the R block.

Alternatively, you can dock the R block onto the dataset block directly.
4. Double-click on the R block.

A R Language editor view opens.
5. In the Variable Definition pane:

a. In the Outputs section, click on the Add new output dataset button( ).

A new output is created, named Output_1
b. In the large text box on the left hand side, on a new line type: Output_1 <-

data.frame(Author=Input_1$Author).
6. Press Ctrl+S to save the configuration.
7. Close the R Language editor view.

The R Language editor view closes. A green execution status is displayed in the Output port of the
R block and the resulting datatset, Working Dataset.
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You now have a dataset that contains only the Author variable using the R block.

SAS block

Enables you to use SAS language programs in a Workflow.

This block can be invoked by dragging the block from the Workflow palette to the Workflow canvas and
if required, dragging a connection from one or more datasets to the Input port of the block. The SAS
block provides a self-contained environment that supports all of the SAS language syntax available in the
Engine.

Input, output datasets and parameters must be referred to in your SAS language program using macro
syntax label names. For example, to use an input dataset named Input_1, you must refer to the dataset
as &Input_1.

Macro reference names for the input dataset are displayed in the Inputs list. Output working dataset
names are displayed in the Outputs list.

The SAS language/> program input and output datasets are configured using the SAS editor view. To
open the SAS editor view, double-click the SAS block. To save changes made, press Ctrl+S.

SAS editor
Used to enter the code for the SAS language program. All code for the program must be present
in the editor, you cannot import program code from an external file.

Inputs
Lists the input datasets and variables in the dataset. You can drag a name label to the SAS editor
rather than typing a label.

Outputs
Lists the datasets created in the SAS language program to be made available to other block in the
Workflow. You can drag a name label to the SAS editor rather than typing a label.

Input datasets
Input datasets displayed in the Inputs list represent the working datasets connected to the SAS block.

To create a new input dataset, on the Workflow canvas, drag a connector from the Output port of the
working dataset to the Input port of the SAS block

To modify the dataset name click Edit ( ), and enter a new name for the dataset in the Inputs list. If
the dataset is already referenced in your SAS language program, the references are not automatically
updated and must be manually modified for the SAS block to run successfully.
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Output datasets
Output datasets displayed in the Outputs list represent the mapping between a dataset created or
modified in the SAS language program, and the working dataset made available to other blocks in the
Workflow.

To create a new output working dataset, click Add ( ). To use the new output dataset reference in the
SAS editor, drag the label to the editor.

To delete the output dataset name click Delete ( ). If the dataset is already referenced in your SAS
language program, the references are not automatically updated and the references to the dataset must
be manually modified for the SAS block to run successfully.

To modify the dataset name click Edit ( ), and enter a new name for the dataset in the Outputs list.
If the dataset is already referenced in your SAS language program, the references are not automatically
updated and must be manually modified for the SAS block to run successfully.

SAS block example: Using SAS language as part of a Workflow

This example demonstrates how the SAS block can be used to filter a dataset creating a new dataset
with only specified observations retained.

In this example, a dataset containing information about loans named loan_data.csv is imported into
a blank Workflow. A SAS block uses SAS code to filter loan_data.csv based on its Income variable.
This example outputs the same result as the Filter block basic example  (page 254).

Workflow Layout

Dataset used

The file used in this example can be found in the samples distributed with Altair SLC.

This example uses a dataset about loans, named loan_data.csv. Each observation in the dataset
describes a past loan and the person who took loan out, with variables such as Income, Loan_Period
and Other_Debt.
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Using the SAS block to filter a dataset

Using the SAS block to restrict observations to loan customers where the Income variable is greater
than or equal to 50000.

1. Import the loan_data.csv dataset onto a blank Workflow canvas. Importing a CSV file is described
in Text File Import block  (page 220).

2. Expand the Code Blocks group in the Workflow palette, then click and drag a SAS block onto the
Workflow canvas, beneath the loan_data.csv dataset.

3. Click on the loan_data.csv dataset block's Output port and drag a connection towards the Input
port of the SAS block.

Alternatively, you can dock the SAS block onto the dataset block directly.
4. Double-click on the SAS block.

A SAS editor view opens.
5. In the Variable Definition pane:

a. In the Outputs section, click on the Add new output dataset button( ).

A new output is created, named Output_1
b. In the large text box on the left hand side, on a new line type: DATA &Output_1; SET

&Input_1; IF Income>=50000 then output; run;.
6. Press Ctrl+S to save the configuration.
7. Close the SAS editor view.

The SAS editor view closes. A green execution status is displayed in the Output port of the SAS
block and the resulting datatset, Working Dataset.

You now have a new dataset that filters loandata.csv based on income using the SAS block.

SQL block

Enables you to create a dataset using the SQL language SELECT statements in a Workflow.

This block can be invoked by dragging the block from the Workflow palette to the Workflow canvas and if
required, dragging a connection from one or more datasets to the Input port of the block. The SQL block
is configured using the SQL Language editor view. To open the SQL Language editor view, double-click
the SQL block. To save changes made, press Ctrl+S.

SQL editor
The editor is used to enter SQL language SELECT statements.

Input datasets and parameters must be referred to in your SQL language code using SAS
language macro syntax label names. For example, to use an input dataset named Input_1, you
must refer to the dataset as &Input_1.
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Inputs
Lists the input datasets and variables in the datasets. You can drag a name label to the SQL editor
rather than typing a label.

Input datasets
Input datasets displayed in the Inputs list represent the working datasets connected to the SQL block.

To create a new input dataset, on the Workflow canvas, drag a connector from the Output port of the
working dataset to the Input port of the SQL block

To modify the dataset name click Edit ( ), and enter a new name for the dataset in the Inputs list. If
the dataset is already referenced in your SQL language statements, the references are not automatically
updated and must be manually modified for the SQL block to run successfully.

SQL block example: Using SQL language as part of a workflow

This example demonstrates how the SQL block can be used to create a new variable.

In this example, a dataset of books named lib_books.csv is imported into a blank Workflow. The
SQL block uses SQL code to retain and output the variables Title and In_Stock. This example
outputs the same result as the Query block basic example  (page 297).

Workflow Layout

Dataset used

The file used in this example can be found in the samples distributed with Altair SLC.

This example uses a dataset of books, named lib_books.csv. Each observation in the dataset
describes a book, with variables such as Title, ISBN and Author.
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Using the SQL block select variables in a dataset

Using the SQL block to select and output two variables from a dataset.

1. Import the lib_books.csv dataset onto a blank Workflow canvas. Importing a CSV file is described
in Text File Import block  (page 220).

2. Expand the Code Blocks group in the Workflow palette, then click and drag an SQL block onto the
Workflow canvas, beneath the lib_books.csv dataset.

3. Click on the lib_books.csv dataset block's Output port and drag a connection towards the Input
port of the SQL block.

Alternatively, you can dock the SQL block onto the dataset block directly.
4. Double-click on the SQL block.

A SQL Language editor view opens.
5. In the large text box on the left hand side, on a new line type:  SELECT Title, In_Stock FROM

"Working Dataset";.
6. Press Ctrl+S to save the configuration.
7. Close the SQL Language editor view.

The SQL Language editor view closes. A green execution status is displayed in the Output port of
the SQL block and the resulting datatset, Working Dataset.

You now have a new dataset that contains only the Title and In_Stock using the SQL block.

Model Training group
Contains blocks that enable you to discover predictive relationships in your data.

Decision Forest block ........................................................................................................................350
Provides an interface to create a decision forest prediction model.

Decision Tree block ...........................................................................................................................360
Provides an interface to create a decision tree for classification purposes.

Hierarchical Clustering block .............................................................................................................375
Provides an interface to create a hierarchical cluster model.

K-Means Clustering block ................................................................................................................. 382
Enables you to cluster data using k-means clustering.

Linear Regression block ....................................................................................................................389
Enables you to create a linear regression model.

Logistic Regression block ..................................................................................................................396
Fits a logistic model between a set of effect variables and a binary dependent variable.
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MLP block ......................................................................................................................................... 405
Enables you to build a Multi-Layer Perceptron (MLP) neural network from an input dataset and use
the trained network to analyse other datasets.

Reject Inference block .......................................................................................................................420
Enables you to use a reject inference method to address any inherent selection bias in a model by
including a rejected population.

Scorecard Model block ..................................................................................................................... 428
Enables the generation of a standard (credit) scorecard and its deployment code. The code can be
copied into a SAS language program for testing or production use.

WoE Transform block ........................................................................................................................ 436
Enables you to measure the influence of an independent variable on a specified dependent
variable. This calculates the Weight of Evidence, or WoE.

Decision Forest block

Provides an interface to create a decision forest prediction model.

This block can be invoked by dragging the block from the Workflow palette to the Workflow canvas and
then dragging a connection from a dataset to the Input port of the block. A decision forest is a prediction
model that uses a collection of decision trees to predict the value of a dependent (target) variable based
on other independent (input) variables in the input dataset.

A decision forest is created and edited using the Configure Decision Forest dialog box. To open the
Configure Decision Forest dialog box, double-click the Decision Forest block.

The Decision Forest block generates a report containing the summary statistics for the model and the
scoring code generated by the model. To view this report, right-click the Decision Forest Model block
and click View Result. The generated scoring code can be copied into a SAS language program for
testing or production use.

Variable Selection panel
Enables you to specify the dependent (target) variable and independent (input) variables.

Dependent Variable
Specifies the dependent (target) variable for which the category is being calculated by the
decision tree.

Dependent Variable Treatment
Specify the type of the dependent (target) variable. The supported variable types are:

Interval
Specifies a continuous dependent (target) variable.
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Nominal
Specifies a discrete dependent (target) variable with no implicit ordering.

Ordinal
Specifies a discrete dependent (target) variable with an implicit category ordering.

Independent Variables

The two boxes in the Variable Selection panel show Unselected Independent Variables and
Selected Independent Variables. To move an item from one list to the other, double-click on it.
Alternatively, click on the item to select it and use the appropriate single arrow button. A selection
can also be a contiguous list chosen using Shift and click, or a non-contiguous list using Ctrl and
click. Use the Select all button ( ) or Deselect all button ( ) to move all the items from one

list to the other. Use the Apply variable lists button ( ) to move a set of variables from one

list to another. Use the filter box ( ) on either list to limit the variables displayed, either using a
text filter, or a regular expression. This choice can be set in the Altair page in the Preferences
window. As you enter text or an expression in the box, only those variables containing the text or
expression are displayed in the list.

For categorical dependent variables, the Entropy Variance column shows how well each
independent variable can predict the value of the selected dependent (target) variable. Entropy
Variance is in the range of 0 – 1. If a variable in a dataset has a high entropy variance, it means
that the variable is a good predictor of the dependent variable. However where the entropy
variance is very high, or 1, the variable might not be a good predictor as using this variable could
lead to over-fitting the model.

The Variable Treatment for each variable enables you to specify that variable's type. Only
applicable types are available to choose from. The full list of types is:

Interval
Specifies a continuous independent (input) variable.

Nominal
Specifies a discrete independent (input) variable with no implicit ordering. When partitioning
this variable into nodes in a tree, any category can be merged with any other category.

Ordinal
Specifies a discrete independent (input) variable with an implicit category ordering. When
partitioning this variable into nodes in a tree, only adjacent categories can be merged
together.

Preferences panel
Specifies the options for the creation of the decision forest.

Number of trees
Specifies the number of decision trees in the forest.
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Minimum improvement
Specifies the minimum improvement (decrease) in Gini Impurity required for a node to be split.

Exclude Missings
When selected, excludes observations with missing values when building the forest.

Classifier combination
Choose Vote to classify observations by a majority vote.
Choose Mean Probability to classify observations by a combination of the probabilities calculated
by each tree.
This option is unavailable if the dependent variable is an Interval variable (a regression forest is
used).

Criterion
Specifies how the variable from the subset of specified dependent variables that gives the largest
overall decrease in Gini Impurity is used to split nodes in all trees.

Note:
This setting is for information only and cannot be changed.

Bootstrap

Specifies that the trees in the forest are constructed using bootstrap re-sampling of the input
dataset.

Note:
This setting is for information only and cannot be changed.

Inputs at split
Defines the number of input variables to randomly select each time a node is split.

Use default
Specifies the default number of input variables is selected.

For N selected independent variables, the default value is    for classification trees and
   for regression trees.

Number of inputs at each split
Specifies the number of input variables.

Split size
Enables you to specify the minimum number of observations for a node to be split either as a
proportion of the input dataset or an absolute number.

Minimum split size
Specifies the absolute minimum number of observations in a node.

Minimum split size as ratio
Specifies the minimum number of observations as a proportion of the input dataset.
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Frequency and weight variables

Frequency variable
Specifies a variable in the input dataset giving the frequency associated with each
observation.

Weight variable
Specifies a variable in the input dataset giving the prior weight associated with each
observation.

Block Outputs
The Decision Forest block can generate one or more of the following outputs:

• Decision Forest Model: A report of the decision forest model.
• Input Summary: A dataset of the Input Summary section in the Decision Forest Model.
• Target Summary: A dataset of the Target Summary section in the Decision Forest Model.
• Run Summary: A dataset of the Model Information section in the Decision Forest Model,  apart

from the Out-Of-Bag error estimate and the Training data error estimate.
• OOB Classification: A dataset conatining the out-of-bag confusion matrix.
• OOB Performance Summary: A dataset conatining the Out-Of-Bag error estimate from the Model

Information section  in the Decision Forest Model.
• Performance Summary: A dataset conatining the Training data error estimate from the Model

Information section  in the Decision Forest Model.

To specify the outputs, right-click on the Decision Forest block and select Configure Outputs. Two
boxes are presented: Unselected Output, showing outputs that are not selected , and Selected Output,
showing selected outputs. To move an item from one list to the other, double-click on it. Alternatively,
click on the item to select it and use the appropriate single arrow button. A selection can also be a
contiguous list chosen using Shift and click, or a non-contiguous list using Ctrl and click. Use the Select
all button ( ) or Deselect all button ( ) to move all the items from one list to the other. Use the

Apply variable lists button ( ) to move a set of variables from one list to another. Use the filter box

( ) on either list to limit the variables displayed, either using a text filter, or a regular expression. This
choice can be set in the Altair page in the Preferences window. As you enter text or an expression in
the box, only those variables containing the text or expression are displayed in the list.
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Decision Forest Model

Displays a summary of the decision forest model and its results, as well as providing scoring code in the
SAS language.

Decision Forest Results tab
Model Information

Provides a summary of the model.

Target Summary
Shows the dependent (target) variable that the decision forest is required to predict.

Input Summary
Summarises the independent (input) variables, their types, categories and the other properties.

Confusion Matrix
Shows the confusion matrix for the decision forest. This is the number of observations in the
training dataset that were correctly and incorrectly classified from the observed results.

For more information about confusion matrices, see the Binary classification statistics  (page
504) section.

Out-of-Bag Confusion Matrix
A confusion matrix that shows the out-of-bag (OOB) error estimate for the decision forest. This
is the number of observations in the training dataset that were correctly and incorrectly classified
using OOB classification.
To calculate the predicted OOB classification for an observation, the observation is classified
using each tree for which the observation was out-of-bag (that is, each tree for which the
observation wasn't selected to train that tree). The most popular value is chosen as the predicted
OOB classification for that observation. The OOB error estimate is the number of observations
which are correctly and incorrectly classified using this algorithm.

Scoring Code tab
The Scoring Code tab displays code for the decision forest in a specified language with specified
variable names. SAS language code can be used in the DATA step.

Saving the Model
To save the Decision Forest model, right-click on the Decision Forest Model block and select Save
Model. Specify a filename and location.
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Decision Forest block basic example

This example demonstrates how the Decision Forest block can be used to model a binary variable.

In this example, a dataset containing information about loans, named loan_data.csv is imported
into a blank Workflow. The dataset contains information about the default status of loans using a binary
Default variable. The Decision Forest block uses this dataset to estimate the likelihood for each loan
to default.

Workflow Layout

Datasets used

The file used in this example can be found in the samples distributed with Altair SLC.

This example uses a dataset about loans, named loan_data.csv. Each observation in the dataset
describes a past loan and the person who took loan out, with variables such as Income, Loan_Period
and Other_Debt.

Using the Decision Forest block to predict loan defaulting

Using the Decision Forest block to create a model predicting loan defaulting.

1. Import the loan_data.csv dataset onto a blank Workflow canvas. Importing a CSV file is described
in Text File Import block  (page 220).

2. Expand the Model Training group in the Workflow palette, then click and drag a Decision Forest
block onto the Workflow canvas, beneath the loandata.csv dataset.

3. Click on the loan_data.csv dataset block's Output port and drag a connection towards the Input
port of the Decision Forest block.

Alternatively, you can dock the Decision Forest block onto the dataset block directly.
4. Double-click on the Decision Forest block.

A Configure Decision Forest dialog box opens.
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5. From the Configure Decision Forest dialog box:

a. In the Dependent variable drop-down list, select Default.
b. In the Dependent variable treatment drop-down list, select Nominal.
c. From the Unselected Independent Variables box, double-click on the variables Age,

Part_Of_UK,  Income and Other_Debt to move them to  the Selected Independent Variables
box.

d. Click Apply and Close.

The Configure Decision Forest dialog box closes. A green execution status is displayed in the
Output port of the Decision Forest block and the model results, Decision Forest Model.
This can take a short while, depending on computer performance.

You now have a decision forest model that predicts the likelihood of each loan defaulting.

Decision Forest block example: Accepting or rejecting loan
applications

This example demonstrates how the Decision Forest block can make predictions on loan defaulting,
assisting with the acceptance or rejection of loan applications.

In this example, a dataset containing information about loans, and a dataset of loan applications, named
loan_data.csv and loan_applications.csv respectively are imported into a blank Workflow.
The Decision Forest block is then configured to output a model that estimates the likelihood for a loan
to default. The model is then applied to another dataset, loan_applications.csv, using a Score
block. Two Filter blocks are then used to divide the dataset of loan applications into two datasets: one
describing accepted loans and the other rejected loans, based on the value of the defaulting prediction.
These new datasets are named Rejected Loans and Accepted Loans accordingly.

356



Altair Analytics Workbench user guide
Version 2023

Workflow Layout

Datasets used

The file used in this example can be found in the samples distributed with Altair SLC.

The datasets used in this example are:

• A dataset about loans, named loan_data.csv. Each observation in the dataset describes a past
loan and the person who took loan out, with variables such as Income, Loan_Period and Other_Debt.

• A dataset about loan applications, named loan_applications.csv. Each observation in the
dataset describes an application for a loan and the person taking the loan out. It contains the same
variables as loan_data.csv except for the lack of a Default variable.
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Using the Decision Forest block to accept or reject loan applications

Training a Decision Forest block and using it to make predictions on new data.

1. Import the loan_data.csv and loan_applications.csv datasets into a blank Workflow.
Importing a CSV file is described in Text File Import block  (page 220).

2. Expand the Model Training group in the Workflow palette, then click and drag a Decision Forest
block onto the Workflow canvas, beneath the loan_data.csv dataset.

3. Click on the loan_data.csv dataset block's Output port and drag a connection towards the Input
port of the Decision Forest block.

Alternatively, you can dock the Decision Forest block onto the dataset block directly.
4. Double-click on the Decision Forest block.

A Configure Decision Forest dialog box opens.
5. From the Configure Decision Forest dialog box Variable selection tab:

a. In the Dependent variable drop-down list, select Default.
b. In the Dependent variable treatment drop-down list, select Nominal.
c. From the Unselected Independent Variables box, double-click on the variables Age,

Part_Of_UK, Income and Other_Debt to move them to the Selected Independent Variables
box.

6. Click on the Preferences tab and change the following:

a. Number of trees to 20.
b. Classifier combination as Mean Probability.
c. Select Minimum split size as ratio and set its value to 5.
d. Click Apply and Close.

The Configure Decision Forest dialog box saves and closes. A green execution status is
displayed in the Output port of the Decision Forest block and the model results, Decision
Forest Model. This may take a short while, depending on computer performance.

7. From the Scoring grouping in the Workflow palette, click and drag a Score block onto the Workflow
canvas, below the new Decision Forest Model block and the loan_applications.csv dataset
block.

A Score block and empty dataset block are created on the Workflow canvas. Note that the Score
block's configuration status (the right-hand bar of the block) is red and displays a screentip stating
that the block requires a model and a dataset input.

8. Click on the loan_applications.csv dataset block's Output port and drag a connection towards
the Input port of the Score block.

9. Click on the Decision Forest Model Output port and drag a connection towards the Input port of the
Score block.

The execution status of the Score block turns green and its dataset output is populated with the
original dataset and the scored variables.

358



Altair Analytics Workbench user guide
Version 2023

10.From the Data Preparation grouping in the Workflow palette, click and drag two Filter blocks onto the
Workflow canvas.

11.Click on the Score block Output port and drag a connection towards the Input port of each Filter
block.

12.Configure the first Filter block:

a. Double-click on a Filter block.

A Filter Editor view opens.
b. Click on the Basic tab.
c. From the Variable drop-down box, select P_1.
d. From the Operator drop-down box, select <.
e. In the Value box, enter 0.5.
f. Press Ctrl+S to save the configuration.
g. Close the Filter Editor view.

The Filter Editor view closes. A green execution status is displayed in the Output port of the
Filter block and the filtered dataset, Working Dataset.

h. Right-click on the Filter block's output dataset block and click Rename. Type Rejected Loans
and click OK.

13.Configure the second Filter block:

a. Double-click on the other Filter block.

A Filter Editor view opens.
b. Click on the Basic tab.
c. From the Variable drop-down box, select P_1.
d. From the Operator drop-down box, select >=.
e. In the Value box, enter 0.5.
f. Press Ctrl+S to save the configuration.
g. Close the Filter Editor view.

The Filter Editor view closes. A green execution status is displayed in the Output port of the
Filter block and the filtered dataset, Working Dataset.

h. Right-click on the Filter block's output dataset block and click Rename. Type Accepted Loans
and click OK.

You now have a decision forest model that predicts if a loan applicant will default and filters data into
acceptances and rejections.
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Decision Tree block

Provides an interface to create a decision tree for classification purposes.

This block can be invoked by dragging the block from the Workflow palette to the Workflow canvas and
then dragging a connection from a dataset to the Input port of the block. Decision trees are created
and edited using the Decision Tree editor view and Decision Tree Preferences dialog box. Double-
clicking a Decision Tree block will open the Decision Tree editor view; if the block is new with no basic
information configured, the Decision Tree Preferences dialog box will also open. Once basic information
to build a tree has been configured, double-clicking the Decision Tree block will just open the Decision
Tree editor view. To open the Decision Tree Preferences dialog box manually, click the preferences icon
( ) at the top right of the Decision Tree editor view.

You can use the Decision Tree editor view Tree tab to grow the tree manually based on the optimal
binning measure of the selected independent variables, or automatically grow one level of the tree
at a time or a full decision tree using the growth preference algorithm specified in the Decision Tree
Preferences dialog box.

Growing a decision tree requires a connected source dataset, although without a connected
dataset, trees may still be viewed and pruned (Unsplit). If a dataset is reconnected after a period of
disconnection, the decision tree will be recalculated.

Decision Tree editor view

Displays graphical, tabular and coded representations of the decision tree and information about specific
nodes or tree levels as the tree is grown. The decision tree editor also stores a history of changes to the
decision tree.

Decision Tree preferences

Enables you to specify the independent and dependent variables and set options for creating the
decision tree.

Opening the Decision Tree preferences dialog box
The Decision Tree Preferences dialog box is opened in three ways:

• When first creating a decision tree, the Decision Tree Preferences dialog box will open automatically.
• By clicking the Preferences ( ) button in the Decision Tree editor view Tree tab.

• By right-clicking on the Decision Tree block in the Workflow and clicking Edit Decision Tree.

The contents of the Decision Tree Preferences dialog box are described below.
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Variable Selection panel
Enables you to specify the dependent (target) variable and category you want to predict based on other
independent (input) variables in the input dataset.

Dependent Variable
Specifies the dependent (target) variable for which the category is calculated by the decision tree.

Tree type
Choose from Classification or Regression. Choice will be limited depending on the type of the
Dependent Variable chosen.

Target Category
For classification trees, specifies the classification of the dependent variable the decision tree will
predict using the selected independent (input) variables selected in the Independent Variables
list.

Weight variable
To weight every node's calculated frequencies, select the check box and choose a weight variable
from the drop-down list.

Independent Variables

The two boxes in the Variable Selection panel show Unselected Independent Variables and
Selected Independent Variables. To move an item from one list to the other, double-click on it.
Alternatively, click on the item to select it and use the appropriate single arrow button. A selection
can also be a contiguous list chosen using Shift and click, or a non-contiguous list using Ctrl and
click. Use the Select all button ( ) or Deselect all button ( ) to move all the items from one

list to the other. Use the Apply variable lists button ( ) to move a set of variables from one

list to another. Use the filter box ( ) on either list to limit the variables displayed, either using a
text filter, or a regular expression. This choice can be set in the Altair page in the Preferences
window. As you enter text or an expression in the box, only those variables containing the text or
expression are displayed in the list.

For categorical dependent variables, the Entropy Variance column shows how well each
independent variable can predict the value of the selected dependent (target) variable. Entropy
Variance is in the range of 0 – 1. If a variable in a dataset has a high entropy variance, it means
that the variable is a good predictor of the dependent variable. However where the entropy
variance is very high, or 1, the variable might not be a good predictor as using this variable could
lead to over-fitting the model.

The Variable Treatment for each variable enables you to specify that variable's type. Only
applicable types are available to choose from. The full list of types is:

Interval
Specifies a continuous independent (input) variable.
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Nominal
Specifies a discrete independent (input) variable with no implicit ordering. When partitioning
this variable into nodes in a tree, any category can be merged with any other category.

Ordinal
Specifies a discrete independent (input) variable with an implicit category ordering. When
partitioning this variable into nodes in a tree, only adjacent categories can be merged
together.

Growth Preferences
Specifies the decision tree growth algorithm and associated growth preferences. The Growth Algorithm
specifies the method used to construct the decision tree, and can be one of C4.5, CART, or BRT,
depending on the type of the chosen dependent variable. Each algorithm has its own specific options.

C4.5
Specifies the C4.5 algorithm should be used to build the decision tree. You can then specify
options for the algorithm as follows:

• Maximum depth: Specifies the maximum depth of the decision tree.
• Minimum node size (%): Specifies the minimum number of observations in a decision tree

node, as a proportion of the input dataset.

Note:

When continuous variables are split into nodes, the minimum node size, s is defined as:

 

where:

‣ d is the node size set in the Minimum node size (%) box.

‣ f is the frequency of the node being split.

‣ c is the number of target categories in the model.

• Merge categories: When selected, merges categories into single leaf nodes.
• Prune: Select to specify that nodes which do not significantly improve the predictive accuracy

are removed from the decision tree to reduce tree complexity.
• Prune confidence level: Specifies the confidence level for pruning, expressed as a

percentage. The default is 25.0%.

CART
Specifies the CART algorithm should be used to build the decision tree. Leaf nodes are merged
according to the algorithm's methodology. You can specify options for the algorithm as follows:
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• Criterion: Specifies the criterion used to split nodes in the decision tree. The supported criteria
are:

‣ Gini: Specifies that Gini Impurity is used to measure the predictive power of variables.
‣ Ordered twoing: Specifies that the Ordered Twoing Index is used to measure the

predictive power of variables.
‣ Twoing: Specifies that the Twoing Index is used to measure the predictive power of

variables.
• Prune: Select to specify that nodes which do not significantly improve the predictive accuracy

are removed from the decision tree to reduce tree complexity.
• Pruning Method: Specifies the method to be used when pruning a decision tree. The

supported methods are:

‣ Holdout: Specifies that the input dataset is randomly divided into a test dataset containing
one third of the input dataset and a training dataset containing the balance. The output
decision tree is created using the training dataset, then pruned using risk estimation
calculations on the test dataset.

‣ Cross validation: Specifies that the input dataset is divided as evenly as possible into
ten randomly-selected groups, and the analysis repeated ten times. The analysis uses a
different group as test dataset each time, with the remaining groups used as training data.
Risk estimates are calculated for each group and then averaged across all groups. The
averaged risk values are used to prune the final tree built from the entire dataset.

• Maximum Depth: Specifies the maximum depth of the decision tree.
• Minimum node size (%): Specifies the minimum number of observations in a decision tree

node, as a proportion of the input dataset.
• Minimum improvement: Specifies the minimum improvement in impurity required to split

decision tree node.
• Exclude missings: Specifies that observations containing missing values are excluded when

determining the best split at a node.

BRT
Specifies the algorithm options for binary response trees. Specifies the BRT algorithm should
be used to build a binary decision tree. Leaf nodes will be merged according to the algorithm's
methodology. You can specify options for the algorithm:
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• Criterion: Specifies the criterion used to split nodes in the decision tree. The supported criteria
are:

‣ Chi-squared: Specifies that Pearson's Chi-Squared statistic is used to measure the
predictive power of variables.

‣ Entropy variance: Specifies that Entropy Variance is used to measure the predictive power
of variables.

‣ Gini variance: Specifies that Gini Variance is used to measure the predictive power of
variables by measuring the strength of association between variables.

‣ Information value: Specifies that Information Value is used to measure the predictive
power of variables.

• Maximum depth: Specifies the maximum depth of the decision tree.
• Select minimum node size by ratio: When selected enables you to specify the minimum

number of observations in a node as a proportion of the input dataset. When cleared, enables
you to specify the absolute minimum number of observations in a node.

• Minimum node size (%): Specifies the minimum number of observations in a decision tree
node, as a proportion of the input dataset.

• Minimum node size: When selected enables you to specify the minimum split size of a
decision tree node as a proportion of the input dataset. When cleared, enables you to specify
the absolute minimum split size of a decision tree node.

• Select minimum split size by ratio: When selected enables you to specify the minimum
number of observations for the node to be split as a proportion of the input dataset. When
cleared, enables you to specify the absolute minimum number of observations in a node.

• Minimum split size (%): Specifies the minimum number of observations a decision tree node
must contain for the node to be split, as a proportion of the input dataset.

• Minimum split size: Specifies the absolute minimum number of observations a decision tree
node must contain for the node to be split.

• Allow same variable split: Specifies that a variable can be used more than once to split a
decision tree node.

• Open left: For a continuous variable, when selected, specifies that the minimum value in the
node containing the very lowest values is    (minus infinity). When clear, the minimum value
is the lowest value for the variable in the input dataset.

• Open right: For a continuous variable, when selected, specifies that the maximum value in the
node containing the very largest values is    (infinity). When clear, the maximum value is the
largest value for the variable in the input dataset.

• Merge missing bin: Specifies that missing values are considered a separate valid category
when binning data.

• Monotonic Weight of Evidence: Specifies that the Weight of Evidence value for ordered input
variables is either monotonically increasing or monotonically decreasing.

• Exclude missings: Specifies that observations containing missing values are excluded when
determining the best split at a node.

• Initial number of bins: Specifies the number of bins available when binning variables.
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• Maximum number of optimal bins: Specifies the maximum number of bins to use when
optimally binning variables.

• Weight of Evidence adjustment: Specifies the adjustment applied to weight of evidence
calculations to avoid invalid results for pure inputs.

• Maximum change in predictive power: Specifies the maximum change allowed in the
predictive power when optimally merging bins.

• Minimum predictive power for split: Specifies the minimum predictive power required for a
decision tree node to be split.

None
Specifies no growth algorithm. This option is for manually building a decision tree in the Decision
Tree editor view.

Tree tab

Displays the decision tree and associated information.

Tree

The main part of the Tree tab displays a graphical representation of the decision tree as it grows.
Each node is numbered, with numbering starting at zero at the root, with each subsequent level
then numbered from left to right following on from the previous level. For discrete dependent
variables, each node shows a frequency breakdown of the target categories. For continuous
variables, each node shows the mean and LSD (least squares deviation) of the dependent
variable for that node.

Tree nodes are colour coded as follows:

• Regression Trees: Nodes are shaded according to their dependent variable's mean value. The
node with a mean closest to the minimum value is shaded blue, and the node with a mean
closest to the maximum is shaded red, with gradations in between.

• Classification Trees: Nodes are shaded according to the percentage of observations for that
node that satisfy the target category. The node with the lowest percentage is shaded blue, and
the node with the highest percentage is shaded red, with shades in between to represent other
percentages.

The growth of the tree is determined by options specified in the Node properties panel. Other
Decision Tree settings are configured using the Preferences window, accessed by clicking the
Preferences button (two cogs symbol).

The Node Information panel shows information about the selected node. If a continuous
dependent variable is being used, two other panels are available: Node Frequencies and
Peer Comparison. The Node Frequencies panel shows a frequency breakdown of the target
categories for the selected node. The Peer Comparison panel, which is collapsed by default,
displays information about a selected node compared to other nodes on the same tree level.

To prune a tree (remove child branches), right-click on a parent branch and click Unsplit.
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To switch between the tree showing unweighted frequencies or weighted frequencies, right-click
on the tree itself and select show unweighted frequencies or show weighted frequencies. This
will also change which frequency value is displayed in the Node Frequencies panel.

Node Information panel

Displays information about the node currently-selected.

Node
Displays the label of the node. If the node is the root of the tree, the label <root> is
displayed, otherwise the Node label specified in Node Properties is displayed.

Size
Displays the total number of observations in the current node.

% of Population
Displays the size of the node as a percentage of the input dataset.

Node Frequencies panel (continuous dependent variables only)

Displays the frequency or weighted frequency of the dependent variable categories in the selected
node. Switching between weighted and unweighted frequencies is done by right-clicking on the
tree and selecting show unweighted frequencies or show weighted frequencies.

The frequency panel can show either a histogram showing the frequency percentage for each
category, or a table showing the frequency and associated observation count. Click the icons at
the top of the panel to switch between the histogram and table views.

The histogram chart can be edited and saved. Click Edit chart  to open a the Chart Editor
from where the chart can be saved to the clipboard. Frequency data for the selected node can be
saved, click Copy data to clipboard  to save the table of data.

Peer comparison panel (continuous dependent variables only)

Displays the frequency of the dependent variable categories in the selected node and other nodes
at the same tree level (peer nodes). The frequency for each category in all peer nodes can be
displayed as either a histogram showing the frequency percentage for each category, or a table
showing the frequency and associated observation count in each node.

The peer comparison chart can be edited and saved. Click Edit chart  to open a the Chart
Editor from where the chart can be saved to the clipboard. Frequency data for the selected node
and peer nodes can be saved, click Copy data to clipboard  to save the table of data.

Node Properties panel

Enables you to grow a tree and specify how new tree level nodes are split.

Split
Displays the independent variable from the Split Variable list used to split the parent node
to create the tree level containing the selected node.
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Node Label
Specifies the label displayed in the graphical decision tree and the Node Information panel
for the node selected in the graphical tree. The default label is the value or values of the
displayed split variable used to create the node. If you modify the label, click Default to
return the label to the Altair Analytics Workbench-generated value.

Grow 1 Level
Grows the next level of the tree using the Growth Algorithm  specified in the Growth
Preferences panel of the Decision tree preferences.

Grow
Grows a complete decision tree using the Growth Algorithm specified in the Growth
Preferences panel of the Decision tree preferences.

Optimal split
Will grow one level of the tree using the Optimal Binning Measure specified in the Binning
panel of the Altair section of the Preferences dialog box.

Split Variable
Displays the variable used to split the selected node and the categories used to determine
the split points. You can change the created nodes using one of the available binning
methods or by selecting a different Split variable. The available binning methods,
depending on variable type, are optimal binning , equal width binning , equal height

binning , or Winsorized binning .

Map panel
The map panel at the bottom right shows how the tree display area, represented by a grey
rectangle, relates to the tree as a whole, shown with blue and red blocks. The main tree
display area can be moved by clicking and dragging the grey rectangle.

Summary tab

Gives information about the decision tree.

Model Information
Provides a summary of the trained Decision Tree model, giving its type, number of nodes and leaf nodes,
and maximum width and depth (measured in nodes).

Dependent Variable
Gives details of the dependent variable
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Independent Variable
Gives details of the independent variable or variables.

Classification Table
Gives predicted category frequencies from the decision tree.

Node Table
The Node Table is a tabular representation of the decision tree, with every leaf node as a row.

Sorting the table

The table can be sorted by clicking on the variable you want to sort by.

Exporting to Excel

The Export to Excel button will export the table's contents to an MS Excel .xlsx file with a
specified location and filename. The sort order of the table view has no influence on the sorted
order of the generated Excel file.

Dependent variable value
Sets the value of the dependent variable. The dependent variable is specified in Decision Tree
preferences  (page 360).

Column Definitions

Node Table Column Description

ID A unique number allocated to each node for
identification purposes.

Condition A logical statement defining the leaf node (row).

Population The total number of observations matching the
condition.

% of Population The percentage of the total population that
match the condition.

Cumulative Population The cumulative total of the population that
match the condition.

Cumulative % of Population The cumulative percentage of the total
population that match the condition.

dependent variable = dependent variable value The number of observations that match the
condition and this statement. The dependent
variable is specified in the Decision Tree
preferences  (page 360) window and the
Dependent variable value is specified in the
drop-down list above the table.
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Node Table Column Description

% dependent variable =
dependent variable value

The percentage of observations in the entire
population that match the condition and this
statement. The dependent variable is specified
in the Decision Tree preferences  (page
360) window and the Dependent variable
value is specified in the drop-down list above
the table.

Cumulative % dependent variable =
dependent variable value

The cumulative percentage of observations in
the entire population that match the condition
and this statement. The dependent variable is
specified in the Decision Tree preferences
(page 360) window and the Dependent
variable value is specified in the drop-down list
above the table.

Proportion % dependent variable =
dependent variable value

The percentage of observations in the node that
match the condition and this statement. The
dependent variable is specified in the Decision
Tree preferences  (page 360) window and
the Dependent variable value is specified in
the drop-down list above the table.

Lift % dependent variable =
dependent variable value

The lift percentage of observations that match
the condition and this statement. Lift is defined
as the ratio between matches for the node and
the entire population.

Cumulative lift % dependent variable =
dependent variable value

The cumulative lift percentage of observations
that match the condition and this statement. Lift
is defined as the ratio between matches for the
node and the entire population.

Scoring Code tab

Displays code for the decision tree in a specified language with specified variable names. SAS language
code can be used in the DATA step.

Choosing the language

From the Select Language list box, select the required language as either SAS or SQL.

Choosing score variable names
Click Options, then in Source Generation Options, click the score variable you want to change
and type the new name. When you are happy with all the score variable names, click OK.
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History tab

Stores all changes to the decision tree.

Events
Lists decision tree change events and has three columns:

Event
Lists events by number, starting with the oldest item (labelled '1') and concluding with the newest.

Action
Describes what took place in each event.

Node
If applicable, gives the node for the event.

Click on a column heading to numerically sort entries.

Clicking on an event will display data from that even in the other four panels, described below.

Click the copy to clipboard button ( ) to copy the entire contents of the panel to the clipboard.

Growth Settings
Lists the growth settings in place for the selected event. These settings are set in the Growth
Preferences tab of Decision Tree preferences  (page 360).

Click the copy to clipboard button ( ) to copy the entire contents of the panel to the clipboard.

Decision Tree Settings
Lists the variables selection for the selected event. These settings are set in the Variable Selection tab
of Decision Tree preferences  (page 360).

Click the copy to clipboard button ( ) to copy the entire contents of the panel to the clipboard.

Binning Settings
Lists the binning settings for the selected event. These settings are set in the Binning Preferences tab
of Decision Tree preferences  (page 360).

Click the copy to clipboard button ( ) to copy the entire contents of the panel to the clipboard.

Dataset Variables
Lists any changes in the Decision Tree block's input dataset variables.

Click the copy to clipboard button ( ) to copy the entire contents of the panel to the clipboard.

370



Altair Analytics Workbench user guide
Version 2023

Decision Tree block basic example

This example demonstrates how the Decision Tree block can be used to model a binary variable.

In this example, a dataset containing information about basketball shots, named
basketball_shots.csv is imported into a blank Workflow. The dataset contains information about
basketball shots and whether they scored through the Scored variable. The Decision Tree block uses
this dataset to estimate the likelihood for each basketball shot to score.

Workflow Layout

Datasets used

The file used in this example can be found in the samples distributed with Altair SLC.

This example uses a dataset about basketball shots, named basketball_shots.csv. Each
observation in the dataset describes an attempt to score and the person shooting, with variables such as
height, weight and distance_feet.

Using the Decision Tree block to create a decision tree model

Using the Decision Tree block to predict whether a basketball shot will score.

1. Import the basketball_shots.csv dataset onto a blank Workflow canvas. Importing a CSV file is
described in Text File Import block  (page 220).

2. Expand the Model Training group in the Workflow palette, then click and drag a Decision Tree block
onto the Workflow canvas, beneath the basketball_shots.csv dataset.

3. Click on the basketball_shots.csv dataset block's Output port and drag a connection towards
the Input port of the Decision Tree block.

Alternatively, you can dock the Decision Tree block onto the dataset block directly.
4. Double-click on the Decision Tree block.

A Decision Tree editor view opens, along with the Decision Tree Preferences dialog box.
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5. From the Preferences window:

a. In the Dependent variable drop-down list, select Score.
b. In the Target category drop-down list, select 1.
c. From the Unselected Independent Variables box, double-click on the variables

distance_feet, angle,  height, weight and position to move them to the Selected
Independent Variables box.

d. Click Apply and Close.  The Decision Tree Preferences dialog box closes. Right-click on the
0:Score node and click Grow (C4.5) to train the model.

The Decision Tree editor view is populated with further nodes that make up the decision tree
model.

e. Press Ctrl+S to save the configuration.
f. Close the Decision Tree editor view.

The Decision Tree window closes. A green execution status is displayed in the Output port of the
Decision Tree block.

You now have a decision tree model that predicts whether a basketball shot will score.

Decision Tree block example: Manually building a decision tree

This example demonstrates how the Decision Tree block can be manually built.

In this example, a dataset containing information about basketball shots, named
basketball_shots.csv is imported into a blank Workflow. The dataset contains information about
a basketball shot and whether it scores through the Scored variable. The Decision Tree block uses
this dataset to estimate the likelihood for each basketball shot to score. The model is then applied to
basketball_shots.csv, using a Score block. The Score block generates an output dataset Shot
Predictions.
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Workflow Layout

Datasets used

The file used in this example can be found in the samples distributed with Altair SLC.

This example uses a dataset about basketball shots, named basketball_shots.csv. Each
observation in the dataset describes an attempt to score and the person shooting, with variables such as
height, weight and distance_feet.

Using the Decision Tree block to create a manual decision tree model

Manually building a Decision Tree block in the Decision Tree editor view to predict a binary variable.

1. Import the basketball_shots.csv dataset onto a blank Workflow canvas. Importing a CSV file is
described in Text File Import block  (page 220).

2. Expand the Model Training group in the Workflow palette, then click and drag a Decision Tree block
onto the Workflow canvas, beneath the basketball_shots.csv dataset.

3. Click on the basketball_shots.csv dataset block's Output port and drag a connection towards
the Input port of the Decision Tree block.

Alternatively, you can dock the Decision Tree block onto the dataset block directly.
4. Double-click on the Decision Tree block.

A Decision Tree editor view opens, along with the Decision Tree Preferences dialog box.
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5. From the Decision Tree Preferences dialog box:

a. In the Dependent variable drop-down list, select Score
b. In the Target category drop-down list, select 1
c. From the Unselected Independent Variables box, double-click on the variables

distance_feet, angle and height to move them to the Selected Independent Variables
box.

d. Click Apply and Close.  The Decision Tree Preferences dialog box closes.
6. In the Decision Tree editor view:

a. From the Split variable drop-down box select distance_feet and click on the Calculate optimal
binning  button ( ).

b. Click on the decision tree node labelled 5: > 19.3 AND <=20.9, from the Split variable drop-down
box   select angle and click on the Calculate equal width binning button ( ).

c. Click on the decision tree node labelled 12: > 14.0 AND <=28.0, from the Split variable drop-
down box   select height and click on the Calculate optimal binning button ( ).

The Decision Tree editor view is populated with further nodes that make up the decision tree
model.

d. Press Ctrl+S to save the configuration.
e. Close the Decision Tree editor view.

The Decision Tree editor view window closes. A green execution status is displayed in the
Output port of the Decision Tree block.

7. From the Scoring grouping in the Workflow palette, click and drag a Score block onto the Workflow
canvas, below the Score block and the basketball_shots.csv dataset block.

A Score block and empty dataset block are created on the Workflow canvas. Note that the Score
block's configuration status (the right-hand bar of the block) is red and displays a screentip stating
that the block requires a model and a dataset input.

8. Click on the basketball_shots.csv dataset block's Output port and drag a connection towards
the Input port of the Score block.

9. Click on the Decision Tree blocks Output port and drag a connection towards the Input port of the
Score block.

The execution status of the Score block turns green and its dataset output is populated with the
original dataset and the scored variables.

10.Right-click on the Score block's output dataset block and click Rename. Type Shot Predictions
and click OK.

You now have a manually configured decision tree model that predicts scoring accuracy of a basketball
shot.
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Hierarchical Clustering block

Provides an interface to create a hierarchical cluster model.

This block can be invoked by dragging the block from the Workflow palette to the Workflow canvas and
then dragging a connection from a dataset to the Input port of the block. A hierarchical cluster model is
created and edited using Hierarchical Clustering view. Required information to build the model is set
using the hierarchical clustering Preferences dialog box. The hierarchical clustering Preferences dialog
box is displayed the first time you open a new Hierarchical Clustering view.

To open the Hierarchical Clustering view, double-click the Hierarchical Clustering block.

Hierarchical clustering preferences

Enables you to specify the variables and set options for creating the cluster model.

Variable Selection
Enables you to specify the variables to be used in the clustering model.

The two boxes in the Variable Selection panel show Unselected Variables and Selected Variables
that will be used in the clustering model. To move an item from one list to the other, double-click on
it. Alternatively, click on the item to select it and use the appropriate single arrow button. A selection
can also be a contiguous list chosen using Shift and click, or a non-contiguous list using Ctrl and click.
Use the Select all button ( ) or Deselect all button ( ) to move all the items from one list to the

other. Use the Apply variable lists button ( ) to move a set of variables from one list to another.

Use the filter box ( ) on either list to limit the variables displayed, either using a text filter, or a regular
expression. This choice can be set in the Altair page in the Preferences window. As you enter text or an
expression in the box, only those variables containing the text or expression are displayed in the list.

Configuration
Enables you to specify settings for the hierarchical model created using variables selected in the
Variable Selection panel.

Standardize
Standardises the variables to normal form, and uses these values when calculating clusters.

Impute output
Specifies that the output dataset will replace any missing values in the input variables with the
mean value of the cluster.

Perform pre-clustering
Specifies that input observations are allocated to a smaller number of clusters to reduce the
problem complexity. Observations are assigned to the clusters using k-means clustering.
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Method
Specifies how cluster distances and cluster centres are calculated.

Average linkage
Specifies the group average method to create data clusters.

Centroid method
Specifies the centroid method to create data clusters.

Complete linkage
Specifies the complete-linkage method to create data clusters.

Density linkage
Specifies the density-linkage method to create data clusters.

Flexible-beta method
Specifies the flexible-beta method to create data clusters, as described in Lance, G.N., and
Williams, W.T., 1967. A general theory of classificatory sorting strategies, 1. Hierarchical
systems in Computer Journal, Volume 9, pp 373–380.

McQuitty similarity analysis
Specifies that McQuitty-similarity analysis is used to create, as described in McQuitty,
L.L., 1966. Similarity Analysis by Reciprocal Pairs for Discrete and Continuous Data, in
Educational and Psychological Measurement, Volume 26, pp 825–831.

Median Method
Specifies the median method of centroids to create data clusters.

Single linkage
Specifies a single linkage or nearest neighbour calculation is used to create data clusters.

Ward minimum variance model
Specifies that the Ward minimum variance model is used to create data clusters, as
described in Ward, H.J., 1963. Hierarchical Grouping to Optimize an Objective Function, in
Journal of the American Statistical Association, Volume 58, pp. 236–244

Suppress squaring distances
Suppresses the squaring of distances in distances calculations. This option can be specified for
the Average linkage, Centroid, Median, and Ward minimum variance models.

Mode
Specifies the minimum number of observations required for a cluster to be distinguished as a
modal cluster. A modal cluster is a region of high density separated from another region of high
density by a region of low density.

Beta
Specifies the beta value required to implement the flexible-beta method.
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Dimensionality
Specifies the number of dimensions to use when calculating density estimates in the density
linkage model.

Frequency variable
Specifies a variable selected in the Value Selection panel that defines the frequency of each
observation.

K Nearest Neighbours
Specifies the number of nearest neighbours to each observation in cluster calculations when using
the Density linkage method.

Radius of Sphere for uniform-kernel
Specifies the radius of the a sphere around each observation used to compute the nearest
neighbours in cluster calculations when using the Density linkage method.

Hierarchical Clustering view

Displays a graphical representation of the cluster model and information about specific clusters in the
model.

The Hierarchical Clustering view displays information using the following tabs.

Clustering
Displays a dendrogram graph, which is a tree displaying the calculated clusters of observations and
the distances between clusters. The graphs show the Cubic Clustering Criteria (CCC), Pseudo F and
Pseudo T-Square statistics for the generated clusters. On all graphs, the vertical dotted line shows the
number of clusters currently selected.

The view contains two slider controls:

• Dendrogram details enables you to adjust the level of detail in the tree.
• dendrogram Height Variable enables you to choose the height variable used.
• Number of clusters enables you to select the number of clusters in the final model. The number

selected determines the number of clusters listed in both the Univariate View and Distribution
Comparison.

Univariate View
Displays the summary statistics for the input dataset and the same summary statistics for each cluster in
the model. These statistics can be based on either the data values in the dataset (the Input Space) or a
standardised normal distribution of the variable values (the Standardised Space).
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The view displays a frequency distribution for a specified variable in the overall or cluster lists. The
frequency distribution of the specified variable can be displayed as a histogram, line chart or pie
chart. In all cases, the charts display the frequency of values as the percentage of the total number of
observations for the variable.

The chart can be edited and saved. Click Edit chart  to open a Chart Editor from where the chart can
be saved to the clipboard.

Distribution Comparison
Enables you to select a variable and view the frequency for a specified variable in one or more of the
specified clusters. The displayed frequency can be based on either the data values in the dataset (the
Input Space) or a standardised normal distribution of the variable values (the Standardised Space).

The frequency distribution of the specified variable and clusters can be displayed as a histogram, line
chart or pie chart. In all cases, the charts display the frequency of values as the percentage of the total
number of observations for the variable.

The chart can be edited and saved. Click Edit chart  to open a Chart Editor from where the chart can
be saved to the clipboard.

Hierarchical Clustering block basic example

This example demonstrates how the Hierarchical Clustering block can be used to cluster observations
in a dataset.

In this example, a dataset containing information about basketball players, named
basketball_players.csv is imported into a blank Workflow. The dataset contains attributes of
various basketball players. The Hierarchical Clustering block uses this dataset to cluster observations
together.

Workflow Layout

Datasets used

The file used in this example can be found in the samples distributed with Altair SLC.
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This example uses a dataset about basketball players, named basketball_players.csv. Each
observation in the dataset describes a basketball player, with variables such as height, weight and
firstName.

Using the Hierarchical Clustering block to create a Hierarchical Clustering model

Using the Hierarchical Clustering block to cluster observations.

1. Import the basketball_players.csv dataset into a blank Workflow canvas. Importing a CSV file
is described in Text File Import block  (page 220).

2. Expand the Model Training group in the Workflow palette, then click and drag a Hierarchical
Clustering block onto the Workflow canvas, beneath the basketball_players.csv dataset.

3. Click on the basketball_players.csv dataset block's Output port and drag a connection
towards the Input port of the Hierarchical Clustering block.

Alternatively, you can dock the Hierarchical Clustering block onto the dataset block directly.
4. Double click on the Hierarchical Clustering block.

A Hierarchical Clustering view opens, along with a hierarchical clustering Preferences dialog box.
5. From the hierarchical clustering Preferences dialog box:

a. From the Unselected Variables box, double click on the variables height, weight,   and
goals_scored to move them to  the Selected Variables box.

b. Click Apply and Close.  The hierarchical clustering Preferences dialog box closes. Drag the
Number of clusters slider to 3.

Several graphs appears showing various details of the clustering.
c. Press Ctrl+S to save the configuration.
d. Close the Hierarchical Clustering view.

The Hierarchical Clustering view closes. A green execution status is displayed in the Output
port of the Hierarchical Clustering block and the resulting dataset, Working Dataset contains the
application of the clustering model to basketball_players.csv.

You now have a hierarchical clustering model that clusters similar observations together.

379



Altair Analytics Workbench user guide
Version 2023

Hierarchical Clustering block example: analysing clustered
observations

This example demonstrates how the Hierarchical Clustering block can be used as part of a cluster
analysis.

In this example, a dataset containing information about basketball players, named
basketball_players.csv is imported into a blank Workflow. The dataset contains attributes of
various basketball players. The Hierarchical Clustering block uses this dataset to cluster observations
together. The Chart Builder block is used to plot attributes of the dataset by its cluster, creating a
visual representation for how the data has been clustered together.   An output chart, Chart Viewer is
generated.

Workflow Layout

Datasets used

The file used in this example can be found in the samples distributed with Altair SLC.

This example uses a dataset about basketball players, named basketball_players.csv. Each
observation in the dataset describes a basketball player, with variables such as height, weight and
firstName.
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Using the Hierarchical Clustering block to plot clusters

Using the Hierarchical Clustering block and Chart Builder block to plot clusters as part of a cluster
analysis.

1. Import the basketball_players.csv dataset into a blank Workflow canvas. Importing a CSV file
is described in Text File Import block  (page 220).

2. Expand the Model Training group in the Workflow palette, then click and drag a Hierarchical
Clustering block onto the Workflow canvas, beneath the basketball_players.csv dataset.

3. Click on the basketball_players.csv dataset block's Output port and drag a connection
towards the Input port of the Hierarchical Clustering block.

Alternatively, you can dock the Hierarchical Clustering block onto the dataset block directly.
4. Double click on the Hierarchical Clustering block.

A Hierarchical Clustering view opens, along with a hierarchical clustering Preferences dialog box.
5. From the hierarchical clustering Preferences dialog box:

a. From the Unselected Variables box, double click on the variables height, weight, 
goals_scored and shot_accuracy to move them to  the Selected Variables box.

b. Click on the Configuration tab.
c. Clear the Perform pre-clustering(recommended for large datasets) checkbox.
d. Click Apply and Close.

The hierarchical clustering Preferences dialog box closes.
6. In the Hierarchical Clustering view:.

a. Drag the Number of clusters slider to 5.

Several graphs appears showing various details of the clustering.
b. Press Ctrl+S to save the configuration.
c. Close the Hierarchical Clustering view.

The Hierarchical Clustering view closes. A green execution status is displayed in the Output
port of the Hierarchical Clustering block and the resulting dataset, Working Dataset contains the
application of the clustering model to basketball_players.csv.

7. Expand the Export group in the Workflow palette, then click and drag a Chart Builder block onto the
Workflow canvas, beneath the Hierarchical Clustering block.

8. Click on the Hierarchical Clustering block Working Dataset Output port and drag a connection
towards the Input port of the Chart Builder block.

Alternatively, you can dock the Chart Builder block onto the dataset block directly.
9. Double click on the Chart Builder block.

A Chart Builder view opens.
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10.Configure the Chart Builder block:

a. Under the Plots pane drop-down box, select Scatter.

A series of configuration boxes appear for customising the scatter plot.
b. In the X drop down box, select height.
c. In the Y drop down box, select goals_scored.
d. In the Options pane, under the Scatter section, click on the Group drop down box and select

CLUSTER.
e. Press Ctrl+S to save the configuration.
f. Close the Chart Builder view window.

Saving generates a preview of the chart, closing the Chart Builder view then takes you back
to the Workflow canvas. A green execution status is displayed in the Output port of the Chart
Builder block and the resulting chart, Chart Viewer contains the full view of the chart.

11.Double click on the Chart Viewer to view the generated chart

The results are displayed in the Chart Viewer, showing how the different data points are assigned to
each cluster.

You now have a hierarchical clustering model that clusters similar observations together, along with a
chart that displays the clusters assigned for a single variable.

K-Means Clustering block

Enables you to cluster data using k-means clustering.

This block can be invoked by dragging the block from the Workflow palette to the Workflow canvas and
then dragging a connection from a dataset to the Input port of the block. Clustering, or cluster analysis,
is an exploratory data analysis technique that divides data into groups. The groups contain items that
are more similar to each other than they are to items in other groups. k-means clustering is a method for
creating such groups.

To open the Configure K-Means Clustering dialog box, double-click the K-Means Clustering block.

The K-Means Clustering block generates a report displaying summary and graphical information about
of the cluster model. To view this report, right-click the K-Means Cluster Model block and click View
Result.
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Configure K-Means Clustering

Enables you to specify the variables and set options for creating the K-Means clustering model. Only
numeric data can be clustered.

Variable Selection
Specifies which variables are to be clustered. Only numeric data can be clustered, therefore only
numeric variables are listed and can be selected.

The two boxes in the Variable Selection panel show Unselected Variables and Selected Variables
that will be used in the clustering model. To move an item from one list to the other, double-click on
it. Alternatively, click on the item to select it and use the appropriate single arrow button. A selection
can also be a contiguous list chosen using Shift and click, or a non-contiguous list using Ctrl and click.
Use the Select all button ( ) or Deselect all button ( ) to move all the items from one list to the

other. Use the Apply variable lists button ( ) to move a set of variables from one list to another.

Use the filter box ( ) on either list to limit the variables displayed, either using a text filter, or a regular
expression. This choice can be set in the Altair page in the Preferences window. As you enter text or an
expression in the box, only those variables containing the text or expression are displayed in the list.

Options
Standardize

Specifies that input variables are standardised; that is, the scales of variables are adjusted so that
they are in a similar range.

Impute

Specifies that the value of missing values is imputed, based on the mean value for the variable.

Number of Clusters
Specifies the number of clusters into which the data is to be partitioned.

Max iterations
Specifies the maximum number of iterations to be performed by the clustering algorithm before
terminating.

Convergence
Specifies a convergence threshold at which the clustering algorithm terminates.

Frequency Variable

Specifies a variable that contains the frequency associated with another variable.

Weight Variable

Specifies a variable that contains the prior weight associated with each variable.
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K-Means Clustering Report view

Displays a summary and graphical representation of the cluster model and information about specific
clusters in the model.

The K-Means Clustering Report view is accessed by double-clicking on the K-Means Cluster Model
that is output by the K-Means Clustering block and displays information using the following tabs.

Clustering Results
Displays summary statistics for the dataset and each specified cluster. The Summary section shows the
Cubic Clustering Criterion (CCC), Pseudo F and R2 for the input dataset. The Clusters section shows
summary statistics for each cluster, and can be based on either the data values in the dataset (the Input
Space) or a standardised normal distribution of the variable values (the Standardised Space).

Univariate View
Displays the summary statistics for the input dataset and the same summary statistics for each cluster in
the model. These statistics can be based on either the data values in the dataset (the Input Space) or a
standardised normal distribution of the variable values (the Standardised Space).

The view displays a frequency distribution for a specified variable in the overall or cluster lists. The
frequency distribution of the specified variable can be displayed as a histogram, line chart or pie
chart. In all cases, the charts display the frequency of values as the percentage of the total number of
observations for the variable.

The chart can be edited and saved. Click Edit chart  to open a Chart Editor from where the chart can
be saved to the clipboard.

Distribution Comparison
Enables you to select a variable and view the frequency for a specified variable in one or more of the
specified clusters. The displayed frequency can be based on either the data values in the dataset (the
Input Space) or a standardised normal distribution of the variable values (the Standardised Space).

The frequency distribution of the specified variable and clusters can be displayed as a histogram, line
chart or pie chart. In all cases, the charts display the frequency of values as the percentage of the total
number of observations for the variable.

The chart can be edited and saved. Click Edit chart  to open a Chart Editor from where the chart can
be saved to the clipboard.

Scoring Code
Displays the K-means model code. The code is available as SAS language code to be used in a SAS
block.
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K-Means Clustering block basic example

This example demonstrates how the K-Means Clustering block can be used to cluster observations in a
dataset.

In this example, a dataset containing information about books, named lib_books.csv, is imported
into a blank Workflow. The K-Means Clustering block uses this dataset to cluster observations together
based on Euclidean distances of the numeric variables.

Workflow Layout

Datasets used

The file used in this example can be found in the samples distributed with Altair SLC.

This example uses a dataset of books, named lib_books.csv. Each observation in the dataset
describes a book, with variables such as Title, ISBN and Author.

Using the K-Means Clustering block to create a K-means Clustering model

Using the K-Means Clustering block to cluster observations.

1. Import the lib_books.csv dataset into a blank Workflow canvas. Importing a CSV file is described
in Text File Import block  (page 220).

2. Expand the Model Training group in the Workflow palette, then click and drag a K-Means Clustering
block onto the Workflow canvas, beneath the lib_books.csv dataset.

3. Click on the lib_books.csv dataset block's Output port and drag a connection towards the Input
port of the K-Means Clustering block.

Alternatively, you can dock the K-Means Clustering block onto the dataset block directly.
4. Double click on the K-Means Clustering block.

A Configure K-Means Clustering dialog box opens.
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5. From the Configure K-Means Clustering dialog box:

a. From the Unselected Variables box, double click on the variables NumberInStock and Price
to move them to  the Selected Variables box.

b. Click Apply and Close.

The Configure K-Means Clustering dialog box closes. A green execution status is displayed in
the Output port of the K-Means Clustering block and the model results, K-Means Clustering
Model.

You now have a K-Means clustering model that clusters similar observations together.

K-Means Clustering block example: clustering observations as an
input variable for a predictive model

This example demonstrates how the K-Means Clustering block can be used to cluster observations
in a dataset and use the variable that represents cluster assignment as an independent variable to a
predictive model

In this example, a dataset containing information about iris flowers, named IRIS.csv is imported into
a blank Workflow. The K-Means Clustering block uses this dataset to cluster observations together
based on the length and width of the petals.   The model is then applied to the dataset, using a Score
block. A Decision Forest block is then used to generate a model that predicts the species variable
using the generated variable that represents cluster assignment, cluster. The decision forest model
is then applied to the clustered dataset, using a second Score block. This Score block generates an
output dataset, Iris Prediction. This contains the predictions for the species variable with 96%
accuracy.
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Workflow Layout

Datasets used

The dataset used in this example is the publicly available iris flower dataset (Ronald A. Fisher, "The
use of multiple measurements in taxonomic problems." Annals of Eugenics, vol.7 no.2, (1936); pp.
179—188.)

Each observation in the dataset describes an iris flower, named IRIS.csv with variables such as
species, sepal_length and petal_width.

Using the K-Means Clustering block to assign clusters for model input

Using the K-Means Clustering block to cluster observations.

1. Import the IRIS.csv dataset into a blank Workflow canvas. Importing a CSV file is described in Text
File Import block  (page 220).
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2. Expand the Model Training group in the Workflow palette, then click and drag a K-Means Clustering
block onto the Workflow canvas, beneath the IRIS.csv dataset.

3. Click on the IRIS.csv dataset block's Output port and drag a connection towards the Input port of
the K-Means Clustering block.

Alternatively, you can dock the K-Means Clustering block onto the dataset block directly.
4. Double click on the K-Means Clustering block.

A Configure K-Means Clustering dialog box opens.
5. From the Configure K-Means Clustering dialog box:

a. From the Unselected Variables box, double click on the variables petal_length and
petal_width to move them to   the Selected Variables box.

b. Click on the Options tab. Set the Number of clusters to 3.
c. Click Apply and Close.

The Configure K-Means Clustering window closes. A green execution status is displayed in the
Output port of the K-Means Clustering block and the model results, K-Means Clustering Model.

6. From the Scoring grouping in the Workflow palette, click and drag a Score block onto the Workflow
canvas, below the new K-Means Clustering Model block and the IRIS.csv dataset block.

A Score block and empty dataset block are created on the Workflow canvas. Note that the Score
block's configuration status (the right-hand bar of the block) is red and displays a screentip stating
that the block requires a model and a dataset input.

7. Click on the IRIS.csv dataset block's Output port and drag a connection towards the Input port of
the Score block.

8. Click on the K-Means Clustering Model Output port and drag a connection towards the Input port of
the Score block.

The execution status of the Score block turns green and its dataset output is populated with the
original dataset and the scored variables.

9. Click and drag a Decision Forest block onto the Workflow canvas.
10.Click on the Score block Working Dataset Output port and drag a connection towards the Input port

of the Decision Forest block.

Alternatively, you can dock the Decision Forest block onto the dataset block directly.
11.Double-click on the Decision Forest block.

A Configure Decision Forest dialog box opens.
12.From the Configure Decision Forest dialog box Variable selection tab:

a. In the Dependent variable drop down list, select species.
b. In the Dependent variable treatment drop down list, select Nominal.
c. From the Unselected Independent Variables box, double click on the cluster variable, to move

it to  the Selected Independent Variables box.
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13.Click on the Preferences tab and change the following:

a. Number of trees to 20.
b. Classifier combination as Mean Probability.
c. Click Apply and Close.

The Configure Decision Forest dialog box saves and closes. A green execution status is
displayed in the Output port of the Decision Forest block and the model results, Decision
Forest Model.

14.From the Scoring grouping in the Workflow palette, click and drag a Score block onto the Workflow
canvas, below the Decision Forest block.

A Score block and empty dataset block are created on the Workflow canvas. Note that the Score
block's configuration status (the right-hand bar of the block) is red and displays a screentip stating
that the block requires a model and a dataset input.

15.Click on the Score block Working Dataset Output port and drag a connection towards the Input port
of the Score block.

16.Click on the Decision Forest Model Output port and drag a connection towards the Input port of the
Score block.

The execution status of the Score block turns green and its dataset output is populated with the
original dataset and the scored variables.

17.right-click on the Score block's output dataset block, Working Dataset and click Rename. Type
Iris Prediction and click OK.

You now have a predictive model that utilises input from a K-Means clustering model.

Linear Regression block

Enables you to create a linear regression model.

This block can be invoked by dragging the block from the Workflow palette to the Workflow canvas and
then dragging a connection from a dataset to the Input port of the block. Linear regression attempts
to model the linear relationship between multiple independent (regressor) variables and a dependent
(response) variable. When you have found the linear relationship, you can use this to estimate the value
of other response variables.

The Linear Regression block generates a report, diagnostic information, and scoring code. The report
contains details of the variance in the dataset and parameter estimates. The diagnostic charts can be
used to identify outlier points in the dataset. The generated scoring code can be copied into a SAS
language program for testing or production use.

The model details are specified in the Variables included in the working dataset, using the Configure
Linear Regression dialog box. To open the Configure Linear Regression dialog box, double-click the
Linear Regression block.
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Configure Linear Regression

Enables you to specify the variables used to create the linear regression model and also the parameters
that define the relationship between the dependent and linear regressors in the model.

Variable Selection
Enables you to specify the variables used to create the linear regression model. Only numeric variables
can be specified.

Dependent Variable
Specifies the dependent variable.

Unselected Regressors and Selected Regressors
Allows you to specify regressors for the linear regression model. The two boxes show Unselected
Regressors and Selected Regressors. To move an item from one list to the other, double-click
on it. Alternatively, click on the item to select it and use the appropriate single arrow button. A
selection can also be a contiguous list chosen using Shift and click, or a non-contiguous list using
Ctrl and click. Use the Select all button ( ) or Deselect all button ( ) to move all the items

from one list to the other. Use the Apply variable lists button ( ) to move a set of variables

from one list to another. Use the filter box ( ) on either list to limit the variables displayed,
either using a text filter, or a regular expression. This choice can be set in the Altair page in
the Preferences window. As you enter text or an expression in the box, only those variables
containing the text or expression are displayed in the list.

Frequency Variable
Specifies a variable that defines the relative frequency of each observation.

Weight Variable
Specifies a variable that defines the prior weight associated with each observation.

Effect Selection
Enables you to specify parameters for the linear regression model.

Effect Selection panel
Enables you to specify parameters for the linear regression model.

Method

Specifies the method used to build the linear regression. The method can be:

Forward
Specifies the use of forward model selection.
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The model will initially contain the intercept (if specified in the Properties panel) and the
selected regressor (independent) variables added one at a time at each iteration of the
model. The most significant variable (the effect variable with the smallest probability value
and below the Entry Significance Level) is added at each iteration, and iterations continue
until no specified effect variable is below the Entry Significance Level.

Backward
Specifies the use of backward model selection.

All selected regressor (independent) variables are included in the model, the variables are
tested for significance, and the least significant dropped at each iteration of the model. The
model is recalculated and the least-significant variable is dropped again.

A variable will not be dropped, however, if it is below the value specified for this method in
Exit Significance Level. When all variables are below this level, the model stops.

Stepwise
Specifies that the model uses a combination of forward model and backward model
selection.

The model initially contains an intercept, if specified, and one or more forward steps are
taken to add regressors to the model. Backward and forward steps are used to remove or
add regressors from or to the model until no further improvement can be made.

Maxr
At each iteration of the model selection process, this option chooses the variable that gives
the largest increase in the R2 statistic (coefficient of determination).

Minr
At each iteration of the model selection process, this option chooses the variable that gives
the smallest increase in the R2 statistic (coefficient of determination).

Rsquare
Specifies that the linear regression should be defined using the coefficient of determination
(R2). This finds a combination of regressors for the model which has highest R2.

Adjrsq
Specifies that the linear regression should be defined using the adjusted coefficient of
determination (adjusted R2). This finds a combination of regressors for the model which has
highest Adjusted R2.

CP
Specifies that the linear regression should be defined using Mallows' Cp.

Frequency Variable
Specifies a variable that defines the relative frequency of each observation.

Weight Variable
Specifies a variable that defines the prior weight associated with each observation.
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Start
Specifies the number of regressor (independent) variables to be included in the initial model for
forward and stepwise model selection.

Stop
Specifies the maximum number of regressor (independent) variables the model can contain.

Entry Significance Level
Specifies the value below which a variable is included in the Forward or Stepwise methods.

Exit Significance Level
Specifies the value above which a variable is removed in the Backward or Stepwise methods.

Properties panel
Enables you to specify properties for the linear regression model.

Singular Value
Specifies the tolerance value used to test for linear dependency among the effect (independent)
variables.

Intercept
Specifies that an intercept should be used.

Linear Regression Report view

Displays a summary and graphical information to help evaluate the linear regression model, along with
SAS language scoring code.

The Linear Regression Report view is accessed by double-clicking on the Linear Regression Model
that is output by the Linear Regression block. The report view displays information across two tabs and
code in another.

Linear Regression Report tab
Displays a summary of the linear regression applied to the input dataset.

The Model Information section shows the Selection Method and Dependent Variable chosen in the
Linear Regression block configuration, as well as the number of observations read and used by the
model.

The Summary Statistics section gives statistics summarising the model used, including: Root MSE
(Means Squared Error), Dependent mean, R² (coefficient of determination), Adjusted R2 (adjusted for the
number of predictors in the model), and Coeff var (the coefficient of variation).
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Note:
The R² statistic is calculated differently depending on whether the linear regression model has an
intercept or not, for more information, see the  R² statistic  (page 503).

Diagnostics Panel tab
Displays plots of statistics relating to the regression model. Plots displayed are:

• Predicted against residual
• Predicted against R-Student
• Leverage against R-Student
• Quantile-quantile
• Prediction against actual value
• Observation against Cook's Distance
• Residual histogram

Click on a plot to view it enlarged in the right hand pane.

Scoring code tab
Displays the linear regression model code. SAS language code can be used in the DATA step.

Linear Regression block basic example

This example demonstrates how the Linear Regression block can be used for a basic linear regression
analysis.

In this example, a dataset named bananas.csv is imported into a blank Workflow. The dataset
describes a crop of bananas, with each observation representing an individual banana. A Linear
Regression block is configured to produce a linear regression model from this dataset.

Workflow Layout
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Dataset used

The file used in this example can be found in the samples distributed with Altair SLC.

This example uses a dataset named bananas.csv. Each observation in the dataset describes a
banana, with numeric variables Length(cm) and Mass(g) giving each banana's measured length in
centimetres and mass in grams respectively.

Using the Linear Regression block to create a linear regression model

Using the Linear Regression block to carry out a basic linear regression analysis.

1. Import the bananas.csv dataset into a blank Workflow. Importing a CSV file is described in Text File
Import block  (page 220).

2. Expand the Model Training group in the Workflow palette, then click and drag a Linear Regression
block onto the Workflow canvas, beneath the bananas.csv dataset.

3. Click on the bananas.csv dataset block's Output port and drag a connection towards the Input port
of the Linear Regression block.

Alternatively, you can dock the Linear Regression block onto the dataset block directly.
4. Double-click on the Linear Regression block.

A Configure Linear Regression dialog box opens.
5. From the Variable Selection tab:

a. From the Dependent Variable drop-down list, select Mass(g).
b. From the Unselected Regressors list, double click Length(cm) to move it to the Selected

Regressors list.
6. Click Apply and Close.

The Configure Linear Regression dialog box closes. A green execution status is displayed in the
Output port of the Linear Regression block and the Output port of the Linear Regression Model.

7. Double-click the Linear Regression Model to view the results.

Linear Regression block example: using multiple regressors

This example demonstrates how the Linear Regression block can be used for a linear regression
analysis that includes multiple regressor variables.

In this example, a dataset named Bananas-Multiple.csv is imported into a blank Workflow. The
dataset describes crops of bananas from different regions of the world. The Linear Regression block is
configured to produce a linear regression model from this dataset.
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Workflow Layout

Dataset used

The file used in this example can be found in the samples distributed with Altair SLC.

This example uses a dataset named Bananas-Multiple.csv. The dataset contains the length
and mass of bananas. The numeric variable Length(cm) gives the length in centimetres, with the
corresponding masses in grams for that length from different regions given by the numeric variables
Mass(g)-In, Mass(g)-Ch, Mass(g)-Ph, Mass(g)-Col and Mass(g)-Ec.

Using the Linear Regression block to create a linear regression model with multiple regressors

Using the Linear Regression block to carry out a linear regression analysis with multiple regressor
variables.

1. Import the Bananas-Multiple.csv dataset into a blank Workflow. Importing a CSV file is
described in Text File Import block  (page 220).

2. Expand the Model Training group in the Workflow palette, then click and drag a Linear Regression
block onto the Workflow canvas, beneath the Bananas dataset.

3. Click on the Bananas dataset block's Output port and drag a connection towards the Input port of
the Linear Regression block.

Alternatively, you can dock the Linear Regression block onto the dataset block directly.
4. Double-click on the Linear Regression block.

A Configure Linear Regression dialog box opens.
5. From the Variable Selection tab:

a. From the Dependent Variable drop-down list, select Length(cm).
b. From the Unselected Regressors list, click Select all ( ) to move every mass variable to the

Selected Regressors list.
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6. From the Model Selection tab:

a. From the Method drop-down list, select Forward.
b. In Entry Significance Level enter 0.7.

7. Click Apply and Close.

The Configure Linear Regression dialog box closes. A green execution status is displayed in the
Output port of the Linear Regression block and the Output port of the Linear Regression Model.

8. Double-click the Logistic Regression Model to view the results.

Logistic Regression block

Fits a logistic model between a set of effect variables and a binary dependent variable.

This block can be invoked by dragging the block from the Workflow palette to the Workflow canvas and
then dragging a connection from a dataset to the Input port of the block. The Logistic Regression block
generates a report and deployment code. The report contains details of the Model fit statistics, Maximum
likelihood estimate analysis, odds ratio estimates, and predicted probability and observed responses.
The generated deployment code is a DATA step that can be copied into a SAS language program for
testing or production use.

The model details are specified in the Variables included in the working dataset are specified using the
Configure Logistic Regression dialog box. To open the Configure Logistic Regression dialog box,
double-click the Logistic Regression block.

Configure Logistic Regression

Enables you to specify the variables used to create the logistic regression model and also the
parameters that define the relationship between the effect variables and binary dependent variable.

Variable Selection
Enables you to specify the variables used to create the logistic regression model.

Dependent variable
Specifies the binary dependent variable for the calculation.

Target category
Specifies the target category for which the probability of occurrence is to be calculated.

Effect Variables
Allows you to specify effect variables. The two boxes show Unselected Effect Variables
and Selected Effect Variables. To move an item from one list to the other, double-click on it.
Alternatively, click on the item to select it and use the appropriate single arrow button. A selection
can also be a contiguous list chosen using Shift and click, or a non-contiguous list using Ctrl and
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click. Use the Select all button ( ) or Deselect all button ( ) to move all the items from one

list to the other. Use the Apply variable lists button ( ) to move a set of variables from one

list to another. Use the filter box ( ) on either list to limit the variables displayed, either using a
text filter, or a regular expression. This choice can be set in the Altair page in the Preferences
window. As you enter text or an expression in the box, only those variables containing the text or

expression are displayed in the list. In the Selected Effect Variables box, use the Move up( )

or Move down ( ) buttons to change the order of the variables entered in the model.

Frequency Variable
Specifies a variable that defines the frequency of each observation.

Weight Variable
Specifies a variable that defines the prior weight associated with each observation.

Model Selection
Enables you to specify parameters for the logistic regression model.

Method
Specifies the model effect variable selection method. Choose from:

• None: Specifies that the fitted model includes every selected effect (independent) variable.
• Forward: Specifies the use of forward model selection.

The model initially contains intercept, if specified, and the selected effect (independent)
variables added one at a time at each iteration of the model. The most significant variable (the
effect variable with the smallest probability value and below the Entry Significance Level) is
added at each iteration, and iterations continue until no specified effect variable is below the
Entry Significance Level.

• Backward: Specifies the use of backward model selection.

All selected effect (independent) variables are included in the model, the variables are tested
for significance, and the least significant dropped at each iteration of the model. The model is
recalculated and the least-significant variable is dropped again. A variable will not be dropped,
however, if it is below the value specified for this method in Stay Significance Level. When all
variables are below this level, the model stops.

• Stepwise: Specifies that the model uses a combination of forward model and backward model
selection.

The model initially contains an intercept, if specified, and one or more forward steps are taken
to add effect variables to the model. Backward and forward steps are used to remove effect
variables from and add effect variables to the model until no further improvement can be made
to the model.
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• Score: Specifies that the model returned has the best likelihood score statistic.

The model is created using a branch-and-bound method. Initially a model is created using
the specified effect (independent) variable with the best individual likelihood score statistic.
A second model is created using the two specified effect variables with the best combined
likelihood score statistic. The model with the best likelihood score statistic is considered the
best current solution and becomes the bound for the next iteration.

At each subsequent iteration, an effect variable is added to the model where the combination
of all effect variables has the best likelihood score statistic. The model is compared to the
best current solution and if the new model likelihood score statistic is better than the current
solution, the new model becomes the bound for the next iteration.

When the best likelihood score statistic cannot be improved, the model is returned.

Fast
Available if Method Is selected as Backward. Implements a quicker approximation for the model.

Link Function
Specifies how effect (independent) variables are linked to the dependent variable. Choose from:

• CLOGLOG. Specifies the cloglog (complementary log-log) function is used:

Where p is the probability of the Event occurring.

• LOGIT. Specifies the logit function (the inverse of the logistic function) is used:

Where p is the probability of the Event occurring.

• PROBIT. Specifies the probit function is used:

Where    is the inverse cumulate distribution function of the standard normal distribution
where the mean = 0 and variance = 1.

Entry Significance Level
Specifies the value below which a variable is included in the Forward or Stepwise methods.

Stay Significance Level
Specifies the value above which a variable is removed in the Backward or Stepwise methods.

Properties
Singular Tolerance

Specifies the tolerance value used to test for linear dependency among the effect (independent)
variables.
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Intercept
If selected, includes an intercept in the model. If cleared, the model will not include an intercept.

Logistic Model Report view

Displays summary and graphical information to help evaluate the Logistic Regression model.

The Logistic Model Report view is accessed by double-clicking on the Logistic Regression Model that
is output by the Logistic Regression block. The report view displays information in one tab and code in
another.

Logistic Regression Results tab
Displays a summary of the logistic regression applied to the input dataset.

The Model Information section confirms the dataset and response variable used along with the number
of response levels. Also shown are the model and optimisation technique used and finally the number of
observations read and used.

The Model Fit Statistics section shows the output of three tests of model fit for relative comparisons:
AIC (Akaike Information Criterion), SC (Schwarz Criterion) and -2 Log L.

The Testing Global Null Hypothesis: BETA=0 section shows the output of three tests: Likelihood ratio,
score and Wald.

The Analysis of Maximum Likelihood Estimates section shows an Analysis of Maximum Likelihood
Estimates for each observation in the dataset.

The Odds Ratio Estimates section shows Odds Ratio Estimates for each observation in the dataset.

The Association of Predicted Probabilities and Observed Responses section shows a comparison of
observations in the dataset and the predicted values from the logistic regression, showing information on
the concordant, discordant and tied pairs.

Scoring code tab
Displays the logistic regression model code. SAS language code can be used in the DATA step..

Logistic Regression block basic example

This example demonstrates how the Logistic Regression block can be used for a basic logistic
regression analysis.

In this example, a dataset of exam results named exam_results.csv is imported into a blank
Workflow. The dataset contains details of the hours students spent studying for an exam and whether
they passed or failed the exam. The Logistic Regression block is configured to produce a logistic
regression model from this dataset.
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Workflow Layout

Dataset used

The file used in this example can be found in the samples distributed with Altair SLC.

This example uses a dataset of exam results, named exam_results.csv. Each observation in the
dataset describes a student, with a numeric variable HoursStudy giving their hours of study for an exam,
and a binary variable Pass? indicating whether they passed the exam or not.

Using the Logistic Regression block to create a logistic regression model

Using the Logistic Regression block to carry out a simple logistic regression analysis.

1. Import the exam_results.csv dataset into a blank Workflow. Importing a CSV file is described in
Text File Import block  (page 220).

2. Expand the Model Training group in the Workflow palette, then click and drag a Logistic
Regression block onto the Workflow canvas, beneath the exam_results.csv dataset.

3. Click on the exam_results.csv dataset block's Output port and drag a connection towards the
Input port of the Logistic Regression block.

Alternatively, you can dock the Logistic Regression block onto the dataset block directly.
4. Double-click on the Logistic Regression block.

A Configure Logistic Regression dialog box opens.
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5. From the Variable Selection tab:

a. From the Dependent Variable drop-down list, select Pass?.
b. From the Target category drop-down list, select 1.
c. From the Unselected Effect Variables list, double-click HoursStudy.

HoursStudy is moved to the Selected Effect Variables list.
d. Click Apply and Close.

The Configure Logistic Regression window closes. A green execution status is displayed in the
Output ports of the Logistic Regression block and of its output Logistic Regression Model.

6. Double-click the Logistic Regression Model to view the results.

You now have a logistic regression model that predicts the likelihood of a student passing an exam
based on their hours of study.

Logistic Regression block example: a more complex logistic
regression and application of the model to a new dataset

This example demonstrates how the Logistic Regression block can be used for a logistic regression
analysis of loan data with multiple effect variables. The model generated is then applied to another
dataset of loan applications, and the results filtered into loan rejections and loan acceptances.

In this example, a dataset of completed loans named loan_data.csv is imported into a blank
Workflow. The dataset contains details of past loan applications and whether or not each loan defaulted.
A Logistic Regression block is used to build a logistic regression model, looking at a selection of effect
variables and how they relate to whether or not each loan defaulted.

The Logistic Regression block is configured to output its model and, using a Score block, this model is
applied against a dataset of new loan applications called loan_applications.csv. The Score block
then outputs the loan_applications.csv dataset appended with the probability of defaulting for
each loan application, which is then filtered, using the probabilities, into two datasets of loan rejections
and loan acceptances.
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Workflow Layout

Datasets used

The file used in this example can be found in the samples distributed with Altair SLC.

The datasets used in this example are:

• A dataset about loans, named loandata.csv. Each observation in the dataset describes a past
loan and the person who took loan out, with variables such as Income, Loan_Period and Other_Debt.

• A dataset about loan applications, named loanapplications.csv. Each observation in the
dataset describes an application for a loan and the person taking the loan out. It contains the same
variables as loandata.csv except for the lack of a Default variable.

Applying a Logistic Regression block model output another dataset

Using the Logistic Regression block to carry out a logistic regression analysis and then applying the
trained model to another dataset.

1. Import the loan_data.csv and loan_applications.csv datasets into a blank Workflow.
Importing a CSV file is described in Text File Import block  (page 220).

2. Expand the Model Training group in the Workflow palette, then click and drag a Logistic
Regression block onto the Workflow canvas, beneath the LOAN_DATA dataset.
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3. Click on the loan_data.csv dataset block's Output port and drag a connection towards the Input
port of the Logistic Regression block.

Alternatively, you can dock the Logistic Regression block onto the dataset block directly.
4. Double-click on the Logistic Regression block.

A Configure Logistic Regression dialog box opens.
5. From the Variable Selection tab:

a. From the Dependent Variable drop-down list, select Default.
b. From the Target category drop-down list, select 1.
c. From the Unselected Effect Variables list, double-click Employment_Type, Income,

Other_Debt, Housing_Situation, and Has_CCJ.

All chosen variables are moved to the Selected Effect Variables list.
6. From the Model Selection tab:

a. From Method, select Forward.
b. From Link function, select LOGIT.
c. In Entry Significance Level, type 0.07.

7. Click Apply and Close.

The Configure Logistic Regression dialog box closes. A green execution status is displayed in the
Output port of the Logistic Regression block.

8. Right-click on the Logistic Regression block and select Configure Outputs....

An Outputs window is displayed.
9. From the Outputs window, click the Select all icon:  and then click Apply and Close.

10.From the Scoring grouping in the Workflow palette, click and drag a Score block onto the Workflow
canvas, below the new Logistic Regression Model block and the loan_applications dataset
block.

A Score block and empty dataset block are created on the Workflow canvas. Note that the Score
block's configuration status (the right-hand bar of the block) is red and displays a screentip stating
that the block requires a model and a dataset input.

11.Click on the loan_applications dataset block's Output port and drag a connection towards the
Input port of the Score block.

12.Click on the Logistic Regression Model Output port and drag a connection towards the Input port
of the Score block.

The execution status of the Score block turns green and its dataset output is populated with the
original dataset and the scored variables.

13.From the Data Preparation grouping in the Workflow palette, click and drag two Filter blocks onto the
Workflow canvas.
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14.Click on the Score block Output port and drag a connection towards the Input port of each Filter
block.

15.Configure the first Filter block:

a. Double-click on a Filter block.

A Filter Editor view opens.
b. Click on the Basic tab.
c. From the Variable drop-down box, select P_1.
d. From the Operator drop-down box, select <.
e. In the Value box, enter 0.5.
f. Press Ctrl+S to save the configuration.
g. Click the cross to close the Filter Editor view.

The Filter configuration window closes. A green execution status is displayed in the Output port of
the Filter block and the filtered dataset, Working Dataset.

h. Right-click on the Filter block's output dataset block and click Rename. Type loan_rejections
and click OK.

16.Now configure the second Filter block:

a. Double-click on the other Filter block.

A Filter configuration window opens.
b. Click on the Basic tab.
c. For the Variable drop-down box, select P_1.
d. For the Operator drop-down box, select >=.
e. In the Value box, enter 0.5.
f. Press Ctrl+S to save the configuration.
g. Click the cross to close the Filter Editor view.

The Filter configuration window closes. A green execution status is displayed in the Output port
of the Filter block and the filtered dataset, Working Dataset.

h. Right-click on the Filter block's output dataset block and click Rename. Type
loan_acceptances and click OK.

You now have a logistic regression model that predicts if a loan applicant will default and an application
of that model to another dataset, with results filtered into acceptances and rejections.
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MLP block

Enables you to build a Multi-Layer Perceptron (MLP) neural network from an input dataset and use the
trained network to analyse other datasets.

This block can be invoked by dragging the block from the Workflow palette to the Workflow canvas
and then dragging a connection from a dataset to the Input port of the block. MLP neural networks
are created and edited using the Multilayer Perceptron view and MLP Preferences dialog box.
Double-clicking a MLP block will open the Multilayer Perceptron view; if the block is new with no basic
information configured, the MLP Preferences dialog box will also open. Once basic information to build
an MLP neural network has been configured, double-clicking the MLP block will just open the Multilayer
Perceptron view. To open the MLP Preferences dialog box manually, click the preferences icon ( ) at
the top right of the Multilayer Perceptron view.

Multilayer perceptron neural networks are a class of non-linear machine learning algorithms that can be
used for classification and regression.

Networks are usually conceptualised as layers of non-linear functions analogous to layers of neurons in
biological neural networks connected by layers of weights analogous to synapses.

Training algorithms are used to find the weights that enable an MLP to approximate relationships
between the effect variables and a response variable, making it possible to create a network that can
predict unknown responses from known effects.

For more information about MLP neural networks, see MLP procedure in the Altair SLC Machine
Learning section in Altair SLC Reference for Language Elements.

Multilayer perceptron preferences

Enables you to specify the preferences used to create a trained network.

Dataset Roles
Defines how the input datasets are used in the trained network.

Train
Specifies the dataset used to train the network.

Validate
Specifies a validation dataset. If specified, the result of training is the network that achieved the
minimum error against this dataset.

Test
Specifies a dataset used to test the network at the end of training.
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Variable Selection
Enables you to specify the dependent (target) variable and independent (input) variables in the input
dataset to use the trained network.

Dependent variable
Specifies the dependent (target) variable for the trained network.

Independent variables
Allows you to specify effect (independent) variables. The two boxes show Unselected
Independent Variables and Selected Independent Variables. To move an item from one list to
the other, double-click on it. Alternatively, click on the item to select it and use the appropriate
single arrow button. A selection can also be a contiguous list chosen using Shift and click, or a
non-contiguous list using Ctrl and click. Use the Select all button ( ) or Deselect all button

( ) to move all the items from one list to the other. Use the Apply variable lists button ( )

to move a set of variables from one list to another. Use the filter box ( ) on either list to limit the
variables displayed, either using a text filter, or a regular expression. This choice can be set in the
Altair page in the Preferences window. As you enter text or an expression in the box, only those
variables containing the text or expression are displayed in the list.

Optimiser
Specifies the optimisation algorithm to be used to train the network.

The optimiser algorithm runs using minibatches from the training dataset. A minibatch is a subset of
observations, where all subsets are used in one iteration (epoch) when training the network.

The following optimisation algorithms are available:

• ADADELTA  (page 406)
• ADAM  (page 407)
• NADAM  (page 408)
• RMSPROP  (page 409)
• SGD  (page 410)
• SMORMS3  (page 411)

The following optimisers run using the whole training dataset in each iteration (epoch) when training the
network:

• RPROP  (page 409)

ADADELTA
Specifies an adaptive step size minibatch learning algorithm that reduces sensitivity to the choice
of learning rate.

Epsilon
Specifies a value for the epsilon parameter.
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Smoothing factor
Specifies a value for the smoothing factor of the network.

Minibatch type
Specifies how observations are selected for minibatches.

DYNAMIC
Specifies that observations are selected randomly without replacement.

STATIC
Specifies that observations are selected in the order they appear in the training
dataset.

BOOTSTRAP
Specifies that observations are selected randomly with replacement.

Minibatch size
Specifies the number of observations in each minibatch.

Learning rates
Specifies a learning rate schedule as a series of minibatch number-learning rate pairs. To
define learning rates, enter a Minibatch number and the required Learning rate for that
minibatch and click Add. Only one learning rate can be specified per minibatch number. If
you specify a single learning rate, that learning rate is used for all iterations.

To change a learning rate, select the row in the Learning rates box, change the rate and
click Update.

To remove a specified minibatch number-learning rate pair, select the required row in the
Learning rates box and click Delete.

ADAM
An algorithm that attempts to maximize speed of convergence by using estimates of lower-order
moments.

Epsilon
Specifies a value for the epsilon parameter.

Beta1
Specifies a value for the beta1 parameter.

Beta2
Specifies a value for the beta2 parameter.

Minibatch type
Specifies how observations are selected for minibatches.

DYNAMIC
Specifies that observations are selected randomly without replacement.
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STATIC
Specifies that observations are selected in the order they appear in the training
dataset.

BOOTSTRAP
Specifies that observations are selected randomly with replacement.

Minibatch size
Specifies the number of observations in each minibatch.

Learning rates
Specifies a learning rate schedule as a series of minibatch number-learning rate pairs. To
define learning rates, enter a Minibatch number and the required Learning rate for that
minibatch and click Add. Only one learning rate can be specified per minibatch number. If
you specify a single learning rate, that learning rate is used for all iterations.

To change a learning rate, select the row in the Learning rates box, change the rate and
click Update.

To remove a specified minibatch number-learning rate pair, select the required row in the
Learning rates box and click Delete.

NADAM
A version of the ADAM optimiser method that incorporates Nesterov momentum.

Epsilon
Specifies a value for the epsilon parameter.

Beta1
Specifies a value for the beta1 parameter.

Beta2
Specifies a value for the beta2 parameter.

Minibatch type
Specifies how observations are selected for minibatches.

DYNAMIC
Specifies that observations are selected randomly without replacement.

STATIC
Specifies that observations are selected in the order they appear in the training
dataset.

BOOTSTRAP
Specifies that observations are selected randomly with replacement.

Minibatch size
Specifies the number of observations in each minibatch.
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Learning rates
Specifies a learning rate schedule as a series of minibatch number-learning rate pairs. To
define learning rates, enter a Minibatch number and the required Learning rate for that
minibatch and click Add. Only one learning rate can be specified per minibatch number. If
you specify a single learning rate, that learning rate is used for all iterations.

To change a learning rate, select the row in the Learning rates box, change the rate and
click Update.

To remove a specified minibatch number-learning rate pair, select the required row in the
Learning rates box and click Delete.

RMSPROP
An adaptive step size minibatch learning algorithm.

Epsilon
Specifies a value for the epsilon parameter.

Smoothing factor
Specifies a value for the smoothing factor.

Minibatch type
Specifies how observations are selected for minibatches.

DYNAMIC
Specifies that observations are selected randomly without replacement.

STATIC
Specifies that observations are selected in the order they appear in the training
dataset.

BOOTSTRAP
Specifies that observations are selected randomly with replacement.

Minibatch size
Specifies the number of observations in each minibatch.

Learning rates
Specifies a learning rate schedule as a series of minibatch number-learning rate pairs. To
define learning rates, enter a Minibatch number and the required Learning rate for that
minibatch and click Add. Only one learning rate can be specified per minibatch number. If
you specify a single learning rate, that learning rate is used for all iterations.

To change a learning rate, select the row in the Learning rates box, change the rate and
click Update.

To remove a specified minibatch number-learning rate pair, select the required row in the
Learning rates box and click Delete.

RPROP
An adaptive step size full batch learning algorithm.
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Initial delta
Specifies the initial step size.

Min delta
Specifies the minimum step size.

Max delta
Specifies the maximum step size.

Step size increment (ETA+)
Specifies the factor by which the step size is increased.

Step size decrement (ETA-)
Specifies the factor by which the step size is reduced.

SGD
A fixed step size minibatch learning algorithm that supports Classical and Nesterov momentum.

Momentum
Specifies the type of momentum, either NESTEROV or CLASSICAL.

Value
Specifies the value of the selected momentum.

Minibatch type
Specifies how observations are selected for minibatches.

DYNAMIC
Specifies that observations are selected randomly without replacement.

STATIC
Specifies that observations are selected in the order they appear in the training
dataset.

BOOTSTRAP
Specifies that observations are selected randomly with replacement.

Minibatch size
Specifies the number of observations in each minibatch.

Learning rates
Specifies a learning rate schedule as a series of minibatch number-learning rate pairs. To
define learning rates, enter a Minibatch number and the required Learning rate for that
minibatch and click Add. Only one learning rate can be specified per minibatch number. If
you specify a single learning rate, that learning rate is used for all iterations.

To change a learning rate, select the row in the Learning rates box, change the rate and
click Update.

To remove a specified minibatch number-learning rate pair, select the required row in the
Learning rates box and click Delete.
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SMORMS3
An adaptive step size minibatch learning algorithm that automatically adjusts the amount of
smoothing to improve the trade-off between rate of convergence and stability.

Epsilon
Specifies a value for the epsilon parameter.

Minibatch type
Specifies how observations are selected for minibatches.

DYNAMIC
Specifies that observations are selected randomly without replacement.

STATIC
Specifies that observations are selected in the order they appear in the training
dataset.

BOOTSTRAP
Specifies that observations are selected randomly with replacement.

Minibatch size
Specifies the number of observations in each minibatch.

Learning rates
Specifies a learning rate schedule as a series of minibatch number-learning rate pairs. To
define learning rates, enter a Minibatch number and the required Learning rate for that
minibatch and click Add. Only one learning rate can be specified per minibatch number. If
you specify a single learning rate, that learning rate is used for all iterations.

To change a learning rate, select the row in the Learning rates box, change the rate and
click Update.

To remove a specified minibatch number-learning rate pair, select the required row in the
Learning rates box and click Delete.

Regularisers
Multiple regularisers can be specified, so that more than one type of regularisation can be applied
simultaneously. To add a regulariser, click Add Regulariser and fill in the required details for the
regulariser type.

Regulariser
Specifies the type of regularisation to be used during training.

LNNORM
Specifies that a norm-based regulariser be applied to all non-bias weights.

DROPOUT
Specifies that dropout regularisation should be used on all hidden layers and that neurons
will be dropped out during training with the specified probability.
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Probability
Specifies the probability of neurons being dropped out during training using the DROPOUT
regulariser.

Strength
Specifies the strength of the LNNORM regulariser.

Power
Specifies the power of the LNNORM regulariser.

Stopping Criteria
Defines when model training stops.

Max training time (s)
Specifies a target maximum training time in seconds.

Number of epochs
Specifies that training should terminate if the likelihood cannot be computed for the specified
number of successive epochs.

Max unimproved validation assessment
Specifies the maximum number of validation assessments to that can be run without termination
where the validation error does not improve.

Validation interval
Specifies the interval between validation set assessments, either in Epochs or Minibatches. The
units available are determined by the specified optimiser.

Options
Weight initialisation seed (0=random)

Sets a seed that is used for weight initialisations within the model.

Multilayer Perceptron view

Enables you to create a Multilayer Perceptron (MLP), export the resulting trained network code and view
the tabular output of the trained network.

The Multilayer Perceptron view is used to create a trained network based on the settings specified
in the MLP Preferences dialog box. The Multilayer Perceptron tab enables you to create a trained
network and view the progress as the network is trained. The Scoring Code tab enables you to export
the trained network SAS language  code. The Report tab displays tabular output information from the
MLP block.
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Multilayer Perceptron Tab

Enables you define the layers of the trained network. The Layers panel contains the detail of the trained
network, and the Error panel displays the current status of the network as it is created.

To create a trained network, click Train.

Configure Multilayer Perceptron

Layers
Displays the layers in the trained network. Every network requires an Input, an Output and at least
one Hidden layer. To add a new hidden layer to the trained network, click Add Layer and complete
the information for the new row in the list. To remove a Hidden layer, click Delete Layer.
You can specify the Number of Neurons for each hidden later and the Activation Function
to specify how the activity    of a neuron is calculated from its post-synaptic potential   . The
available Activation functions are:

ARCTAN

ELLIOTT

LEAKYRECTIFIEDLINEAR

LINEAR

LOGISTIC

RECTIFIEDLINEAR

SOFTMAX

where    is the number of network outputs.

SOFTPLUS

SOFTSIGN

TANH

Error
Displays the performance of the MLP block as it runs and automatically updates the history of any
training error and validation error at each iteration.
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Scoring Code tab

Displays the trained network code. The code is available as SAS language code to be used in the DATA
step.

Report tab

Displays the tabular output of the trained network.

Configuration
The configuration table records the specified configuration used during this execution of the MLP
block.

Input Encoding
Shows the mapping between the independent variables and the input neuron in the MLP. Numeric
variables are mapped to a single input node. Categorical variables are mapped to multiple
neurons, and the range is displayed in this table.

Input Lengths
Shows the weights of each input neuron.

Input Mapping
Shows the mapping between independent variables and input neuron for each neuron in the
input layer of the MLP. Numerical variables have a single row in the table showing the neuron to
which the variable is mapped. Categorical variables have multiple rows in the table showing which
neuron each category is mapped to.

Input Scaling
Shows the original range in values of numerical values before being scaled to a consistent range,
typically -1 to 1.

Network Architecture
The network architecture table summarises the MLP generated during the execution of the MLP
block.

Results
The results table displays the results of training.

Stopping reasons
The stopping reason table lists all the reasons why training stopped.

Training History
The training history table shows how training, validation and regularisation errors have changed
during training.
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MLP block basic example

This example demonstrates how the MLP block can be used to model a binary variable.

In this example, a dataset containing information about basketball shots, named
basketball_shots.csv is imported into a blank Workflow. The dataset contains observations of each
basketball shot and whether it scored through the Scored variable. The MLP block uses this dataset to
estimate the likelihood for each basketball shot to score.

Workflow Layout

Datasets used

The file used in this example can be found in the samples distributed with Altair SLC.

This example uses a dataset about basketball shots, named basketball_shots.csv. Each
observation in the dataset describes an attempt to score and the person shooting, with variables such as
height, weight and distance_feet.

Using the MLP block to create an MLP model

Using the MLP block to model shooting accuracy in basketball

1. Import the basketball_shots.csv dataset onto a blank Workflow canvas. Importing a CSV file is
described in Text File Import block  (page 220).

2. Expand the Model Training group in the Workflow palette, then click and drag a MLP block onto the
Workflow canvas, beneath the basketball_shots.csv dataset.

3. Click on the basketball_shots.csv dataset block's Output port and drag a connection towards
the Input port of the MLP block.

Alternatively, you can dock the MLP block onto the dataset block directly.
4. Double-click on the MLP block.

A Multilayer Perceptron view opens, along with the MLP Preferences dialog box.
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5. From the MLP Preferences dialog box:

a. In the Train drop-down list, select Working Dataset.
b. Click on the Variable Selection tab.
c. In the Dependent variable drop-down list, select Score.
d. From the Unselected Independent Variables box, double-click on the variables

distance_feet, angle,  height, weight and position to move them to  the Selected
Independent Variables box.

e. Click on the Optimiser tab, from the Optimiser drop-down list, select ADAM.
f. Click on the Stopping Criteria tab, set the Max training time (s) to 10.
g. Click Apply and Close.

The MLP Preferences dialog box closes.
h. Click on the Train button ( ) to train the MLP model.

A graph appears on the right hand side showing the live training error during model training.
i. Press Ctrl+S to save the configuration.
j. Close the Multilayer Perceptron view.

The Multilayer Perceptron view closes. A green execution status is displayed in the Output port
of the MLP block.

You now have an MLP model that predicts the probability of a basketball shot scoring.

MLP block example: Predicting a multinomial variable

This example demonstrates how the MLP block can be used to incorporate training, testing and
validation data to model a non-binary class variable.

In this example, a dataset containing information about basketball players, named
basketball_players.csv is imported into a blank Workflow. The dataset contains observations
about each basketball player and their position through the position variable. The Partition block
splits the dataset into a training, testing and validation dataset, named Train, Test and Validation
respectively. The MLP block uses these datasets to estimate the position of the basketball player. The
model is then applied to the original dataset, basketball_players.csv, using a Score block. The
Score block generates an output dataset MLP Scored.
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Workflow Layout

Datasets used

The file used in this example can be found in the samples distributed with Altair SLC.

This example uses a dataset about basketball players, named basketball_players.csv. Each
observation in the dataset describes a basketball player, with variables such as height, weight and
firstName.

Using an MLP block to predict a multinomial variable

Using the MLP block to predict the position of a player in basketball.

1. Import the basketball_players.csv dataset onto a blank Workflow canvas. Importing a CSV file
is described in Text File Import block  (page 220).

2. Expand the Data Preparation group in the Workflow palette, then click and drag a Partition block
onto the Workflow canvas, beneath the basketball_players.csv dataset.
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3. Double-click on the Partition block.

A Configure Partition dialog box opens.
4. Click on the Add partition button ( ) do the following:

A third partition named Partition3 is added to the Configure Partition dialog box.
5. Rename your partitions:

a. Click on Partition1 and type Train to rename the partition. Click on its corresponding weight and
type 85.

b. Click on Partition2 and type Validate to rename the partition. Click on its corresponding weight
and type 10.

c. Click on Partition3 and type Test to rename the partition. Click on its corresponding weight and
type 5.

d. Click Apply and Close.

The Configure Partition dialog box saves and closes. A green execution status is displayed in the
Output port of the Partition block and the resulting datatsets, Train, Test and Validate.

6. Expand the Model Training group in the Workflow palette, then click and drag an MLP block onto the
Workflow canvas, beneath the basketball_shots.csv dataset.

7. Click on the Train, Test and Validate dataset block's Output port and drag a connection towards
the Input port of the MLP block for each dataset.

8. Double-click on the MLP block.

A Multilayer Perceptron view opens, along with the MLP Preferences dialog box.
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9. From the MLP Preferences dialog box:

a. In the Train drop-down list, select Train.
b. In the Validate drop-down list, select Validate.
c. In the Test drop-down list, select Test.
d. Click on the Variable Selection tab.
e. In the Dependent variable drop-down list, select position.
f. From the Unselected Independent Variables box, double-click on the variables height, weight

and  goals_scored to move them to the Selected Independent Variables box.
g. Click on the Optimiser tab, from the Optimiser drop-down list, select ADAM.
h. Click on the Stopping Criteria tab, set the Max training time (s) to 15.
i. Click Apply and Close.

The MLP Preferences dialog box closes.
j. Click on the Train button ( ) to train the MLP model.

A graph appears on the right hand side showing the live training error during model training.
k. Press Ctrl+S to save the configuration.
l. Close the Multilayer Perceptron view.

The Multilayer Perceptron view closes. A green execution status is displayed in the Output port
of the MLP block.

10.From the Scoring grouping in the Workflow palette, click and drag a Score block onto the Workflow
canvas, below the MLP block.

A Score block and empty dataset block are created on the Workflow canvas. Note that the Score
block's configuration status (the right-hand bar of the block) is red and displays a screentip stating
that the block requires a model and a dataset input.

11.Click on the basketball_players.csv dataset block's Output port and drag a connection
towards the Input port of the Score block.

12.Click on the MLP block Output port and drag a connection towards the Input port of the Score block.

The execution status of the Score block turns green and its dataset output is populated with the
original dataset and the scored variables.

13.Right-click on the Score block's output dataset block and click Rename. Type MLP Scored and
click OK.

You now have an MLP model that predicts the probability of the position of each player.
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Reject Inference block

Enables you to use a reject inference method to address any inherent selection bias in a model by
including a rejected population.

The Reject Inference block takes two inputs: one from a logistic regression model and another from
a dataset containing rejected records. The Reject Inference block then outputs a logistic regression
model, labelled the Inference Model, that has been trained on both the performance of the accepted
records and the inferred performance of the rejected records.

Note:
The input logistic regression model provides a template configuration for the Inference Model that can
be changed in the Reject Inference block configuration.

Block Outputs
The Reject Inference block can generate one or more of the following outputs:

• Inferred Rejects: A new dataset containing the inferred rejects.
• Inference Report: The report containing a comparison of the rejected dataset and accepted dataset.
• Inference Model: A report containing the results of the output logistic regression model.

To specify the outputs, right-click on the Reject Inference block and select Configure Outputs. Two
boxes are presented: Unselected Output, showing outputs that are not selected, and Selected Output,
showing selected outputs. To move an item from one list to the other, double-click on it. Alternatively,
click on the item to select it and use the appropriate single arrow button. A selection can also be a
contiguous list chosen using Shift and click, or a non-contiguous list using Ctrl and click. Use the Select
all button ( ) or Deselect all button ( ) to move all the items from one list to the other. Use the

Apply variable lists button ( ) to move a set of variables from one list to another. Use the filter box

( ) on either list to limit the variables displayed, either using a text filter, or a regular expression. This
choice can be set in the Altair page in the Preferences window. As you enter text or an expression in
the box, only those variables containing the text or expression are displayed in the list.

Configure Reject Inference

The Configure Reject Inference dialog box enables you to configure the Reject Inference block.

Inference Options
Inference Method

Choose from:

• Proportional Assignment: Assigns a good or bad status to each rejected record at random.
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• Simple Augmentation: Assigns a good or bad status to each rejected record based on a
threshold.

• Fuzzy Augmentation: Scores the rejects using an iteratively trained logistic regression model.

Bad event
The category of the accepted dataset's dependent variable that defines 'bad' (for example, a
boolean determining defaulting on a loan).

Inferred factor
The rate at which rejected records are considered bad compared with accepted records. If not
specified, defaults to 3.

Seed
Used for random assignment operations within the model. If zero is specified, then seeding will be
determined by the system clock during execution.

Iterations
Available if Fuzzy Augmentation is selected. The number of times to iterate the modelling
process; higher numbers give greater accuracy, but take more processing time.

Convergence threshold
Available if Fuzzy Augmentation is selected. Determines the point at which the model is
considered converged, so no more iterations are performed and the modelling process terminates
early (before it reaches the Iterations specified). Convergence is defined by similarity between
coefficients of parameters between successive models.

Model Variables
Dependent Variable

Read-only. Displays the binary dependent variable of the attached Logistic Regression model.

Event
Read-only. Displays the target category for which the probability of occurrence has been
calculated.

Effect Variables
Allows you to specify effect variables. The two boxes show Unselected Effect Variables
and Selected Effect Variables. To move an item from one list to the other, double-click on it.
Alternatively, click on the item to select it and use the appropriate single arrow button. A selection
can also be a contiguous list chosen using Shift and click, or a non-contiguous list using Ctrl and
click. Use the Select all button ( ) or Deselect all button ( ) to move all the items from one

list to the other. Use the Apply variable lists button ( ) to move a set of variables from one

list to another. Use the filter box ( ) on either list to limit the variables displayed, either using a
text filter, or a regular expression. This choice can be set in the Altair page in the Preferences
window. As you enter text or an expression in the box, only those variables containing the text or
expression are displayed in the list.

421



Altair Analytics Workbench user guide
Version 2023

Frequency Variable
Specifies a variable that defines the frequency of each observation.

Weight Variable
Specifies a variable that defines the prior weight associated with each observation.

Model Options
Configures the logistic model generated by the block. The options are the same as those in the Logistic
Regression block.

Method
Specifies the model effect variable selection method. Choose from:

• None: Specifies that the fitted model includes every selected effect (independent) variable.
• Forward: Specifies the use of forward model selection.

The model initially contains intercept, if specified, and the selected effect (independent)
variables added one at a time at each iteration of the model. The most significant variable (the
effect variable with the smallest probability value and below the Entry Significance Level) is
added at each iteration, and iterations continue until no specified effect variable is below the
Entry Significance Level.

• Backward: Specifies the use of backward model selection.

All selected effect (independent) variables are included in the model, the variables are tested
for significance, and the least significant dropped at each iteration of the model. The model is
recalculated and the least-significant variable is dropped again. A variable will not be dropped,
however, if it is below the value specified for this method in Stay Significance Level. When all
variables are below this level, the model stops.

• Stepwise: Specifies that the model uses a combination of forward model and backward model
selection.

The model initially contains an intercept, if specified, and one or more forward steps are taken
to add effect variables to the model. Backward and forward steps are used to remove effect
variables from and add effect variables to the model until no further improvement can be made
to the model.

• Score: Specifies that the model returned has the best likelihood score statistic.

The model is created using a branch-and-bound method. Initially a model is created using
the specified effect (independent) variable with the best individual likelihood score statistic.
A second model is created using the two specified effect variables with the best combined
likelihood score statistic. The model with the best likelihood score statistic is considered the
best current solution and becomes the bound for the next iteration.

At each subsequent iteration, an effect variable is added to the model where the combination
of all effect variables has the best likelihood score statistic. The model is compared to the
best current solution and if the new model likelihood score statistic is better than the current
solution, the new model becomes the bound for the next iteration.

When the best likelihood score statistic cannot be improved, the model is returned.

422



Altair Analytics Workbench user guide
Version 2023

Fast
Available if Method Is selected as Backward. Implements a quicker approximation for the model.

Link Function
Specifies how effect (independent) variables are linked to the dependent variable. Choose from:

• CLOGLOG. Specifies the cloglog (complementary log-log) function is used:

Where p is the probability of the Event occurring.

• LOGIT. Specifies the logit function (the inverse of the logistic function) is used:

Where p is the probability of the Event occurring.

• PROBIT. Specifies the probit function is used:

Where    is the inverse cumulate distribution function of the standard normal distribution
where the mean = 0 and variance = 1.

Entry Significance Level
Specifies the value below which a variable is included in the Forward or Stepwise methods.

Stay Significance Level
Specifies the value above which a variable is removed in the Backward or Stepwise methods.

Singular Tolerance
Specifies the tolerance value used to test for linear dependency among the effect (independent)
variables.

Intercept
If selected, includes an intercept in the model. If cleared, the model will not include an intercept.

Inference Report view

Displays a summary and graphical information to help evaluate the reject inference model.

The Inference Report view is accessed by double-clicking it from the Reject Inference block output.

Summary tab
Displays a summary of the inference applied to the input dataset.
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The Model Information section shows the names of the accepts dataset, rejects datasets and the
dependent variable as well as the good event, bad event and inferred factor chosen in the Reject
Inference block configuration. It will also show the name of the frequency or weight variable if one is
selected.

Summary sections shows the total number of observations and what proportion of the dataset belongs
to the good and bad event. There is a Summary section for the accepts dataset, rejects dataset
and the total of the two.  It will also show the number of event observations if the dependent variable
contains any missing values, event weighted total if a weight variable is selected, and an event weighted
frequency if a frequency variable is selected.

Frequency distribution sections display a chart showing the proportions between the good and bad
events in a dataset. There is a Frequency Distribution section for the accepts dataset, rejects dataset
and the total of the two.  This can be displayed as either a histogram or a pie chart.

Reject Inference block example: building a model with rejected loan
applications

This example demonstrates how the Reject Inference block is used to create a model and analyse
rejected loan applicants that are otherwise unconsidered in traditional models.

In this example, a dataset of completed loans named accepted_loans.csv is imported into a blank
Workflow. The dataset contains details of accepted loan applications and whether or not each loan
defaulted. Another dataset of rejected loan applicants named rejected_loans.csv is also imported. 
A WoE Transform block uses the accepted_loans.csv dataset to transform several independent
variables into several bins, using the optimal binning technique. A Logistic Regression block is used
to build a logistic regression model using the output variables from the WoE Transform block to target
whether or not each loan defaulted.  The Score block is then used to apply the WoE Transform model
to the rejected_loans.csv dataset and is named Scored Rejects. The Reject Inference block
then outputs an inference model using the Scored Rejects dataset and logistic regression model.
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Workflow Layout

Datasets used

The files used in this example can be found in the samples distributed with Altair SLC.

The datasets used in this example are:

• A dataset about loans, named accepted_loans.csv. Each observation in the dataset describes a
completed loan and the person who took the loan out, with variables such as Income, Loan_Period
and Other_Debt.

• A dataset about rejected loan applications, named rejected_loans.csv. Each observation in the
dataset describes the loan details and the loan applicant. This dataset contains the same variables as
accepted_loans.csv, but without a Default variable.

Using the Reject Inference block to build an inference model

Using the Reject Inference block and rejected loan applications to build an inference model.

1. Import the accepted_loans.csv and rejected_loans.csv datasets into a blank Workflow.
Importing a CSV file is described in Text File Import block  (page 220).

2. Expand the Model Training group in the Workflow palette, then click and drag a WoE Transform
block onto the Workflow canvas, beneath the accepted_loans.csv dataset.
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3. Click on the accepted_loans.csv dataset block's Output port and drag a connection towards the
Input port of the WoE Transform block.

Alternatively, you can dock the WoE Transform block onto the dataset block directly.
4. Double-click on the WoE Transform block.

A WoE Transform Editor view opens.
5. From the Variable Selection tab:

a. From the Dependent Variable drop-down list, select Default.
b. From the Target Category drop-down list, select 1.
c. From the Independent Variables section's Unselected Variables list, double-click Other_Debt,

Income, Sector, Age and Housing_Situation.

All chosen variables are moved to the Selected Variables list.
d. From the Selected Variables list, confirm that the Treatment specified for each variable is as

follows: Other_Debt, Income and Age are set to Interval; and Sector and Housing_Situation
are set to Nominal.

e. Click on the Optimisation tab and click on Apply optimal binning to all variables.

Optimal binning is applied. The results for each variable can be viewed by selecting the variable
from the drop down list at the top of the editor window.

f. Press Ctrl+S to save the configuration.
g. Close the WoE Transform Editor view.

The WoE Transform Editor view closes. A green execution status is displayed in the Output
ports of the WoE Transform block and the dataset that contains the applied transformation,
Working Dataset.

6. Click and drag a Logistic Regression block onto the Workflow canvas, beneath the WoE Transform
block.

7. Click on the WoE Transform block Working Dataset's Output port and drag a connection towards
the Input port of the Logistic Regression block.

Alternatively, you can dock the Logistic Regression block onto the dataset block directly.
8. Double-click on the Logistic Regression block.

A Configure Logistic Regression dialog box window opens.
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9. From the Variable Selection tab:

a. From the Dependent Variable drop-down list, select Default.
b. From the Target category drop-down list, select 1.
c. From the Unselected Effect Variables list, double-click Other_Debt_WOE, Income_WOE,

Sector_WOE, Age_WOE and Housing_Situation_WOE.

All chosen variables are moved to the Selected Effect Variables list.
d. From the Selected Effect Variables list, under the Class column, clear the checkbox for each

variable.
10.From the Model Selection tab:

a. From Method, select Forward.
b. Click Apply and Close.

The Configure Logistic Regression dialog box closes. A green execution status is displayed in
the Output ports of the Logistic Regression block and of its output Logistic Regression Model.

11.Click and drag a Score block onto the Workflow canvas, below the rejected_loans.csv dataset.

A Score block is created on the Workflow canvas. Note that the Score block's configuration status
(the right-hand bar of the block) is red and displays a screentip stating that the block requires a model
and a dataset input.

12.Now connect two inputs to the Score block:

a. First, click on the WoE Transform block (not its output dataset) and drag a connection towards the
Input port of the Score block.

b. Secondly, click on the rejected_loans.csv dataset and drag a connection towards the Input
port of the Score block.

The execution status of the Score block turns green and its dataset output is populated with the
original dataset and the scored variables.

13.Right-click on the Score block's output dataset block and click Rename. Type Scored Rejects
and click OK.

14.Click and drag a Reject Inference block onto the Workflow canvas, beneath the Logistic
Regression block and Score block.

15.Click on the Score block Scored Rejects Output port and drag a connection towards the Input port
of each Reject Inference block.

16.Click on the Logistic Regression block Logistic Regression Models Output port and drag a
connection towards the Input port of the Reject Inference block.

17.Double-click on the Reject Inference block.

A Configure Reject Inference dialog box opens.
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18.From the Inference Options tab:

a. From the Inference Method drop-down list, select Proportional Assignment.
b. From the Bad Event drop-down list, select 1.
c. Click Apply and Close.

The Configure Reject Inference dialog box closes. A green execution status is displayed in the
Output ports of the Reject Inference block and of its outputs Inference Model, Inference Report
and Inferred Rejects.

You now have a reject inference model, that predicts loan defaulting with rejected applications
considered.

Scorecard Model block

Enables the generation of a standard (credit) scorecard and its deployment code. The code can be
copied into a SAS language program for testing or production use.

The Scorecard Model block creates a scorecard model consisting of a set of attributes, each with an
assigned weighted score (either positive or negative). The sum of these scores equals the final credit
score representing the lending risk.

The Scorecard Model block can take input from either:

• The transformation model from a WoE Transform block and a logistic regression model created from
the working dataset of the same WoE Transform block.

• A dataset.

The Scorecard Model block is configured using the Scorecard Editor view, which can be opened by
double-clicking the Scorecard Model block.
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Configure Scorecard Model

Enables you to specify the parameters used to define the scorecard model.

Point Allocation
Model Output Type

Specifies whether the model should produce scores using probability variables or probabilities
using a score variable. This option is for dataset input only.

Scores
Configures the model to produce scores. This enables the following options:

• Minimum score and Maximum score in the Scaling Parameters panel.
• Target class probability and Non-target class probability in the Input panel.
• Scored output variable and Generate integer score in the Output panel.

These options are not available when selecting Probabilities.

Probabilities
Configures the model to produce probabilities. This enables the following options:

• Score variable in the Input panel.
• Target class probability, Non-target class probability, Log odds and Odds in the

Output panel.

These options are not available when selecting Scores.

Scaling Parameters

Base Odds
Specifies the number of Target class category entries for each Non-target class category
entry.

Points at base odds
Specifies the number of points to represent the Base Odds.

Points to Double the Odds
Specifies the number of points decrease in score at which the probability is doubled.

Minimum score
Specifies the minimum score output by the model.

Maximum score
Specifies the maximum score output by the model.

Higher Score Category
Specifies which value in the binary dependent variable higher scores are allocated to.

• Target Class indicates higher scores towards the target category.
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• Non-target class indicates higher scores towards the non-target category.

Input
Specifies input variables for producing probabilities or scores.

Target class probability
Specifies the probability of the target category in a binary dependent variable for calculating
scores.

Non-target class probability
Specifies the probability of the target category in a binary dependent variable for calculating
scores.

Score
Specifies a score variable as input for calculating probabilities.

Output
Specifies variables for the model to output.

Scored output variable
Specifies the name of the output score variable.

Generate integer score
Specifies the score output to only produce whole numbers.

Target class probability
Specifies output of the probability of the target category in the binary dependent variable.

Non-target class probability
Specifies output of the probability of the non-target category in the binary dependent
variable.

Log odds
Specifies output of the log odds.

Odds
Specifies output of the odds.

Scorecard
Displays the variables and associated scores making up the credit scorecard.

Scoring Code
Displays the scorecard model code. The code is available as SAS language or SQL language.

The final generated code can be copied using Copy generated text to clipboard .
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Scorecard Model block example: building a scorecard process

This example demonstrates how the Scorecard Model block is used to construct a scorecard process.
The scorecard generated is applied to a dataset of loan applications, and the results filtered into loan
rejections and loan acceptances.

In this example, a dataset of completed loans named loan_data.csv is imported into a blank
Workflow. The dataset contains details of past loan applications and whether or not each loan defaulted.
A WoE Transform block is used to transform several independent variables into bins, using an optimal
binning technique. A Logistic Regression block is used to build a logistic regression model using
the output variables from the WoE Transform block to target whether or not each loan defaulted. The
Scorecard Model block is then configured to output a scorecard model and, using a Score block, this is
applied against a dataset of new loan applications called loan_application.csv. The Score block
then outputs a dataset appended with the probability of defaulting for each loan application, which, using
the score, is then filtered with two Filter blocks into two datasets of loan rejections and loan acceptances.

Workflow Layout
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Datasets used

The file used in this example can be found in the samples distributed with Altair SLC.

The datasets used in this example are:

• A dataset about loans, named loan_data.csv. Each observation in the dataset describes a past
loan and the person who took loan out, with variables such as Income, Loan_Period and Other_Debt.

• A dataset about loan applications, named loan_applications.csv. Each observation in
the dataset describes an application for a loan. This dataset contains the same variables as
loan_data.csv, but without a Default variable.

Using the Scorecard Model block for the scorecard modelling process

Using several blocks to set up the scorecard modelling process and the Scorecard Model block to
output the results.

1. Import the loan_data.csv and loan_application.csv datasets into a blank Workflow.
Importing a CSV file is described in Text File Import block  (page 220).

2. Expand the Model Training group in the Workflow palette, then click and drag a WoE Transform
block onto the Workflow canvas, beneath the loan_data.csv dataset.

3. Click on the loan_data.csv dataset block's Output port and drag a connection towards the Input
port of the WoE Transform block.

Alternatively, you can dock the WoE Transform block onto the dataset block directly.
4. Double-click on the WoE Transform block.

A WoE Transform Editor view opens.
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5. From the Variable Selection tab:

a. From the Dependent Variable drop-down list, select Default.
b. From the Target Category drop-down list, select 1.
c. From the Unselected Variables list, double-click Other_Debt, Income, Sector, Age and

Housing_Situation.

All chosen variables are moved to the Selected Variables list.
d. From the Selected Variables list, click on the drop-down boxes under Treatment and

set  Other_Debt to Interval, Income to Interval, Sector to Nominal, Age to Interval and
Housing_Situation to Nominal.

e. Click on the Optimisation tab and click on Apply optimal binning to all variables.
f. Press Ctrl+S to save the configuration.
g. Close the WoE Transform Editor view.

The WoE Transform Editor view closes. A green execution status is displayed in the Output
ports of the WoE Transform block and the dataset that contains the applied transformation,
Working Dataset.

6. Click and drag a Logistic Regression block onto the Workflow canvas, beneath the WoE Transform
block.

7. Click on the WoE Transform block Working Dataset's Output port and drag a connection towards
the Input port of the Logistic Regression block.

Alternatively, you can dock the Logistic Regression block onto the dataset block directly.
8. Double-click on the Logistic Regression block.

A Configure Logistic Regression dialog box window opens.
9. From the Variable Selection tab:

a. From the Dependent Variable drop-down list, select Default.
b. From the Target category drop-down list, select 1.
c. From the Unselected Effect Variables list, double-click Other_Debt_WOE, Income_WOE,

Sector_WOE, Age_WOE and Housing_Situation_WOE.

All chosen variables are moved to the Selected Effect Variables list.
d. From the Selected Effect Variables list, under the Class column, clear the checkbox for each

variable.
10.From the Model Selection tab:

a. From Method, select Forward.
b. Click Apply and Close.

The Configure Logistic Regression dialog box closes. A green execution status is displayed in
the Output ports of the Logistic Regression block and of its output Logistic Regression Model.
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11.Click and drag a Scorecard Model block onto the Workflow canvas, below the new Logistic
Regression block.

A Scorecard Model block is created on the Workflow canvas. Note that the Scorecard Model
block's configuration status (the right-hand bar of the block) is red and displays a screentip stating
that the block requires input.

12.Click on the WoE Transform block WoE Transform and Logistic Regression block Logistic
Regression Model Output port and drag a connection towards the Input port of the Scorecard
Model block.

13.Double-click on the Scorecard Model block.

A Scorecard Editor view opens.
14.From the Point Allocation tab:

a. In the Points at base odds box, type 500.
b. In the Points to double the odds box, type 60.
c. In the Higher Score Category pane, select Non-target class.
d. Press Ctrl+S to save the configuration.
e. Close the Scorecard Editor view.

The Scorecard Editor view closes. A green execution status is displayed in the Output ports of
the Scorecard Model block.

15.From the Scoring grouping in the Workflow palette, click and drag a Score block onto the Workflow
canvas, below the Scorecard Model block and the loan_applications.csv dataset.

A Score block and empty dataset block are created on the Workflow canvas. Note that the Score
block's configuration status (the right-hand bar of the block) is red and displays a screentip stating
that the block requires a model and a dataset input.

16.Click on the loan_applications.csv dataset block's Output port and drag a connection towards
the Input port of the Score block.

17.Click on the Scorecard Model block Working Dataset Output port and drag a connection towards
the Input port of the Score block.

The execution status of the Score block turns green and its dataset output is populated with the
original dataset and the scored variable.

18.From the Data Preparation grouping in the Workflow palette, click and drag two Filter blocks onto the
Workflow canvas.

19.Click on the Score block Output port and drag a connection towards the Input port of each Filter
block.
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20.Configure the first Filter block:

a. Double-click on a Filter block.

A Filter Editor view opens.
b. Click on the Basic tab.
c. From the Variable drop-down box, select Score.
d. From the Operator drop-down box, select <.
e. In the Value box, enter 230.
f. Press Ctrl+S to save the configuration.
g. Close the Filter Editor view.

The Filter Editor view. A green execution status is displayed in the Output port of the Filter block
and the filtered dataset, Working Dataset.

h. Right-click on the Filter block's output dataset block and click Rename. Type Rejected Loans
and click OK.

21.Now configure the second Filter block:

a. Double-click on the other Filter block.

A Filter Editor view opens.
b. Click on the Basic tab.
c. From the Variable drop-down box, select Score.
d. From the Operator drop-down box, select >=.
e. In the Value box, enter 230.
f. Press Ctrl+S to save the configuration.
g. Close the Filter Editor view.

The Filter Editor view closes. A green execution status is displayed in the Output port of the
Filter block and the filtered dataset, Working Dataset.

h. Right-click on the Filter block's output dataset block and click Rename. Type Accepted Loans
and click OK.

You now have a scorecard process that scores loan application, which are then sorted into acceptances
and rejections.
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WoE Transform block

Enables you to measure the influence of an independent variable on a specified dependent variable. This
calculates the Weight of Evidence, or WoE.

This block can be invoked by dragging the block from the Workflow palette to the Workflow canvas
and then dragging a connection from a dataset to the Input port of the block. You can use the WoE
Transform block to measure risk, for example to test hypotheses such as the risk of loan default based
on area of residence if your dataset is grouped by geographic areas.

A WoE Transform block is edited through the WoE Transform Editor view. To open the WoE
Transform Editor view, double-click the WoE Transform block.

The WoE Transform Editor view is used to select a dependent variable, its target category, and the
most influential independent variables and their treatment.

Variable Selection view
Dependent Variable

Specifies the target variable for the calculation.

Target Category
Specifies the target category for which the probability of occurrence is to be calculated.

Frequency Variable
Specifies a variable that defines the frequency of each observation.

Independent Variables
Enables you to select the most influential independent variables for the WoE transform.

Variable
Displays the name of all independent variables in the input dataset.

Entropy Variance
Displays the Entropy Variance value for each variable in relation to the specified
Dependent Variable. For more information, see Predictive power criteria  (page 112)

Treatment
Enables you to specify the type of each variable.

Excluded
Specifies the variable is excluded from Weight of Evidence calculations.

Interval
Specifies a continuous independent (input) variable.

Nominal
Specifies a discrete independent (input) variable with no implicit ordering.
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Ordinal
Specifies a discrete independent (input) variable with an implicit category ordering.

Monotonic WoE
Specifies that the Weight of Evidence value for the variable is either monotonically
increasing or monotonically decreasing.

Frequency Chart
Shows the effect the selected independent variable has on each potential target category for the
specified dependent variable.

Optimisation view
Displays the output from transforming the specified independent variables using optimal binning.

Independent variable
Specifies the variable to use in the weight of evidence transformation. The list contains the
variables selected in the Variable Selection view.

Binning Definition
Displays the effects of binning the specified independent variable. Click Apply optimal binning
to all variables   to optimally bin the independent variables. The table then displays the classes
used for each bin and the Altair Analytics Workbench-generated label for the bin, which can be
modified if required.

WoE Transformation
Displays a table with information about each optimal bin created including the:

• Number of observations in the bin.
• Percentage of observations in the bin.
• Number of observations in the bin matching each value in the dependent variable specified for

the dependent variable.
• Column percentages for each value in the dependent variable, representing proportions of

frequencies between the bins.
• Row percentages for each value in the dependent variable, representing proportions of

frequencies the dependent variable values.
• WoE for each bin.
• Information value for each bin.

The panel contains graphs showing the percentage of the specified target category to the
non-target category for all bins, the Weight of Evidence for each bin, and the total number of
observations (count) in each bin.

The charts can be edited and saved. Click Edit chart  at the top of the required chart to open
the Chart Editor from where the chart can be saved to the clipboard. The frequency data used to
create each node can be saved by clicking Copy data to clipboard  at the top of the required
chart to save the table of data.
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Transformation Code
Displays the transformation code for the WoE calculations. The code is available as either SQL, for use
in the SQL block, or as SAS language code for use in the DATA step.

Click Options to open the Source Generation Options dialog box to modify the names of the
transformation variables in the generated code.

The final generated code can be copied using Copy generated text to clipboard .

WoE Transform block basic example

This example demonstrates how the WoE Transform block can be used to transform variables.

In this example, a dataset of completed loans named loan_data.csv is imported into a blank
Workflow. The dataset contains details of past loan applications and whether or not each loan defaulted.
A WoE Transform block is used to transform several variables into several bins, using an optimal
binning technique.

Workflow Layout

Datasets used

The file used in this example can be found in the samples distributed with Altair SLC.

This example uses a dataset about loans, named loan_data.csv. Each observation in the dataset
describes a past loan and the person who took loan out, with variables such as Income, Loan_Period
and Other_Debt.
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Using a WoE Transform block to transform variables

Using the WoE Transform block to transform variables into a finite number of bins and output the
results.

1. Import the loan_data.csv dataset into a blank Workflow. Importing a CSV file is described in Text
File Import block  (page 220).

2. Expand the Model Training group in the Workflow palette, then click and drag a WoE Transform
block onto the Workflow canvas, under the loan_data.csv dataset.

3. Click on the loan_data.csv dataset block's Output port and drag a connection towards the Input
port of the WoE Transform block.

Alternatively, you can dock the WoE Transform block onto the dataset block directly.
4. Double-click on the WoE Transform block.

A WoE Transform Editor view opens.
5. From the Variable Selection tab:

a. From the Dependent Variable drop-down list, select Default.
b. From the Target Category drop-down list, select 1.
c. From the Unselected Variables list, double-click Income and Housing_Situation.

All chosen variables are moved to the Selected Variables list.
d. From the Selected Variables list, click on the drop-down boxes under Treatment and set  Income

to Interval and Housing_Situation to Nominal.
e. Click on the Optimisation tab and click on Apply optimal binning to all variables.
f. Press Ctrl+S to save the configuration.
g. Close the WoE Transform Editor view.

The WoE Transform Editor view closes. A green execution status is displayed in the Output
ports of the WoE Transform block and the dataset that contains the applied transformation,
Working Dataset.

You now have a WoE transformation model that outputs transformed variables.

WoE Transform block example: use as part of a scorecard process

This example demonstrates how the WoE Transform block can be used as part of a scorecard process.
The workflow generates a scorecard, which is then applied to a dataset of loan applications, and the
results filtered into loan rejections and loan acceptances.

In this example, a dataset of completed loans named loandata.csv is imported into a blank Workflow.
The dataset contains details of past loan applications and whether or not each loan defaulted. A WoE
Transform block is used to transform several independent variables into bins, using an optimal binning
technique. A Logistic Regression block is used to build a logistic regression model using the output
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variables from the WoE Transform block to target whether or not each loan defaulted. The Scorecard
Model block is then configured to output a scorecard model and, using a Score block, this is applied
against a dataset of new loan applications called loan_application.csv. The Score block then
outputs a dataset appended with the probability of defaulting for each loan application, which, using the
score, is then filtered with two Filter blocks  into two datasets of loan rejections and loan acceptances.

Workflow Layout

Datasets used

The file used in this example can be found in the samples distributed with Altair SLC.

The datasets used in this example are:

• A dataset about loans, named loandata.csv. Each observation in the dataset describes a past
loan and the person who took loan out, with variables such as Income, Loan_Period and Other_Debt.
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• A dataset about loan applications, named loan_applications.csv. Each observation in
the dataset describes an application for a loan. This dataset contains the same variables as
loandata.csv, but without a Default variable.

Using the WoE Transform block as part of a scorecard process

Using the WoE Transform block with other blocks to create a scorecard modelling process.

1. Import the loandata.csv and loan_application.csv datasets into a blank Workflow. Importing
a CSV file is described in Text File Import block  (page 220).

2. Expand the Model Training group in the Workflow palette, then click and drag a WoE Transform
block onto the Workflow canvas, under the loandata.csv dataset.

3. Click on the loandata.csv dataset block's Output port and drag a connection towards the Input
port of the WoE Transform block.

Alternatively, you can dock the WoE Transform block onto the dataset block directly.
4. Double-click on the WoE Transform block.

A WoE Transform Editor view opens.
5. From the Variable Selection tab:

a. From the Dependent Variable drop-down list, select Default.
b. From the Target Category drop-down list, select 1.
c. From the Unselected Variables list, double-click Other_Debt, Income, Sector, Age and

Housing_Situation.

All chosen variables are moved to the Selected Variables list.
d. From the Selected Variables list, click on the drop-down boxes under Treatment and

set  Other_Debt to Interval, Income to Interval, Sector to Nominal, Age to Interval and
Housing_Situation to Nominal.

e. Click on the Optimisation tab and click on Apply optimal binning to all variables.
f. Press Ctrl+S to save the configuration.
g. Close the WoE Transform Editor view.

The WoE Transform Editor view closes. A green execution status is displayed in the Output
ports of the WoE Transform block and the dataset that contains the applied transformation,
Working Dataset.

6. Click and drag a Logistic Regression block onto the Workflow canvas, beneath the WoE Transform
block.

7. Click on the WoE Transform block Working Dataset's Output port and drag a connection towards
the Input port of the Logistic Regression block.

Alternatively, you can dock the Logistic Regression block onto the dataset block directly.
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8. Double-click on the Logistic Regression block.

A Configure Logistic Regression dialog box window opens.
9. From the Variable Selection tab:

a. From the Dependent Variable drop-down list, select Default.
b. From the Event drop-down list, select 1.
c. From the Unselected Effect Variables list, double-click Other_Debt_WOE, Income_WOE,

Sector_WOE, Age_WOE and Housing_Situation_WOE.

All chosen variables are moved to the Selected Effect Variables list.
d. From the Selected Effect Variables list, under the Class column, clear the checkbox each

variable.
10.From the Model Selection tab:

a. From Method, select Forward.
b. Click Apply and Close.

The Configure Logistic Regression dialog box closes. A green execution status is displayed in
the Output ports of the Logistic Regression block and of its output Logistic Regression Model.

11.Click and drag a Scorecard Model block onto the Workflow canvas, below the new Logistic
Regression block.

A Scorecard Model block is created on the Workflow canvas. Note that the Scorecard Model
block's configuration status (the right-hand bar of the block) is red and displays a screentip stating
that the block requires input.

12.Click on the WoE Transform block WoE Transform and Logistic Regression block Logistic
Regression Model Output port and drag a connection towards the Input port of the Scorecard
Model block.

13.Double-click on the Scorecard Model block.

A Scorecard Editor view opens.
14.From the Point Allocation tab:

a. In the Base points box, type 500.
b. In the Points to double the odds box, type 60.
c. In the Higher Score Category pane, select Good.
d. Press Ctrl+S to save the configuration.
e. Close the Scorecard Editor view.

The Scorecard Editor view closes. A green execution status is displayed in the Output ports of
the Scorecard Model block.
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15.From the Scoring grouping in the Workflow palette, click and drag a Score block onto the Workflow
canvas, below the Scorecard Model block and the loan_applications.csv dataset.

A Score block and empty dataset block are created on the Workflow canvas. Note that the Score
block's configuration status (the right-hand bar of the block) is red and displays a screentip stating
that the block requires a model and a dataset input.

16.Click on the loan_applications.csv dataset block's Output port and drag a connection towards
the Input port of the Score block.

17.Click on the Scorecard Model block Working Dataset Output port and drag a connection towards
the Input port of the Score block.

The execution status of the Score block turns green and its dataset output is populated with the
original dataset and the scored variable.

18.From the Data Preparation grouping in the Workflow palette, click and drag two Filter blocks onto the
Workflow canvas.

19.Click on the Score block Output port and drag a connection towards the Input port of each Filter
block.

20.Configure the first Filter block:

a. Double-click on a Filter block.

A Filter Editor view opens.
b. Click on the Basic tab.
c. From the Variable drop-down box, select Score.
d. From the Operator drop-down box, select <.
e. In the Value box, enter 540.
f. Press Ctrl+S to save the configuration.
g. Close the Filter Editor view.

The Filter Editor view. A green execution status is displayed in the Output port of the Filter block
and the filtered dataset, Working Dataset.

h. Right-click on the Filter block's output dataset block and click Rename. Type Rejected Loans
and click OK.

443



Altair Analytics Workbench user guide
Version 2023

21.Now configure the second Filter block:

a. Double-click on the other Filter block.

A Filter Editor view opens.
b. Click on the Basic tab.
c. For the Variable drop-down box, select Score.
d. For the Operator drop-down box, select >=.
e. In the Value box, enter 540.
f. Press Ctrl+S to save the configuration.
g. Close the Filter Editor view.

The Filter Editor view closes. A green execution status is displayed in the Output port of the
Filter block and the filtered dataset, Working Dataset.

h. Right-click on the Filter block's output dataset block and click Rename. Type Accepted Loans
and click OK.

You now have a scorecard process that scores loan application, which are then sorted into acceptances
and rejections.

Scoring group
Contains blocks that enable you to analyse and score models.

Analyse Models block ....................................................................................................................... 444
Enables analysis of a scored dataset to determine performance of a model.

Score block ....................................................................................................................................... 451
Enables you to test multiple models against the same dataset, or to apply an existing model to a
new dataset.

PSI block ........................................................................................................................................... 457
Population Stability Index (PSI) assesses how a scorecard has changed over time.

Analyse Models block

Enables analysis of a scored dataset to determine performance of a model.

Overview
The Analyse Models block accepts a connection from a scored dataset. To test the same model with
multiple datasets, create one Analyse Models block and connect each scored dataset to the same
block.
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Configure Analyse Models
Double-clicking on a new Analyse Models block will open the Configure Analyse Models window,
which has two tabs:

Analysis Type
Choose the type of model analysis:

• Classification: Performs a classification analysis on a predicted variable, comparing a chosen
truth category against the predicted probability from the dataset.

• Regression: Performs a regression analysis on a predicted variable, comparing it against the
observed value from the dataset.

Variable Selection
If you have selected a classification analysis, select the following for each dataset:

• True class: the variable that's being predicted.
• Truth category: the value of the True class variable that the model is aiming to predict.
• Predicted probability: probability of occurrence for the truth category value.

If you have selected a regression analysis, for each dataset, select:

• Outcome variable: the variable that's being predicted.
• Predicted result: the model's prediction for the outcome variable.

Report
The Analyse Models block generates a report showing charts and statistics. To display the report, right-
click on the report and select Open Report.

Classification Analysis
If you have selected a classification analysis, the report contains a Summary tab showing all
charts and statistics, along with a tab for each chart: Gains Chart, K-S Chart, ROC Chart and
Lift Chart for the model. When in its full screen tab view, the K-S Chart allows you to toggle its
constituent plots on and off by clicking on the legend items.   For information about the statistics ,
see the Binary classification statistics  (page 504) section.

Regression Analysis
If you have selected a regression analysis, the report contains a Summary tab showing all
statistics, along with a tab for each chart: Normal Q-Q plots, Predicted vs Outcome Q-Q Plots,
Residual Histograms, Residual Scatterplots and Predicted vs Outcome Scatterplots for the
model.

Note:
The R² statistic is calculated differently when using a linear regression model with no intercept, this might
mean there is a different R² value in the Linear Regression Report view. For more information see the 
R² statistic  (page 503) section.
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Analyse Models block basic example

This example demonstrates how the Analyse Models block can be used as part of a modelling process
to assess model performance.

In this example, a dataset named basketball_shots.csv is imported into a blank Workflow. The
dataset contains information about basketball shots, with the Scored variable indicating whether the
shot scored. The Logistic Regression block is configured to produce a logistic regression model from
this dataset. The model is then applied to basketball_shots.csv using a Score block. The Analyse
Models block then uses the scored dataset to create a report that details the models' performance.

Workflow Layout

Datasets used

The file used in this example can be found in the samples distributed with Altair SLC.

This example uses a dataset about basketball shots, named basketball_shots.csv. Each
observation in the dataset describes an attempt to score and the person shooting, with variables such as
height, weight and distance_feet.
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Using the Analyse Models block to create a model performance report

Using the Analyse Models block to assess the performance of a trained models application to a dataset.

1. Import the basketball_shots.csv dataset into a blank Workflow. Importing a CSV file is
described in Text File Import block  (page 220).

2. Expand the Model Training group in the Workflow palette, then click and drag a Logistic
Regression block onto the Workflow canvas, beneath the basketball_shots.csv dataset.

3. Click on the basketball_shots.csv dataset block's Output port and drag a connection towards
the Input port of the Logistic Regression block.

Alternatively, you can dock the Logistic Regression block onto the dataset block directly.
4. Double-click on the Logistic Regression block.

A Configure Logistic Regression dialog box opens.
5. From the Variable Selection tab:

a. From the Dependent Variable drop-down list, select Scored.
b. From the Unselected Regressors list, double-click on the variables height, weight

distance_feet and  position to move them to the Selected Regressors list.
6. Click Apply and Close.

The Configure Logistic Regression dialog box closes. A green execution status is displayed in the
Output port of the Logistic Regression block.

7. From the Scoring grouping in the Workflow palette, click and drag a Score block onto the Workflow
canvas, below the Score block and the basketball_shots.csv dataset block.

A Score block and empty dataset block are created on the Workflow canvas. Note that the Score
block's configuration status (the right-hand bar of the block) is red and displays a screentip stating
that the block requires a model and a dataset input.

8. Click on the basketball_shots.csv dataset block's Output port and drag a connection towards
the Input port of the Score block.

9. Click on the Logistic Regression block Output port and drag a connection towards the Input port of
the Score block.

The execution status of the Score block turns green and its dataset output is populated with the
original dataset and the scored variables.

10.Right-click on the Score block's output dataset block and click Rename. Type LR Model and click
OK.

11.From the Scoring grouping in the Workflow palette, click and drag an Analyse Models block onto the
Workflow canvas, below the Score block.

12.Click on the Score block LR Model Output port and drag a connection towards the Input port of the
Analyse Models block.

13.Double-click on the Analyse Models block.

A Configure Analyse Models dialog box opens.
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14.From the Analyse Models block:

a. In the Analysis Type tab, under the Type of analysis drop-down box, select Classification.
b. Click on the Variable Selection tab.
c. In the True class drop-down box, select Score.
d. In the True category drop-down box, select Score.
e. In the Predicted probability drop-down box, select P_1.

15.Click Apply and Close.

The Configure Analyse Models dialog box closes. A green execution status is displayed in the
Output port of the Analyse Models block and the resulting report, Model Analysis Report.

You now have a report that assesses the performance of a logistic regression model.

Analyse Models block example: Comparing multiple models that
predict the same variable

This example demonstrates how the Analyse Models block can be used as part of a modelling process
to compare different models and aid in choosing one that's more favourable.

In this example, a dataset named basketball_shots.csv is imported into a blank Workflow. The
dataset contains information about basketball shots, with the Scored variable indicating whether the
shot scored. The Logistic Regression block and Decision Forest block is configured to produce a
logistic regression model and a decision forest model respectively, where both blocks aim to predict the
Scored variable. The models are then applied to basketball_shots.csv using two Score block.
The Analyse Models block then uses the scored datasets to create a report that details each models'
performance and enables a comparison between them.
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Workflow Layout

Datasets used

The file used in this example can be found in the samples distributed with Altair SLC.

This example uses a dataset about basketball shots, named basketball_shots.csv. Each
observation in the dataset describes an attempt to score and the person shooting, with variables such as
height, weight and distance_feet.

Using the Analyse Models block to create a model performance report and compare multiple
models

Using the Analyse Models block to assess the performance of a trained models application to a dataset
and aid in deciding on a more favourable model.

1. Import the basketball_shots.csv dataset into a blank Workflow. Importing a CSV file is
described in Text File Import block  (page 220).

2. Expand the Model Training group in the Workflow palette, then click and drag a Logistic
Regression block onto the Workflow canvas, beneath the basketball_shots.csv dataset.
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3. Click on the basketball_shots.csv dataset block's Output port and drag a connection towards
the Input port of the Logistic Regression block.

Alternatively, you can dock the Logistic Regression block onto the dataset block directly.
4. Double-click on the Logistic Regression block.

A Configure Logistic Regression dialog box opens.
5. From the Variable Selection tab:

a. From the Dependent Variable drop-down list, select Scored.
b. From the Unselected Regressors list, double-click on the variables height, weight

distance_feet and  position to move them to the Selected Regressors list.
6. Click Apply and Close.

The Configure Logistic Regression dialog box closes. A green execution status is displayed in
the Output port of the Logistic Regression block and the Output port of the Logistic Regression
Model.

7. From the Model Training group in the Workflow palette, then click and drag a Decision Forest block
onto the Workflow canvas, beneath the basketball_shots.csv dataset.

8. Click on the basketball_shots.csv dataset block's Output port and drag a connection towards
the Input port of the Decision Forest block.

Alternatively, you can dock the Decision Forest block onto the dataset block directly.
9. Double-click on the Decision Forest block.

A Configure Decision Forest dialog box opens.
10.From the Configure Decision Forest dialog box:

a. In the Dependent variable drop-down list, select Score.
b. In the Dependent variable treatment drop-down list, select Nominal.
c. From the Unselected Independent Variables list, double-click on the variables angle, height, 

weight and position to move them to  the Selected Independent Variables list.
d. Click Apply and Close.

The Configure Decision Forest dialog box closes. A green execution status is displayed in the
Output port of the Decision Forest block and the model results, Decision Forest Model.

11.From the Scoring grouping in the Workflow palette, click and drag two Score blocks onto the
Workflow canvas, one below the Logistic Regression block and the other below the Decision
Forest block.

A Score block and empty dataset block are created on the Workflow canvas for each Score block.
Note that the Score blocks configuration status (the right-hand bar of the block) is red and displays a
screentip stating that the block requires a model and a dataset input.

12.Click on the basketball_shots.csv dataset block's Output port and drag a connection towards
the Input port of each Score block.
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13.Click on the Logistic Regression block and Decision Forest block Output port and drag a
connection towards the Input port of the Score blocks underneath.

The execution status of each Score block turns green and its dataset output is populated with the
original dataset and the scored variables.

14.Right-click on each Score blocks output dataset block and click Rename. Type LR Model for the
scored logistic regression model,  and DF Model for the scored decision forest model, then click
Apply and Close.

15.From the Scoring grouping in the Workflow palette, click and drag an Analyse Models block onto the
Workflow canvas, below both Score blocks.

16.Click on each Score blocks Output port and drag a connection towards the Input port of the Analyse
Models block.

17.Double-click on the Analyse Models block.

A Configure Analyse Models dialog box opens.
18.From the Analyse Models block:

a. In the Analysis Type tab, under the Type of analysis drop-down box, select Classification.
b. Click on the Variable Selection tab.
c. In each True class drop-down box, select Score.
d. In each True category drop-down box, select Score.
e. In each Predicted probability drop-down box, select P_1.

19.Click Apply and Close.

The Configure Analyse Models dialog box closes. A green execution status is displayed in the
Output port of the Analyse Models block and the resulting report, Model Analysis Report.

You now have a report that compares performances of multiple models.

Score block

Enables you to test multiple models against the same dataset, or to apply an existing model to a new
dataset.

Testing multiple models
To test multiple models, create one Score block for each model you want to test, and connect the same
dataset to each Score block. The output from the multiple blocks will enable you to identify the preferred
model to deploy.
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Applying an existing model to a new dataset
To apply an existing model to a new dataset, configure a model output from a compatible block, for
example a block used against a training dataset, and connect that model output to the score block along
with a connection from the new dataset. The score block will then output a new dataset that is the result
of the connected model being applied to the connected dataset.

Note:
Not all models come from the Model Training group, for example, the score block can also take model
input from the Binning block and Impute block. To produce a model from one of these blocks, right click
the block and select Configure Outputs, then add the model to the Selected Output panel and click
OK.

Score block basic example

This example demonstrates how the Score block can be used to apply a linear regression model to a
dataset.

In this example, a dataset named Bananas.csv is imported into a blank Workflow. The dataset contains
the length and mass of bananas, with each observation representing an individual banana. The Linear
Regression block is configured to produce a linear regression model from this dataset. The model is
then applied to Bananas.csv, using a Score block.

Workflow Layout
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Datasets used

The file used in this example can be found in the samples distributed with Altair SLC.

This example uses a dataset named Bananas.csv. Each observation in the dataset describes a
banana, with numeric variables Length(cm) and Mass(g) giving each banana's measured length in
centimetres and mass in grams respectively.

Using the Score block to apply a predictive model to a dataset

Using the Score block to apply a basic linear regression model to a dataset.

1. Import the Bananas.csv dataset into a blank Workflow. Importing a CSV file is described in Text File
Import block  (page 220).

2. Expand the Model Training group in the Workflow palette, then click and drag a Linear Regression
block onto the Workflow canvas, beneath the Bananas.csv dataset.

3. Click on the Bananas.csv dataset block's Output port and drag a connection towards the Input port
of the Linear Regression block.

Alternatively, you can dock the Linear Regression block onto the dataset block directly.
4. Double-click on the Linear Regression block.

A Configure Linear Regression dialog box opens.
5. From the Variable Selection tab:

a. From the Dependent Variable drop-down list, select Mass(g).
b. From the Unselected Regressors list, double click Length(cm) to move it to the Selected

Regressors list.
6. Click Apply and Close.

The Configure Linear Regression dialog box closes. A green execution status is displayed in the
Output port of the Linear Regression block and the Output port of the Linear Regression Model.

7. From the Scoring grouping in the Workflow palette, click and drag a Score block onto the Workflow
canvas, below the Score block and the basketball_shots.csv dataset block.

A Score block and empty dataset block are created on the Workflow canvas. Note that the Score
block's configuration status (the right-hand bar of the block) is red and displays a screentip stating
that the block requires a model and a dataset input.

8. Click on the Bananas.csv dataset block's Output port and drag a connection towards the Input port
of the Score block.

9. Click on the Linear Regression block Output port and drag a connection towards the Input port of
the Score block.

The execution status of the Score block turns green and its dataset output is populated with the
original dataset and the scored variables.
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You now have a scored logistic regression model that predicts the mass of a banana.

Score block advanced example

This example demonstrates how the Score block can be used multiple times to use the clustering of
observations as an input to a predictive model

In this example, a dataset containing information about iris flowers, named IRIS.csv is imported into
a blank Workflow. The K-Means Clustering block uses this dataset to cluster observations together
based on the length and width of the petals.   The model is then applied to the dataset, using a Score
block. A Decision Forest block is then used to generate a model that predicts the species variable
using the generated variable that represents cluster assignment, cluster. The decision forest model
is then applied to the clustered dataset, using a second Score block.   This Score block generates an
output dataset, Iris Prediction. This contains the predictions for the species variable with 96%
accuracy.

Workflow Layout
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Datasets used

The dataset used in this example is the publicly available iris flower dataset (Ronald A. Fisher, "The
use of multiple measurements in taxonomic problems." Annals of Eugenics, vol.7 no.2, (1936); pp.
179—188.)

Each observation in the dataset describes an iris flower, with variables such as species, sepal_length
and petal_width.

Using the Score block to assign clusters and make predictions

Using the Score block to score a clustering and decision forest model.

1. Import the IRIS.csv dataset into a blank Workflow canvas.
2. Expand the Model Training group in the Workflow palette, then click and drag a K-Means Clustering

block onto the Workflow canvas, beneath the IRIS.csv dataset.
3. Click on the IRIS.csv dataset block's Output port and drag a connection towards the Input port of

the K-Means Clustering block.

Alternatively, you can dock the K-Means Clustering block onto the dataset block directly.
4. Double click on the K-Means Clustering block.

A Configure K-Means Clustering dialog box opens.
5. From the Configure K-Means Clustering dialog box:

a. From the Unselected Independent Variables box, double click on the variables petal_length
and petal_width to move them to   the Selected Independent Variables box.

b. Click on the Options tab. Set the Number of clusters to 3.
c. Click Apply and Close.

The Configure K-Means Clustering window closes. A green execution status is displayed in the
Output port of the K-Means Clustering block and the model results, K-Means Clustering Model.

6. From the Scoring grouping in the Workflow palette, click and drag a Score block onto the Workflow
canvas, below the new K-Means Clustering Model block and the IRIS.csv dataset block.

A Score block and empty dataset block are created on the Workflow canvas. Note that the Score
block's configuration status (the right-hand bar of the block) is red and displays a screentip stating
that the block requires a model and a dataset input.

7. Click on the IRIS.csv dataset block's Output port and drag a connection towards the Input port of
the Score block.

8. Click on the K-Means Clustering Model Output port and drag a connection towards the Input port of
the Score block.

The execution status of the Score block turns green and its dataset output is populated with the
original dataset and the scored variables.

9. Click and drag a Decision Forest block onto the Workflow canvas.

455



Altair Analytics Workbench user guide
Version 2023

10.Click on the Score block Working Dataset Output port and drag a connection towards the Input port
of the Decision Forest block.

Alternatively, you can dock the Decision Forest block onto the dataset block directly.
11.Double-click on the Decision Forest block.

A Configure Decision Forest dialog box opens.
12.From the Configure Decision Forest dialog box Variable selection tab:

a. In the Dependent variable drop down list, select species.
b. In the Dependent variable treatment drop down list, select Nominal.
c. From the Unselected Independent Variables box, double click on the cluster variable, to move

it to  the Selected Independent Variables box.
13.Click on the Preferences tab and change the following:

a. Number of trees to 20.
b. Classifier combination as Mean Probability.
c. Click Apply and Close.

The Configure Decision Forest dialog box saves and closes. A green execution status is
displayed in the Output port of the Decision Forest block and the model results, Decision
Forest Model.

14.From the Scoring grouping in the Workflow palette, click and drag a Score block onto the Workflow
canvas, below the Decision Forest block.

A Score block and empty dataset block are created on the Workflow canvas. Note that the Score
block's configuration status (the right-hand bar of the block) is red and displays a screentip stating
that the block requires a model and a dataset input.

15.Click on the Score block Working Dataset Output port and drag a connection towards the Input port
of the Score block.

16.Click on the Decision Forest Model Output port and drag a connection towards the Input port of the
Score block.

The execution status of the Score block turns green and its dataset output is populated with the
original dataset and the scored variables.

17.right-click on the Score block's output dataset block, Working Dataset and click Rename. Type
Iris Prediction and click OK.

You now have a predictive model that utilises input from a K-Means clustering model.
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PSI block

Population Stability Index (PSI) assesses how a scorecard has changed over time.

Block inputs
The PSI block requires two inputs: a reference dataset containing the expected distribution of scores, in
labelled bins; and a second current dataset containing the current distribution of scores, also in labelled
bins. The block will analyse the bin label variable from each dataset, counting the observations for each
bin in the reference dataset and comparing it to that of the current dataset.

Block outputs
The PSI block has the following outputs:

• The block label can be set to show the primary metric for the block (either PSI or p-value).
• A coloured border around the PSI block's comment indicator indicating the PSI and how it compares

to specified thresholds.
• An automatically generated comment for the PSI block, giving a summary of the block's results.
• A PSI Report view, selected as an output by default, but can be removed by right-clicking on the PSI

block and selecting Configure Outputs.
• A Distributions Dataset, giving the block's outputs as a dataset. This is not selected by default, but

can be selected by right-clicking on the PSI block and selecting Configure Outputs.
• Summary Statistics. This is not selected by default, but can be selected by right-clicking on the PSI

block and selecting Configure Outputs.

Configure PSI

Enables you to configure the PSI block.

The Configure PSI window allows you to specify the following:

Reference dataset
Choose the reference dataset against which comparisons will be made.

Reference binned variable
Choose the reference binned variable from the reference dataset. This variable will be a list of bin
labels, for example assigned from another continuous variable.

Current binned variable
Choose the binned variable from the current dataset to compare with the reference binned variable
from the reference dataset. This variable will be a list of bin labels, for example assigned from
another continuous variable.
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Automatically update block label and comment

When selected, this will display the primary metric (specified below) as a label on the block in the
Workflow, and automatically generate a comment with further detail. Both of these indicators will
be updated if the data changes. This automatic update will overwrite any manual edits you have
made to the block label or comment.

When not selected, the automatic block label and comment will not be created.

Minor change threshold
Sets the threshold for a minor change in the p-value. When the p-value falls below this value, this
will be noted as a minor change in the block's outputs.

Major change threshold
Sets the threshold for a major change in the p-value to be noted in the block's outputs. When the
p-value falls below this value, this will be noted as a major change in the block's outputs.

Primary metric
Choose between PSI and p-value to display on the block label and as the primary metric in the
report view.

PSI Report view

Displays the block's output in detail.

Summary
The summary at the top of the report view shows:

• A colour coded indicator showing:

‣ Green: No significant change. The p-value is above the specified Minor change threshold.
‣ Amber: Minor change. The p-value is below the specified Minor change threshold.
‣ Red: Major change. The p-value is below the specified Major change threshold.

• PSI.
• p-value.

Current and Reference Distributions
A table with a row for each reference bin, displaying:

• Reference Bin: The label for the bin.
• Reference Frequency: The number of items in the bin for the reference dataset.
• Reference Percent: The percentage of the total items that this bin's items represent for the reference

dataset.
• Current Frequency: The number of items in the bin for the current dataset.
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• Current Percent: The percentage of the total items that this bin's items represent for the current
dataset.

• Current - Reference: The difference between the current and reference percentages.
• Index: The PSI for each bin.

PSI block basic example: comparing two binned datasets

This example demonstrates how a PSI block can be used to compare binned observations in two similar
datasets.

In this example, two datasets are imported into a blank Workflow, each describing a crop of bananas:
bananas_july.csv and bananas_august.csv. The datasets are identical in structure, with each
observation representing an individual banana.

The bananas_july.csv dataset is passed to a Binning block, which is configured to bin observations
by the variable Mass(g), creating a dataset appended with a new categorical variable, Mass(g)_bin,
stating which bin each observation belongs in. The Binning block is configured to output its binning
model, which is applied to the bananas_august.csv dataset using a Score block, creating a new
dataset for bananas_august.csv, also with a binning variable appended.

Finally, the binned datasets are passed to a PSI block, which compares them and outputs a PSI Report,
showing how the mass of bananas from the crop in August differs from the crop in July.

Workflow Layout
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Datasets used

The files used in this example can be found in the samples distributed with Altair SLC.

The datasets used in this example are:

• bananas_july.csv. This dataset describes a crop of bananas from the month of July. Each
observation in the dataset describes a banana, with numeric variables Length(cm) and Mass(g)
giving each banana's measured length in centimetres and mass in grams respectively.

• bananas_august.csv. This dataset describes a crop of bananas from the month of August and is
identical in structure to bananas_july.csv.

Using the PSI block to compare two binned datasets

Binning observations in two datasets and then using the PSI block to compare the two datasets.

1. Import the datasets bananas_july.csv and bananas_august.csv into a blank Workflow.
Importing a CSV file is described in Text File Import block  (page 220).

2. Expand the Data Preparation group in the Workflow palette, then click and drag a Binning block
onto the Workflow canvas, beneath the bananas_july.csv dataset.

3. Click on the Output port of the bananas_july.csv dataset block and drag a connection towards
the Input port of the Binning block.

4. Double-click on the Binning block.

A Binning editor opens.
5. From the Unselected Variables list, double click Mass(g) to move it to the Selected Variables list.
6. From the Binning type drop-down list, select Equal Height.
7. Click Bin Variables ( ).

Bins are created and displayed in the View Bins and Bin Statistics panes.
8. Press Ctrl+S to save the configuration.
9. Close the Binning editor by clicking the cross.
10.Right-click on the Binning block and select Configure Outputs.

An Outputs window is displayed. By default, only the Working Dataset is listed in Selected Output.
11.Double-click Binning Model to move it from Unselected Output to Selected Output and then click

Apply and Close.

The Binning block outputs a Working Dataset, which is the bananas_july.csv dataset with new
binning variables added, and a Binning Model.

12.Right-click on the dataset output from the Binning block, click Rename, type Bananas July
Binned and click OK.
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13.If necessary, expand the Scoring group in the Workflow palette, then click and drag a Score block
onto the Workflow canvas, beneath the bananas_august.csv dataset and Binning Model.

14.Click on the Output port of the bananas_august.csv dataset block and drag a connection towards
the Input port of the Score block.

15.Click on the Output port of the Binning Model and drag a connection towards the Input port of the
Score block.

16.Right-click on the dataset output from the Score block, click Rename and type Bananas August
Binned.

17.Expand the Scoring group in the Workflow palette, then click and drag a PSI block onto the Workflow
canvas, beneath the Bananas July Binned dataset and Bananas August Binned dataset.

18.Double-click on the PSI block.

A Configure PSI dialog box opens.
19.From the Configure PSI dialog box:

a. From the Reference dataset drop-down list, select Bananas July Binned.
b. From the Reference binned variable drop-down list, select Mass(g)_bin.
c. From the Current binned variable drop-down list, select Mass(g)_bin.
d. Leave the remaining options as default.

20.Click Apply and Close.

The Configure PSI dialog box closes. A green execution status is displayed in the Output port of
the PSI block and a PSI report is generated as an output block, displaying the PSI score as its label.
Double-clicking on the PSI report open a window giving further information. In addition to the PSI
report, other outputs can be specified for the PSI block by right-clicking and selecting Configure
Outputs.

You now have a workflow that bins observations in two datasets by a common variable and then uses
the PSI block to compare the two datasets by that variable.

Export group
Contains blocks that enable you to export data from a Workflow.

Data exported can be saved in either the current workspace or to the file system accessible through the
active Workflow link.

Chart Builder block ............................................................................................................................462
Enables you to export a working dataset to a variety of different charts.

Delimited File Export block ............................................................................................................... 475
Enables you to export a working dataset to a text file, specifying the field delimiters.
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Excel Export block .............................................................................................................................478
Enables you to export a dataset from a Workflow to an Excel Workbook.

Database Export block ...................................................................................................................... 481
Enables you to export a dataset from a Workflow to a specified database. This block has Include
in Auto Run disabled by default.

Tableau Export block ........................................................................................................................ 485
The Tableau Export block allows you to export an Altair Analytics Workbench dataset to Tableau
Data Extract file format (.tde) and, if required, uploaded to a Tableau server.

Dataset Export block ......................................................................................................................... 489
Enables you to export a WPD format dataset file (.wpd) to a specified location.

Chart Builder block

Enables you to export a working dataset to a variety of different charts.

Overview
This block can be invoked by dragging the block from the Workflow palette to the Workflow canvas and
then dragging a connection from a dataset to the Input port of the block.

Charts are created and edited using the Chart Builder editor, which is opened by double-clicking the
Chart Builder block. The Chart Builder editor is divided into five areas:

Note:
Changes to a chart must be saved for them to appear in the preview area or Chart Viewer output.

Chart Setup
At the top of the Chart Builder tab are the following options to configure labels and size for the chart:

Title
A title, displayed above the chart.

Footnote
A footnote, displayed below the chart.

Width
The width of the chart, in pixels.

Height
Specifies the height of the chart, in pixels.
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Plots
Allows you to add, delete and configure one or many plots to appear on the chart.

If there are multiple plots, the order of the plots can be changed, which determines their display order on
the chart.

Only plots compatible with the input dataset are displayed. If adding additional plots to a chart, the list of
available plots is further constrained to plots compatible with existing plots on that chart.

Each plot type has its own set of definable variables and parameters, which appear in the Options
panel.

Plot Type Plot Variables and Parameters

Band: Plots a series plot (line graph) together with
a shaded band.

X: the main series to be plotted.

Upper: the upper limit of the band.

Lower: the lower limit of the band.

Bubble: Plots isolated points from two variables,
one assigned to the x axis and one to the y axis.
Each point is represented by a bubble.

X: the variable to be plotted on the x axis.

Y: the variable to be plotted on the y axis.

Size: the variable used to determine the size of
each bubble.

Density Plots a density plot for a specified
variable, with the x axis showing variable values,
and the y axis showing density.

Variable: the variable to be plotted.

Ellipse: When selected in addition to a scatter plot,
draws an ellipse around values that fall within a
specified percentile of the total observations.

X: the variable to be plotted on the x axis.

Y: the variable to be plotted on the y axis.

High Low: Plots three series plots (line graphs) on
one axes: a main series and an upper and lower
series.

X: the main series to be plotted.

Upper: the upper series.

Lower: the lower series.

Histogram: Plots a histogram for a specified
variable, with the x axis showing automatically
binned variable values, and the y axis showing
percentages of the dataset's observations.

Variable: the variable to be plotted.

Horizontal Bar: Plots a horizontal bar graph
for a specified variable, with the y axis showing
variable values and the x axis showing frequency
of occurrence for those values.

Response variable: the variable to be plotted.
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Plot Type Plot Variables and Parameters

Horizontal Bar (parameterized): Plots a
horizontal bar graph for a specified variable,
categorised by another variable. The x axis
shows variable values and the y axis shows the
categories.

Category: the variable to be used for
categorisation.

Response: the variable to be plotted.

Horizontal Box: Plots a single variable on the
x axis, drawing a box centred on the variable's
median value, with sides set at the 25th and 75th
percentile. Also shown are whiskers on the left
and right sides of the box. The lower (left side)
whisker is the lowest value still within 1.5 times
the interquartile range of the lower quartile. The
upper (right side) whisker is the highest value still
within 1.5 times the interquartile range of the upper
quartile.

Response variable: the variable to be plotted.

Horizontal Line: Plots a line graph for a specified
variable, with the y axis showing variable values,
and the x axis showing frequency of occurrence.

Response variable: the variable to be plotted.

LOESS: Plots isolated points from two variables,
one assigned to the x axis and one to the y axis.
Each point is represented by a diamond. Also
performs a LOESS (Locally Weighted Scatterplot
Smoothing) fit to the data and plots this as a dotted
line on the same axes.

X: the variable to be plotted on the x axis.

Y: the variable to be plotted on the y axis.

Needle: Plots isolated points from two variables,
one assigned to the x axis and one to the y axis.
Each point is joined to the x axis with a line.

X: the variable to be plotted on the x axis.

Y: the variable to be plotted on the y axis.

Penalized B-Spline: Plots isolated points from two
variables, one assigned to the x axis and one to
the y axis. Each point is represented by a diamond.
Also performs a Penalized B-Spline fit on the
dataset and plots this as a dotted red line on the
same axes.

X: the variable to be plotted on the x axis.

Y: the variable to be plotted on the y axis.

Regression: Plots isolated points from two
variables, one assigned to the x axis and one to
the y axis. Each point is represented by a diamond.
Also performs a linear regression on the dataset
and plots the resultant model as a dotted red line
on the same axes.

X: the variable to be plotted on the x axis.

Y: the variable to be plotted on the y axis.

Scatter: Plots isolated points from two variables,
one assigned to the x axis and one to the y axis.
Each point is represented by a diamond.

X: the variable to be plotted on the x axis.

Y: the variable to be plotted on the y axis.
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Plot Type Plot Variables and Parameters

Series: Plots points from two variables, one
assigned to the x axis and one to the y axis. All
points are joined directly with lines.

X: the variable to be plotted on the x axis.

Y: the variable to be plotted on the y axis.

Step: Plots points from two variables, one
assigned to the x axis and one to the y axis. All
points are joined with horizontal and vertical lines,
creating steps.

X: the variable to be plotted on the x axis.

Y: the variable to be plotted on the y axis.

Vector: Plots points from two variables, one
assigned to the x axis and one to the y axis. Each
point is treated as the end-point of a vector, plotted
with an arrow; with the start point as the origin.

X: the variable to be plotted on the x axis.

Y: the variable to be plotted on the y axis.

Vertical Bar: Plots a vertical bar graph for a
specified variable, with the x axis showing variable
values and the y axis showing frequency of
occurrence for those values.

Response variable: the variable to be plotted.

Vertical Bar (parameterized): Plots a horizontal
bar graph for a specified variable, categorised by
another variable. The y axis shows variable values
and the x axis shows the categories.

Category: the variable to be used for
categorisation.

Response: the variable to be plotted.

Vertical Box: Plots a single variable on the y
axis, drawing a box centred on the variable's
median value, with sides set at the 25th and 75th
percentile. Also shown are whiskers above and
below the box. The lower whisker is the lowest
value still within 1.5 times the interquartile range of
the lower quartile. The upper whisker is the highest
value still within 1.5 times the interquartile range of
the upper quartile.

Response variable: the variable to be plotted.

Vertical Line: Plots a line graph for a specified
variable, with the y axis showing variable values,
and the x axis showing frequency of occurrence.

Response variable: the variable to be plotted.

Note:
Multiple chart types can be combined on the same axis by clicking the New plot button ( ) and
specifying a second plot. Not all chart types can be combined.

Options
The options panel displays options specific to the currently selected plot type. To select a plot type,
select its check box in the Plots panel.
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Plot specific options
This section has the same title as the plot type selected (for example: Scatter, Series, and so on)
and lists options tailored to that plot type. The table below lists and describes every plot option.

Plot Option Description

Group Chooses which variable to group plotted
elements by, with the grouping shown on the
plot by style and colour.

Legend Label The text that appears next to the chart's legend.

Marker or Markers When enabled, uses a larger marking for each
data point.

Missing Displays missing values on the chart.

No missing variable Displays missing variables on the chart.

No missing group Displays missing groups on the chart.

Frequency Specifies a frequency variable in the input
data set, determining how many times each
observation counts. Only accepts integer values
– decimal values will be truncated.

Break Allows a break in data points from missing
values when drawing a contiguous plot.

Data label Specifies a variable to use as a label for each
data point.

Degree Degrees of freedom.

Statistic Selects a statistic to use for the plot.

Response variable Specifies a response variable.

Alpha The percentile of the total observations that lie
outside the plotted area.

Smooth The smoothing parameter. Must be positive.

Category Specifies a category variable.

Type Specifies the distribution type.

Clip Clips an ellipse plot, if necessary, so that it
doesn't extend past the plot axes.

Weight Specifies a weighting variable in the input data
set, determining the degree by which each
observation counts. Accepts positive integer
and decimal values.

Style Options
The list of style options presented in this section is tailored to the currently selected plot type. The
table below lists and describes every option.
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Style Option Description

Transparency Transparency for the plot, where 1.00 is
completely transparent and 0.00 is completely
opaque.

Fill Select to fill the plot areas (for example, bars
for a histogram) with a colour. If no fill style is
chosen, a default colour will be allocated to the
bars.

Fill style select to enable fill colour and transparency
options. If not selected, a default fill style will be
chosen.

Fill colour Click to choose the fill colour.

Fill transparency Transparency for the fill, where 1.00 is
completely transparent and 0.00 is completely
opaque.

Outline Draws a border around the plot.

Line style Select to enable line colour and thickness
options. If not selected, a default line style and
colour will be chosen.

Line colour Click to choose the plot line colour.

Line thickness Click to choose the plot line thickness.

Axes Options
Some plot types allow a second X axis and or a second Y axis to be specified. If selected, each
option flips the axis to a location opposite to its default position.

Style Options
The list of style options presented in this section is tailored to the currently selected plot type. The table
below lists and describes every option.

Chart Builder Preferences

Allows you to set axes and basic charting options.

By Variables
Generates separate charts for each unique value in the specified variables. The charts can be viewed in
the Chart Builder preview pane using the left and right arrow buttons, whereas Chart Viewer will generate
thumbnails for each chart that can then be selected to view the full chart. To use the By Variables
function, the selected variables must be sorted, so that all observations are grouped together by value.
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X Axis, Y Axis, Second X Axis, and Second Y Axis
Configures the X Axis, Y Axis, Second X Axis, and Second Y Axis. There is a tab for each axis, each
with the same options, as described below.

Display
Check boxes are used to choose the following axis features:

• Label: A label for the axis, placed centrally and on the side of the axis outside the plot area.
• Line: Displays an axis line. When a chart has a border, this line option may not be noticeable.
• Ticks: Markers for each numeric value shown adjacent to the axis.
• Values: Numeric values shown adjacent to the axis. These values are chosen automatically

and cannot be edited.
• Grid: Lines extending across the plot area from each numeric value.

Axis
Allows you to specify the following axis features:

• Type: Choose from:

‣ Discrete: Dataset values determine tick placement.
‣ Linear: Ticks are spaced evenly based on minimum and maximum values.
‣ Log: Logarithmic scale with base 10.
‣ Time: If the axis variable is formatted as date or time in the input dataset, this option

formats the axis as date or time, as applicable. If this option is not selected, the axis will
display numerical values instead.

• Tick placement: When a logarithmic axis type is chosen, tick placement can either also be
logarithmic at intervals of log(x) or log(y) (where x or y are integers); or linear, where ticks are
spaced linearly and chosen automatically based on minimum and maximum values.

• Log base: Choose the log base for the tick placement.
• Label: Enter text for the axis label, which will be centred on the axis. There is no limit for the

length of the label, although if the label exceeds the axis length it will be truncated at both
ends.

• Min: Specifies a starting value for the axis. If this field is left blank, the smallest value from the
plotted variable will be chosen.

• Max: Specifies an ending value for the axis. If this field is left blank, the largest value from the
plotted variable will be chosen.

• Offset min: Specifies an offset for the start of the axis plot area away from the origin. Enter a
fractional value equal to the proportion the offset is to be relative to the total axis range.

• Offset max: Specifies an offset for the end of the axis plot area away from the origin. Enter a
fractional value equal to the proportion the offset is to be relative to the total axis range.

• Integer: Forces ticks to be at integer values.
• Minor: Inserts minor ticks between major ticks. Only applies when Type is set to Log or Time.
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• Reverse: Reverses the axis, so the last observation in the dataset is plotted first (on the left
hand end of the axis), and the first observation plotted last (on the right hand end of the axis).

• Fit Policy. Allows you to choose how large axis labels are fitted in the event of them
overlapping. Choose from:

‣ None: Leaves the labels overlapped.
‣ Rotate: If labels overlap, this option will rotate them by 45 degrees.
‣ Rotate thin: If labels overlap, this option first tries rotating them by 45 degrees. If labels still

overlap after the rotation, alternate labels will be removed.
‣ Stagger: If labels overlap, this option creates two rows for labels and splits the labels

between the rows alternately.
‣ Stagger rotate: If labels overlap, this option tries creating two rows for the labels, splitting

labels between the rows alternately. If the labels still overlap, this option will then try rotating
the labels by 45 degrees.

‣ Stagger thin: If labels overlap, this option tries creating two rows for the labels, splitting
labels between the rows alternately. If the labels still overlap, this option will then try
removing alternate labels.

‣ Thin: If labels overlap, this option removes alternate labels.

Style
Allows you to specify font and colour for axis labels and axis values.
Penalized B-Spline and Regression plots also have a Show individual prediction limits option,
which displays 95% prediction limits for each point. The default label for individual prediction
limits is 95% Prediction Limits, although this can be changed by entering text in the Individual
prediction limits text box.

Chart Builder Chart View

Displays the results of the Chart Builder block.

To open the Chart Builder Chart View, double-click on the Chart Builder block output. If there are
multiple charts, specified by using the By Variables function in Chart Builder, thumbnails of these are
displayed on the left hand side, with the full chart displayed on the right hand side when each thumbnail
is selected.

Note:
Changes to a chart must be saved for them to appear in the Chart Viewer output.

Chart Editor
Double-click the Resize Chart button at the top right of the Chart Viewer to open the Chart Editor
window.
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To copy the chart to the clipboard, click Copy Chart. The size of the copied chart is determined by the
size of the Chart Editor window when the chart is copied.

Chart Builder block basic example: creating a chart with a scatter plot

This example demonstrates how the Chart Builder block can be used to create chart containing a basic
scatter plot.

In this example, a dataset named bananas.csv is imported into a blank Workflow. The dataset
describes a crop of bananas, with each observation representing an individual banana. A Chart Builder
block is configured to produce a scatter plot of the variables Length(cm) and Mass(g).

Workflow Layout

Dataset used

The file used in this example can be found in the samples distributed with Altair SLC.

This example uses a dataset named bananas.csv. Each observation in the dataset describes a
banana, with numeric variables Length(cm) and Mass(g) giving each banana's measured length in
centimetres and mass in grams respectively.

Using the Chart Builder block to create a chart with a scatter plot

Using the Chart Builder block to create a chart containing a scatter plot of two variables.

1. Import the bananas.csv dataset into a blank Workflow. Importing a CSV file is described in Text File
Import block  (page 220).

2. Expand the Export group in the Workflow palette, then click and drag a Chart Builder block onto the
Workflow canvas, beneath the bananas.csv dataset.
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3. Click on the bananas.csv dataset block's Output port and drag a connection towards the Input port
of the Chart Builder block.

Alternatively, you can dock the Chart Builder block onto the dataset block directly.
4. Double-click on the Chart Builder block.

The Chart Builder view opens.
5. From the Chart Builder view:

a. In Title, type Banana Length vs Mass.
b. At the top of the Plots area, from the drop-down list select Scatter.

An X and Y drop-down are displayed.
c. In the X drop-down list, select Length(cm).
d. In the Y drop-down list, select Mass(g).

6. Press Ctrl+S to save the configuration.

After a pause, a preview of the chart is displayed in the Preview area.
7. Click the cross to close the Chart Builder view.

The Chart Builder view closes. A green execution status is displayed in the Output port of the Chart
Builder block.

8. Right click on the Chart Viewer block, click Rename and type Banana Length vs Mass.
9. Double-click the Banana Length vs Mass chart viewer block.

The chart showing the scatter plot for the specified variables is displayed.
10.Click the cross to close the chart.

You have created a chart containing a scatter plot of the variables Length(cm) and Mass(g).

Chart Builder block example: creating a chart with scatter and
regression plots

This example demonstrates how the Chart Builder block can be used to create a chart with both a
scatter plot and a regression line.

In this example, a dataset named Bananas.csv is imported into a blank Workflow. The dataset
describes a crop of bananas, with each observation representing an individual banana. A Chart Builder
block is configured to produce a scatter plot of the variables length(cm) and mass(g). A regression
plot with confidence limits is added to the chart.
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Workflow Layout

Dataset used

The file used in this example can be found in the samples distributed with Altair SLC.

This example uses a dataset named Bananas.csv. Each observation in the dataset describes a
banana, with numeric variables Length(cm) and Mass(g) giving each banana's measured length in
centimetres and mass in grams respectively.

Using the Chart Builder block to create a chart with scatter and regression plots

Using the Chart Builder block to create a chart containing a scatter plot of two variables, including a
regression line with confidence limits.

1. Import the Bananas.csv dataset into a blank Workflow. Importing a CSV file is described in Text File
Import block  (page 220).

2. Expand the Export group in the Workflow palette, then click and drag a Chart Builder block onto the
Workflow canvas, beneath the Bananas dataset.

3. Click on the Bananas.csv dataset block's Output port and drag a connection towards the Input port
of the Chart Builder block.

Alternatively, you can dock the Chart Builder block onto the dataset block directly.
4. Double-click on the Chart Builder block.

The Chart Builder view opens.
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5. From the Chart Builder view:

a. In Title, type Banana Mass vs Length.
b. At the top of the Plots area, from the drop-down list select Scatter.

An X and Y drop-down are displayed.
c. In the X drop-down list, select Length(cm).
d. In the Y drop-down list, select Mass(g).
e. At the top right of the Plots area, click the plus icon ( ).

A new drop-down selector appears in the Plots area.
f. From the new drop-down selector, choose Regression.
g. In the X drop-down list, select Length(cm).
h. In the Y drop-down list, select Mass(g).
i. Select the checkbox to the right of the drop-down list that shows Regression.
j. Under Style on the right-hand side of the Chart Builder view, select the Mean value confidence

limits checkbox and set Transparency to 0.50
6. Press Ctrl+S to save the configuration.

After a short pause, a preview of the chart is displayed in the Preview area.
7. Click the cross to close the Chart Builder view.

The Chart Builder view closes. A green execution status is displayed in the Output port of the Chart
Builder block.

8. Right click on the Chart Viewer block, click Rename and type Banana Length vs Mass.
9. Double-click the Banana Length vs Mass chart viewer block.

The chart showing the scatter plot for the specified variables is displayed.
10.Click the cross to close the chart.

You have created a chart containing a scatter plot of the variables Length(cm) and Mass(g), including
a regression line with confidence limits.

Chart Builder block example: creating a chart with multiple density
plots

This example demonstrates how the Chart Builder block can be used to create a chart containing five
density plots, each corresponding to a different variable in the input dataset.

In this example, a dataset named Bananas-Multiple.csv is imported into a blank Workflow. The
dataset describes crops of bananas from different regions of the world. A Chart Builder block is
configured to produce density plots of the variables for banana mass from different regions: Mass(g)-
In, Mass(g)-Ch, Mass(g)-Ph, Mass(g)-Col and Mass(g)-Ec.
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Workflow Layout

Datasets used

The file used in this example can be found in the samples distributed with Altair SLC.

This example uses a dataset named Bananas-Multiple.csv. The dataset contains the length
and mass of bananas. The numeric variable Length(cm) gives the length in centimetres, with the
corresponding masses in grams for that length from different regions given by the numeric variables
Mass(g)-In, Mass(g)-Ch, Mass(g)-Ph, Mass(g)-Col and Mass(g)-Ec.

Using the Chart Builder block to create a chart with multiple density plots

Using the Chart Builder block to create a chart containing five density plots, each for a variable
describing the mass of bananas from a different region.

1. Import the Bananas-Multiple.csv dataset into a blank Workflow. Importing a CSV file is
described in Text File Import block  (page 220).

2. Expand the Export group in the Workflow palette, then click and drag a Chart Builder block onto the
Workflow canvas, beneath the Bananas-Multiple.csv dataset.

3. Click on the Bananas-Multiple.csv dataset block's Output port and drag a connection towards
the Input port of the Chart Builder block.

Alternatively, you can dock the Chart Builder block onto the dataset block directly.
4. Double-click on the Chart Builder block.

The Chart Builder view opens.
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5. From the Chart Builder view:

a. In Title, type Banana Mass by Region.
b. In Footnote, type Distribution of banana mass (g) for different countries of

origin.
c. At the top of the Plots area, select Density from the drop-down list.
d. In the Variable drop-down list, select Mass(g)-In.
e. Select the checkbox to the right of Density, then in Legend Label under Options on the right-

hand side, type India.
f. At the top right of the Plots area, click the plus icon ( ).

A new drop-down selector appears in the Plots area.
6. Now repeat steps 5.c to 5.f inclusive for the remaining variables as follows:

a. Mass(g)-Ch, with Legend Label China.
b. Mass(g)-Ph, with Legend Label Phillipines.
c. Mass(g)-Col, with Legend Label Colombia.
d. Mass(g)-Ec, with Legend Label Ecuador, but do not carry out step 5.f.

7. Press Ctrl+S to save the configuration.

After a short pause, a preview of the chart is displayed in the Preview area.
8. Click the cross to close the Chart Builder view.

The Chart Builder view closes. A green execution status is displayed in the Output port of the Chart
Builder block.

9. Right click on the Chart Viewer block, click Rename and type Banana Mass by Region.
10.Double-click the Banana Mass by Region chart viewer block.

The chart showing density plots for the specified variables is displayed.
11.Click the cross to close the chart.

You have created a chart containing five density plots, each for a variable describing the mass of
bananas from a different region..

Delimited File Export block

Enables you to export a working dataset to a text file, specifying the field delimiters.

This block can be invoked by dragging the block from the Workflow palette to the Workflow canvas and
then dragging a connection from a dataset to the Input port of the block.

Exporting a dataset is configured using the Configure Delimited File Export dialog box. To open the
Configure Delimited File Export dialog box, double-click the Delimited File Export block.
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Format

Delimiter
Specifies the character used to mark the boundary between variables in an observation of
the exported dataset.

If the required delimiter is not listed, select Other and enter the character to use as the
delimiter for exported dataset.

Write headers to first row
Specifies that the names of the variables in the input dataset are written as column
headings to the first row of the exported file.

Workspace
Specifies that the location of the file is in the current workspace.

Workpace files specified using Workspace can only be imported when using the Local
Engine.

External
Specifies that the location of the file is on the file system accessible from the device running
the Workflow Engine.

External files specified using External can be imported when using either a Local Engine
or a Remote Engine.

Path
Specifies the path and file name for the file containing the output dataset. If you enter the
path:

• When exporting a dataset to the Workspace, the root of the path is the Workspace. For
example, to export a file to a project named datasets, the path is:

/datasets/filename

• When exporting a file to an external location, the path is the absolute (full) path to the file
location.

The path to the file is only valid for the Workflow Engine enabled when the Workflow
is created. This path will need to be re-entered if the Workflow is used with a different
Workflow Engine.

If you do not know the path to the file, click Browse and navigate to the required dataset in
the Choose file dialog box.
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Delimited File Export block basic example: exporting a dataset to a
delimited file

This example demonstrates how the Delimited File Export block can be used to export a dataset to a
tab separated variables (.tsv) file.

In this example, a dataset named lib_books.csv is imported into a blank Workflow. The dataset
contains information about books. A Delimited File Export block is configured to export the dataset to a
tab separated variables (.tsv) file.

Workflow Layout

Dataset used

The file used in this example can be found in the samples distributed with Altair SLC.

This example uses about dataset of books, named lib_books.csv. Each observation in the dataset
describes a book, with variables such as Title, ISBN and Author.

Delimited File Export block basic example: exporting a dataset to a delimited file

Using the Delimited File Export block to export a dataset to a tab separated variables (.tsv) file.

1. Import the lib_books.csv dataset into a blank Workflow. Importing a CSV file is described in Text
File Import block  (page 220).

2. Expand the Export group in the Workflow palette, then click and drag a Delimited File Export block
onto the Workflow canvas, beneath the lib_books.csv dataset.

3. Click on the lib_books.csv dataset block's Output port and drag a connection towards the Input
port of the Delimited File Export block.

Alternatively, you can dock the Delimited File Export block onto the dataset block directly.
4. Double-click on the Delimited File Export block.

The Configure Delimited File Export dialog box opens.
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5. From the Configure Delimited File Export dialog box:

a. In the Delimiter drop-down list, select Tab.
b. Select the Write headers to first row checkbox.
c. Under File Location, select External.
d. To the right of Path, click Browse.

A Save File As dialog box opens.
e. Browse to and select a suitable location to save the file.
f. In Filename, type a name for the file, including the extension .tsv.
g. Click Finish.
h. Click Apply and Close.

The Configure Delimited File Export dialog box closes. A green execution status is displayed in the
Output port of the Delimited File Export block.

You have now exported the lib_books.csv dataset to a tab separated variables (.tsv) file in the
specified location.

Excel Export block

Enables you to export a dataset from a Workflow to an Excel Workbook.

This block can be invoked by dragging the block from the Workflow palette to the Workflow canvas and
then dragging a connection from a dataset to the Input port of the block.

Exporting a dataset to Microsoft Excel is configured using the Configure Excel Export dialog box. To
open the Configure Excel Export dialog box, double-click the Excel Export block.

Format
Specifies the Excel Workbook version of the saved file containing the exported dataset. The
format options are:

• Excel 2007-2013 Workbook (.xlsx)
• Excel 97-2003 Workbook .(xls)

Write headers to first row
Specifies that the names of the variables in the input dataset are written as column
headings to the first row of the exported file.

File Location
Specifies where the file containing the output dataset is located.

Workspace
Specifies the location of file containing the dataset is the current workspace.

Workspace datasets are only accessible when using the Local Engine.
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External
Specifies the location of the file containing the dataset is on the file system accessible from
the device running the Workflow Engine.

External files are accessible when using either a Local Engine or a Remote Engine.

Path
Specifies the path and file name for the file containing the output dataset. If you enter the
path:

• When exporting a dataset to the Workspace, the root of the path is the Workspace. For
example, to export a file to a project named datasets, the path is:

/datasets/filename

• When exporting a file to an external location, the path is the absolute (full) path to the file
location.

The path to the file is only valid for the Workflow Engine enabled when the Workflow
is created. This path will need to be re-entered if the Workflow is used with a different
Workflow Engine.

If you do not know the path to the file, click Browse and navigate to the required dataset in
the Choose file dialog box.

Excel Export block basic example: exporting a dataset to an Excel
workbook file

This example demonstrates how an Excel Export block can be used to export a dataset to an Excel
workbook file (.xlsx).

In this example, a dataset named lib_books.csv is imported into a blank Workflow. The dataset
contains information about books. A Excel Export block is configured to export the dataset to an Excel
workbook file (.xlsx).

Workflow Layout
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Dataset used

The file used in this example can be found in the samples distributed with Altair SLC.

This example uses about dataset of books, named lib_books.csv. Each observation in the dataset
describes a book, with variables such as Title, ISBN and Author.

Excel Export block basic example: exporting a dataset to an Excel workbook file

Using an Excel Export block to export a dataset to an Excel workbook (.xlsx) file.

1. Import the lib_books.csv dataset into a blank Workflow. Importing a CSV file is described in Text
File Import block  (page 220).

2. Expand the Export group in the Workflow palette, then click and drag a Excel Export block onto the
Workflow canvas, beneath the lib_books.csv dataset.

3. Click on the lib_books.csv dataset block's Output port and drag a connection towards the Input
port of the Excel Export block.

Alternatively, you can dock the Excel Export block onto the dataset block directly.
4. Double-click on the Excel Export block.

The Configure Excel Export dialog box opens.
5. From the Configure Excel Export dialog box:

a. Under Format, select Excel Workbook (xlsx).
b. Select the Write headers to first row checkbox.
c. Under File Location, select External.
d. To the right of Path, click Browse.

A Save File As dialog box opens.
e. Browse to and select a suitable location to save the file.
f. In Filename, type a name for the file, including the extension .xlsx.
g. Click Finish.
h. Click Apply and Close.

The Configure Excel Export dialog box closes. A green execution status is displayed in the Output
port of the Excel Export block.

You have now exported the lib_books.csv dataset to an Excel workbook (.xlsx) file in the specified
location.

480



Altair Analytics Workbench user guide
Version 2023

Database Export block

Enables you to export a dataset from a Workflow to a specified database. This block has Include in
Auto Run disabled by default.

First steps
This block can be invoked by dragging the block from the Workflow palette to the Workflow canvas and
then dragging a connection from a dataset to the Input port of the block. If any database references have
already been created for Workflow, for example added from the Workflow Settings tab, then double-
clicking on a new Database Export block will open the Configure Database Export  (page 481) tab.

If no database references have been created for Workflow, then double-clicking on a new Database
Export block will take you straight to the Add Database wizard, which will guide you through creating
a new database reference. For guidance on completing the wizard, see Database References  (page
175). The newly added database will then appear in the Configure Database Export  (page 481)
tab.

Include in Auto Run
By default, the Database Export block has Include in Auto Run disabled, so to run the block you need
to right-click on it, then from the pop-up menu select Run Block, then Run to Block.

Configure Database Export

Enables configuration of the export of an Altair Analytics Workbench dataset to a target database.

Export Type
Specifies the type of export to be carried out. Choose from:

• Append to existing table: the dataset will be added to an existing Target Table within the Target
Database.

• Truncate existing table and insert: Selecting this option will delete all existing data in the Target
Table (but retain that table's structure) and replace it with the exported data.

• Create new table: Selecting this option will use the exported data to create a new Target Table
within the Target Database. If the specified Target Table already exists, it will be deleted completely.
If the specified Target Table does not exist, a new table will be created. When this option is selected,
a warning is displayed. To suppress this warning, deselect Warn when switching to destructive
export types or deselect this same option from Workbench Preferences under Workflow and then
Database Export.

The Target Table and Target Database are specified in the Database Parameters panel.
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Database Parameters
Target Database

Specifies the target database from a list of database references known to Workflow. To add a
new database reference, click the Create a new database button ( ), which launches the Add
Database wizard. For guidance on completing the wizard, see Database References  (page
175).

Target table
If Export type is set to Append to existing table or Truncate existing table and insert, displays
a list of all tables within the specified Target Database. Choose the table that the dataset will be
exported to.
If Export type is set to Create new table, allows you to specify a name for the new table. If the
specified name already exists, that existing table will be deleted and replaced. If the specified
name does not exist, a new table will be created.

Input Columns and Exported Columns
Input Columns lists variables from the input dataset which can be added as columns to the target
database. Exported Columns lists variables from the input dataset that will be added to the target
database. To move an item from one list to the other, double-click on it. Alternatively, click on the
item to select it and use the appropriate single arrow button. A selection can also be a contiguous
list chosen using Shift and click, or a non-contiguous list using Ctrl and click. Use the Select
all button ( ) or Deselect all button ( ) to move all the items from one list to the other.

Use the Apply variable lists button ( ) to move a set of variables from one list to another.

Use the filter box ( ) on either list to limit the variables displayed, either using a text filter, or a
regular expression. This choice can be set in the Altair page in the Preferences window. As you
enter text or an expression in the box, only those variables containing the text or expression are
displayed in the list.
If you are appending or truncating, Target Column allows you to specify the column the variable
will be exported to (from compatible columns) and Target Type displays the data type. If a
column in the Target database's Target table matches the variable name and type, this will be
automatically selected. If you are creating a new table, the Target Column and Target Type must
be specified.

Database Export block basic example: exporting a dataset to an
Oracle database

This example demonstrates how the Database Export block can be used to export a dataset to an
Oracle database.

In this example, a dataset containing information about books, named lib_books.csv, is imported into
a blank Workflow. The dataset contains information about books. A Database Export block is configured
to export specified variables from the dataset to a new table in an existing Oracle database.
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Workflow Layout

Dataset used

The file used in this example can be found in the samples distributed with Altair SLC.

This example uses about dataset of books, named lib_books.csv. Each observation in the dataset
describes a book, with variables such as Title, ISBN and Author.

Database Export block basic example: exporting a dataset to an Oracle database

Using a Database Export block to export specified variables from a dataset to a new table in an existing
Oracle database.

This task requires write access to an Oracle database and permission to create a new table in that
database.

1. Import the lib_books.csv dataset into a blank Workflow. Importing a CSV file is described in Text
File Import block  (page 220).

2. Expand the Export group in the Workflow palette, then click and drag a Database Export block onto
the Workflow canvas, beneath the lib_books.csv dataset.

3. Click on the lib_books.csv dataset block's Output port and drag a connection towards the Input
port of the Database Export block.

Alternatively, you can dock the Database Export block onto the dataset block directly.
4. Double-click on the Database Export block.

Because this is a new Workflow with no existing database connections, an Add Database wizard is
displayed.
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5. From the Add Database wizard:

a. Select Oracle from the Database type drop-down list and click Next.
b. Enter the Net service name.
c. Choose the authentication method from the Authentication drop-down list. If you choose

Credentials, then enter a Username and Password. If you choose Auth domain, then choose an
Auth domain from the drop-down list.

d. Click Connect.

A Connection successful message is displayed.
e. Click OK on the Connection successful message, then click Next.
f. Click Next.
g. Choose the Schema and then click Next.
h. In the Name box, enter OracleExportExample and click Finish.

The Add Database wizard closes and a Configure Database Export view is displayed, with Target
database automatically set to OracleExportExample.

6. From the Export Type pane on the left-hand side:

a. Select Create new table.
b. Click Yes at the Confirmation Required message (if displayed).

7. From the Database Parameters pane:

a. In Target table, type Books.
b. From the Input Columns list, double-click Title, Dewey_Decimal_Number and Author.

The specified columns are added to the Exported Columns list.
8. Press Ctrl+S to save the configuration.
9. Click the cross to close the Configure Database Export view.

The Configure Database Export view closes.
10.Right click on the Database Export block and from the pop-up menu, select Run Block, then Run to

Block.

The Database Export block runs, and when the database upload is complete a green execution
status is displayed in the block's Output port.

You have now exported specified variables from the lib_books.csv dataset to an existing Oracle
database in a new table, named Books.
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Tableau Export block

The Tableau Export block allows you to export an Altair Analytics Workbench dataset to Tableau Data
Extract file format (.tde) and, if required, uploaded to a Tableau server.

Pre-requisite
This block can be invoked by dragging the block from the Workflow palette to the Workflow canvas and
then dragging a connection from a dataset to the Input port of the block. To use the Tableau Export
block, you must have the Tableau Software Developer Kit (SDK) installed. The Tableau SDK is available
from the Tableau website.

Include in Auto Run
By default, the Tableau Export block has Include in Auto Run disabled, so to run the block you need to
right-click on it, then from the pop-up menu select Run Block, then Run to Block.

Configure Tableau Export

Enables configuration of the export of an Altair Analytics Workbench dataset to a Tableau Data Extract
file format (.tde) and, if required, upload to a Tableau server.

Opening the Configure Tableau Export dialog box
To open the Configure Tableau Export dialog box, double-click the Tableau Export block.

File Location
Choose from:

• Workspace, to use an Altair Analytics Workbench workspace.
• External, to use an external folder.

Path
Type a filename in the box and click Browse to open either a Workspace browser or file system browser,
depending on which option is selected above.

Click OK to export the file.

Server Upload
If Perform Upload is selected, when the block is run the Tableau file will be uploaded to a Tableau
Server with specified details:

• Hostname: the hostname for the Tableau server you want to upload to.
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• Site ID: the Tableau server Site ID.
• Project: the name of the Tableau project on the Tableau server.
• Datasource: the name of the data source on the Tableau server.
• User name: the user name to connect to the Tableau server as.
• Password: the password for the specified user name.

Tableau Export block basic example: exporting a dataset to a Tableau
file

This example demonstrates how the Tableau Export block can be used to export a dataset to a Tableau
file (.tde).

In this example, a dataset named lib_books.csv is imported into a blank Workflow. The dataset
contains information about books. A Tableau Export block is configured to export the dataset to a
Tableau file (.tde).

Workflow Layout

Dataset used

The file used in this example can be found in the samples distributed with Altair SLC.

This example uses about dataset of books, named lib_books.csv. Each observation in the dataset
describes a book, with variables such as Title, ISBN, Author .

Tableau Export block basic example: exporting a dataset to a Tableau file

Using a Tableau Export block to export a dataset to a Tableau file (.tde).

1. Import the lib_books.csv dataset into a blank Workflow. Importing a CSV file is described in Text
File Import block  (page 220).

2. Expand the Export group in the Workflow palette, then click and drag a Tableau Export block onto
the Workflow canvas, beneath the lib_books.csv dataset.
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3. Click on the lib_books.csv dataset block's Output port and drag a connection towards the Input
port of the Tableau Export block.

Alternatively, you can dock the Tableau Export block onto the dataset block directly.
4. Double-click on the Tableau Export block.

The Configure Tableau Export dialog box opens.
5. From the Configure Tableau Export dialog box:

a. Under File Location, select External.
b. To the right of Path, click Browse.

A Save File As dialog box opens.
c. Browse to and select a suitable location to save the file.
d. In Filename, type a name for the file, including the extension .tde.
e. Click Finish.
f. Click Apply and Close.

The Configure Tableau Export dialog box closes.
6. Right click on the Tableau Export block, labelled working dataset.tde. From the pop-up menu,

select Run Block, then Run to Block.

The Tableau Export block runs, and once file writing is complete a green execution status is
displayed in the block's Output port.

You have now exported the lib_books.csv dataset to a Tableau file (.tde) in the specified location.

Tableau Export block example: uploading a dataset to a Tableau
server

This example demonstrates how the Tableau Export block can be used to upload a dataset to a
Tableau server.

In this example, a dataset named lib_books.csv is imported into a blank Workflow. The dataset
contains information about books. A Tableau Export block is configured to upload a dataset to a
Tableau server.

Workflow Layout
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Dataset used

The file used in this example can be found in the samples distributed with Altair SLC.

This example uses about dataset of books, named lib_books.csv. Each observation in the dataset
describes a book, with variables such as Title, ISBN and Author.

Tableau Export block example: uploading a dataset to a Tableau server

Using a Tableau Export block to upload a dataset to a Tableau server.

1. Import the lib_books.csv dataset into a blank Workflow. Importing a CSV file is described in Text
File Import block  (page 220).

2. Expand the Export group in the Workflow palette, then click and drag a Tableau Export block onto
the Workflow canvas, beneath the lib_books.csv dataset.

3. Click on the lib_books.csv dataset block's Output port and drag a connection towards the Input
port of the Tableau Export block.

Alternatively, you can dock the Tableau Export block onto the dataset block directly.
4. Double-click on the Tableau Export block.

The Configure Tableau Export dialog box opens.
5. From the Configure Tableau Export dialog box:

a. Under Server Upload, select Perform upload.

The six server upload fields are enabled.
b. Hostname: Enter the hostname for the Tableau server you want to upload to.
c. Site ID: Enter the Tableau server Site ID.
d. Project: Enter the name of the Tableau project on the Tableau server.
e. Datasource: Enter the name of the data source on the Tableau server.
f. User name: Enter the user name to connect to the Tableau server as.
g. Password: Enter the password for the user name just entered.
h. Click Apply and Close.

The Configure Tableau Export dialog box closes.
6. Right click on the Tableau Export block, labelled working dataset.tde. From the pop-up menu,

select Run Block, then Run to Block.

The Tableau Export block runs, and once the server upload is complete a green execution status is
displayed in the block's Output port.

You have now uploaded the lib_books.csv dataset to a Tableau server.
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Dataset Export block

Enables you to export a WPD format dataset file (.wpd) to a specified location.

This block can be invoked by dragging the block from the Workflow palette to the Workflow canvas and
then dragging a connection from a dataset to the Input port of the block.

Exporting a dataset is configured using the Configure Dataset Export dialog box. To open the
Configure Dataset Export dialog box, double-click the Dataset Export block.

File Location
Specifies where the file containing the output dataset is located.

Workspace
Specifies the location of file containing the dataset is the current workspace.

Workspace datasets are only accessible when using the Local Engine.

External
Specifies the location of the file containing the dataset is on the file system accessible from
the device running the Workflow Engine.

External files are accessible when using either a Local Engine or a Remote Engine.

Path
Specifies the path and file name for the file containing the output dataset. If you enter the
path:

• When exporting a dataset to the Workspace, the root of the path is the Workspace. For
example, to export a file to a project named datasets, the path is:

/datasets/filename

• When exporting a file to an external location, the path is the absolute (full) path to the file
location.

The path to the file is only valid for the Workflow Engine enabled when the Workflow
is created. This path will need to be re-entered if the Workflow is used with a different
Workflow Engine.

If you do not know the path to the file, click Browse and navigate to the required dataset in
the Choose file dialog box.

Dataset Export block basic example: exporting a dataset to a file

This example demonstrates how an Dataset Export block can be used to export a dataset as a WPD
dataset file (.wpd).

In this example, a dataset named lib_books.csv is imported into a blank Workflow. The dataset
contains information about books. A Dataset Export block is configured to export the dataset to a WPD
dataset file (.wpd).
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Workflow Layout

Dataset used

The file used in this example can be found in the samples distributed with Altair SLC.

This example uses about dataset of books, named lib_books.csv. Each observation in the dataset
describes a book, with variables such as Title, ISBN and Author.

Dataset Export block basic example: exporting a dataset as a file

Using a Dataset Export block to export a dataset to a WPD dataset (.wpd) file.

1. Import the lib_books.csv dataset into a blank Workflow. Importing a CSV file is described in Text
File Import block  (page 220).

2. Expand the Export group in the Workflow palette, then click and drag a Dataset Export block onto
the Workflow canvas, beneath the lib_books.csv dataset.

3. Click on the lib_books.csv dataset block's Output port and drag a connection towards the Input
port of the Dataset Export block.

Alternatively, you can dock the Dataset Export block onto the dataset block directly.
4. Double-click on the Dataset Export block.

The Configure Dataset Export dialog box opens.
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5. From the Configure Dataset Export dialog box:

a. Select External.
b. To the right of Path, click Browse.

A Save File As dialog box opens.
c. Browse to and select a suitable location to save the file.
d. In Filename, type a name for the file, including the extension .wpd.
e. Click Finish.
f. Click Apply and Close.

The Configure Dataset Export dialog box closes. A green execution status is displayed in the
Output port of the Dataset Export block.

You have now exported the lib_books.csv dataset to a WPD dataset (.wpd) file in the specified
location.

SLC Hub group
Contains the blocks that enables you to deploy a Workflow to the Altair SLC Hub.

Hub Program block ........................................................................................................................... 492
Enables deployment of a Workflow to the Altair SLC Hub as an executable deployment services
program.

Program Inputs block ........................................................................................................................ 495
Enables you to import one or more Workflow or Hub parameters into the Workflow as a dataset for
part of an Altair SLC Hub executable deployment services program.

Program Results block ...................................................................................................................... 496
Enables output of a dataset in the Workflow as an Altair SLC Hub program result.

Setting up a Hub program from the Workflow ...................................................................................497
Creating a new Altair SLC Hub program from the Workflow
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Hub Program block

Enables deployment of a Workflow to the Altair SLC Hub as an executable deployment services
program.

Altair SLC Hub is an enterprise management tool. Altair SLC Hub can be managed either locally or
remotely using a web interface called the Altair SLC Hub web portal. When a Workflow is stored in
an Altair Analytics Workbench Project, it can be uploaded to the Altair SLC Hub as an executable
deployment services program. An Altair Analytics Workbench Project can be built into an artefact for
uploading to the Altair SLC Hub from Workbench. An artefact is a singular entity that can consist of
multiple files of programs that can be deployed to the Altair SLC Hub.

By default a Workflow contains the Program Inputs block and Program Results block instead of the
Hub Program block. The Hub Program block is made available by going to the Workflow Settings and
selecting the Use legacy Hub Program blocks option from the Hub tab.

A Hub Program block is edited through the Configure Hub Program dialog box. To open the Configure
Hub Program dialog box, double-click the Hub Program block.

The Hub Program block must be used with a Workflow stored in an Altair Analytics Workbench Project.
For more information see the Altair Analytics Workbench Projects  (page 57) section.

Program Tab
Program label

Specifies the label of the program on the Altair SLC Hub.

Program path
Specifies the endpoint of the Altair SLC Hub program.

Categories
Specifies one or more categories for the Altair SLC Hub program. Categories can be added and
removed using the Add and Remove buttons.

Parameters Tab
Parameters

Specifies parameters for the Altair SLC Hub program. Parameters can be added and removed
using the Add and Remove buttons.

Hub Parameter Definition
Specifies the attributes of a specified Hub parameter.

Name
Sets the name of the Altair SLC Hub parameter.

Label
Sets a label for the Altair SLC Hub parameter.

492



Altair Analytics Workbench user guide
Version 2023

Prompt
Sets the prompt message for the Altair SLC Hub parameter.

Hidden
Specifies that the parameter is hidden in the Altair SLC Hub interface.

Required
Specifies whether the Altair SLC Hub parameter is required or not.

Type
Specifies the type of Altair SLC Hub parameter. The following options are available:

• String
• Password
• Choice
• Integer
• Float
• Boolean
• Stream
• Date
• Time
• Date and Time

For more information on parameter types, see the Altair SLC Hub documentation.

Description Tab
Description

Enables you to specify a description for the Altair SLC Hub program.

For detailed information about the Altair SLC Hub or artefacts, see the Altair SLC Hub documentation.
For more information about using Altair SLC Hub in Workbench, see the Running an Altair SLC Hub
program  (page 73) section.

Input Parameters
Enables a representation of the input paramters in the Workflow as a dataset containing the default value
for each specified input parameter. A connection from this to another block serves as the start of the
Altair SLC Hub program.

Program Results
Defines the outputs of the Altair SLC Hub program. An output is added upon dragging a connection from
another block to the Program Results. The Program Results component can be opened by double-
clicking it.
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Results
Displays a list of each program output.

Hub Result Definition
Defines the outputs of the Altair SLC Hub program.

Name
Specifies the name of the result.

Result format
Specifies the format of the result. The following options are available:

• CSV
• XML
• JSON

For detailed information about the Altair SLC Hub or artefacts, see the Altair SLC Hub documentation.
For more information about using Altair SLC Hub in Workbench, see the Running an Altair SLC Hub
program  (page 73) section.

Setting up a legacy Hub program from the Workflow

Creating a new Altair SLC Hub program from the Workflow.

1. From the Project Explorer view, create, or reuse an existing Altair Analytics Workbench Project,
more information about Altair Analytics Workbench Projects can be found in the Projects  (page 51)
section. Create a Workflow within the Altair Analytics Workbench Project, or copy a Workflow in from
elsewhere and open it.

You can specify information for your Hub artefact, including the Group, Name and Version when
you are using the New Altair Analytics Workbench Project wizard to create an Altair Analytics
Workbench Project. Alternatively, you can right-click an existing Altair Analytics Workbench Project
and select Properties to fill out the information in Altair Analytics Workbench Project tab of the
Properties dialog box. For detailed information about Altair SLC Hub artefacts, see the Altair SLC
Hub documentation.

2. Open the Workflow, expand the SLC Hub group in the Workflow palette, then click and drag a Hub
Program block onto the Workflow canvas. The Hub Program block is made available by going to the
Workflow Settings and selecting the Use legacy Hub Program blocks option from the Hub tab.

3. Double-click on the Hub Program block.

A Configure Hub Program dialog box opens.
4. From the Configure Hub Program dialog box:

a. From the Program tab, set the endpoint for the program under Program path.
b. From the Parameters tab, add any desired parameters for your Altair SLC Hub program.
c. Click Ok.
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5. Begin the Altair SLC Hub program by connecting Input Parameters to other blocks that enable
dataset input.

6. At the end of the Workflow, connect all desired dataset outputs to the Program Results component. 
The Program Results component can be opened by double-clicking it, allowing you to configure the
name and types of each result.

The Altair SLC Hub program is completed and is now ready to be built as an Artefact and uploaded to
the Altair SLC Hub.

7. Right-click the Altair Analytics Workbench Project the Workflow is stored in and select Build Project. 
If the Build Automatically option is selected under Projects in the Workflow menu,  this step is not
needed.

The Workflow must be an included file in the Altair Analytics Workbench Project. To do this, right-
click the Altair Analytics Workbench Project, select Included Files to open a Properties dialog box,
ensure the WorkflowS  is selected and click Apply and close.

8. Right-click the Altair Analytics Workbench Project the Workflow is stored in and select Upload to
Hub, if not already logged in to the Altair SLC Hub, a Hub login window appears where credentials
can be entered.

The artefact is now uploaded to the Altair SLC Hub. For more information about using the Altair SLC
Hub, for example, using the Hub to deploy the artefact, see the Altair SLC Hub documentation.

Program Inputs block

Enables you to import one or more Workflow or Hub parameters into the Workflow as a dataset for part
of an Altair SLC Hub executable deployment services program.

Altair SLC Hub is an enterprise management tool. Altair SLC Hub can be managed either locally or
remotely using a web interface called the Altair SLC Hub web portal. When a Workflow is stored in
an Altair Analytics Workbench Project, it can be uploaded to the Altair SLC Hub as an executable
deployment services program. An Altair Analytics Workbench Project can be built into an artefact for
uploading to the Altair SLC Hub from Workbench. An artefact is a singular entity that can consist of
multiple files of programs that can be deployed to the Altair SLC Hub.

The Program Inputs block is edited using the Configure Program Inputs dialog box. To open the
Configure Program Inputs dialog box, double-click the Program Inputs block.

For more information about building a Workflow into an Altair SLC Hub program, see the Setting up a
Hub program from the Workflow  (page 497) section.

Configure Program Inputs
Specifies parameters for the Altair SLC Hub program. An existing parameter can be added to the
Hub Program by moving it from the Unselected Parameters list to the Selected Parameters
list. To move an item from one list to the other, double-click on it. Alternatively, click on the item
to select it and use the appropriate single arrow button. A selection can also be a contiguous
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list chosen using Shift and click, or a non-contiguous list using Ctrl and click. Use the Select
all button ( ) or Deselect all button ( ) to move all the items from one list to the other.

Use the Apply variable lists button ( ) to move a set of variables from one list to another.

Use the filter box ( ) on either list to limit the variables displayed, either using a text filter, or a
regular expression. This choice can be set in the Altair page in the Preferences window. As you
enter text or an expression in the box, only those variables containing the text or expression are
displayed in the list. Parameters are defined in the Workflow Settings. For more information, see
the Parameters section.

For detailed information about the Altair SLC Hub or artefacts, see the Altair SLC Hub documentation.

Program Results block

Enables output of a dataset in the Workflow as an Altair SLC Hub program result.

Altair SLC Hub is an enterprise management tool. Altair SLC Hub can be managed either locally or
remotely using a web interface called the Altair SLC Hub web portal. When a Workflow is stored in
an Altair Analytics Workbench Project, it can be uploaded to the Altair SLC Hub as an executable
deployment services program. An Altair Analytics Workbench Project can be built into an artefact for
uploading to the Altair SLC Hub from Workbench. An artefact is a singular entity that can consist of
multiple files of programs that can be deployed to the Altair SLC Hub.

The Program Results block is edited through the Configure Program Results dialog box. To open the
Configure Program Results dialog box, double-click the Program Results block.

For more information about building a Workflow into an Altair SLC Hub program, see the Setting up a
Hub program from the Workflow  (page 497) section.

Configure Program Results
Defines the outputs of the Altair SLC Hub program. An output is added upon dragging a connection from
another block with a dataset output to the Program Results block.

Result name
Specifies the name of the result.

Result format
Specifies the format of the result. The following options are available:

• CSV
• XML
• JSON

For detailed information about the Altair SLC Hub or artefacts, see the Altair SLC Hub documentation.
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Setting up a Hub program from the Workflow

Creating a new Altair SLC Hub program from the Workflow

1. From the Project Explorer view, create, or reuse an existing Altair Analytics Workbench Project, more
information about Altair Analytics Workbench Projects can be found in Projects  (page 51). Create
a Workflow within the Altair Analytics Workbench Project, or copy a Workflow in from elsewhere and
open it.

You can specify information for your Hub artefact, including the Group, Name and Version when
you are using the New Altair Analytics Workbench Project wizard to create an Altair Analytics
Workbench Project. Alternatively, you can right-click an existing Altair Analytics Workbench Project
and select Properties to fill out the information in Altair Analytics Workbench Project tab of the
Properties dialog box. For detailed information about Altair SLC Hub artefacts, see the Altair SLC
Hub documentation.

2. From the Workflow Settings, create any desired Workflow parameters for your Hub program,
these will be converted to Hub parameters in the Hub program. For more information about creating
Workflow parameters, see Parameters  (page 185).

3. Expand the SLC Hub group in the Workflow palette, then click and drag a Program Results block
and a Program Inputs block onto the Workflow canvas.

Using a Program Results block or Program Inputs block to set up a Hub program is optional. If you
are not using a Program Inputs block go to step 7. If you are not using a Program Results block,
skip steps 7-9. If you are not using either block, go to step 10

4. Double-click the Program Inputs block.

A Configure Program Inputs dialog box opens.
5. In the Configure Program Inputs dialog box:

a. Choose your desired parameters for the Hub program by moving any parameters from the
Unselected Parameters box to the Selected Parameters box.

b. Click Apply and close to close the Configure Program Inputs dialog box.

The Configure Program Inputs dialog box closes and the selected parameters are included in the
Hub program. An alternative way of including Hub parameters is to bind Workflow parameters to
a field in the configuration window of a Workflow block, to do this, see Binding a parameter to an
option  (page 197) or Using parameters in code  (page 198) for blocks that require coding.

6. Connect an output dataset from a Program Inputs block to other blocks that enable dataset input.
7. Connect a desired dataset output to the Program Results block. The Program Results block takes

only one dataset input, so if required, drag more Program Results blocks onto the Workflow canvas
to connect more datasets.

8. Double-click on the Program Results block.

A Configure Program Results dialog box opens.
9. From the Configure Program Results dialog box enter a name and type for your result in the Result

name and Result type boxes. Repeat for any other Program Results block.
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10.Set the endpoint for the Hub program, to do this:

a. Click Workflow Settings located in the bottom left of the Workflow canvas to open the Workflow
Settings dialog box.

b. Click the Hub tab
c. Under Program path, enter the pathname of the program.
d. Click Apply and close to close the Workflow Settings dialog box.

The Altair SLC Hub program is completed ready to be built as an Artefact and uploaded to the Altair
SLC Hub.

11.Right-click the Altair Analytics Workbench Project that the Workflow is stored in and select Build
Project. If the Build Automatically option is selected under Projects in the Workflow menu, this step
is not needed.

The Workflow must be an included file in the Altair Analytics Workbench Project. To do this, right-
click the Altair Analytics Workbench Project, select Included Files to open a Properties dialog box,
ensure the Workflow is selected and click Apply and close.

12.Right-click the Altair Analytics Workbench Project the Workflow is stored in and select Upload to
Hub, if not already logged in to the Altair SLC Hub, a Hub login window appears where credentials
can be entered.

The artefact is now uploaded to the Altair SLC Hub. For more information about using the Altair SLC
Hub, for example, using the Hub to deploy the artefact, see the Altair SLC Hub documentation.

Custom
Contains the Custom block that enables you to build a customised Workflow.

Custom block .....................................................................................................................................499
Enables you to apply functionality of a Custom block Workflow.

Parameter Import block ..................................................................................................................... 499
Enables you to import one or more Workflow parameters into the Workflow as a dataset.

Input Dataset block ........................................................................................................................... 500
Defines an input dataset of a Custom block Workflow.

Output Dataset block .........................................................................................................................500
Defines an output dataset of a Custom block Workflow.

Creating a Custom block Workflow ................................................................................................... 500
Creating a new Custom block Workflow to define a Custom block.

Using a Custom block .......................................................................................................................502
Applying a newly defined Custom block in a separate Workflow.
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Custom block

Enables you to apply functionality of a Custom block Workflow.

A custom block is a user-defined workflow block that encapsulates functionality of a Workflow to a
block for use in other Workflows. Unlike other Workflow blocks, Custom blocks are defined and created
by you. This is done by specifying a Workflow as a Custom block Workflow through the Workflow
Settings. The contained Custom block Workflow is then defined using the functionality from the
provided workflow blocks, including previously-defined Custom blocks. Custom blocks can include one
or more input parameters from the Parameter Import block or Input Dataset block and one or more
output datasets from the Output Dataset block. For more information about creating a Custom block
Workflow, see Creating a Custom block Workflow  (page 500).

A Custom block can be configured through the Configure Custom dialog box (where Custom is the
name of the Custom block). To open the Configure Custom dialog box, double-click the Custom block.
The Configure Custom dialog box enables you to specify values for any input parameters specified for
the Custom block Workflow

Parameter Import block

Enables you to import one or more Workflow parameters into the Workflow as a dataset.

The Parameter Import block can be invoked by dragging the block onto the Workflow canvas and
configuring the block to specify one or more parameters. The Parameter Import block, then generates
an output dataset containing those parameters.

The importing of parameters into the Workflow is configured using the Configure Parameter Import
dialog box. To open the Configure Parameter Import dialog box, double-click the Parameter Import
block.

Unselected Parameters and Selected Parameters
Allows you to specify parameters for the output dataset. The two boxes show Unselected
Parameters and Selected Parameters. To move an item from one list to the other, double-click
on it. Alternatively, click on the item to select it and use the appropriate single arrow button. A
selection can also be a contiguous list chosen using Shift and click, or a non-contiguous list using
Ctrl and click. Use the Select all button ( ) or Deselect all button ( ) to move all the items

from one list to the other. Use the Apply variable lists button ( ) to move a set of variables

from one list to another. Use the filter box ( ) on either list to limit the variables displayed,
either using a text filter, or a regular expression. This choice can be set in the Altair page in
the Preferences window. As you enter text or an expression in the box, only those variables
containing the text or expression are displayed in the list.
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Input Dataset block

Defines an input dataset of a Custom block Workflow.

This block can be invoked as part of a Custom block Workflow, for more information about setting up a
Custom block Workflow, see the Creating a Custom block Workflow  (page 500) section.

The Input Dataset block can only select dataset parameters. Any required datasets for this block
must first be bound to a parameter. This can be defined before invoking the block, or by using the Add

Dataset Parameter ( ) button in the Configure Input Dataset dialog box.

The input dataset is specified using the Configure Input Dataset dialog box. To open the Configure
Input Dataset dialog box, double-click the Input Dataset block.

Configure Input Dataset

Input Name
Specifies the name of the input dataset parameter.

Output Dataset block

Defines an output dataset of a Custom block Workflow.

This block can be invoked as part of a Custom block Workflow, for more information about setting up a
Custom block Workflow, see the Creating a Custom block Workflow  (page 500) section.

The output name is specified using the Configure Output Dataset dialog box. To open the Configure
Output Dataset dialog box, double-click the Output Dataset block.

Configure Ouptut Dataset

Output Name
Specifies the name of the output dataset.

Creating a Custom block Workflow

Creating a new Custom block Workflow to define a Custom block.

1. From the Workflow Link Explorer, right-click the host node containing the Engine in which you are
running your current session and select Properties.
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2. From the Properties dialog box

a. Select the Workflow Properties tab.
b. From the Custom Block Locations section, select Add... to open the Select Folder dialog box.
c. Select a folder for storing custom blocks, then click Finish.

For it to be used, a Custom block Workflow must be saved to one of the specified folders.
d. Click Apply and Close.

3. Open the Workflow Settings. From the Options tab, select Custom Block, then select an icon or
enter a description as required using the SVG icon or Description fields respectively.

4. Select the Parameters tab. If required, define any input parameters then close the Workflow
Settings. For more information about  defining parameters in the Workflow Settings, see Adding a
parameter from the Workflow  Settings  (page 185)

Use of input parameters for a Custom block Workflow is optional. If you are not using any input
parameters, go to step 9.

5. Expand the Custom group in the Workflow palette, then click and drag a Parameter Import block
onto the Workflow canvas.

6. Double-click the Parameter Import block.

A Configure Parameter Import dialog box opens.
7. In the Configure Parameter Import dialog box:

a. Choose your desired input parameters for the Custom block Workflow by moving your chosen
parameters from the Unselected Parameters box to the Selected Parameters box.

b. Click Apply and close to close the Configure Parameter Import dialog box.

The Configure Parameter Import dialog box closes and the selected parameters are included in the
Custom block Workflow.

If you are only using a dataset parameter, you can alternatively use an Input Dataset block. To do
this, drag an Input Dataset block block onto the canvas, double click it to open the Configure Input
Dataset dialog box, select the dataset in the Dataset drop down box and click Apply and Close to
close the Configure Input Dataset dialog box.

8. Connect the output dataset from the Parameter Import block to a block that enables dataset input.
9. Build the Custom block Workflow functionality by using any required Workflow blocks.
10.Click and drag an Output Dataset block onto the Workflow canvas, then finish the Custom block

Workflow by connecting a desired dataset output to the Output Dataset block. The Output Dataset
block takes only one dataset input, if you want to use multiple output datasets, drag more Output
Dataset blocks onto the Workflow canvas to connect more datasets.

11.Double-click on the Output Dataset block to open the Configure Output Dataset dialog box. From
the Configure Output Dataset dialog box enter a name for your result in the Ouput name field.
Repeat for any other Output Dataset block.
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12.Press Ctrl+S to save the configuration.

The Custom block Workflow is saved and the new custom block is created in the Custom group in
the Workflow palette. Note that your new Custom block must have a unique name in the Workflow
palette, including from other Custom blocks.

The new Custom block has been created and is ready to use in other Workflows.

Using a Custom block

Applying a newly defined Custom block in a separate Workflow.

1. Open or create a Workflow; this should not be a Custom block Workflow.
2. If required, drag and configure one or more prerequisite Workflow blocks onto the Workflow canvas.
3. Expand the Custom group in the Workflow palette, then click and drag the new Custom block onto

the Workflow canvas.
4. If required, click on a block's Output port and drag a connection towards the Input port of the

Custom block.

Alternatively, you can dock the required block onto the Custom block directly.
5. Double-click on the Custom block.

A Configure Custom dialog box (where Custom is the name of the Custom block) opens.
6. From the Configure Custom dialog box, populate each required parameter field either by entering a

value or by adding a binding; for more information, see Adding a parameter from its place of use
(page 195).

7. If the custom block uses one or more dataset parameters, click Map Variables to to open the Map
Variables dialog box.

8. Complete the Map Variables dialog box as follows:

a. From the Mapped Dataset drop down box, select the corresponding dataset input for the dataset
parameter selected in the Dataset Parameter drop down box.

b. For each Required Variable, select the corresponding variable from the mapped dataset using
the drop down boxes in the Mapped Variable column.

c. Click OK
9. Click Apply and Close.

The Configure Custom dialog box closes. A green execution status is displayed in the Output port
of the Custom block.

A Custom block has been applied in the Workflow.
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Statistics
Overview of statistics present in the Workflow Environment.

 R² statistic
Description of the R² statistic and how it is calculated.

The R², also known as the coefficient of determination, is often calculated when predicting an unbounded
numeric variable, for example in the Linear Regression block.  The R² statistic measures the proximity
of the predictions of a model to the observed values. R² is usually thought of as a scale between
0(model does not explain variance in dependent variable) and 1(model fully explains variance in
dependent variable), however it is possible for the R² statistic to output negative values. A negative R²
statistic means the model contains a variance  that has no association with the variance in the dependent
variable. There are two different ways of calculating R², one being  the standard method and the other
used for evaluating a linear regression model without an intercept.

Standard R² calculation
The standard R² calculation uses the total sum of squares (TSS) and error sum of squares (SSE):

 

 

where:

• n is the total number of observations.

• y is the value of the dependent variable.

•  is the mean of the dependent variable.

• f(x) is the application of the model to the set of independent variables, that is the predicted values.

R² is then calculated as:
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R² calculation for linear regression models without an intercept
When the Linear Regression block has no intercept, it calculates R² differently. This R² calculation uses
the error sum of squares (SSE) as defined above and the uncorrected sum of squares (USS):

 

where:

• n is the total number of observations.

• y is the value of the dependent variable.

R² is then calculated as:

 

Binary classification statistics
Description of statistics for binary classification models and how they are calculated.

A binary classification model is a model that aims to predict a binary variable, such as the Logistic
Regression block. The statistics for a binary classification model evaluate the performance of the model.
These statistics are formed around a confusion matrix, which compares the predictions of a model to the
observed values. In binary classification, there are four possible outcomes:

• True positive (TP) – Model correctly predicts a positive outcome.
• False positive (FP) – Model incorrectly predicts a positive outcome, also known as a Type I error.
• True negative (TN) – Model correctly predicts a negative outcome.
• False negative (FN) – Model incorrectly predicts a negative outcome, also known as a Type II error.

The following statistics also make use of the following terms in its calculations:

• P – Total number of positives.
• N – Total number of negatives.

Sensitivity
Sensitivity, also known as the true positive rate, is the ratio of the number of true positives to the total
number of positive events, defined as:
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Specificity
Specificity, also known as the true negative rate, is the ratio of the number of true negatives to the total
number of negative events, defined as:

 

Precision
Precision is the ratio of the number of true positives to the total number of predicted positive outcomes,
defined as:

 

NegPredValue
NegPredValue is the ratio of the number of true positives to the total number of predicted negative
outcomes, defined as:

 

F1 Score
The F1 score, also known as the F1 statistic, is the harmonic mean of precision and sensitivity, defined
as:

 

Accuracy
Accuracy is a measure of how many correct predictions the model has made, defined as:
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Altair Analytics Workbench
Preferences
Enables you to configure how Altair Analytics Workbench operates in the SAS Language Environment,
the Workflow Environment, and generically.

Using Altair Analytics Workbench
Preferences
How to find and navigate Altair Analytics Workbench Preferences.

There are many user settings, controls and defaults that you can control using the Preferences window.
To open the window, click the Window menu and then click Preferences.

The Preferences window has a filter function that can help you find preference pages quickly. Once you
have opened the window, you will see the filter at the top of the preferences list.

General preferences
The General page of the Preferences window contains controls that affect general aspects of Altair
Analytics Workbench.

Always Run in Background
Specifies that long running tasks to be run without displaying the Executing window. This allows
you to carry on using Altair Analytics Workbench for other tasks.

Show Heap Status
When selected, an indicator is displayed in Altair Analytics Workbench showing information about
usage of the current Java heap memory used by the Altair Analytics Workbench interface This
indicator appears in the bottom of the window to the left of the server status.
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To increase your Java heap storage, modify the workbench.ini in the eclipse folder of your
installation, to, for example, -vmargs -Xmx1024m. This sets the maximum Java heap value of
1024 megabytes.

Altair Analytics Workbench save interval (in minutes)
Specifies how often the state of the Altair Analytics Workbench, including perspective layouts, is
automatically saved to disk. Set to 0 (zero) to disable automatic saving.

Open Mode
Specifies the method used to open objects in Altair Analytics Workbench.

• double-click – open an object with a double-click, select by single click.
• Single click (Select on hover) – Open an object with a single click, select by hovering the

mouse cursor over the resource.
• Single click (Open when using arrow keys) – Open an object with a single click, select by

hovering the mouse cursor over the resource. When you use the arrow keys to open an object
with a single click, selecting a resource with the arrow keys will automatically open it in an
editor.

Changing shortcut key preferences
Altair Analytics Workbench provides shortcut key mappings for the most commonly-used commands.
You can modify these mappings, or create new mappings.

To change a shortcut key mapping:

1. Click the Window menu and then click Preferences.
2. In the Preferences window, expand the General group and select Keys.
3. Either type the command name, for example Cancel edits in the filter, or select the required command

in the list.
4. Select Binding and type the shortcut key, for example Ctrl= 5.
5. If no conflicts are reported, click OK to save the new mapping.

To delete a binding, select the required command and click Unbind Command.

Backing up Altair Analytics Workbench
preferences
Saving your current preferences to file to preserve preferences or to import into a different Altair Analytics
Workbench installation.

To save your preferences to file:
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1. Click the File menu and then click Export.
2. In the Export dialog, expand the General group and click Preferences.
3. Click Next and in the Export Preferences page, select the required preferences and enter a

preference file name.

If you are updating an existing file, you can select Overwrite existing files without warning to avoid
warning dialogs during export.

4. Click Finish to create the backup file.

Importing Altair Analytics Workbench preferences
Importing saved preferences from file to an Altair Analytics Workbench installation.

To import preferences from file:

1. Click the File menu and then click Import.
2. In the Import dialog, expand the General group and click Preferences.
3. Click Next and in the Import Preferences page, select the required preferences file and choose the

preference group to import. and enter a preference filename.
4. Click Finish to import the preferences.

Workflow Environment preferences
The Workflow Environment preferences in the Altair section of the Preferences dialog box specify
defaults and preferences when using the Workflow Environment perspective.

Data panel ......................................................................................................................................... 509
Specifies the default level for classifying variables and whether a subset of the dataset is used for
profiling or growing decision trees.

Data Profiler panel .............................................................................................................................509
Specifies the default settings for profiling datasets in the Data Profiler view.

Workflow panel .................................................................................................................................. 510
Specifies default settings for running a Workflow and where intermediate datasets are stored.
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Data panel
Specifies the default level for classifying variables and whether a subset of the dataset is used for
profiling or growing decision trees.

Classification threshold
Specifies the threshold for the number of unique values in a variable for classification. Below
the threshold, the classification is Categorical. If the number of unique values is above the
threshold, the classification is Discrete for character type variables or Continuous for numeric
type variables. The classification is displayed in the Summary View tab of the Data Profiler view.

Limit cells processed to
Specifies the maximum number of cells processed when creating statistics in the Data Profiler
view or Decision Tree editor view. If left empty, all cells in the dataset are used when creating
statistical information or growing a decision tree.

Reducing the number of processed cells in a dataset can help reduce the time taken to view
information about a dataset or grow a decision tree.

The  restriction can be applied to one or both views enabling you to, for example, use a subset of
the dataset in the Data Profiler view and use the whole dataset to grow a decision tree.

Data Profiler panel
Specifies the default settings for profiling datasets in the Data Profiler view.

Summary View preferences
Enables you to specify whether the frequency graph for variables is displayed in the Summary View
panel. In a dataset with a large number of variables displaying the frequency graph may reduce the
responsiveness of the Data Profiler view.

To display the graph, select Show Frequency Graph. To hide the graph, clear Show Frequency
Graph.

Predictive power preferences
Enables you to specify the number of variables displayed in the Entropy chart of the Predictive Power
panel. Variables displayed are those calculated to have the highest Entropy Variance. If the number of
displayed variables is too small, the graph may only display variables with a value variance that is too
random to enable a good selection of dependent variables.
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Workflow panel
Specifies default settings for running a Workflow and where intermediate datasets are stored.

Execution
Specifies whether the Workflow is run automatically or manually. To run the Workflow manually, on
the File menu, click Run Workflow. This option will only run blocks that have changed. If you need to
regenerate all working datasets in the Workflow, on the File menu click Force Run Workflow.

Auto Run Workflow
Select to run a Workflow when a new block is added, or an existing block updated. If left clear the
Workflow needs to be run manually when modified.

Temporary Resources
Specifies whether working datasets and temporary resources used by the Workflow are saved to disk,
and where the resources are located.

Persist to disk
Select to save working datasets in a temporary location on disk. If left clear, working datasets are
stored in memory while the Workflow is open; this may lead to a Workflow failing if the datasets
produced are large.

Location
Specifies the folder where working datasets and other temporary resources are located. By
default this folder is in your user profile. To change the location, click Browse, and select an
alternative folder.

Time-To-Live
Specifies the number of minutes, hours or days the temporary resources are kept for before
being deleted. The default value is 30 days and the maximum value is 180 days.

Clear temporary resources
Click to remove all working datasets and other temporary resources saved to disk.

Binning panel
Specifies the default number of bins created, and the maximum number of bins that can be created.

Default bin count
Specifies the number of bins to be used in equal-width or equal-height binning.
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Winsorrate
Specifies the minimum and maximum percentile value for winsorized binning. All values below
the specified minimum percentile of observations are set to the lower observational value at this
point. All values above the specified maximum percentile of observations are set to the upper
observational value at this point.
For example, if you specify 0.05; prior to the data being split into bins, all values below the 5th
percentile are set to the lower observational value at the 5th percentile, and all values above the
95th percentile are set to the upper observational value at the 95th percentile.

Optimal binning
Specifies the default settings used to determine how a dataset is split into optimal groups for further
analysis.

Measure

Specifies the split measure used when performing optimal binning. for more information about
these measures, see Predictive power criteria  (page 112).

Chi-squared

Specifies that Pearson's Chi-Squared Test is used to measure the predictive power of
variables by measuring the likelihood that the value of the dependent variable is related to
the value of the independent variable.

Gini Variance

Specifies that Gini Variance is used to measure the predictive power of variables by
measuring the strength of association between variables.

Entropy Variance

Specifies that Entropy Variance is used to measure the predictive power of variables by
measuring how well an independent variable value can predict the dependent variable
value.

Information Value
Specifies that Information Value is used to measure the predictive power of variables by
measuring the likelihood that the dependent variable value is related to the value of the
independent variable.

Information Value
Specifies the default settings for the Information Value measure.

Minimum information value
Specifies the minimum value for the information variable. If the information value of a
variable falls below this limit it is not added to the bin.

Maximum change when merging
Specifies the maximum change allowed in the predictive power when optimally merging
bins.
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WoE adjust
Specifies the adjustment applied in weight of evidence calculations to avoid invalid results
for pure inputs.

Entropy Variance
Specifies the default settings for the Entropy Variance measure.

Minimum value
Specifies the minimum value for the Entropy Variance. If the Entropy Variance of a variable
falls below this limit it is not added to the bin.

Maximum change when merging
Specifies the maximum change allowed in the predictive power when optimally merging
bins.

Gini Variance
Specifies the default settings for the Gini Variance measure.

Minimum value
Specifies the minimum value for the Gini Variance. If the Gini Variance of a variable falls
below this limit it is not added to the bin.

Maximum change when merging
Specifies the maximum change allowed in the predictive power when optimally merging
bins.

Chi-squared
Specifies the default settings for the Chi-squared measure.

Minimum value
Specifies the minimum value for the Chi-squared measure. If the Chi-squared measure of a
variable falls below this limit it is not added to the bin.

Maximum change when merging
Specifies the maximum change allowed in the predictive power when optimally merging
bins.

Initial number of bins
Specifies the number of bins into which data is merged before the optimal binning begins.

For example, if you specify 50, then before starting the optimal binning process, a numerical
variable is equally binned into 50 bins; if the number of categories in a variable is greater than 50,
similar categories are merged to create 50 bins.

Maximum number of bins
Specifies the maximum number of bins to use when optimally binning variables.

Exclude Missing
Excludes missing values.

512



Altair Analytics Workbench user guide
Version 2023

Merge a bin with missing values
Specifies that missing values are merged into the bin containing the most similar values. If left
clear, a separate bin is created for missing values.

Monotonic Weight of Evidence
Specifies that the Weight of Evidence value for ordered input variables is either monotonically
increasing or monotonically decreasing.

Minimum bin size
Specifies the minimum number of observations for bin as either a proportion of the input dataset
or an absolute value.

Count
Specifies the absolute minimum number of observations a bin can contain.

Percent
Specifies the minimum size of each bin as a proportion of the number of input observations.

Chart panel
Specifies preferences for the Correlation Analysis view of the Data Profiler view.

Scatter plot observations threshold
Specifies the limit above which a heat map of values is shown in the Scatter Plot panel of the
Correlation Analysis view.

Correlation Matrix
Specifies how items are displayed in the Correlation Coefficient Matrix chart in the Correlation
Analysis view.

Vary matrix item size by coefficient magnitude
Select to display the size of the items in the Correlation Coefficient Matrix chart relative to
the coefficient of the two variables being compared. Clear to display all items in the chart at
the same size.

Matrix item shape
Specifies the shape of the item on the Correlation Coefficient Matrix chart, either Circle
or Square
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Decision Tree panel
Specifies the default tree growth preferences for a decision tree.

The Decision Tree block uses the information specified in this panel when growing a decision tree using
the DECISIONTREE procedure in Altair SLC. For more information see the DECISIONTREE procedure in
the Altair SLC Reference for Language Elements.

Default Growth
Specifies the default growth algorithm for a new decision tree, one of:

• C4.5. Specifies the C4.5 algorithm is used for generating a classification decision trees.
• CART. Specifies the CART algorithm is used for generating classification and regression

decision trees.
• BRT. Specifies the BRT algorithm is used for generating binary response decision trees.

C4.5
Specifies the default preferences for a decision tree grown using the C4.5 method. A decision tree grown
with this method always uses the Entropy Variance to determine when to split a node in the tree.

Maximum depth
Specifies the maximum depth of the decision tree.

Minimum node size (%)
Specifies the minimum number of observations in a decision tree node, as a proportion of the
input dataset.

Merge categories
Specifies that discrete independent (input) variables are grouped together to optimize the
dependent (target) variable value used for splitting.

Prune
Select to specify that nodes which do not significantly improve the predictive accuracy are
removed from the decision tree to reduce tree complexity.

Prune confidence level
Specifies the confidence level for pruning, expressed as a percentage.

Exclude missings
Specifies that observations containing missing values are excluded when determining the best
split at a node.

CART
Specifies the default preferences for a decision tree grown using the CART method.

Criterion
Specifies the criterion used to split nodes in the decision tree. The supported criteria are:
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Gini
Specifies that Gini Impurity is used to measure the predictive power of variables.

Ordered twoing
Specifies that the Ordered Twoing Index is used to measure the predictive power of
variables.

Twoing
Specifies that the Twoing Index is used to measure the predictive power of variables.

Prune
Select to specify that nodes which do not significantly improve the predictive accuracy are
removed from the decision tree to reduce tree complexity.

Pruning method
Specifies the method to be used when pruning a decision tree. The supported methods are:

Holdout
Specifies that the input dataset is randomly divided into a test dataset containing one third
of the input dataset and a training dataset containing the balance. The output decision tree
is created using the training dataset, then pruned using risk estimation calculations on the
test dataset.

Cross validation
Specifies that the input dataset is divided as evenly as possible into ten randomly-selected
groups, and the analysis repeated ten times. The analysis uses a different group as test
dataset each time, with the remaining groups used as training data.

Risk estimates are calculated for each group and then averaged across all groups. The
averaged risk values are used to prune the final tree built from the entire dataset.

Maximum depth
Specifies the maximum depth of the decision tree.

Minimum node size (%)
Specifies the minimum number of observations in a decision tree node, as a proportion of the
input dataset.

Minimum improvement
Specifies the minimum improvement in impurity required to split decision tree node.

Exclude missings
Specifies that observations containing missing values are excluded when determining the best
split at a node.

BRT
Specifies the default preferences for a decision tree grown using the BRT method.
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Criterion
Specifies the criterion used to split nodes in the decision tree. The supported criteria are:

Chi-squared
Specifies that Pearson's Chi-Squared statistic is used to measure the predictive power of
variables.

Entropy variance
Specifies that Entropy Variance is used to measure the predictive power of variables.

Gini variance
Specifies that Gini Variance is used to measure the predictive power of variables by
measuring the strength of association between variables.

Information value
Specifies that Information Value is used to measure the predictive power of variables.

Maximum depth
Specifies the maximum depth of the decision tree.

Select minimum node size by ratio
When selected enables you to specify the minimum number of observations in a node as a
proportion of the input dataset. When cleared, enables you to specify the absolute minimum
number of observations in a node.

Minimum node size (%)
Specifies the minimum number of observations in a decision tree node, as a proportion of the
input dataset.

Minimum node size
When selected enables you to specify the minimum split size of a decision tree node as a
proportion of the input dataset. When cleared, enables you to specify the absolute minimum split
size of a decision tree node .

Select minimum split size by ratio
When selected enables you to specify the minimum number of observations for the node to be
split as a proportion of the input dataset. When cleared, enables you to specify the absolute
minimum number of observations in a node.

Minimum split size (%)
Specifies the minimum number of observations a decision tree node must contain for the node to
be split, as a proportion of the input dataset.

Minimum split size
Specifies the absolute minimum number of observations a decision tree node must contain for the
node to be split.

Allow same variable split
Specifies that a variable can be used more than once to split a decision tree node.
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Open left
For a continuous variable, when selected, specifies that the minimum value in the node containing
the very lowest values is    (minus infinity). When clear, the minimum value is the lowest value
for the variable in the input dataset.

Open right
For a continuous variable, when selected, specifies that the maximum value in the node
containing the very largest values is    (infinity). When clear, the maximum value is the largest
value for the variable in the input dataset.

Merge missing bin
Specifies that missing values are considered a separate valid category when binning data.

Monotonic Weight of Evidence
Specifies that the Weight of Evidence value for ordered input variables is either monotonically
increasing or monotonically decreasing.

Exclude missings
Specifies that observations containing missing values are excluded when determining the best
split at a node.

Initial number of bins
Specifies the number of bins available when binning variables.

Maximum number of optimal bins
Specifies the maximum number of bins to use when optimally binning variables.

Weight of Evidence adjustment
Specifies the adjustment applied to weight of evidence calculations to avoid invalid results for pure
inputs.

Maximum change in predictive power
Specifies the maximum change allowed in the predictive power when optimally merging bins.

Minimum predictive power for split
Specifies the minimum predictive power required for a decision tree node to be split.

Workflow Canvas panel
Specifies preferences for the Workflow canvas.

Show execution status colour on block at zoom <=
Specifies that the colour of the Workflow blocks change to their execution status upon reaching a
zoom percentage threshold and sets the zoom percentage threshold.
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Workflow magnifier
Specifies the size parameters of the Workflow magnifier. For more information on the Workflow
magnifier, see Workflow magnifier  (page 174).

Height
Specifies the height of the Workflow magnifier.

Width
Specifies the width of the Workflow magnifier.
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Using Git with Workbench
Git support can be installed into Altair Analytics Workbench, enabling a Git Staging view and Git
perspective, which allow management of Git files from within Workbench.

Installing Altair Analytics Workbench Git
support
Setting up Altair Analytics Workbench to work with Git.

Git support can be installed into any version of Altair Analytics Workbench. Before you start, obtain the
URL of the eGit update site (at the time of writing, this is https://download.eclipse.org/egit/updates).

To install Git into Altair Analytics Workbench:

1. Open Altair Analytics Workbench.
2. From the Help drop-down menu, select Install New Software.
3. In Work with, enter the URL of the eGit update site and press Return.
4. Expand the Git integration for Eclipse folder and then select Git integration for Eclipse.
5. Click Next.

The progress bar shows Calculating requirements and dependencies. After a short delay, you will
be asked to Review the items to be installed.

6. Click Next.
7. Select I accept the terms of the license agreements and click Finish.

An Installing Software progress window is displayed.
8. At the Do you trust these certificates? page, select the certificate at the top of the list and click OK.

The Installing Software progress window continues.
9. When asked to restart Altair Analytics Workbench, click Yes.

Altair Analytics Workbench restarts.

Altair Analytics Workbench Git support is now installed.
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Using Workbench with Git
Workbench provides two ways to integrate with Git: the Git Staging view and the Git perspective.

Opening the Altair Analytics Workbench Git
Staging view
The Altair Analytics Workbench Git Staging view offers basic Git integration, such as simple commit
operations.

To use the Git Staging view, you must have installed Git Workbench support (see Installing Altair
Analytics Workbench Git support  (page 519)).

To display the Git Staging view:

1. From Altair Analytics Workbench, select the Window menu, then Show View and click Other.

A Show View window is displayed.
2. From the Git folder, select Git Staging and click OK.

The Git Staging view is displayed.

Opening the Altair Analytics Workbench Git
perspective
The Altair Analytics Workbench Git perspective offers full Git support within Workbench.

To use the Git perspective, you must have installed Git Workbench support (see Installing Altair Analytics
Workbench Git support  (page 519)).

To display the Git perspective:

1. From Altair Analytics Workbench, select the Window menu, then Perspective and click Other.
2. From the list of perspectives, click Git and click OK.

The Altair Analytics Workbench Git perspective is displayed.
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Configuration files
Configuration files contain system options that define the behaviour of an Altair SLC session. A session
starts when an Altair SLC program is run from the command line, and also when the Altair SLC server is
started by Altair Analytics Workbench.

When Altair SLC is installed, a default configuration file, called altairslc.cfg, is created in the Altair
SLC installation directory. This configuration file contains the system options used to define the initial
Altair SLC environment. You are advised not to edit this file. Instead, you should create a configuration
file in one of the directories described below. When a session starts, various default directories are
checked for configuration files. If a system option is set in more than one configuration file, the setting
of the system option in the last accessed configuration file is used. System options that have been set
on the command line, or in the Startup Options configuration panel for a server, override the settings of
corresponding system options in the configuration files.

A configuration file is a text file that can be edited in a text editor. You can add, remove or change
system options to suit your needs. It is recommended that you use the altairslc.cfg file in the:

• C:\ProgramData\altairslc-pathname directory on Windows.
• /etc/altairslc-pathname/ directory on UNIX platforms.

where altairslc-pathname is an Altair SLC-specific path that is created during installation.

Altair SLC initialisation procedure for Windows
When Altair SLC is invoked, the following initialisation procedure occurs:

1. The WPS_SYS_CONFIG operating system environment variable is evaluated and, if it exists, the
specified configuration file is processed. The processing of this file does not affect whether the
default configuration file and user-defined configuration files in default locations are also processed.

2. Any files specified via the -config option on the command line or in the startup options for a server
are processed.

If any configuration files are specified via the -config option, the default configuration files are not
loaded, and the WPS_USER_CONFIG is processed instead.
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3. Altair SLC searches for configuration files with the following names in the following directories. The
order of the list is the same as the order of precedence. altairslc.cfg is created when Altair SLC
is installed. Other files can be created by users to specify server specific options.

a. altairslc.cfg in the Altair SLC installation directory.
b. altairslc_local.cfg in the Altair SLC installation directory. You can create and edit this file

to provide site-specific overrides of various options.
c. C:\ProgramData\altairslc-pathname\altairslc.cfg, where altairslc-pathname is

an Altair SLC-specific path that is created during installation. If you want to change the system
options set for the session by the default altairslc.cfg file in the installation directory, then it
is recommended that you use this configuration file to reset or add system options.

d. C:\ProgramData\altairslc-pathname\altairslc_local.cfg, where
altairslc-pathname is an Altair SLC-specific path created during installation.

e. Documents\My WPS Files\altairslc.cfg or wps.cfg
f. Documents\My WPS Files\.altairslc.cfg or .wps.cfg.
g. Documents\My WPS Files\altairslcversion.cfg or wpsversion.cfg.
h. Documents\My WPS Files\altairslcversion.cfg or wpsversion.cfg.
i. altairslc.cfg in the current directory.
j. altairslcversion.cfg in the current directory.

version is the version of your Altair SLC installation.
4. The WPS_USER_CONFIG environment variable is evaluated and, if it exists, the specified

configuration file is processed.
5. The WPS_OPTIONS environment variable is evaluated and, if it exists, any system options specified

are processed. The syntax of this environment variable is the same as if the options are specified on
the command line.

6. Any system options specified on the command line are processed.

Altair SLC initialisation procedure for UNIX platforms
When Altair SLC is invoked, the following initialisation procedure occurs:

1. Any files specified via the -config option on the command line or in the startup options for the
server are processed.

If any configuration files are loaded in this way, the default configuration file and user-created
configuration files in default directories are not loaded.

2. The WPS_OPTIONS and WPS_versionOPTIONS environment variables (where version is the version
of your Altair SLC installation) are evaluated and any contained -config options are processed.

Note:
If any configuration files are loaded in this way, the default configuration files are not loaded.

Note:
This step is skipped if the -NOCONFIG option is specified on the command line.
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3. The WPS_CONFIG and WPS_versionCONFIG environment variables (where version is the version
of your Altair SLC installation.) are evaluated and, if they exist, the specified configuration files are
processed.

Note:
If any configuration files are loaded in this way, the default configuration files are not loaded.

Note:
This step is skipped if the -NOCONFIG option is specified on the command line.

4. If no configuration files have yet been loaded, the default configuration files are loaded in the
following order:

a. altairslc.cfg in the Altair SLC installation directory.
b. altairslc_local.cfg in the Altair SLC installation directory. This file can be edited to provide

site-specific overrides of various system options.
c. /etc/world programming/altairslc.cfg. If you want to add, remove or change system

options, it is recommended that you use this configuration file.
d. /etc/world programming/altairslc_local.cfg.
e. .altairslc.cfg in your home directory.
f. altairslc.cfg in your home directory.
g. .altairslcversion.cfg in your home directory.
h. altairslcversion.cfg in your home directory.
i. altairslc.cfg in the current directory.
j. altairslcversion.cfg in the current directory

version is the version of your Altair SLC installation.
5. The WPS_OPTIONS environment variable is evaluated and, if it exists, any system options specified

are processed. The syntax of this environment variable is the same as if the system options are
specified on the command line.

6. Any system options specified on the command line are processed.

There are also restricted configuration files. These files contain system options that cannot be set using
any other method. The files are based on the user's user id and group id. For example, if the user is
user and the group is group, the following configuration files are processed:

1. misc/rstropts/raltairslc.cfg in the Altair SLC installation directory
2. misc/rstropts/groups/group_raltairslc.cfg in the Altair SLC installation directory
3. misc/rstropts/users/user_raltairslc.cfg in the Altair SLC installation directory
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Get information about the startup procedure
It is possible to check which configuration files have been processed by viewing the current setting of the
CONFIG system option. You can do this using the PROC OPTIONS statement:

PROC OPTIONS OPTION=CONFIG;
RUN;

You can also set the VERBOSE system option on the command line, or in the startup options for the
server; this writes information to the log about which configuration files were processed and which
system options were set.
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AutoExec file
An AutoExec file contains SAS language statements or a program that is automatically executed when
a Processing Engine is started, or restarted from Altair Analytics Workbench. The file can be used for
a number of purposes, such as setting up common LIBNAMES so that they do not need to be added to
every program that is run.

Windows
The Altair SLC Server automatically runs a file called autoexec.sas. The Altair SLC Server
searches for the autoexec.sas file in the following directories, in the order shown:

1. The current directory
2. My Documents in your user profile
3. Paths specified in the PATH environment variable
4. The root directory of the drive, for example C:\
5. The Altair SLC installation directory.

Other operating systems
The Altair SLC Server automatically runs a file called autoexec.sas. The Altair SLC Server
searches for the autoexec.sas file in the following directories, in the order shown:

1. The current directory
2. Your user home ($HOME) directory
3. The Altair SLC installation directory.

Specifying a different file
To automatically run a different file, or a file not in the searched directory hierarchy, set the AUTOEXEC
system option to point to the file (see Configuration files  (page 521)).

You can also set the AUTOEXEC system option through Altair Analytics Workbench:

1. In the Link Explorer or Workflow Link Explorer view, right-click the server name and click
Properties from the shortcut menu.

2. In the Properties list, double-click Startup, click System Options.
3. On the System Options panel, click Add.
4. In the Name field, enter AUTOEXEC, and in the Value field enter the path to the required configuration

file and click OK.
5. Click OK on the Properties dialog and you will be prompted to restart the server.
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Altair SLC tips and tricks
Tips and tricks for general setup, file management, running SAS language programs and datasets.

General Setup
• Use Link connect to a remote server solution and run SAS language programs (see Connecting to a

remote Processing Engine  (page 33)).
• You can change the Altair Analytics Workbench font, background appearance, or change the shortcut

key bindings (see Using Altair Analytics Workbench Preferences  (page 506)).
• You can export and import preferences (including templates) between workspaces.
• You can use configuration files to control the system options used in the Altair SLC environment (see

Configuration files  (page 521)).
• You can use an AutoExec file to set up common LIBNAME statements and use them any program

running on the Altair SLC Server (see AutoExec file  (page 525)).
• You can define multiple servers the same machine and distribute programs between those servers

(see Defining a new Processing Engine  (page 36)).

File Management
• To display or create a different group of projects, you can switch to a different workspace (see

Switching to a different workspace  (page 64)).
• You can restore a file deleted in the Project Explorer from the project's local history (see Restoring

from local history  (page 63)).
• You can use the Project Explorer to compare and merge files (see Comparing and merging multiple

files  (page 56)).
• You can create directory shortcuts in the File Explorer to access files on the host file system (see

Creating a new remote host connection  (page 34)).

Running SAS language programs
• You can specify code that is to be executed automatically before and after each program (see Code

Injection  (page 126)).
• You can create templates containing code snippets that can be re-used (see Entering Altair SLC

code via templates  (page 126)).
• You can run part of a program from the Altair Analytics Workbench (see Running a selected section

of a program  (page 128)).
• You can control whether or not the ODS destinations are to be controlled automatically, and, if so,

which specific types of output are to be used (see Automatically manage ODS destinations  (page
156)).
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• You can set a permanent location for the WORK library to preserve datasets when Altair Analytics
Workbench is closed (see Setting the WORK location  (page 133)).

Datasets
• You can edit datasets from within the Altair Analytics Workbench, using in-place context-aware editing

and column re-ordering.
• You can export datasets as delimited and fixed width text, and also as Microsoft Excel spreadsheets.
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Altair SLC troubleshooting
A list of potential problems and how to resolve them.

Why are the icons greyed out so that I cannot run any programs?

The icons will be greyed out if:

• The server on which you are running programs is not licensed or has been uninstalled. See
Processing Engines  (page 31) for more information.

• The name of the program file open in the Editor view does not use the .sas or .wps file name
extension.

• The focus of the mouse is in a view other than the Editor view.

Why do I see a dialog saying that there is no default server on which to submit the program?

Usually because the default Altair SLC Server has been removed. If you have other Altair SLC
Servers defined, select one of those as the new default (see Default Processing Engine  (page
41)). Alternatively, you can restore the Altair SLC Server that was removed (see Defining a new
Processing Engine  (page 36)) and set it as the default.

Why are the characters in my files not being displayed correctly?

This is likely to be an encoding issue. You should follow all the steps in Processing Engine 
LOCALE and ENCODING settings  (page 43) and General text file encoding  (page 44), and
restart Altair Analytics Workbench. If you have imported the files that are displayed incorrectly,
then you many need to re-import them.

Why can't I start the Altair Analytics Workbench?

If the Altair Analytics Workbench usually starts, but then fails, you may have run out of disk space,
causing one or more files in the workspace .metadata directory to become corrupted. Rename
the .metadata folder in the corrupt workspace directory to something else, restart Altair SLC ,
and select to the workspace again. The Project Explorer contains no entries, but the project
content and location are unaffected. You can reimport any existing projects as required. See
Importing an existing project  (page 11) for more information.

How do I increase my Java heap storage in the event of Java Runtime errors?

You can set the -Xmx and -Xms Java options to change the amount of heap memory available to
the Java Runtime. See Show Heap Status  (page 506) for more information.
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Making technical support
requests
Technical support procedures for Altair SLC , including guidance for submitting log files.

How you access technical support for your Altair SLC software depends on how you purchased your
software. If you made a standard purchase of Altair SLC software you have an annual subscription
licence that entitles you to unlimited free upgrades throughout the twelve months, and free email support
via support@worldprogramming.com.

Larger customers may have additional support arrangements in place. In this case, the handling of
technical support requests may be carried out via one or more super users in your organisation; you
need to be aware who the super users are to progress support issues.

Due to the complex nature of the SAS language, extended interaction between World Programming
and yourselves may be required to identify and resolve the issue. Resolutions to problems may include
suggested workarounds or may require you to update your Altair SLC software installation.

Altair SLC Server log files
For certain types of issue, you may be requested to provide the log file. If the log is open in Altair
Analytics Workbench, right-click on the view and click Save as from the shortcut menu. If the log is not
open, the .log file is stored in the .metadata directory in the active workspace.

Because .metadata and .log start with a period, they will normally be hidden and you will need to
ensure you can see these types of file.
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Legal Notices
Copyright 2002-2023 World Programming, an Altair Company

This information is confidential and subject to copyright. No part of this publication may be reproduced or
transmitted in any form or by any means, electronic or mechanical, including photocopying, recording, or
by any information storage and retrieval system.

Trademarks
Altair SLCTM, Altair Analytics WorkbenchTM, and Altair SLC HubTM are registered trademarks or
trademarks of Altair Engineering, inc. (r) or ® indicates a Community trademark.

SAS and all other SAS Institute Inc. product or service names are registered trademarks or trademarks of
SAS Institute Inc. in the USA and other countries. ® indicates USA registration.

All other trademarks are the property of their respective owner.

General Notices
Altair Engineering, inc. is not associated in any way with the SAS Institute.

Altair SLC is not the SAS System.

The phrases "SAS", "SAS language", and "language of SAS" used in this document are used to refer to
the computer programming language often referred to in any of these ways.

The phrases "program", "SAS program", and "SAS language program" used in this document are used to
refer to programs written in the SAS language. These may also be referred to as "scripts", "SAS scripts",
or "SAS language scripts".

The phrases "IML", "IML language", "IML syntax", "Interactive Matrix Language", and "language of IML"
used in this document are used to refer to the computer programming language often referred to in any
of these ways.

Altair SLC includes software developed by third parties. More information can be found in the THANKS
or acknowledgments.txt file included in the Altair SLC installation.
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